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How to use this manual

Introduction

How to use this manual

About This User Manual
• Symbols
The following symbols are used in this User Manual to indicate safety information and explanations
on restrictions or precautions in use.

Important Indicates important information that must be followed when using the
printer. Be sure to read this information to prevent printer damage or
operating errors.

Caution Indicates caution items for which operating error poses a risk of injury or
damage to equipment or property. To ensure safe use, always follow these
precautions.

Note Indicates helpful reference information and supplemental information on
particular topics.

• Button names and user interface elements
Key and button names on the control panel and user interface elements in software (such as menus and
buttons) are indicated as follows in this User Manual.

Control panel buttons Example: Press the OK button.

Control panel messages Example: Head Cleaning is displayed.

Software interface items
(Menus and Buttons)

Example: Click OK.

Keyboard keys Example: Press the Tab key.

• Part names
Names of printer parts are indicated as follows in this User Manual.

Printer part names Example: Open the Top Cover.

• Cross-reference
Other pages or manuals that provide related information are indicated as follows in this User Manual.

Cross-reference in the same user manual Example: see “Turning the Printer On and Off”.
(→P.24)

Cross-reference in related manuals Example: See the Paper Reference Guide.

Other cross-reference Example: See the printer driver help.
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• Figures and software screens
• Figures in this User Manual may be different from the actual appearance of the printer in some
cases.

• Screens depicted in this User Manual for the printer driver or other software may be different from
the actual screens because of subsequent updates.

• Windows XP screens are used in explanations of Windows operations in this User Manual.
• Trademarks

• Canon, the Canon logo, and imagePROGRAF are trademarks or registered trademarks of Canon
Inc.

• Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States
and other countries.

• Macintosh is a registered trademark of Apple Inc. in the United States and other countries.
• Other company and product names are trademarks or registered trademarks of their respective
owners.

• Copyright
© 2009 Canon Inc.

• Unauthorized reproduction of this User Manual in whole or part is prohibited.
• May we request
Thank you for understanding the following points.

• The information in this User Manual is subject to change without notice.
• We strive to ensure accuracy of information in this User Manual, but if you notice errors or
omissions, please contact us.
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Searching Topics
You can nd information in topics of this User Manual by searching for relevant terms.

1. Enter a term and click the Search button.

Note
• To search for multiple terms at once, enter a space between each term.

Search results are listed at left.
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2. Click a topic you want to read.
The terms you searched for will be highlighted in the topic.

To review multiple topics at once, select the check box of desired topics and click the Apply
button.
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HTML Version of the Manual for Printing
You can select a group of topics in the table of contents or individual topics in this manual for printing.
The following procedure describes how to do this, using the information in Basic Printing Workow as an
example.

Printing a group of topics in the manual
When you access printable HTML versions of the content from section titles in the table of contents, you
can specify a group of topics to print.

1. Click a section title in the table of contents. Here, Basic Printing Workow is used as an
example.
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2. Click Access to the HTML for printing in the title area.

The topics in Basic Printing Workow are displayed together in HTML format, ready for printing.
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3. Clear the sections you will not print and click the Apply button.

Printing a group of individual topics in the manual
When you access printable HTML versions from subtitles in the table of contents, you can specify a group
of topics to print.

1. Click a section title in the table of contents. Here, Basic Printing Workow is used as an
example.
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2. Under Basic Printing Workow, click Printing Procedure.

3. Click Access to the HTML for printing in the title area.
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The topics in Printing Procedure are displayed together in HTML format, ready for printing.

4. Clear the topics you will not print and click the Apply button.
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Printing selected topics
Print selected topics as follows.

1. Access the printing dialog box as follows, depending on your computer’s operating system.
• Windows
In Windows, right-click anywhere in the explanation area except on a gure or a link.In the shortcut
menu, click Print to display the Print dialog box.
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• Macintosh
On a Macintosh computer, click anywhere in the explanation area except on a gure or a link while
holding the Ctrl key. In the shortcut menu, click Print Frame to display the Print dialog box.

2. Specify conditions as needed, and then click Print (Windows) or Print (Macintosh).
• Windows
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• Macintosh

Note
• To print only individual topics that are displayed, use this method.
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Printer parts

Printer Parts

Printer parts

Front

a. Roll Cover
Open this cover to load rolls. (→P.17)

b. Paper Feed Slot
When loading paper, insert it here.

c. Roll Ledge
When loading rolls, rest the Roll Holder here before loading it in the Roll Holder Slot.

d. Release Lever
When releasing the Paper Retainer, push this lever back.

e. Control Panel
Use this panel to operate the printer and check the printer status. (→P.20)

f. Ink Tank Cover
Open this cover to replace an Ink Tank. (→P.18)

g. Paper Alignment Line
An orange line for alignment of paper.

h. Maintenance Cartridge Cover
Open this cover to replace the Maintenance Cartridge.

i. Maintenance Cartridge
Absorbs ink used for maintenance purposes such as head cleaning. (Replace the cartridge when it
is full.)
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j. Cutter Unit
A round-bladed cutter for automatic roll cutting.

k. Cutter Rail
The Cutter Unit passes over this rail to cut paper.

l. Output Tray
All printed documents are ejected from this slot.

m.Ejection Guide
Guides printed documents as they are ejected.

n. Top Cover
Open this cover to install the Printhead and remove any jammed paper from inside the printer,
as needed. (→P.16)

o. Width Guide
When loading the sheets , move the guide to match the paper size.

p. Stand
A stand that holds the printer. Equipped with casters to facilitate moving it. (→P.19)
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Side

a. Manual Pocket
Store printer manuals in this pocket.

b. Ethernet Port
Connect an Ethernet cable to this port. The lamp is lit if the Ethernet cable is connected correctly
and communication is possible between the computer and printer.

c. USB Port
Connect a USB cable to this port. The printer is compatible with Hi-Speed USB connections.

d. Carrying Handles
When carrying the printer, have three people hold it by these handles on the back at both ends.

e. Power Supply Connector
Connect the power cord to this connector.

Printer Parts 15



Printer parts

Top Cover (Inside)

a. Carriage
Moves the Printhead. The carriage serves a key role in printing. (→P.17)

b. Carriage Shaft
The Carriage slides along this shaft.

c. Paper Retainer
Important in supplying the paper. This retainer holds paper as it is fed.

d. Platen
The Printhead moves across the platen to print. Vacuum holes on the platen hold paper in place.

e. Borderless Printing Ink Grooves
For catching ink outside the edges of paper during borderless printing.

f. Linear Scale
The linear scale serves a key role in detecting the Carriage position. Be careful not to touch this
part when cleaning inside the Top Cover or clearing paper jams.

g. Cleaning Brush
When cleaning inside the printer under the Top Cover, use this brush to sweep away paper dust on
the Platen.
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Roll Cover (Inside)

a. Roll Holder
Load the roll on this holder.

b. Holder Stopper
Secure rolls on the Roll Holder with this part.

c. Roll Loading Slots
Slide the Roll Holder along these slots.

d. Roll Holder Slot
Load the Roll Holder into this holder slot.

Carriage

a. Angle Adjustment Lever
Use this lever to ne-tune the printer to correct misalignment of printed lines.

b. Printhead
The printhead is equipped with ink nozzles. The carriage serves a key role in printing.

c. Printhead Fixer Lever
Locks the Printhead Fixer Cover.

d. Printhead Fixer Cover
Holds the Printhead in place.
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Ink Tank Cover (Inside)
Left Side Right Side

a. Ink Tank Lock Lever
A lever that locks the Ink Tank in place and protects it. Lift and press down
the lever when replacing an Ink Tank.

b. Ink Set Label
An Ink Tank that can be used in the printer is labeled with a white letter “J” in a black circle on the
side. When purchasing an Ink Tank, make sure a “J” is printed on the label. (→P.622)

c. Ink Color Label
Load an Ink Tank that matches the color and name on this label.

d. Ink Lamp (Red)
Indicates the state of the Ink Tank as follows when the Ink Tank Cover is opened.

• On
The Ink Tank is installed correctly.

• Off
No Ink Tank is installed, or the ink level detection function has been released.

• Flashing Slowly
Not much ink is left.

• Flashing Rapidly
There is no ink left.

e. Ink Tank
Cartridges of ink in various colors.
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Stand

a. Accessory Pocket
Stores printer accessories.

b. Output Stacker
Printed documents are ejected into the output tray.

c. Locking Caster
Lock to immobilize the caster.
Before moving the printer, always unlock all four casters. Moving the printer while casters are locked
may scratch the casters or the oor.

d. Adjustable Stopper
Pull out when using the output stacker in the extended position.

e. Paper Guide
Guides printed documents into the output stacker.
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Control Panel

a. Display Screen
Shows printer menus, as well as the printer status and messages.

b. Data Lamp (green)
• Flashing
During printing, the Data lamp ashes when the printer is receiving or processing print jobs.
Otherwise, this lamp ashes when the print job is paused or the printer is updating the rmware.

• Off
There are no active print jobs when the Data lamp is off.

c. Message Lamp (orange)
• On
A warning message is displayed.

• Flashing
An error message is displayed.

• Off
The printer is off or is operating normally.

d. Power button (green)
Turns the printer on and off. (→P.24)
The Power button is lit when the printer is on or in Sleep mode.

e. Stop button
Cancels print jobs in progress and ends the ink drying period.

f. Navigate button
Enables you to check instructions for loading and removing paper or replacing ink tanks or
printheads, as well as other operations. (→P.29)

g. Arrow buttons
• ◄ button
Press this button on the Tab Selection screen to move to another tab.
In menu items requiring numerical input, press this button to move to another digit.

• ▲ button
Press this button when viewing menus to display the next menu item or setting value.

• ► button
Press this button on the Tab Selection screen to move to another tab.
In menu items requiring numerical input, press this button to move to another digit.

• ▼ button
Press this button when viewing menus to display the next menu item or setting value.
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h. OK button
Press this button on the Tab Selection screen to display the menu of the tab shown.
Pressing this button in menu items of each tab for which is displayed at left will move to the lower
level of the menu item, enabling you to execute menu commands or set menu values.
Also press this button if the Display Screen indicates to press the OK button.

i. Back button
Displays the screen before the current screen.

j. Menu button
Displays the Tab Selection screen. (→P.49)

k. Load button
Press this button when loading or replacing paper.
(→P.106)
(→P.136)

l. Feed button
Pressing this button when rolls are loaded enables you to reposition the paper. (→P.125)

m.Cut button
Pressing this button when rolls are loaded cuts the paper, if you have specied Automatic or Eject
in Cutting Mode in the Control Panel menu. (→P.129)

n. Cut Sheet lamp (green)
Lit when sheets are selected as the paper source.

o. Roll Media lamp (green)
Lit when rolls are selected as the paper source.

Note
• To recover from Sleep mode, any button can be pressed except the Power button.
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Control Panel

Control Panel

a. Display Screen
Shows printer menus, as well as the printer status and messages.

b. Data Lamp (green)
• Flashing
During printing, the Data lamp ashes when the printer is receiving or processing print jobs.
Otherwise, this lamp ashes when the print job is paused or the printer is updating the rmware.

• Off
There are no active print jobs when the Data lamp is off.

c. Message Lamp (orange)
• On
A warning message is displayed.

• Flashing
An error message is displayed.

• Off
The printer is off or is operating normally.

d. Power button (green)
Turns the printer on and off. (→P.24)
The Power button is lit when the printer is on or in Sleep mode.

e. Stop button
Cancels print jobs in progress and ends the ink drying period.

f. Navigate button
Enables you to check instructions for loading and removing paper or replacing ink tanks or
printheads, as well as other operations. (→P.29)
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g. Arrow buttons
• ◄ button
Press this button on the Tab Selection screen to move to another tab.
In menu items requiring numerical input, press this button to move to another digit.

• ▲ button
Press this button when viewing menus to display the next menu item or setting value.

• ► button
Press this button on the Tab Selection screen to move to another tab.
In menu items requiring numerical input, press this button to move to another digit.

• ▼ button
Press this button when viewing menus to display the next menu item or setting value.

h. OK button
Press this button on the Tab Selection screen to display the menu of the tab shown.
Pressing this button in menu items of each tab for which is displayed at left will move to the lower
level of the menu item, enabling you to execute menu commands or set menu values.
Also press this button if the Display Screen indicates to press the OK button.

i. Back button
Displays the screen before the current screen.

j. Menu button
Displays the Tab Selection screen. (→P.49)

k. Load button
Press this button when loading or replacing paper.
(→P.106)
(→P.136)

l. Feed button
Pressing this button when rolls are loaded enables you to reposition the paper. (→P.125)

m.Cut button
Pressing this button when rolls are loaded cuts the paper, if you have specied Automatic or Eject
in Cutting Mode in the Control Panel menu. (→P.129)

n. Cut Sheet lamp (green)
Lit when sheets are selected as the paper source.

o. Roll Media lamp (green)
Lit when rolls are selected as the paper source.

Note
• To recover from Sleep mode, any button can be pressed except the Power button.
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Turning the Printer On and Off
Turning the printer on
1. Press the Power button to turn on the printer.

The printer will now start up.
After the Display Screen shows the Canon logo, Starting up... Please wait. is displayed.

2. The Power Lamp is lit when the printer nishes starting up, and the printer is now in Standby.

The printer will not go into Standby in the following situations. Take the appropriate action.
• The Top Cover is open
Close the Top Cover.

• The Ink Tank Cover is open
Close the Ink Tank Cover.

• The Printhead is not installed
see “Replacing the Printhead”. (→P.633)

• An Ink Tank is not installed
see “Replacing Ink Tanks”. (→P.623)

• If “ERROR” is shown on the Display Screen
(See "Error messages.")

• The Power Lamp and Message Lamp are not lit (even once), and nothing appears on the Display
Screen
Make sure the printer is plugged in correctly. Check the connection at the plug and electrical outlet.

• No paper is loaded
Load paper. (→P.78) (→P.81)

Important
• Starting the printer when it is connected via the USB cable to a Macintosh computer that is off may
cause the computer to start up at the same time. To prevent this, disconnect the USB cable before
starting the printer. Connecting the printer to the computer via a USB hub may solve this issue.
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Turning the printer off

Important
• Never disconnect the printer’s power supply or unplug it during a print job. This may damage the printer.

1. Make sure no print jobs are in progress.
If the Message Lamp is ashing, check the message on the Display Screen and take action as
necessary. (See "Error Messages.")

If the Data Lamp is ashing, the printer is receiving a print job. Turn off the printer only after
printing is nished.

2. Hold down the Power button for more than a second.

After Shut Down.. Please Wait.. is shown on the Display Screen, the printer shuts off.
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Control Panel Display
After the printer starts up, the Tab Selection screen is displayed.
Each of the four tabs presents status, menus, and error information related to the particular tab.

Types of tabs
The Tab Selection screen presents four tabs. Each tab is represented by an icon in the top row. Press
the ◄ or ► button to access other tabs.

Paper tab A tab indicating status and showing menus related
to paper. Pressing the OK button when this tab is
highlighted will display the Paper Menu.
• Top line displayed
The paper icon is highlighted.

• Middle line displayed
Indicates the printer status and shows menu
names.

• Bottom line displayed
The rst and second lines display the paper type
and size.

Ink tab A tab indicating status and showing menus related
to ink. Pressing the OK button when this tab is
highlighted will display the Ink Menu.
• Top line displayed
The ink icon is highlighted.

• Middle line displayed
Indicates the printer status and shows menu
names.

• Bottom line displayed
Here, the remaining ink level is indicated.
(→P.628)

Job tab A tab indicating status and showing menus related to
print jobs. Pressing the OK button when this tab is
highlighted will display the Job Menu menu.
• Top line displayed
The job icon is highlighted.

• Middle line displayed
Indicates the printer status and shows menu
names.

Settings/Adj. tab A tab indicating status and showing menus related
to settings and adjustment. Pressing the OK button
when this tab is highlighted will display the Set./Adj.
Menu.
• Top line displayed
The settings/adjustment icon is highlighted.

• Middle line displayed
Indicates the printer status and shows menu
names.

• Bottom line displayed
Indicates the remaining maintenance cartridge
capacity.
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Printer status and modes
Printer status is classied according to the following ve modes.

Standby The printer is ready to receive jobs sent from the
computer. Jobs sent from the computer are printed
immediately.

Printing Paused Printing is paused on the printer. Any jobs sent from
the computer are held without being printed.

Printing Printing is in progress on the printer. Jobs sent from
the computer are printed after the current job. The
time left until printing is nished is indicated in the
upper-right corner of the screen. (Values exceeding
10 hours are not shown.)

Sleep The printer is in power-saving mode. The printer
automatically enters Sleep mode to conserve power
when idle for a specic period (by default, ve
minutes), that is, if no print jobs are received or
buttons are pressed while all covers are closed.
You can specify the period before the printer enters
Sleep mode in the Sleep Timer menu. (→P.49)
After entering Sleep mode from Standby mode,
the printer automatically recovers if print jobs are
received, and the jobs are printed.

Error The printer requires your attention. Any jobs sent
from the computer cannot be processed. The tab
related to the error is displayed.
For information about the display in the case of
multiple errors, see “Error message mode transition”.
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Mode transition
• Mode display
The printer mode is indicated as follows.

*1: The printer automatically enters Sleep mode when idle for a specic period (by default, ve
minutes), that is, if no print jobs are received or buttons are pressed while all covers are closed.
However, it does not enter Sleep mode while error messages are displayed.

*2: In Sleep mode, any button can be pressed except the Power button to recover from Sleep mode.
Sleep mode is also terminated if a print job is received or a command is issued from RemoteUI.

• Error display
Mode transition during error display is as follows.
If multiple errors occur, tabs related to errors other than the error currently shown ash. Press the ◄
or ► button to access other tabs and check those errors. If multiple errors occur that are related to
the Job tab and Settings/Adj. tab, each error message is displayed for 4 seconds on each tab before
another message is shown.
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How to View Instructions With Navigate
You can refer to instructions for loading paper, replacing ink tanks, and performing other operations on the
printer control panel.

1. Press the Navigate button.
2. Press ▲ or ▼ to select the desired navigation menu.
3. Press ▲ or ▼ to select View Op. Guide, and then press the OK button.

Instructions are now displayed.

■Example: Loading sheets
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Printer Menu Operations
The printer menu is classied into menu items available when no print job is in progress and menu items
only available during printing.

• Menu operations when no print job is in progress (→P.30)
• Menu operations during printing (→P.31)

Menu operations when no print job is in progress
To view available menus organized on tabs, select a tab on the Tab Selection screen and press the OK
button.

Note
• If the Tab Selection screen is not displayed, pressing OK will not display menus.
Menus can be selected after you resolve the problem.

The following operations are available from the menu.
• Paper Menu
Paper menu settings

• Ink Menu
Ink menu operations

• Job Menu
Menu operations to manage print jobs

• Set./Adj. Menu
Menu operations for printer adjustment and maintenance
Settings related to HP-GL2 jobs

For a description of specic menu items available, see “Menu Settings”. (→P.49)
For instructions on selecting menu items, see “Menu Operations”. (→P.32)

Note
• By default, menu settings apply to all print jobs. However, for settings that are also available in the
printer driver, the values specied in the printer driver take priority.
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Menu operations during printing
To display menus during printing, select a tab on the Tab Selection screen on the Control Panel, and then
press the OK button. Other menus are available after printing is nished.

Note
• If the Tab Selection screen is not displayed, pressing OK will not display menus.
Menus can be selected after you resolve the problem.

The following operations are available from the menu during printing.
• Ink Menu
Ink menu operations

• Job Menu
Menu operations to manage print jobs

• Set./Adj. Menu
Fine-tuning paper feeding
Display of printer-related information

For a description of specic menu items available during printing, see “Menu Settings (During Printing)”.
(→P.60)
For instructions on selecting menu items during printing, see “Menu Operations”. (→P.32)
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Menu Operations
To view available menus organized on tabs, select a tab on the Tab Selection screen and press the OK
button. For details, see “Menu Settings”. (→P.49)

• Menus (when the Ink tab is selected and the OK button is pressed)

Note
• If the Tab Selection screen is not displayed, pressing OK will not display menus.
Menus can be selected after you resolve the problem.

Simply press buttons on the Control Panel to access menus on various tabs from the Tab Selection screen
and set or execute Menu items.
The following section describes menu operations and how they are presented in this User Manual.

• Accessing menus (→P.33)
• Specifying menu items (→P.34)
• Specifying numerical values (→P.34)
• Executing menu commands (→P.34)
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Accessing menus
Printer menus are grouped by function.
Menus are displayed with the upper line selected. You can use the buttons on the Control Panel to access
each menu.

• Press Back to access a higher menu in the menu list, and press OK to access a lower one. If not all
menu items are displayed, hold down▲ or▼ to scroll through higher and lower menu items. Items you
select are highlighted.

The scroll bar at right indicates the current position in the overall menu.
• Lower menus are available if is displayed at right next to the second and subsequent rows. To access
the lower menus, select the menu and press the OK button.
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Specifying menu items
Menu items can be set as follows.

1. Press ▲ or ▼ to select the desired setting, and then press the OK button.

After two seconds, the display reverts to the upper level menu.

Note
• If a conrmation message is displayed regarding the setting you entered, press the OK button. The
setting is applied, and the printer is now in Standby.

Specifying numerical values
Follow these steps to enter numbers. In this example, network settings items are entered.

1. Press the ◄ or ► button to move to the next eld for input.

2. Press the ▲ or ▼ button to enter the value.

Note
• Hold down ▲ or ▼ to increase or decrease the value continuously.

3. Repeat steps 1 and 2 to complete the settings, and then press the OK button.

Note
• If a conrmation message is displayed regarding the setting you entered, press the OK button. The
setting is applied, and the printer is now in Standby.

Executing menu commands
Menu commands can be executed as follows.

1. Press▲ or▼ to select the action to execute, and then press the OK button.
The menu command is now executed.
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Menu Structure
The menu structure is organized by tabs, as follows. Values at right indicated by an asterisk are the defaults.

• Paper Menu (→P.35)
• Ink Menu (→P.37)
• Job Menu (→P.38)
• Set./Adj. Menu (→P.39)

For instructions on menu operations, see “Menu Operations”. (→P.32)
For details on menu items, see “Menu Settings”. (→P.49)

Paper Menu
First Level Second Level Third Level Fourth Level

Load Paper Roll Paper (The type of paper is
displayed here.) (*1)

Cut Sheet (The type of paper is
displayed here.) (*1)

Eject Paper

Chg. Paper Type (*1) Roll Paper

Cut Sheet

Chg. Paper Size Sheet Size (The size of paper is
displayed here.) (*2)

Roll Length (*3)

Roll Width (*4)

ManageRemainRoll Off *

On

Paper Details (The type of paper is
displayed here.) (*1)

Head Height Automatic *

Highest

High

Standard

Low

Lowest

Super Low

Skew Check Lv. High Accuracy

Standard *

Loose

Off

Cutting Mode Automatic

Eject

Manual

Cut Speed Fast
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First Level Second Level Third Level Fourth Level
Standard

Slow

Trim Edge First Automatic

Off

On

CutDustReduct. Off

On

VacuumStrngth Automatic *

Strongest

Strong

Standard

Weak

Weakest

Scan Wait Time Off

1 sec.

3 sec.

5 sec.

7 sec.

9 sec.

Roll DryingTime Off

30 sec.

1 min.

3 min.

5 min.

10 min.

30 min.

60 min.

NearEnd RollMrgn 3mm

20mm

NearEnd Sht Mrgn 3mm

20mm

Bordless Margin Automatic

Fixed

Width Detection Off

On *
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First Level Second Level Third Level Fourth Level
Return Defaults

Paper Details

Keep Paper Type Off *

On

*1: For information on the types of paper the printer supports, refer to the Paper Reference Guide.
(→P.95) Types of paper in the printer driver and related software (as well as on the Control Panel) are
updated when you install the printer driver from the User Software CD-ROM or if you update paper
information with the Media Conguration Tool. (See the Media Conguration Tool Guide (Windows) or
Media Conguration Tool Guide (Macintosh).)

*2: For information on the sizes of paper the printer supports, see “Paper Sizes”. (→P.100)
*3: Available only if ManageRemainRoll is On.
*4: Available only if Width Detection is Off.

Ink Menu
First Level

Rep. Ink Tank

Head Cleaning A
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Job Menu
First Level Second Level Third Level Fourth Level Fifth Level

Job Log (Choose from
information about
the latest three print
jobs.)

Document Name

User Name

Page Count

Job Status OK

CANCELED

Print Start Time yyyy/mm/dd
hh:mm:ss

Print End Time yyyy/mm/dd
hh:mm:ss

Print Time xxxsec.

Print Size xxxxxxxxsq.mm

Media Type

Interface USB

Network

Ink Consumed (The ink color is
displayed here.)

xxx.xxx ml

Print Job Log

Pause Print Off *

On
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Set./Adj. Menu
First Level Second

Level Third Level Fourth
Level Fifth Level Sixth Level Seventh

Level
Eighth
Level

Test Print Nozzle
Check

Status
Print

Interface
Print

GL2 Set
Print

Paper
Details

Print Job
Log

Menu Map

Color
Palette

Adjust
Printer

Head Posi.
Adj.

Auto
(Standard)

Auto
(Advanced)

Manual (*1)

Head Inc.
Adj.

Feed
Priority

Adj.
Priority

Automatic
*

Print
Quality

Print
Length

Adj.
Quality (*2)

Auto
(Genuine
Ppr)

Auto
(Other
Paper)

Manual

Adjust
Length (*3)

Adjustment
Print

A:High

B:Standard/
Draft

Change
Settings

A:High
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First Level Second
Level Third Level Fourth

Level Fifth Level Sixth Level Seventh
Level

Eighth
Level

B:Standard/
Draft

Adj. Fine
Feed (*2)

Mainte-
nance

Head
Cleaning

Head
Cleaning
A

Head
Cleaning
B

Nozzle
Check

Replace
P.head

Repl.
maint cart

Head Info Product
Name:

s/n:

Days
elapsed:

Count
[Mdot]:

GL2 Replot

GL2
BufferClear

GL2
Settings

Quality
Manager

Color
Mode

Monoch-
rome

Color
(CAD) 1 *

Color
(CAD) 2

Color
(CAD) 3

Color
(CAD) 4

Color
(CAD) 5

Print
Quality

Fast

Standard *

High
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First Level Second
Level Third Level Fourth

Level Fifth Level Sixth Level Seventh
Level

Eighth
Level

Input
Resolution

600dpi *

300dpi

Print
(Economy)

Off *

On

Paper
Manager

Paper
Source

Automatic
*

Roll Paper

Cut Sheet

Margin 3mm
(Standard)
*

5mm

Conserve
Paper

Off *

On

Auto
Rotate

Off *

On

Line & Pen
Manager

Enable
merge

Off *

On

Pen Setup Select
Palette

Software *

Palette A

Palette B

Factory

Dene
Palette

Palette A (Select
the pen
number)

Width (Indicates
the value of
Width)

Color 0-255

Line
Attributes

No Setting

Circle
Setting
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First Level Second
Level Third Level Fourth

Level Fifth Level Sixth Level Seventh
Level

Eighth
Level

Palette B (Select
the pen
number)

(Indicates
Width,
Color,
and Line
Attributes)

(Specify
the values
of Width,
Color,
and Line
Attributes)

Factory (Select
the pen
number)

(Indicates
Width,
Color,
and Line
Attributes)

Reset
Palette

All Palette

Palette A

Palette B

Smoothing Software *

Smooth

Thicken
FineLines

Off *

On

Adjust
FaintLines

Off

On *

Processing
Option

Warning Off *

On

PageSize
Process1

Off *

On

PageSize
Process2

Off *

On

GL2 Set
Print

Interface
Setup

EOP Timer
(*8)

10 sec.

30 sec.

1 min.

2 min.

5 min.

10 min. *
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First Level Second
Level Third Level Fourth

Level Fifth Level Sixth Level Seventh
Level

Eighth
Level

30 min.

60 min.

TCP/IP (*8) IPv4 IPv4 Mode Automatic

Manual *

Protocol
(*4)

DHCP On

Off *

BOOTP On

Off *

RARP On

Off *

IPv4
Settings
(*9)

IP Address xxx.xxx.xxx.
xxx

Subnet
Mask

xxx.xxx.xxx.
xxx

Default
G/W

xxx.xxx.xxx.
xxx

IPv6 IPv6
Support

On

Off *

IPv6 Stless
Addrs

On *

Off

DHCPv6 On

Off *

NetWare
(*8)

NetWare On

Off *

Frame
Type (*5)

Auto
Detect

Ethernet 2

Ethernet
802.2 *

Ethernet
802.3

Ethernet
SNAP
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First Level Second
Level Third Level Fourth

Level Fifth Level Sixth Level Seventh
Level

Eighth
Level

Print
Service
(*5)

Bindery
PServer

RPrinter

NDS
PServer *

NPrinter

AppleTalk
(*8)

On

Off *

Ethernet
Driver (*8)

Auto
Detect

On *

Off

Comm.
Mode (*6)

Half Duplex
*

Full Duplex

Ethernet
Type (*6)

10 Base-T *

100
Base-TX

1000
Base-T

Spanning
Tree

Not Use *

Use

MAC
Address

xxxxxxxxx
xxx

Interface
Print (*8)

Return
Defaults
(*8)

System
Setup

Sleep
Timer

5 min. *

10 min.

15 min.

20 min.

30 min.

40 min.

50 min.
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First Level Second
Level Third Level Fourth

Level Fifth Level Sixth Level Seventh
Level

Eighth
Level

60 min.

240 min.

Buzzer Off

On *

Contrast
Adj.

-4, -3, -2,
-1, 0*, +1,
+2, +3, +4

Date &
Time (*8)

Date yyyy/mm/
dd (*7)

Time hh:mm

Date
Format (*8)

yyyy/mm/
dd *

dd/mm/
yyyy

mm/dd/
yyyy

Language

*

Time Zone
(*8)

0:London
(GMT)

+1:Paris,
Rome

+2:Athens,
Cairo

+3:Moscow

+4:Eerevan,
Baku
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First Level Second
Level Third Level Fourth

Level Fifth Level Sixth Level Seventh
Level

Eighth
Level

+5:
Islamabad

+6:Dacca

+7:Bangkok

+8:Hong
Kong

+9:Tokyo,
Seoul

+10:
Canberra

+11New
Caledonia

+12:
Wellington

-12:
Eniwetok

-11:Midway
is.

-10:Hawaii
(AHST)

-9:Alaska
(AKST)

-8:Oregon
(PST)

-7:Arizona
(MST)

-6:Texas
(CST)

-5:NewYork
(EST)

-4:Santiago

-3:Buenos
Aires

-2:

-1:Cape
Verde

Length
Unit

meter *

feet/inch

Detect
Mismatch

Pause
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First Level Second
Level Third Level Fourth

Level Fifth Level Sixth Level Seventh
Level

Eighth
Level

Warning

None *

Paper Size
Basis

Roll
Selection
1

ISO A3
(297mm) *

300mm
Roll

Roll
Selection
2

10in.
(254mm) *

JIS B4
(257mm)

Keep
Paper Size

Off *

On

TrimEdge
Reload

Automatic

Off *

On

Rep.P.head
Print

Off

On *

Nozzle
Check

Frequency Standard *

1 page

Warning Off *

On

Use
RemoteUI
(*8)

On *

Off

Reset
PaprSetngs
(*8)

Prep.Move
Printer

Admin.
Menu (*8)

Change
Password
(*9)

Init.Admin.
Pswd (*9)
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First Level Second
Level Third Level Fourth

Level Fifth Level Sixth Level Seventh
Level

Eighth
Level

Printer Info Paper Info

Ink Info

Head Info

System
Info

Error Log

Other
Counter

*1: Available after you have used Auto(Advanced) in Head Posi. Adj. once.
*2: Available if Adj. Priority is Automatic or Print Quality.
*3: Available if Adj. Priority is Automatic or Print Length.
*4: Not displayed if IPv4 Mode is Manual.
*5: Not displayed if NetWare is Off.
*6: Not displayed if Auto Detect is On.
*7: Follows the setting in Date Format.
*8: Viewing and conguration is possible for administrators, and only viewing for other users.
*9: Viewing and conguration is possible for administrators only.
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Menu Settings
Menu items are as follows.

For instructions on selecting menu items, see “Menu Operations”. (→P.32)
For details on menu levels and values, see “Menu Structure”. (→P.35)

Paper Menu
Setting Item Description, Instructions

Load Paper Select sheets or rolls and load the paper.

Eject Paper Choose this item before removing loaded paper.

Chg. Paper Type (*1) Change the type of paper loaded. (→P.110)

Chg. Paper Size Change the size of paper loaded. (→P.112) (→P.100)

ManageRemainRoll Choose On to print a barcode at the end of a roll
before you remove it. The printed barcode can
be used in managing the amount of roll paper left.
Choose Off if you prefer not to print the barcode.
(→P.126)

Head Height Adjust the Printhead height. (→P.611)

Skew Check
Lv.

If you print on Japanese paper (washi) or other
handmade paper that has an irregular width, choose
Loose for a higher skew detection threshold, or
choose Off to disable skew detection. However, if
paper is loaded askew when detection is Off, note
that paper jams or Platen soiling may occur.

Cutting Mode Specify whether or not to cut with the standard
round-bladed cutter.
Choose Automatic to have the roll cut automatically
after printing. If you choose Manual, the paper will
not be cut after printing. Instead, a line will be printed
at the cut position.
Choose Eject if you prefer not to have documents
dropped immediately after printing, as when waiting
for ink to dry.

Cut Speed Choose the cutting speed. If you use adhesive paper,
choosing Slow helps prevent adhesive from sticking
to the cutter and keeps the cutter sharp.

Trim Edge First If a roll is loaded, the end of the paper will be cut.

Paper Details (The type
of paper is
displayed
here.)(*1)

CutDustReduct. If you choose On, a line will be printed at the cut
position when paper cutting is selected. This option
reduces the amount of debris given off after cutting.
It also helps prevent adhesive from sticking to the
cutter and keeps the cutter sharp if you use adhesive
paper. (→P.134)
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Setting Item Description, Instructions

VacuumStrngth Specify the level of suction that holds paper against
the Platen. (→P.621)

Scan Wait Time Specify the time to wait for the ink to dry between
each scan in bidirectional printing, in consideration of
how quickly the ink dries. Note that printing will take
longer if you specify a wait time.

Roll
DryingTime

Specify the time to wait for the ink to dry for each
sheet.

NearEnd
RollMrgn

Specify the minimum margin at the leading edge
of roll paper to ensure better printing quality at the
leading edge.
Note that if you choose 3mm, it may lower the
printing quality at the leading edge and affect feeding
accuracy. The printed surface may be scratched,
and ink may adhere to the leading edge. It may also
cause the Platen to become soiled.

NearEnd Sht
Mrgn

Specify a margin at the leading edge of sheets to
ensure better printing quality at the leading edge.
Note that if you choose 3mm, it may lower the
printing quality at the leading edge and affect feeding
accuracy. The printed surface may be scratched, and
ink may adhere to the leading edge.

Bordless
Margin

Adjust the margin during borderless printing.
Choose Automatic to have the printer automatically
detect the paper width and congure the margin
settings for borderless printing. If margins are
mistakenly created when Automatic is selected,
choose Fixed. In this case, the paper width is not
detected automatically, and the document is printed
without borders, using the margin settings required
by the printer.

Width
Detection

Specify this option to print inside boundaries or in
other cases when specifying a particular starting
position for printing. (→P.113)
Paper width and skew are not detected if you select
Off. If paper is loaded askew, note that paper jams or
Platen soiling may occur.

Paper Details (The type
of paper is
displayed
here.)(*1)

Return
Defaults

Choose OK to restore Paper Details to the default
values.

Paper Details Print the paper settings as specied in Paper Details.

Keep Paper Type Select On when printing on a particular type of paper
regularly. (→P.110)

*1: For information on the types of paper the printer supports, refer to the Paper Reference Guide. (→P.95)
The types of paper indicated in the printer driver and related software (as well as on the Control Panel)
are updated when you install the printer driver from the User Software CD-ROM or if you update paper
information by using the Media Conguration Tool. (See Media Conguration Tool Guide (Windows) or
Media Conguration Tool Guide (Macintosh).)
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Ink Menu
Setting Item Description, Instructions

Rep. Ink Tank Replace the Ink Tank at this point. Follow the
instructions displayed to complete the required
procedure. (→P.623)

Head Cleaning A Printhead cleaning options. (→P.632)
Execute Head Cleaning A if printing is faint, oddly
colored, or contains foreign substances.

Job Menu
Setting Item Description, Instructions

Document
Name

Indicates the document name in the last print job.

User Name Indicates the name of the user who sent the print job.

Page Count Indicates the number of pages in the job.

Job Status Indicates the printing results.

Print Start Time Indicates when the print job was started.

Print End Time Indicates when the print job was nished.

Print Time Indicates the time required to print the job.

Print Size Indicates the paper size in the print job.

Media Type Indicates the type of paper in the print job.

Interface Indicates the interface used for the print job.

Job Log (Choose from
information
about the last
three print jobs.)

Ink Consumed Indicates a rough estimate of how much ink was
consumed per page.(*1)

Print Job Log Print a record of print jobs, including the paper type
and size, amount of ink consumed, and so on. Ink
consumption indicates a rough estimate of how much
ink was consumed per page.(*1)

Pause Print Choose On to stop printing.

*1: Indicates a rough estimate of how much ink was consumed per page. Actual ink consumption may
be different. The average margin of error for estimates calculated according to Canon measurement
conditions for ink costs is ±15%. Canon does not guarantee the accuracy of these estimates.
Estimates may vary depending on conditions of use. Calculation of these estimates does not include
ink consumed when cleaning printheads by forceful ejection of ink.
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Set./Adj. Menu
Setting Item Description, Instructions

Nozzle Check Print a test pattern to check the nozzles.

Status Print Print information about the printer.

Interface Print Print interface settings information.

GL2 Set Print Print GL2 settings information.

Paper Details Print the paper settings as specied in Paper Details.

Print Job Log Print a record of print jobs, including the paper type
and size, amount of ink consumed, and so on. Ink
consumption indicates a rough estimate of how much
ink was consumed per page.(*1)

Menu Map Print the menu structure.

Test
Print

Color Palette Print the GL2 color palette.

Auto(Standard) The printer prints and reads a test pattern for the
automatic adjustment of Printhead alignment relative
to the printing direction.
(→P.604)

Auto(Advanced) The printer prints and reads a test pattern for the
automatic adjustment of Printhead alignment relative
to the printing direction and spacing between nozzles
and colors.
(→P.604)

Head
Posi.
Adj.

Manual Print a test pattern for adjustment of Printhead
alignment relative to the printing direction. Enter the
adjustment value manually based on the resulting
pattern.
(→P.606)

Head Inc. Adj. Print a test pattern for adjustment of the Printhead
orientation.
(→P.608)

Automatic

Print Quality

Adj.
Priority

Print Length

Specify exact paper feeding, if desired. Normally,
select Automatic. Choose Print Quality for attractive
printing. Choosing Print Quality also makes banding
less noticeable. Choose Print Length if you prefer to
feed the paper an exact amount. However, note that
slight banding may occur in the direction of carriage
scanning when Print Length is selected.

Adjust
Printer

Feed
Priority

Adj.
Quality

Auto(GenuinePpr) Specify this mode with paper identied in the Paper
Reference Guide.
The printer prints and reads a test pattern for
automatic adjustment of the feed amount.
(→P.614)
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Setting Item Description, Instructions

Auto(OtherPaper) Specify this mode with paper not in the Paper
Reference Guide.
The printer prints and reads a test pattern for
automatic adjustment of the feed amount. Note that
this function takes more time and consumes more ink
than Auto(GenuinePpr).
(→P.614)

Adj.
Quality

Manual Use this mode with highly transparent media
or other paper for which Auto(GenuinePpr) or
Auto(OtherPaper) cannot be used.
Print a test pattern for adjustment of the feed amount
based on the type of paper.
(→P.616)

A:HighAdjust-
ment
Print B:

Standard/
Draft

Print a test pattern for particular types of paper to
compensate for paper stretching or shrinkage, after
which you enter the amount of adjustment.
(→P.619)

A:High

Feed
Priority

Adjust
Length

Change
Settings

B:
Standard/
Draft

Displayed when you have selected Feed Priority >
Adj. Priority > Print Length.
Adjustment relative to the amount of stretching or
shrinkage of the current paper.
Enter either the adjustment results from
AdjustmentPrint or the discrepancy that you
measured (as a percentage).
For paper that tends to stretch, increase the feed
amount by choosing a higher adjustment value. For
paper that tends to shrink, decrease the feed amount
by choosing a lower adjustment value.

Adjust
Printer

Adj. Fine Feed Displayed when you have selected Feed Priority
> Adj. Priority > Automatic or Print Quality.
Fine-tune the feed amount manually during printing.
(→P.618)

Head Cleaning Clean the Printhead. (→P.632)
Choose Head Cleaning A if printing is faint, oddly
colored, or contains foreign substances.
Choose Head Cleaning B if no ink is printed at all, or
if printing is not improved by Head Cleaning A.

Nozzle Check Print a test pattern to check the nozzles.

Replace P.head When replacing the Printhead, choose Yes and follow
the instructions on the screen.
(→P.633)
Not displayed during a warning message that the
remaining Maintenance Cartridge capacity is low.

Repl. maint cart When replacing the Maintenance Cartridge, choose
Yes and follow the instructions on the screen.
(→P.639)

Mainte-
nance

Head Info Indicates information about the printhead.

GL2 Replot Print the previous GL2 print job again.
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Setting Item Description, Instructions

GL2 BufferClear Clear the print data in the replot buffer.

Monochrome Print in monochrome.

Color (CAD) 1 Print in standard colors.

Color (CAD) 2 Print in brighter colors.

Color (CAD) 3 Print emulating the following printers, in colors
resembling colors produced by these printers: Canon
iPF500, iPF600, iPF700, iPF510, iPF610, iPF710,
iPF605, iPF720, iPF810, and iPF820.(*2)

Color (CAD) 4 Print emulating the HP Designjet 500/800, in colors
resembling colors produced by these printers.(*2)

Color
Mode

Color (CAD) 5 Print emulating the HP Designjet 1000, in colors
resembling colors produced by this printer.(*2)

Print Quality Choose the print quality.

Input Resolution Choose the printer input resolution, 600dpi or 300dpi.

Quality
Manager

Print (Economy) Although printing quality is diminished, less ink is
consumed than in regular printing. Select On to
conserve ink.

Paper Source Choose the source of paper for HP-GL/2 printing.

Margin Specify the margin around paper. The margin for the
trailing edge of sheets is 23 mm (0.9 in).
However, if you have specied the leading margin in
Paper Details, the value in Paper Details has priority.

Conserve Paper Conserves paper when printing.

Paper
Manager

Auto Rotate If the long side of an original is shorter than the roll
width, the original is automatically rotated 90 degrees
to conserve paper. Similarly, if the long side of an
original in landscape orientation is longer than the roll
width and the short side is shorter than the roll width,
the original is repositioned to t on the paper.
HP RTL print jobs are not rotated. Because HP RTL
images are not rotated even if the paper is rotated 90
degrees, images may be cut off or the blank paper
may be ejected. In this case, set Auto Rotate to Off.

Enable merge Specify whether to merge or print over colors where
lines overlap.
Choose Off to print the second line over the rst.
Choose On to merge all overlapping colors.

GL2
Settings

Line
& Pen
Manager

Pen
Setup

Select Palette As pen values, choose Software, Palette A, Palette
B, or Factory.
Choose Software to print according to software
settings. Choose Palette A or Palette B to print using
the value specied in Dene Palette.
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Setting Item Description, Instructions

Dene Palette Specify the Width, Color, and Line Attributes in
the palette Pen no.. Choose Factory to conrm the
values when Factory is selected in Select Palette.
In Line Attributes, choose No Setting or Circle
Setting as the processing for the ends and junctions
of lines.
• If you choose No Setting

• If you choose Circle Setting

Pen
Setup

Reset Palette Restore Dene Palette to the default palette settings.

Smoothing Choose whether to print arcs as smooth curved lines
or as multiple connected line segments.
• If you choose Software
Operation is determined by the application. If
nothing is specied by the application, the result is
as shown in the gure.

Note: By default, this is a 72-sided gure
• If you choose Smooth

ThickenFineLines Select On to print ne lines more distinctly.

Line
& Pen
Manager

AdjustFaintLines If ne lines are printed in colors that do not match
the colors of other shapes, selecting Off may help
produce the expected results. However, lines in some
colors may appear broken.

Warning Select On to have any GL2-related warnings
displayed.

GL2
Settings

Process-
ing
Option

PageSizeProcess1 Normally, the area available for printing excludes
a margin required by the printer, and images are
positioned accordingly. Selecting On in this setting
eliminates any misalignment of the printing position if
the image itself includes a border.
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Setting Item Description, Instructions

Process-
ing
Option

PageSizeProcess2 Selecting On will determine the paper size based on
the image rendering area.

GL2
Settings

GL2 Set Print Print GL2 settings information.

EOP Timer Specify the timeout period before cancellation of print
jobs that cannot be received by the printer.

IPv4 Mode Choose whether the printer IP address is congured
automatically or a static IP address is entered
manually.

DHCP

BOOTP

Protocol

RARP

Specify the protocol used to congure the IP address
automatically.

IP
Address

Subnet
Mask

IPv4

IPv4
Settings

Default
G/W

Specify the printer network information when using
a static IP address.
Enter the IP address assigned to the printer, as well
as the network subnet mask and default gateway.

IPv6 Support Specify whether to connect via IPv6.

IPv6 StlessAddrs Specify whether a IPv6 stateless address is used.

TCP/IP

IPv6

DHCPv6 Specify whether DHCPv6 settings are used.

NetWare Specify the NetWare protocol. To apply your changes,
choose Register Setting.

Frame Type Specify the frame type to use.

NetWare

Print Service Choose the print service.

AppleTalk Specify whether to use the AppleTalk protocol. To
apply your changes, choose Register Setting.

Auto Detect Specify the communication method. To apply your
changes, choose Register Setting.
Choose On for automatic conguration of the LAN
communication protocol. Choose Off to use settings
values of Comm.Mode and Ethernet Type.

Comm.Mode Choose the LAN communication method.

Ethernet Type Choose the LAN transfer rate.

Spanning Tree Choose whether spanning-tree packets are supported
over the LAN.

Ethernet
Driver

MAC Address Indicates the MAC address.

Interface Print Print interface settings information.

Interface
Setup

Return Defaults Choose OK to restore Interface Setup settings to
the default values.
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Setting Item Description, Instructions

Sleep Timer Specify the period before the printer enters sleep
mode.

Buzzer Choose On for the buzzer to sound in case of errors.

Contrast Adj. Adjust the Display Screen contrast level.

Date Set the current date.Date &
Time

Time Set the current time. Available only if the Date setting
is specied.

Date Format Specify the date format.

Language Specify the language used on the Display Screen.

Time Zone Specify the time zone. Time zone options indicate a
main city in this time zone and the difference from
Greenwich Mean Time.

Length Unit Choose the unit of measurement when roll length
is displayed. Change the unit displayed for the
remaining amount of roll paper.

Detect Mismatch Specify printing behavior if the type and size of paper
specied in the printer menu does not match the type
and size in the printer driver.
Choose Pause to have printing paused under these
circumstances. ChooseWarning to continue printing
after notication. Choose None to continue printing
without notication.

Roll Selection 1 If roll size detection is activated, choose whether ISO
A3 (297mm) or 300mm Roll is applied when a roll of
an intermediate width is detected.

Paper
Size
Basis

Roll Selection 2 If roll size detection is activated, choose whether
10in. (254mm) or JIS B4 (257mm) is applied when a
roll of an intermediate width is detected.

System
Setup

Keep Paper Size Choose On to use the paper size setting as the basis
for printing instead of other settings. The margin
setting of the printer menu will be used instead of
the margin setting of the printer driver if the latter
is smaller, which may prevent text or images in the
margin from being printed.
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Setting Item Description, Instructions

Keep Paper Size Choose Off to give priority to margin settings. The
larger value is used if the margin specied in the
printer driver does not match the margin in the printer
menu

TrimEdge Reload Specify whether to trim the leading edge of the
currently retracted roll when the roll is advanced. Cut
the edge if you are concerned about any marks left
on the roll when the roll is left in the retracted position.
Specify On to have rolls cut when printing begins after
Sleep mode or when the power is restored. Selecting
Automatic will trim the edge when the roll has been
in the retracted position for two days or more.

Rep.P.head Print Choose On to have the printer automatically execute
the Advanced Adj. operations after you replace the
Printhead.
(→P.604)

Nozzle Check In Frequency, specify the timing for automatic
checks of nozzle clogging. Choose Standard to have
the printer adjust the timing for checks based on the
frequency of nozzle use. Choose 1 page to check
once per page.
Select Warning > On to display warnings if the
nozzles clog during printing.

Use RemoteUI Choosing Off prohibits access from RemoteUI.
Settings can only be congured from the control
panel.

System
Setup

Reset PaprSetngs Restores settings that you have changed with Media
Conguration Tool to the default values.

Prep.MovePrinter Select this option when transferring the printer to
another location. Follow the instructions displayed to
complete the required procedure.
(→P.651)
Not displayed during a warning message that the
remaining Maintenance Cartridge capacity is low.

Admin.
Menu

Change Password By setting a password, you can restrict menu display
and conguration as follows. You can input between
0 and 9999999.
• Viewing and conguration by administrators only
IPv4 Settings
Change Password
Init.Admin.Pswd
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Setting Item Description, Instructions

Change Password • Viewing and conguration by administrators, and
only viewing by other users
Interface Setup settings (except IPv4 Settings)
Date & Time
Date Format
Time Zone
Use RemoteUI
Reset PaprSetngs

Admin.
Menu

Init.Admin.Pswd Choose OK to restore the Admin. Menu password to
the default values.

Paper Info Indicates the current paper size, type, and related
printer settings.

Ink Info Indicates ink levels and maintenance cartridge
capacity.

Head Info Indicates the model name, serial number, number of
days used, and dot count of the current printhead.

System Info Indicates the rmware version, serial number, and
interface information.

Error Log Indicates the most recent error messages (up to ve).

Printer
Info

Other Counter Indicates the total printing volume of the printer.

*1: Indicates a rough estimate of how much ink was consumed per page. Actual ink consumption may
be different. The average margin of error for estimates calculated according to Canon measurement
conditions for ink costs is ±15%. Canon does not guarantee the accuracy of these estimates.
Estimates may vary depending on conditions of use. Calculation of these estimates does not include
ink consumed when cleaning printheads by forceful ejection of ink.

*2: It is not possible to match the colors and image quality produced by the specied printer exactly.
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Menu Settings (During Printing)
Menu items are described in the following tables.
For instructions on selecting menu items, see “Menu Operations”. (→P.32)
For details on menu levels and values, see “Menu Structure”. (→P.35)

Ink Menu
Setting Item Description, Instructions

Rep. Ink Tank Replace the Ink Tank at this point. Follow the instructions displayed to
complete the required procedure. (→P.623)

Head Cleaning A Clean the Printhead. (→P.632)
Execute Head Cleaning A if printing is faint, oddly colored, or contains
foreign substances.

Job Menu
Setting Item Description, Instructions

Document Name Indicates the document name in the last
print job.

User Name Indicates the name of the user who sent
the print job.

Page Count Indicates the number of pages in the job.

Job Status Indicates the printing results.

Print Start Time Indicates when the print job was started.

Print End Time Indicates when the print job was nished.

Print Time Indicates the time required to print the job.

Print Size Indicates the paper size in the print job.

Media Type Indicates the type of paper in the print job.

Interface Indicates the interface used for the print
job.

Job Log (Choose from
information about
the last three print
jobs.)

Ink Consumed Indicates a rough estimate of how much
ink was consumed per page.(*1)

Print Job Log Print a record of print jobs, including
the paper type and size, amount of ink
consumed, and so on. Ink consumption
indicates a rough estimate of how much
ink was consumed per page.(*1)

Pause Print Choose On to stop printing.

*1: Indicates a rough estimate of how much ink was consumed per page. Actual ink consumption may
be different. The average margin of error for estimates calculated according to Canon measurement
conditions for ink costs is ±15%. Canon does not guarantee the accuracy of these estimates.
Estimates may vary depending on conditions of use. Calculation of these estimates does not include
ink consumed when cleaning printheads by forceful ejection of ink.
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Set./Adj. Menu
Setting Item Description, Instructions

Adj. Fine Feed Displayed when you have selected Feed Priority
> Adj. Priority > Automatic or Print Quality.
Fine-tune the feed amount manually.

Paper Info Indicates the current paper size, type, and related
printer settings.

Ink Info Indicates ink levels and maintenance cartridge
capacity.

Head Info Indicates the model name, serial number, number of
days used, and dot count of the current printhead.

System Info Indicates the rmware version, serial number, and
interface information.

Error Log Indicates the most recent error messages (up to ve).

Printer Info

Other Counter Indicates the total printing volume of the printer.
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Status Print
You can print a Status Print report indicating the current status of the printer.
With Status Print, information is printed regarding the printer rmware version, various settings, and the
status of consumables.

Printing Status Print reports
1. Load paper.

If using sheets, load paper of A4/Letter size. You will need at least two sheets.
2. On the Tab Selection screen of the Control Panel, press ◄ or ► to select Settings/Adj. tab

( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Test Print, and then press the OK button.
5. Press ▲ or ▼ to select Status Print, and then press the OK button.

Checking the information in Status Print reports
The following information is included in Status Print reports.

Canon imagePROGRAF iPFxxxx Status Print Printer model

Firm Firmware Version

Boot Boot ROM Version

MIT(DBF) MIT Database Format Version

MIT(DB) MIT Database Version

S/N Printer serial number

Date Indicates when the status print report was printed.

Paper Menu

Roll Media Type

Cut Sheet Type

ManageRemainRoll

Keep Paper Type

Information on the loaded paper.

62 Printer Parts



Control Panel

Ink Menu Ink-related information.

MC Maintenance Cartridge capacity
(%)

C, M, Y, MBK, MBK2, BK Ink levels.
The remaining ink is displayed in a
ve-level scale.

Set./Adj. Menu

System Setup

System settings.

Sleep Timer

Buzzer

Contrast Adj.

Date Format

Language

Time Zone

Length Unit

Detect Mismatch

Paper Size Basis

Roll Selection 1

Roll Selection 2

Printer system
settings, as well as
settings regarding
warnings and errors.

Keep Paper Size

TrimEdge Reload

Current
paper-related
settings.

Rep.P.head Print Settings after a
test pattern was
printed following
head replacement.

TimingNozzle Check

Warning

Nozzle-check
settings.

Use RemoteUI Settings used by
RemoteUI.

Printer Info

Error Log

The past ve error
codes.

HEAD LOT NUMBER

LOT

Printhead lot number.

PARTS STATUS

COUNTER xx

Utilization status of
replacement parts that
require servicing.
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COUNTER

CUTTER

MEDIA

LIFE TTL

LIFE ROLL

LIFE CUTSHEET

MEDIA 1-7,OTHER

NAME

TTL

ROLL

CUTSHEET

AFTER INSTALLATION

Utilization status of the
cutter, media, and other
items (indicating how
much they have been
used).
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Printing Interface Setting Reports
You can print an Interface Print report indicating the current interface settings values of the printer.
Interface Print reports indicate settings values for TCP/IP, NetWare, and other settings.

Printing Interface Print reports
1. Load the paper.

If using sheets, load paper A4/Letter-sized, you will need at least three sheets.
2. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.

tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Test Print, and then press the OK button.
5. Press ▲ or ▼ to select Interface Print, and then press the OK button.

Conrming Interface Print information
The following information is included in the Interface Print report.

Canon imagePROGRAF iPFxxxx Interface Print Printer model

Firm Firmware Version

Boot Boot ROM Version

MIT(DBF) MIT Database Format Version

MIT(DB) MIT Database Version

S/N Printer serial number

Date The date when the interface setup print report was
printed.
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EOP Timer Sets the elapsed time between
receiving last data and canceling
printing.

Frame Type

Use DHCP

Use BOOTP

Use RARP

Enable DNS Dynamic Update

Use Zeroconf Function

IP Address

Subnet Mask

Gateway Address

LPD Printing

IPP Printing

IPP Printer URI

RAW Printing

Raw Mode Bi-direction

FTP Printing

Use Discovery

Scope

SMTP Server Address

Primary DNS Server Address

Secondary DNS Server Address

DNS Host Name

DNS Domain Name

MulticastDNS ServiceName

SNMPv1

TCP/IPv4

SNMPv3

IPv4 settings values.
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Use IPv6

Stateful Address

Prex Length

Primary DNS Server
Address

Use DHCPv6

Secondary DNS Server
Address

Stateless Address 1

Prex Length 1

Stateless Address 2

Prex Length 2

Stateless Address 3

Prex Length 3

Stateless Address 4

Prex Length 4

Stateless Address 5

Prex Length 5

Stateless Address 6

Use a stateless address

Prex Length 6

Link-Local AddressUse a link-local Address

Prex Length

IP Address

Prex Length

Default Router Address

Prex Length

Primary DNS Server
Address

Use a manual address

Secondary DNS Server
Address

DNS Host NameUse the same host name
and domain name as IPv4

DNS Domain Name

Perform dynamic updating of stateful addresses

Dynamically update the stateless address

TCP/IPv6

Dynamically update the manual address

IPv6 settings values.
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Frame Type

IPX External Network Number

Node Number

Print Application

File Server Name

Print Server Name

Print Server Password

Bindery Pserver(*1)

Polling Interval

Print Server NameRPrinter(*1)

Printer Number

Tree Name

Context Name

Print Server Name

Print Server Password

NDS Pserver(*1)

Polling Interval

Print Server Name

NetWare

Nprinter(*1)

Printer Number

NetWare settings values.

Phase Type

Name

Network Number

AppleTalk

Zone

AppleTalk settings
values.

Physical Interface

Transmission Rate

MAC Address

Auto Detect

Communication

Ethernet Type

Spanning Tree

Network Interface

Use the Jumbo Frame Function

Settings values regarding
the communication path
used for sending and
receiving messages.

*1: Only items congured in Print Application are printed.
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Checking Instructions During Printer Operations
You can refer to instructions on the printer control panel when loading paper, replacing ink tanks, or performing
other operations.

How to view instructions
Once you complete an action described in the instructions, the printer detects the action and switches to the
next instruction screen.
In the case of actions the printer cannot detect, instruction screens are switched every four seconds, and
the sequence of operations is shown repeatedly.
When all actions in the sequence are nished, the instruction screen for the next step is displayed.

■Example: Ink tank replacement

Note
• During a continuous display of instructions, you can press the ◄ button to pause the instructions
on the current screen.
Press the◄ or► button to display the previous or next screens. If you do not press the◄ or► button
within 30 seconds, continuous display is resumed.
Press the OK button to display the instruction screen for the next step.
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Optional accessories

Roll Holder Set
Load a roll on the roll holder and then load the holder in the printer. The Roll Holder in the Roll Holder Set RH2-33 is
for use with both 2-inch and 3-inch paper cores. Use the correct attachment for the particular paper core. (→P.103)

• Roll Holder Set RH2-33
• Roll Holder (for 2- and 3-inch paper cores)

• Attachments

Using the 2-Inch Paper
Core Attachment

Using the 3-Inch Paper Core Attachment

2-Inch Paper Core Attachment 3-Inch Paper Core Attachment
L

3-Inch Paper Core Attachment
R
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Printer Specications

Specications

Important
• This information is subject to change as the printer is updated.
• The following values may vary depending on the operating environment.

Printer
Power supply 100-120 V AC (50/60 Hz), 220-240 V AC (50/60 Hz)

During operation 140 W max.

Sleep mode 100-120 V: 5 W max.
220-240 V: 6 W max.

Power consumption

Off 1 W max. (*1)

During operation (sound
pressure level/LWAd)

Approx. 50 dB (A) (6.6 bels)Operating noise (*2)

Standby 35 dB (A) max.

Temperature 15-30°C (59-86°F)Operating environment

Humidity 10-80%, non-condensing

Dimensions (W × D × H) Printer and Stand (with
Output Stacker open)

1,304×870×1,062 mm (51.3×34.3×41.8 in)

Weight Printer and Stand (not
including the Printhead
and ink tanks)

Approx. 62.9 kg (138.7 lb)

Space for installation (W
× D × H)

Printer only 1,704×1,470×1,362 mm (67.1×57.9×53.6 in)

Applicable standards International Energy Star Program, Law on
Promoting Green Purchasing, Eco Mark, GPN,
RoHS, Eco Declaration, WEEE, U.S. presidential
directives

*1: The printer uses a trace amount of power even when turned off. To stop all power consumption,
turn off the printer and unplug the power cord.

*2: Calculation based on ISO 7779. Operating conditions: On the Main sheet of the printer driver, Media
Type > Plain Paper, Advanced Settings > Print Priority > Line Drawing/Text, and Print Quality >
Standard.

Printing performance
Print method Bubblejet

Maximum resolution 2400 dpi horizontally (*1) × 1200 dpi vertically

Printhead PF-04

Number of nozzles MBK: 5,120; others: 2,560 per color

*1: Prints with a minimum 1/2400 inch dot pitch between ink droplets.
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Interface
Format Internal port

Mode Full-speed (12 Mbps), high-speed (480 Mbps), bulk transfer

USB 2.0 (*1)

Connector Series B (4-pin)

Format Internal port

Specication IEEE 802.3 10Base-T, IEEE 802.3u
100Base-TX/Auto-Negotiation, IEEE
802.3ab1000Base-T/Auto-Negotiation, IEEE 802.3x
Full Duplex

Ethernet

Protocols IPX/SPX (Netware 4.2, 5.1, 6.0), SNMP, TCP/IP, AppleTalk,
HTTP

*1: Use in USB 2.0 High Speed mode requires the following environment:
• Computer: USB 2.0 High-Speed-compatible
• Operating system: Windows Vista/Windows Server 2008/Windows Server 2003/Windows
XP/ Windows 2000 or Mac OS X ver. 10.3.9 or later

• USB 2.0 driver: Microsoft USB 2.0 driver (available from Windows Update or the Service Pack.)
• USB cable: Certied USB 2.0 cable

Ink
MBK Ink Tank (Matte Black Ink, or
black ink for matte paper)

Pigment ink PFI-102MBK

BK Ink Tank (Black Ink) Dye ink PFI-102BK

C Ink Tank (Cyan Ink) Dye ink PFI-102C

M Ink Tank (Magenta Ink) Dye ink PFI-104M

Ink Tank

Y Ink Tank (Yellow Ink) Dye ink PFI-102Y

Capacity 130 ml (4.4  oz) per
color (*1)

*1: The provided Starter Ink Tanks contain 90 ml (3.0  oz) each.
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Paper (*1)
Rolls 254.0-914.4 mm (10-36 in)Paper width

Sheets 203.2-917.0 mm (8-36.1 in)

Rolls 203.2(*2)-18,000 mm (8-708.7 in)Length of one page

Sheets 279.4-1,600 mm (11-63 in)

Rolls 0.07-0.8 mm (0.0028-0.031 in)Thickness

Sheets 0.07-0.8 mm (0.0028-0.031 in)

Roll width 36-in. Roll (914.4mm), ISO A0/A1 Roll (841.0mm), 30-in. Roll
(762.0mm), JIS B1/B2 Roll (728.0mm), 24-in. Roll (609.6mm),
ISO A1/A2 Roll (594.0mm), JIS B2/B3 Roll (515.0mm), 17-in.
Roll (431.8mm), ISO A2/A3 Roll (420.0mm), 16-in. Roll
(406.4mm), 14-in. Roll (355.6mm), 300mm Roll (300.0mm),
ISO A3/A4 Roll (297.0mm), JIS B4 Roll (257.0mm), and 10-in.
Roll (254.0mm)

Paper Size

Sheets ISO A0, ISO A1, ISO A2+, ISO A2, ISO A3+, ISO A3, ISO A4,
ISO B1, ISO B2, ISO B3, ISO B4, JIS B1, JIS B2, JIS B3,
JIS B4, 34"x44" (ANSI E), 28"x40" (ANSI F), 22"x34"(ANSI
D), 17"x22"(ANSI C), 13"x19" (Super B), 11"x17" (Ledger),
Legal (8.5"x14"), Letter (8.5"x11"), 36"x48" (ARCH E),
30"x42" (ARCH E1), 26"x38" (ARCH E2), 27"x39" (ARCH
E3), 24"x36" (ARCH D), 18"x24" (ARCH C), 12"x18" (ARCH
B), 9"x12" (ARCH A), DIN C0, DIN C1, DIN C2, DIN C3, DIN
C4, 20"x24", 18"x22", 14"x17", 12"x16", 10"x12", 10"x15",
US Photo 16"x20", Poster 20"x30", Poster 30"x40", 13"x22",
and Poster 300x900mm

Normal size Printable area
• Rolls
3 mm (0.12 in) from each side

• Sheets
3 mm (0.12 in) from the top, 23 mm (0.91 in) from the bottom,
and 3mm (0.12 in) from the left and right sides

For information on the recommended print area, see “Print
Area”. (→P.75)

Print area

Borderless printing
(*3)

Printable area (rolls)
0 mm from the top, 0 from the bottom, and 0 mm from the left
and right sides

Supported width for borderless printing 36-in. Roll (914.4mm), ISO A0/A1 Roll (841.0mm), JIS B1/B2
Roll (728.0mm), 24-in. Roll (609.6mm), ISO A1/A2 Roll
(594.0mm), JIS B2/B3 Roll (515.0mm), 17-in. Roll (431.8mm),
ISO A2/A3 Roll (420.0mm), 14-in. Roll (355.6mm), 300mm
Roll (300.0mm), ISO A3/A4 Roll (297.0mm), JIS B4 Roll
(257.0mm), and 10-in. Roll (254.0mm)

*1: For information on the types of paper the printer supports, refer to the Paper Reference Guide (→P.95)
*2: When supplying paper, use a roll approximately 1,000 mm (1,093.6 yd) or longer.
*3: Printing may not be possible in some cases, depending on the type and size of paper.
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Output stacker capacity, in sheets
Regular position 1

Extended position (*1) 20

*1: For information on types of paper you can use with the stacker in Extended position, refer to the Paper
Reference Guide. (→P.95)

Options
Roll Holder Set RH2-33

74 Printer Parts



Printer Specications

Print Area
A margin required by the printer is added with respect to the size of paper loaded in the printer. Except in
borderless printing, the actual printing area corresponds to the paper size minus the space for this margin.

Note
• Printable Area: The area that can be printed.
• There is no margin (that is, a margin of 0 mm) during borderless printing on rolls.
• Recommended Print Area: We recommend printing within this area.
• To print so that your original matches the print area exactly, use an oversized paper size that includes
the required margin. (→P.219)

Margins of Printable Area Margins of Recommended Print Area
Top Edge Bottom Edge Sides Top Edge Bottom Edge Sides

Sheets 3 mm (0.12 in) 23 mm (0.91
in) 3 mm (0.12 in) 20 mm (0.79

in)
23 mm (0.91

in) 5 mm (0.20 in)

Rolls 0/3 mm (0/0.12
in)

0/3 mm (0/0.12
in)

0/3 mm (0/0.12
in)

20 mm (0.79
in) 5 mm (0.20 in) 5 mm (0.20 in)

Sheets

• Printable Area
a margin of 3 mm (0.12 in) on top, 23 mm (0.91 in) on bottom, and 3 mm (0.12 in) on left and right
sides is required.

• Recommended Print Area
A margin of 20 mm (0.79 in) on top, 23 mm (0.91 in) on bottom, and 5 mm (0.20 in) on left and right
sides is required.

Rolls

• Printable Area
A margin of 3 mm (0.12 in) on all sides is required. During borderless printing, the margin on all sides
is 0 mm. For information on paper compatible with borderless printing, see the Paper Reference
Guide. (→P.95)

• Recommended Print Area
A margin of 20 mm (0.79 in) on top, 5 mm (0.20 in) on bottom, and 5 mm (0.20 in) on left and right
sides is required.
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Printing procedure

Printing Options Using Rolls and Sheets
The printer supports both rolls and sheets.
This section introduces the main features of each, as well as the main printing methods available. Select rolls
or sheets to suit your particular printing application.

Note
• For information on the types of paper the printer supports, refer to the Paper Reference Guide. (→P.95)
• A variety of other ways to print are available besides those introduced here. Choose the printing
method that suits your particular printing application, referring to "Working With Various Print Jobs" and
"Enhanced Printing Options" from the table of contents.

Roll printing
Media in spooled rolls is generally called Roll Media. Rolls are loaded on the Roll Holder, which are in
turn loaded in the printer.
Rolls can be used to print large photos or create posters or banners that cannot be printed on regular sheets.

• Large-format printing
Easily print vertical or horizontal banners from familiar applications such as Microsoft Ofce applications.
(→P.253)

• Borderless printing
Print without a margin (border) around posters or photos.
(→P.232)
(→P.239)
(→P.225)

• Banner printing
You can print multiple pages as a single continuous image, without margins between pages.
(→P.275)

• 90-degree rotation before printing
Originals in portrait orientation are rotated 90 degrees when possible to use paper more efciently.
(→P.301)

• Enlarged/reduced printing
You can freely adjust the size of originals by enlarging or reducing originals before printing.
(→P.201)
(→P.207)
(→P.213)

• Free Layout function
Print multiple documents from multiple applications (such as word-processing programs, spreadsheet
programs, and so on) next to each other.
(→P.269)
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Sheet printing
Sheets refer to individual sheets of paper.
Insert the sheet between the Platen and the Paper Retainer.

• Enlarged/reduced printing
You can freely adjust the size of originals by enlarging or reducing originals before printing.
(→P.201)
(→P.213)

• Free Layout function
Print multiple documents from multiple applications (such as word-processing programs, spreadsheet
programs, and so on) next to each other.
(→P.269)
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Loading and Printing on Rolls
These are the basic steps for loading and printing on rolls.
Follow these steps to load and print on rolls.

Note
• For details on supported sizes and types of rolls, see “Paper Sizes” or the Paper Reference Guide.
(→P.100) (→P.95)

• If you prefer to wait for the ink to dry after printing and simply eject the document, you can deactivate
automatic cutting and cut the paper manually. (→P.129)

1. Turn the printer on. (→P.24)

2. Load the roll on the Roll Holder. (→P.103)
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3. Load the roll in the printer. (→P.106)

4. Select the type of paper. (→P.110)

Note
• If no barcode has been printed on the roll and you have set ManageRemainRoll to On, specify
the roll length after the type of paper. (→P.112)
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5. Complete settings in the printer driver for the type of paper and other details.
• Specifying Paper in the Printer Driver (Windows) (→P.86)
• Specifying Paper in the Printer Driver (Mac OS X) (→P.88)

6. Send the print job.
• Printing in Windows (→P.83)
• Printing in Mac OS X (→P.84)

The printer now starts printing the print job.
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Loading and Printing on Sheets
These are the basic steps for loading sheets and then printing.
Follow the steps below to load and print on sheets.

Note
• For details on supported types and sizes of paper, see “Paper Sizes” or the Paper Reference Guide.
(→P.100) (→P.95)

1. Turn the printer on. (→P.24)

2. Complete settings in the printer driver for the type of paper and other details.
• Specifying Paper in the Printer Driver (Windows) (→P.86)
• Specifying Paper in the Printer Driver (Mac OS X) (→P.88)

3. Send the print job.
• Printing in Windows (→P.83)
• Printing in Mac OS X (→P.84)

Basic Printing Workow 81



Printing procedure

4. Load the sheet. (→P.136)

The printer now starts printing the print job.
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Printing in Windows
Print from the application menu.

Important
• The Windows printer driver can be used in the following versions of Windows.

• Windows 2000 (Professional or Server)
• Windows XP (Home Edition or Professional)
• Windows Server 2003 (Standard Edition)
• Windows Vista
• Windows Server 2008

• We recommend exiting unnecessary applications before printing. Running several applications while
printing may interrupt the transfer of print data and affect printing quality.

1. In the source application, select Print from the File menu to display the dialog box for printing
conditions.

2. After conrming that the printer is selected in the dialog box, click Print or OK to start printing.

Note
• The appearance of the dialog box varies depending on the software application. In most cases, the
dialog box includes basic printing options and enables you to choose the printer, specify the range of
pages, number of copies, and so on.
Example: Print dialog box displayed by the application

Note
• If another printer is selected, select the printer you want to use under Select Printer or in the dialog
box displayed after clicking Printer.

Settings for many printing methods (including enlarged or reduced printing, borderless printing, and so on) are
displayed in the printer driver dialog box. There are two ways to access the printer driver dialog box, as follows.

• From the application
(→P.346)

• From the operating system menu
(→P.348)
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Printing in Mac OS X
Print from the application menu after registering the printer.

Important
• The Macintosh printer driver can be used in the following versions of Mac OS.

• Mac OS X 10.3.9-10.5
• We recommend exiting unnecessary applications before printing. Running several applications while
printing may interrupt the transfer of print data and affect printing quality.

Registering the printer
Before printing, you must register the printer in imagePROGRAF PrinterSetup.app.
For instructions on registering the printer, see “Conguring the Printer Driver Destination (Macintosh)”.
(→P.596)

Important
• During this setup process, the printer will not be listed among available printers if it is off or disconnected.
• By default, the AppleTalk protocol is disabled on the printer. In Mac OS X 10.4 and earlier, you
must enable AppleTalk protocol on the printer before using the printer in an AppleTalk network. For
instructions on activating AppleTalk protocol, see “Conguring the Destination for AppleTalk Networks
(Macintosh)”. (→P.598)

Printing from the source application
1. In the source application, select Print from the File menu to display the dialog box for printing

conditions.

Note
• This dialog box includes basic printing options and enables you to choose the printer, specify the
range of pages, number of copies, and so on.

2. Select the printer in the Printer list.
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3. Click Print to start printing.
As shown in the following illustration, you can switch to other panes in this dialog box to complete
settings for various methods of printing, including enlarged and reduced printing, borderless
printing, and so on.
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Specifying Paper in the Printer Driver (Windows)
If you have replaced the paper, you must complete the following settings in the printer driver.

Important
• Always specify the same type and size of paper in the printer menu and printer driver.
If the type and size do not match, an error message will be displayed and printing is not possible.

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded.

Note
• Click the B Get Information button to display the Paper Information on Printer dialog box. On the
Paper Information on Printer dialog box, you can obtain information on the paper in the printer and
congure printer driver settings for the feed source and type of paper.

5. Click the Page Setup tab to display the Page Setup sheet.
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6. In the A Page Size list, select the size of the original as specied in the application.
7. In the L Paper Source list, select how paper is supplied.
8. If you have selected Roll Paper in L Paper Source, select the width of the loaded roll inM Roll

Paper Width.

Note
• A variety of settings are available in the printer driver to suit different printing applications.
For details on available printing conditions, see “Printer Driver Settings (Windows)”. (→P.336)
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Specifying Paper in the Printer Driver (Mac OS X)
If you have replaced the paper, you must complete the following settings in the printer driver.

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. Choose the original size in the F Paper Size list.
4. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded.
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7. Access the Page Setup pane.

8. In the A Paper Source list, select how paper is supplied.
9. If you have selected Manual in A Paper Source, make sure the size as selected in Page Setup

is displayed in C Page Size. If you have selected Roll Paper in A Paper Source, make sure
the width of the loaded roll is displayed in B Roll Width.

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Information
on the Main pane to update the printer information.

Note
• A variety of settings are available in the printer driver to suit different printing applications.
For details on available printing conditions, see “Printer Driver Settings (Mac OS X)”. (→P.454)
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Canceling print jobs

Canceling Print Jobs from the Control Panel
To cancel printing or reception of print jobs, press the Stop button on the Control Panel.

When you press the Stop button during printing, printer operation varies depending on the current status.
• If you press the Stop button before printing starts
Pressing the Stop button before printing starts will display a conrmation message. To cancel the
print job, select Yes.

• If you press the Stop button during printing
Pressing the Stop button during printing will display a conrmation message. To cancel the print job
immediately, select Yes.
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Canceling Print Jobs from Windows
In the printer window, you can cancel jobs that are being sent to the printer.
Using imagePROGRAF Status Monitor, you can cancel print jobs that have already been received by the printer or
that are currently being printed.

1. Click the printer icon in the taskbar to display the printer window.

Note
• You can also display this window by double-clicking the printer icon in the Printers and Faxes (or
Printers) folder, accessible through the Windows start menu.

2. Right-click the job to cancel and select Cancel.

3. If the job to cancel is not shown in the printer window (that is, if the print data has already been
received by the printer), double-click the taskbar icon to display imagePROGRAF Status Monitor.

4. On the Printer Status sheet, click Cancel Job.

Basic Printing Workow 91



Canceling print jobs

Canceling Print Jobs from Mac OS X
In the printer window, you can cancel jobs that are being sent to the printer.
Otherwise, you can cancel jobs from imagePROGRAF Printmonitor if they have been received by the printer
or are currently being printed.

Note
• Print jobs are shown in the printer window while they are being sent from the computer. After
transmission, jobs are not displayed even during printing.

• Print jobs are displayed in the imagePROGRAF Printmonitor window from the moment the printer starts
receiving the print data until the moment printing is nished. They are not displayed before print data is
sent to the printer, even if the computer has started preparing the print data.

1. Click the printer icon in the Dock to display the printer window.
2. Click Stop Jobs to stop printing.

3. If there are no jobs in the printer window that can be canceled, (that is, if the print data has
already been sent to the printer), click Utility to display imagePROGRAF Printmonitor.
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4. Select the print job to cancel and click to delete the print job.

The job sent to the printer is canceled.
5. Exit imagePROGRAF Printmonitor. In the printer window, click Start Jobs.

Important
• Always follow these steps if you cancel print jobs from imagePROGRAF Printmonitor. If you do not
restart job processing, the next job cannot be printed.
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Pausing Printing

Pausing Printing
During printing, if you set Pause Print in the Control Panel menu to On, printing is stopped at that point and the
printer enters a state in which printing is paused. (→P.26)
Printing from the job queue is not possible in this state.
To restore normal operation after this state, set Pause Print to Off.

Note
• In the following cases, the status is cleared even if you do not set Pause Print to Off, and printing
from the job queue resumes.

• When paper is advanced
• When you execute Chg. Paper Type in the Paper Menu

1. During printing, on the Tab Selection screen of the Control Panel, press◄ or► to select the
Job tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Job Menu is displayed.

3. Press ▲ or ▼ to select Pause Print, and then press the OK button.
4. Press ▲ or ▼ to select On or Off, and then press the OK button.
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Types of Paper
For information on the types of paper the printer supports (such as plain paper, coated paper, glossy photo
paper, proong paper, and CAD paper), refer to the Paper Reference Guide. The Paper Reference Guide
identies types of paper and gives specications, printer driver settings, and tips on handling paper. (See
Paper Reference Guide.)
By downloading the latest version of the Media Conguration Tool from the imagePROGRAF website, you
can make sure the paper information indicated in the Paper Reference Guide, on the printer Control Panel,
and in the printer driver is up to date.

Accessing the Paper Reference Guide from imagePROGRAF Support
Information
The Paper Reference Guide can also be accessed from imagePROGRAF Support Information. Follow
these instructions, as appropriate for your operating system.

• Windows
1. Double-click the iPFxxxx Support desktop icon. (iPFxxxx indicates the printer model.)

The imagePROGRAF Support Information window is displayed.
2. Click the Paper Reference Guide button.
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The Paper Reference Guide is displayed.

• Mac OS X
1. Click the iPF Support icon in the Dock.

The imagePROGRAF Support Information window is displayed.
2. Click the Paper Reference Guide button.
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The Paper Reference Guide is displayed.
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Updating paper information
To update the paper information in the Paper Reference Guide and on the printer, download the latest
version of the Media Conguration Tool from the imagePROGRAF website. For information about the Media
Conguration Tool, see Media Conguration Tool (Windows) or Media Conguration Tool (Macintosh).
The imagePROGRAF website is accessible from imagePROGRAF Support Information.

Important
• When you use the Media Conguration Tool to update information about paper, the types of paper on
the printer Control Panel, in the printer driver, and in related software are updated.

• Windows
1. Double-click the iPFxxxx Support desktop icon. (iPFxxxx indicates the printer model.)

The imagePROGRAF Support Information window is displayed.
2. Click Visit the imagePROGRAF webpage.

The default browser on your computer is started and the imagePROGRAF webpage is displayed.
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• Mac OS X
1. Click the iPF Support icon in the Dock.

The imagePROGRAF Support Information window is displayed.
2. Click Visit the imagePROGRAF webpage.

The default browser on your computer is started and the imagePROGRAF webpage is displayed.
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Paper Sizes
Rolls
Rolls that meet the following conditions are supported.

• Outer diameter: Up to 150 mm (6 in)
• Inner diameter of paper core: 2 or 3 inches
• Printing side out

Roll Width Roll Paper Width Setting in
Printer Driver Borderless Printing (*1)

914.4 mm (36.00 in) 36-in. Roll (914.4mm) Yes

841.0 mm (33.11 in) ISO A0/A1 Roll (841.0mm) Yes

762.0 mm (30.00 in) 30-in. Roll (762.0mm) No

728.0 mm (28.66 in) JIS B1/B2 Roll (728.0mm) Yes

609.6 mm (24.00 in) 24-in. Roll (609.6mm) Yes

594.0 mm (23.39 in) ISO A1/A2 Roll (594.0mm) Yes

515.0 mm (20.28 in) JIS B2/B3 Roll (515.0mm) Yes

431.8 mm (17.00 in) 17-in. Roll (431.8mm) Yes

420.0 mm (16.54 in) ISO A2/A3 Roll (420.0mm) Yes

406.4 mm (16.00 in) 16-in. Roll (406.4mm) No

355.6 mm (14.00 in) 14-in. Roll (355.6mm) Yes

300.0 mm (11.81 in) 300mm Roll (300.0mm) Yes

297.0 mm (11.69 in) ISO A3/A4 Roll (297.0mm) Yes

257.0 mm (10.12 in) JIS B4 Roll (257.0mm) Yes

254.0 mm (10.00 in) 10-in. Roll (254.0mm) Yes

*1: For information on types of paper compatible with borderless printing, refer to the Paper Reference
Guide. (→P.95)
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Sheets
Sheets of the following sizes are supported.

Paper Sizes Dimensions
ISO A0 841.0 × 1189.0 mm (33.11 × 46.81 in)

ISO A1 594.0 × 841.0 mm (23.39 × 33.11 in)

ISO A2+ 431.8 × 609.6 mm (17.00 × 24.00 in)

ISO A2 420.0 × 594.0 mm (16.54 × 23.39 in)

ISO A3+ 329.0 × 483.0 mm (12.95 × 19.02 in)

ISO A3 297.0 × 420.0 mm (11.69 × 16.54 in)

ISO A4 210.0 × 297.0 mm (8.27 × 11.69 in)

ISO B1 707.0 × 1000.0 mm (27.83 × 39.37 in)

ISO B2 500.0 × 707.0 mm (19.69 × 27.83 in)

ISO B3 353.0 × 500.0 mm (13.90 × 19.69 in)

ISO B4 250.0 × 353.0 mm (9.84 × 13.90 in)

JIS B1 728.0 × 1030.0 mm (28.66 × 40.55 in)

JIS B2 515.0 × 728.0 mm (20.28 × 28.66 in)

JIS B3 364.0 × 515.0 mm (14.33 × 20.28 in)

JIS B4 257.0 × 364.0 mm (10.12 × 14.33 in)

34"x44"(ANSI E) 863.6 × 1117.6 mm (34.00 × 44.00 in)

28"x40"(ANSI F) 711.2 × 1016.0 mm (28.00 × 40.00 in)

22"x34"(ANSI D) 558.8 × 863.6 mm (22.00 × 34.00 in)

17"x22"(ANSI C) 431.8 × 558.8 mm (17.00 × 22.00 in)

11"x17"(Ledger) 279.4 × 431.8 mm (11.00 × 17.00 in)

13"x19"(Super B) 330.2 × 482.6 mm (13.00 × 19.00 in)

Letter(8.5"x11") 215.9 × 279.4 mm (8.50 × 11.00 in)

Legal(8.5"x14") 215.9 × 355.6 mm (8.50 × 14.00 in)

36"x48"(ARCH E) 914.4 × 1219.2 mm (36.00 × 48.00 in)

30"x42"(ARCH E1) 762.0 × 1066.8 mm (30.00 × 42.00 in)

26"x38"(ARCH E2) 660.4 × 965.2 mm (26.00 × 38.00 in)

27"x39"(ARCH E3) 685.8 × 990.6 mm (27.00 × 39.00 in)

24"x36"(ARCH D) 609.6 × 914.4 mm (24.00 × 36.00 in)

18"x24"(ARCH C) 457.2 × 609.6 mm (18.00 × 24.00 in)

12"x18"(ARCH B) 304.8 × 457.2 mm (12.00 × 18.00 in)

9"x12"(ARCH A) 228.6 × 304.8 mm (9.00 × 12.00 in)

DIN C0 917.0 × 1296.0 mm (36.10 × 51.02 in)

DIN C1 648.0 × 917.0 mm (25.51 × 36.10 in)

DIN C2 458.0 × 648.0 mm (18.03 × 25.51 in)
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Paper Sizes Dimensions
DIN C3 324.0 × 458.0 mm (12.76 × 18.03 in)

DIN C4 229.0 × 324.0 mm (9.02 × 12.76 in)

20"x24" 508.0 × 609.6 mm (20.00 × 24.00 in)

18"x22" 457.2 × 558.8 mm (18.00 × 22.00 in)

14"x17" 355.6 × 431.8 mm (14.00 × 17.00 in)

12"x16" 304.8 × 406.4 mm (12.00 × 16.00 in)

10"x12" 254.0 × 304.8 mm (10.00 × 12.00 in)

10"x15" 254.0 × 381.0 mm (10.00 × 15.00 in)

US Photo 16"x20" 406.4 × 508.0 mm (16.00 × 20.00 in)

Poster 20"x30" 508.0 × 762.0 mm (20.00 × 30.00 in)

Poster 30"x40" 762.0 × 1016.0 mm (30.00 × 40.00 in)

13"x22" 329.0 × 558.0 mm (12.95 × 21.97 in)

Poster 300x900mm 300.0 × 900.0 mm (11.81 × 35.43 in)

Custom Paper Size 203.2 x 203.2 mm (8.00 x 8.00 in) to 917.0 x 1600.0
mm (36.10 x 62.99 in)

Note
• For details on non-standard paper sizes, see “Printing on Non-Standard Paper Sizes”. (→P.261)
• Borderless printing is not supported on sheets.
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Handling rolls

Attaching the Roll Holder to Rolls
When printing on rolls, attach the Roll Holder to the roll.

Rolls have a two- or three-inch paper core. Use the correct attachment for the paper core. The printer comes
equipped with the 2-Inch Paper Core Attachment installed.

Using Rolls with a 2-Inch Paper Core Using Rolls with a 3-Inch Paper Core

Holder Stopper (Left Side) Roll Holder (Right Side) Holder Stopper (Left Side) Roll Holder (Right Side)

2-Inch Paper Core
Attachment

No Attachment Needed 3-Inch Paper Core
Attachment L

3-Inch Paper Core
Attachment R

Caution
• Set the roll on a table or other at surface so that it does not roll or fall. Rolls are heavy, and dropping a
roll may cause injury.

Important
• When handling the roll, be careful not to soil the printing surface. This may affect the printing quality. We
recommend wearing clean cloth gloves when handling rolls to protect the printing surface.

• Use scissors or a cutting tool to cut the edge of the roll paper if it is uneven, dirty, or has tape residue.
Otherwise, it may cause feeding problems and affect the printing quality. Be careful not to cut through
any barcodes printed on the roll.

• Align the edges of the paper on both ends of the roll. Misalignment may cause feeding problems.

Note
• For details on supported sizes and types of rolls, see “Paper Sizes” or the Paper Reference Guide.
(→P.100) (→P.95)

• To view instructions as you attach the Roll Holder, press the Navigate button. (→P.29)

Handling Paper 103



Handling rolls

1. Lift the Holder Stopper lever (a) from the shaft side to unlock it. Holding the Holder Stopper at
the position indicated (b), remove it from the Roll Holder.

2. Insert the respective attachments for the roll paper core on the Roll Holder and Holder Stopper.
• Using rolls with a 2-inch paper core

Holder Stopper (Left Side) Roll Holder (Right Side)

Align the tips (a) of the 2-Inch Paper Core
Attachment with the holes (b) of the Holder
Stopper and insert it rmly.

No attachment is needed.

• Using rolls with a 3-inch paper core
Holder Stopper (Left Side) Roll Holder (Right Side)

Align the tips (a) of the 3-Inch Paper Core
Attachment L with the holes (b) of the Holder
Stopper and insert it rmly.

Align the tips (a) of 3-Inch Paper Core
Attachment R with the holes (b) of the Roll
Holder and insert it rmly.
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3. With the edge of the roll paper facing forward as shown, insert the Roll Holder from the right of
the roll. Insert it rmly until the roll touches the ange (a) of the Roll Holder, leaving no gap.

4. Insert the Holder Stopper from the left in the Roll Holder as shown. Holding it at the position
shown (b), push it rmly in until the ange (a) of the Holder Stopper touches the roll. Lock the
Holder Stopper lever (c) by pushing it down toward the shaft side.
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Loading Rolls in the Printer
Follow these steps to load rolls in the printer.

Note
• Before loading rolls, make sure the printer is clean inside the Top Cover and around the Ejection Guide.
If these areas are dirty, we recommend cleaning them in advance. (→P.647)

1. Press the Load button.

2. Press ▲ or ▼ to select Load Roll Paper, and then press the OK button.

Note
• If any paper has been advanced that will not be used, a message is shown requesting you to
remove it.
Press ▲ or ▼ to select Yes, and then press the OK button. Remove the paper and go to the
next step.

3. Positioning your hands as shown, open the Roll Cover.
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4. Holding the Roll Holder ange (a), rest the Roll Holder shaft on the Roll Ledge (b).
At this time, position the holder so that the “R” label (c) on the Roll Holder ange is aligned
with the “R” label (d) on the printer .

5. Holding the Roll Holder ange (a), guide the holder along the Roll Loading Slots (b) on both
ends, keeping the holder level as you load it in the Roll Holder Slot.

Caution
• Do not force the Roll Holder into the printer with the right and left ends reversed. This may damage
the printer and Roll Holder.

• Do not release the anges until the holder is loaded in the Roll Holder Slot.
• Be careful not to pinch your ngers between the Roll Loading Slots (b) and the Roll Holder shaft
(c) when loading rolls.

Handling Paper 107



Handling rolls

6. Advance the roll to insert the leading edge in the Paper Feed Slot (a) until you hear a tone.

Important
• Be careful not to soil the printing surface of roll paper as you insert it in the slot. This may affect
the printing quality. We recommend wearing clean cloth gloves when handling rolls to protect the
printing surface.

• If the paper is wrinkled or warped, straighten it out before loading it.
• Load paper straight so it is not fed askew.

7. Once paper feeding starts, you will need to do the following, based on the ManageRemainRoll
setting and the barcode printed on rolls. (→P.126)
ManageRemainRoll Barcodes Printer Operation After the Paper is Fed

PrintedOff

Not printed

A menu for selection of the type of paper is automatically
shown on the Display Screen.
Press▲ or▼ to select the type of paper, and then press
the OK button.

Printed The type and amount of paper left is automatically
detected based on the barcode printed on the roll.
There is no need to specify the type and length of the
paper.

On

Not printed A menu for selection of the paper type and length is
automatically shown on the Display Screen.
Press ▲ or ▼ to select the type and length of paper
loaded, and then press the OK button.

Note
• For details on types of paper to select, see the Paper Reference Guide. (→P.95)
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8. Holding it at the positions indicated, close the Roll Cover.

Note
• Cut the edge of the roll after the paper is advanced if it is soiled or if there are cuts from scissors or
the blade after removing creased edges. (→P.129)
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Changing the Type of Paper
Follow these steps to change the type of paper specied on the printer after you have loaded paper.
If you will continue using this type of paper later, selecting Keep Paper Type > On will save the time and effort of
conguring the media type setting when you load the paper again. The current media type settings before you
select On will be automatically selected at that time. (→P.111)

Important
• For best printing results, the printer ne-tunes the feed amount for each type of paper. Be sure to select
the type of paper to use correctly before printing.

• Because the printer ne-tunes the feed amount for each type of paper, the margins and the size of
printed images may vary depending on the type of paper used. If margins and the size of images are not
as you expected, adjust the paper feed amount.
(→P.612)

Changing the Type of Paper

Note
• After you load a roll, the printer automatically shows a menu for selection of the type of paper on the
Display Screen. Select the type of paper and press the OK button.
If no barcode has been printed on the roll and you have set ManageRemainRoll to On, specify the roll
length after the type of paper. (→P.112)

1. On the Tab Selection screen of the Control Panel, press◄ or► to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Chg. Paper Type, and then press the OK button.
4. Press ▲ or ▼ to select the type of paper loaded (Roll Paper or Cut Sheet), and then press

the OK button.
5. Press▲ or▼ to select the type of paper loaded in the printer, and then press the OK button.

Note
• For details on types of paper, see the Paper Reference Guide. (→P.95) By default, Plain Paper
is selected.

• If you move the Release Lever, the setting automatically reverts to the previously selected paper.
• Be sure to select the correct paper type. If this setting does not match the loaded paper, it may
cause feed errors and affect printing quality.
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Using the Same Type of Paper Regularly
Congure this setting so that current media type settings will be automatically selected when you load the
same type of paper later.

1. On the Tab Selection screen of the Control Panel, press◄ or► to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Keep Paper Type, and then press the OK button.
4. Press ▲ or ▼ to select On, and then press the OK button.

Note
• The specied media type setting is updated in the following situations.

• When using sheets, if you send a print job before loading a sheet, the media type setting is
updated to match the type of paper specied by the print job.

• When you have selected ManageRemainRoll > On on the Control Panel and a barcode is printed
on the roll, the media type setting is updated to match the type of paper specied by the barcode.

• To change the media type setting, see “Changing the Type of Paper”. (→P.110)
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Specifying the Paper Length
When changing the length of paper after the paper has been advanced, specify the length as follows.

Note
• Specify the paper length when you have set ManageRemainRoll to On. (→P.126)

1. On the Tab Selection screen of the Control Panel, press◄ or► to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Chg. Paper Size, and then press the OK button.
4. Press ▲ or ▼ to select Roll Length, and then press the OK button.
5. Press▲ or▼ to select the length of paper loaded in the printer, and then press the OK button.

Specify the roll length as follows.
1. Press the ◄ or ► button to move to the next eld for input.
2. Press the ▲ or ▼ button to enter the value.
3. Repeat steps 1 and 2 to nish entering the value, and then press the OK button.
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Printing From a Desired Starting Point
When printing inside boundaries or in other situations when you want to specify a particular position to start
printing from, set Width Detection to Off in the printer menu for the type of paper used.

Set Width Detection to Off
1. On the Tab Selection screen of the Control Panel, press◄ or► to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Paper Details, and then press the OK button.
4. Press ▲ or ▼ to select the type of paper, and then press the OK button.
5. Press ▲ or ▼ to select Width Detection, and then press the OK button.
6. Press ▲ or ▼ to select Off, and then press the OK button.

Load paper in the desired position to start printing from
Follow these instructions to load paper at the desired starting position for printing when Width Detection
is Off.

1. If you did not send a print job in advance, a menu for selection of the type of paper is displayed.
Press ▲ or ▼ to select the type of paper, and then press the OK button.

Note
• If a print job was received before paper was advanced, the media type and size specied by the job
are shown on the Display Screen.
Thus, this screen is not displayed. Go to step 2.

2. Width Detection OFF. OK to continue? is now shown on the Display Screen. Press▲ or▼ to
select Leave OFF, and then press the OK button.

3. After a menu for selection of the paper size is displayed, press ▲ or ▼ to select the paper
size, and then press the OK button.
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4. Open the Top Cover and check the position where paper is loaded.

To start printing from the current position, close the Top Cover.
To reposition the paper, push the Release Lever back.

5. Keeping the right edge of the paper aligned with the extended line of the Paper Alignment Line
(a) to the right of the ejection guide and the leading edge aligned with the groove (b) at the far
end of the Platen, load the paper at the position from which to start printing.
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6. Pull the Release Lever forward and close the Top Cover.
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Removing the Roll from the Printer
Remove rolls from the printer as follows.

Note
• If you need to cut the roll, see “Specifying the Cutting Method for Rolls”. (→P.129)

1. On the Tab Selection screen of the Control Panel, press◄ or► to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Eject Paper, and then press the OK button.
4. Press ▲ or ▼ to select Yes, and then press the OK button.

The roll is now rewound and ejected.

Caution
• If you have selected ManageRemainRoll > On in the Control Panel menu, a barcode is printed on
the leading edge of the roll.
Do not remove the roll before the barcode is printed. You will be unable to keep track of the amount
of roll paper left. (→P.126)

5. Positioning your hands as shown, open the Roll Cover.
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6. Using both hands, rotate the Roll Holder toward the back to rewind the roll.

7. Holding the Roll Holder ange (a), remove the holder from the Roll Holder Slot.

Note
• For instructions on removing the Roll Holder from rolls, see “Removing the Roll Holder from Rolls”.
(→P.118)

8. Holding it at the positions indicated, close the Roll Cover.

Note
• To load new paper in the printer at this point, see “Loading Rolls in the Printer”. (→P.106)
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Removing the Roll Holder from Rolls
1. Lift the Holder Stopper lever (a) from the shaft side to unlock it. Holding the Holder Stopper at

the position indicated (b), remove it from the Roll Holder.

2. Remove the Roll Holder from the roll.

3. When removing attachments, push the tips (a) in as you remove the attachment.
• 3-Inch Paper Core Attachment R (Roll Holder side)

• 3-Inch Paper Core Attachment L (Holder Stopper side)
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• 2-Inch Paper Core Attachment

Important
• Store the roll in the original bag or box, away from high temperature, humidity, and direct sunlight. If
paper is not stored properly, the printing surface may become scratched, which may affect the printing
quality when you use it again.
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Clearing Jammed Roll Paper
If paper from a roll becomes jammed, Paper jam. is shown on the Display Screen of the Control Panel.
Remove the jammed paper as follows.

1. Open the Roll Cover. Use a commercially available cutter or the like to cut the paper of the
loaded roll.

Caution
• When cutting paper, be careful to avoid injury or damage to the printer.

2. Push the Release Lever back.

3. Remove the jammed paper.
• If paper is jammed inside the Top Cover

1. Open the Top Cover and move the Carriage to the left or right side manually, away from the jam.

2. Clear any jammed paper from inside the Top Cover.
After removing the paper, make sure there are no other scraps of paper in the printer.
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3. Close the Top Cover.

Important
• Do not move the Carriage over jammed paper. This may damage the Printhead.
• Do not touch the Linear Scale (a) or Carriage Shaft (b). This may stain your hands and damage
the printer.

• If paper from a roll is jammed by the Paper Feed Slot
1. Open the Roll Cover.
2. Remove the jammed paper from the Paper Feed Slot.

After removing the paper, make sure there are no other scraps of paper in the printer.
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• If the paper is jammed by the Ejection Guide
Remove the jammed paper from the Output Tray.
After removing the paper, make sure there are no other scraps of paper in the printer.

4. Pull the Release Lever forward.
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Clearing Jammed Paper (Paper Feed Slot)
Follow these steps to remove any scraps left in the Paper Feed Slot after you clear jammed sheets or roll paper.

1. Turn the printer off. (→P.24)
2. Push the Release Lever back.

3. Positioning your hands as shown, open the Roll Cover.

4. Fold an A4 sheet lengthwise four times and insert it through the gap of the Paper Feed Slot.
Push the scrap out toward the Platen.

5. Remove the scrap when it is pushed out onto the Platen.
6. If any scraps remain inside the paper feed slot, repeat steps 4 and 5.
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7. Holding it at the positions indicated, close the Roll Cover.

8. Pull the Release Lever forward.
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Feeding Roll Paper Manually
After a roll has been advanced, you can press the Feed button to feed or retract the roll with the▲ and▼ buttons.

1. Press the Feed button.
2. Press the ▲ or ▼ button to advance or retract the roll.

Press ▲ to retract the roll manually.
Press ▼ to advance the roll manually.

Note
• If you hold down▲ or▼ for less than a second, the roll will move about 1 mm (0.04 in).
If you hold down▲ or▼ for more than a second, the roll will move until you release the button. Release
the button when the Display Screen indicates End of paper feed. Cannot feed paper more..
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Keeping Track of the Amount of Roll Paper Left
Setting ManageRemainRoll to On in the Paper Menu of the Control Panel will print a barcode with text on the roll
when the roll is removed that identies the type of paper and amount left. When ManageRemainRoll is On and
you load rolls with printed barcodes, the type of paper and amount left are automatically detected after rolls are
loaded. The barcode will be cut off after it has been read.

Important
• Because the ManageRemainRoll function is not compatible with clear lm, an error message may be
displayed (The roll is empty.) after you load clear lm. For this reason, set ManageRemainRoll to
Off before loading clear lm.

• If the barcode on the roll is not detected, enter the type and length of paper on the Control Panel.

Follow these steps to set ManageRemainRoll to On as follows.

1. On the Tab Selection screen of the Control Panel, press◄ or► to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press▲ or▼ to select ManageRemainRoll, and then press the OK button.
4. Press ▲ or ▼ to select On, and then press the OK button.
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Specifying the Ink Drying Time for Rolls
When you are using paper that takes longer for ink to adhere, if the Cutter touches printed surfaces that are still
wet, it may damage the paper or cause rough cut edges. Also, ink may be transferred onto the paper surface during
ejection, soiling it. You can prevent problems by adjusting the drying time after printing before the paper is cut.

Windows
1. Display the printer driver dialog box.

(→P.348)
2. Select the Main sheet and click C Advanced Settings in A Media Type.

3. In the Paper Detailed Settings dialog box displayed next, select the desired settings values in B
Between Pages and C Between Scans in A Drying Time, and then click OK.
(→P.354)

Handling Paper 127



Handling rolls

Mac OS X
1. Choose Print in the application menu.
2. Select the Main pane and click C Settings in A Media Type.

3. In the Paper Detailed Settings dialog box displayed next, select the desired settings values in
C Between Pages and D Between Scans in B Drying Time, and then click OK.
(→P.465)

Note
• By factory default, Drying Time is deactivated (Off) for all paper types.
• To have the printer wait for ink to dry immediately after printing without releasing paper, set Cutting
Mode to Eject in the printer menu.
(→P.129)
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Specifying the Cutting Method for Rolls
How rolls are cut after ejection varies depending on printer settings.

Cutting Method Printer Setting Driver Setting

Automatic The roll is automatically cut by the Cutter
Unit following printer driver settings.

Automatic Yes

Eject
(→P.130)

Choose this setting if you prefer not to
have documents dropped immediately after
printing, as when waiting for ink to dry.
To cut the roll with the Cutter Unit, press the
Cut button.

Eject Yes

Manual
(→P.131)

Choose this setting when using media that
cannot be cut using the Cutter Unit.
Cut each page from the roll using scissors.
For continuous printing (if you will cut each
page later), select Auto Cut > Yes or select
Print Cut Guideline.
(→P.331)

Media
Menu >
Paper
Details >
(Various
Types of
Paper) >
Cutting
Mode Manual NoYesPrint

Cut
Guideline

Paper
Cutting
(→P.132)

Choose this option if you want to cut pages
by pressing Cutter Unit buttons for manual
cutting after printing when Auto Cut > No is
selected or Print Cut Guideline is selected
in the printer driver.
Otherwise choose this option if you want to
cut the roll edge after loading a roll.

Cut button
pressed

Yes

Auto Cut

NoPrint
Cut
Guideline

Note
• Automatic and Eject are valid only when you have selected Auto Cut > Yes in the printer driver.
• With Eject, printing does not resume after a series of jobs have been printed continuously until the
roll is cut.

• Eject is the preset selection in Cutting Mode for some types of paper. For this paper, we recommend
keeping the preset cutting mode.

Cut rolls manually in the following cases:
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Eject (waiting for ink to dry after printing)

Important
• When cutting wide printed documents after ejection, have two people support the documents. If the
paper drops, printed documents may be damaged.

• Do not lift the paper when holding printed documents before cutting. If the paper rises, it may affect
the printing quality or cause rough cut edges.

1. On the Tab Selection screen of the Control Panel, press◄ or► to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button. The Paper Menu is displayed.
3. Press ▲ or ▼ to select Paper Details, and then press the OK button.
4. Press ▲ or ▼ to select the type of paper, and then press the OK button.
5. Press ▲ or ▼ to select Cutting Mode, and then press the OK button.
6. Press ▲ or ▼ to select Eject, and then press the OK button.
7. Starts printing.

When printing is nished, the printer will stop without cutting.
8. Holding the printed document to prevent it from dropping, press the Cut button to cut the roll.
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Manual (when using media that cannot be cut with the Cutter Unit)

1. On the Tab Selection screen of the Control Panel, press◄ or► to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button. The Paper Menu is displayed.
3. Press ▲ or ▼ to select Paper Details, and then press the OK button.
4. Press ▲ or ▼ to select the type of paper, and then press the OK button.
5. Press ▲ or ▼ to select Cutting Mode, and then press the OK button.
6. Press ▲ or ▼ to select Manual, and then press the OK button.
7. Starts printing.

The printer stops advancing the paper after printing.
8. Press the Feed button.

Roll paper is fed to the specied cut position and then automatically stopped.
9. Cut the roll paper manually with scissors or the like.
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10. Press the OK button.

After the roll is rewound, it stops automatically.

Paper cutting (to have the roll cut at your specied position)

1. Press the Feed button.
2. Press the ▼ button to advance the roll to the position for cutting.

3. Press the Cut button.

4. Press ▲ or ▼ to select Yes, and then press the OK button.
After the roll paper is cut, it is rewound automatically.

Caution
• If paper would be short when cut at a particular position, the roll may automatically be advanced in
some cases before cutting.

132 Handling Paper



Handling rolls

Cutting the Leading Edge of Roll Paper Automatically
If the leading edge of a roll is crooked or warped, it may cause an error message or printing problems. In this
case, set Trim Edge First to Automatic or On in the Paper Menu on the Control Panel to have the printer cut the
leading edge to make the edge straight after you load a roll.

Trim Edge First offers the following options.
• Automatic
If the left and right side of the leading edge of the roll ((a) and (b)) are uneven by 3 mm (0.12 in) or
more when you load the roll, the edge is cut an amount relative to the slant to ensure a straight edge,
and scraps are removed. The edge is not cut if the unevenness is less than 3 mm. However, paper
may sometimes be cut, depending on the state of the leading edge.

• Off
The edge is not cut and scraps are not removed. This setting is Off for most types of paper, by default.
For more information, see the Paper Reference Guide. (→P.95)

• On
The leading edge is cut off when you load a roll, and scraps are removed. The amount of paper cut
from the leading edge varies depending on the type of paper. For more information, see the Paper
Reference Guide. (→P.95)

Follow these steps to change the Trim Edge First setting.

1. On the Tab Selection screen of the Control Panel, press◄ or► to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Paper Details, and then press the OK button.
4. Press ▲ or ▼ to select the type of paper, and then press the OK button.
5. Press ▲ or ▼ to select Trim Edge First, and then press the OK button.
6. Press▲ or▼ to select the desired setting option, and then press the OK button.

This setting takes effect the next time you load a roll.
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Reducing Dust from Cutting Rolls
For media such as Backlit Film that are more likely to generate debris when cut, select CutDustReduct. > On in
the Paper Menu of the Control Panel. This option reduces debris from cutting by printing black lines at the leading
and trailing edges of documents. It may help prevent Printhead damage. You can specify for CutDustReduct. to
be activated for particular types of paper.

Important
• Do not set CutDustReduct. to On for paper that wrinkles easily, such as Plain Paper or lightweight
paper. This may impair cutting and cause paper jams.

• Borderless printing is not available when CutDustReduct. is set to On. To use borderless printing,
select CutDustReduct. > Off.

Set CutDustReduct. to On as follows.

1. On the Tab Selection screen of the Control Panel, press◄ or► to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Paper Details, and then press the OK button.
4. Press▲ or▼ to select the type of paper loaded in the printer, and then press the OK button.
5. Press ▲ or ▼ to select CutDustReduct., and then press the OK button.
6. Press ▲ or ▼ to select On, and then press the OK button.
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Roll Holder Set
Load a roll on the roll holder and then load the holder in the printer. The Roll Holder in the Roll Holder Set RH2-33 is
for use with both 2-inch and 3-inch paper cores. Use the correct attachment for the particular paper core. (→P.103)

• Roll Holder Set RH2-33
• Roll Holder (for 2- and 3-inch paper cores)

• Attachments

Using the 2-Inch Paper
Core Attachment

Using the 3-Inch Paper Core Attachment

2-Inch Paper Core Attachment 3-Inch Paper Core Attachment
L

3-Inch Paper Core Attachment
R
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Loading Sheets in the Printer
Follow these steps to load sheets in the printer.

Important
• One sheet of paper can be loaded in the Paper Feed Slot at a time. Do not load more than one sheet at
a time. This may cause paper jams.

• Before feeding paper or printing, make sure the sheet is at against the Roll Cover. The sheet may jam
if it curls before feeding or printing and the trailing edge drops toward the front.

Note
• Store unused paper in the original package, away from high temperature, humidity, and direct sunlight.
• Paper that is wrinkled or warped may jam. If necessary, straighten the paper and reload it.
• Load the paper straight. Loading paper askew will cause an error.

1. Select sheets as the paper source.
• If a print job was received
Sheets are automatically selected, and the media type and size specied by the print job are shown
on the Display Screen. Go to the next step.

• If no print job was received
1. Press the Load button.

2. Press ▲ or ▼ to select Load Cut Sheet, and then press the OK button.

Note
• If any paper has been advanced that will not be used, a message is shown requesting you to
remove it.
Press ▲ or ▼ to select Yes, and then press the OK button. Remove the paper and go to the
next step.
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2. Slide the Width Guide (a) to align it with the mark for the size of paper you will load.

3. Load a single sheet printing-side up in the Paper Feed Slot, with the right edge aligned with the
Paper Alignment Guide (a) to the right of the Roll Cover.
Insert the paper until the leading edge makes contact and you hear a tone.
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4. Move the Width Guide (a) carefully to match the size of paper loaded.
Set the Width Guide against the edge of the paper to prevent the paper from becoming crooked
or wrinkled.

5. Press the OK button.
• If a print job was received
The printer now starts printing the print job.

• If no print job was received
A menu for selection of the type of paper is automatically shown on the Display Screen.
Press ▲ or ▼ to select the type of paper, and then press the OK button.
The printer now starts feeding the paper.

Note
• For details on types of paper to select, see the Paper Reference Guide. (→P.95)

138 Handling Paper



Handling sheets

Changing the Type of Paper
Follow these steps to change the type of paper specied on the printer after you have loaded paper.
If you will continue using this type of paper later, selecting Keep Paper Type > On will save the time and effort of
conguring the media type setting when you load the paper again. The current media type settings before you
select On will be automatically selected at that time. (→P.111)

Important
• For best printing results, the printer ne-tunes the feed amount for each type of paper. Be sure to select
the type of paper to use correctly before printing.

• Because the printer ne-tunes the feed amount for each type of paper, the margins and the size of
printed images may vary depending on the type of paper used. If margins and the size of images are not
as you expected, adjust the paper feed amount.
(→P.612)

Changing the Type of Paper

Note
• After you load a roll, the printer automatically shows a menu for selection of the type of paper on the
Display Screen. Select the type of paper and press the OK button.
If no barcode has been printed on the roll and you have set ManageRemainRoll to On, specify the roll
length after the type of paper. (→P.112)

1. On the Tab Selection screen of the Control Panel, press◄ or► to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Chg. Paper Type, and then press the OK button.
4. Press ▲ or ▼ to select the type of paper loaded (Roll Paper or Cut Sheet), and then press

the OK button.
5. Press▲ or▼ to select the type of paper loaded in the printer, and then press the OK button.

Note
• For details on types of paper, see the Paper Reference Guide. (→P.95) By default, Plain Paper
is selected.

• If you move the Release Lever, the setting automatically reverts to the previously selected paper.
• Be sure to select the correct paper type. If this setting does not match the loaded paper, it may
cause feed errors and affect printing quality.
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Using the Same Type of Paper Regularly
Congure this setting so that current media type settings will be automatically selected when you load the
same type of paper later.

1. On the Tab Selection screen of the Control Panel, press◄ or► to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Keep Paper Type, and then press the OK button.
4. Press ▲ or ▼ to select On, and then press the OK button.

Note
• The specied media type setting is updated in the following situations.

• When using sheets, if you send a print job before loading a sheet, the media type setting is
updated to match the type of paper specied by the print job.

• When you have selected ManageRemainRoll > On on the Control Panel and a barcode is printed
on the roll, the media type setting is updated to match the type of paper specied by the barcode.

• To change the media type setting, see “Changing the Type of Paper”. (→P.139)
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Printing From a Desired Starting Point
When printing inside boundaries or in other situations when you want to specify a particular position to start
printing from, set Width Detection to Off in the printer menu for the type of paper used.

Set Width Detection to Off
1. On the Tab Selection screen of the Control Panel, press◄ or► to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Paper Details, and then press the OK button.
4. Press ▲ or ▼ to select the type of paper, and then press the OK button.
5. Press ▲ or ▼ to select Width Detection, and then press the OK button.
6. Press ▲ or ▼ to select Off, and then press the OK button.
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Load paper in the desired position to start printing from
Follow these instructions to load paper at the desired starting position for printing when Width Detection
is Off.

1. If you did not send a print job in advance, a menu for selection of the type of paper is displayed.
Press ▲ or ▼ to select the type of paper, and then press the OK button.

Note
• If a print job was received before paper was advanced, the media type and size specied by the job
are shown on the Display Screen.
Thus, this screen is not displayed. Go to step 2.

2. Width Detection OFF. OK to continue? is now shown on the Display Screen. Press▲ or▼ to
select Leave OFF, and then press the OK button.

3. After a menu for selection of the paper size is displayed, press ▲ or ▼ to select the paper
size, and then press the OK button.

4. Open the Top Cover and check the position where paper is loaded.

To start printing from the current position, close the Top Cover.
To reposition the paper, push the Release Lever back.
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5. Keeping the right edge of the paper aligned with the extended line of the Paper Alignment Line
(a) to the right of the ejection guide and the leading edge aligned with the groove (b) at the far
end of the Platen, load the paper at the position from which to start printing.

6. Pull the Release Lever forward and close the Top Cover.
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Removing Sheets
Remove sheets from the printer as follows.

1. On the Tab Selection screen of the Control Panel, press◄ or► to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Eject Paper, and then press the OK button.
4. Press ▲ or ▼ to select Yes, and then press the OK button.

The paper is ejected from the front of the printer.
5. Holding the paper, push the Release Lever back and remove the sheet.

6. Pull the Release Lever forward.
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Clearing a Jammed Sheet
If a sheet becomes jammed, Paper jam. is shown on the Display Screen of the Control Panel. Remove
the jammed paper as follows.

1. Push the Release Lever back.

2. Remove the jammed paper.
• If paper is jammed inside the Top Cover

1. Open the Top Cover and move the Carriage to the left or right side manually, away from the jam.

2. Clear any jammed paper from inside the Top Cover.
After removing the paper, make sure there are no other scraps of paper in the printer.

3. Close the Top Cover.
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Important
• Do not move the Carriage over jammed paper. This may damage the Printhead.
• Do not touch the Linear Scale (a) or Carriage Shaft (b). This may stain your hands and damage
the printer.

• If the paper is jammed by the Paper Feed Slot
Remove the jammed paper from the Paper Feed Slot.
After removing the paper, make sure there are no other scraps of paper in the printer.

• If the paper is jammed by the Ejection Guide
Remove the jammed paper from the Output Tray.
After removing the paper, make sure there are no other scraps of paper in the printer.
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3. Pull the Release Lever forward.
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Clearing Jammed Paper (Paper Feed Slot)
Follow these steps to remove any scraps left in the Paper Feed Slot after you clear jammed sheets or roll paper.

1. Turn the printer off. (→P.24)
2. Push the Release Lever back.

3. Positioning your hands as shown, open the Roll Cover.

4. Fold an A4 sheet lengthwise four times and insert it through the gap of the Paper Feed Slot.
Push the scrap out toward the Platen.

5. Remove the scrap when it is pushed out onto the Platen.
6. If any scraps remain inside the paper feed slot, repeat steps 4 and 5.
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7. Holding it at the positions indicated, close the Roll Cover.

8. Pull the Release Lever forward.
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Using the Output Stacker
The Output Stacker can be held at two positions, as shown.

• When storing printed documents on the Output Stacker
Use position (1).

• When the Output Stacker is not used, or when moving the printer
Use position (2).
When moving the printer, lift the Support Rod to the Extended position. (→P.151)

Important
• When storing printed documents on the Output Stacker, always use it in position (1). If you do not, printed
documents may not be dropped into the Output Stacker, and the printed surface may become soiled.

• When moving the printer, always lift the Support Rod to the Extended position before use in position (2).
If the stacker is not used in position (2), the Basket Cloth may touch the oor and be soiled or damaged.

• The Output Stacker can hold one sheet. When printing multiple pages, remove each sheet after it
is printed.
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Note regarding the Extended position
The Output Stacker can be used in the regular position and an Extended position for easy removal of printed
documents.
For information on types of paper you can use with the stacker in Extended position, refer to the Paper
Reference Guide. (→P.95)

Regular position Extended position

Switch the stacker to Extended position as follows.
1. Lift the Support Rod to the position shown (a) and switch the stacker to Extended position.

2. When using rolls larger than A1 or 24 inches wide, pull out the Adjustable Stopper.
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Working With Various Print Jobs

Printing Photos and Images

Printing Photos and Images
Printing is easy when you simply choose the print target.

Easy Settings
Simply choose the printing application in the list for optimal printing results.

Print Target
Choose presets that match the type of document to be printed.

Print targets for photos and images
Print Target Description

Poster The best setting for posters. Prints using vivid and
high impact colors.

Photo (Color) Suitable for printing photographic images captured
with a digital camera.

Faithful Color
Reproduction

Prints by minimizing color differences. Suitable
for when the printing results are too vivid or when
printing scanned images.

Caution
• Depending on the Media Type setting, some Print Target options may not be available.

Note
• You can check the settings values for each print target by clicking View Settings.
• You can also ne-tune these values as needed. (Advanced Settings)
For details on Advanced Settings, see “Giving Priority to Particular Graphic Elements and Colors
for Printing”. (→P.187)
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Print Quality
Choose the print quality.
The printing mode is determined by a combination of the print quality and resolution.

Print Quality Description

Highest A setting for printing at the highest resolution when quality is most
important. Printing takes longer and consumes more ink than in other
modes, but this mode offers superior printing quality.

High Choose this setting to print at high resolution when quality is most
important.
Printing takes longer and consumes more ink than in “Standard” or “Draft”
modes, but this mode offers exceptional printing quality.

Standard Choose this setting to print at standard resolution when quality and speed
are both important.
Printing takes less time than in “Highest” or “High” mode.

Draft Choose this setting to print faster.
Printing in draft mode can help you work more efciently when checking
layouts.

For instructions on printing photos and images, refer to the following topics, as appropriate for your computer
and operating system.

• Printing Photos and Images (Windows) (→P.154)
• Printing Photos and Images (Mac OS X) (→P.156)
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Printing Photos and Images (Windows)
This topic describes how to print photos based on the following example.

• Document: Photo image from a digital camera
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Premium Glossy Paper 200
• Roll paper width: 10 inches (254.0 mm)

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Premium
Glossy Paper 200.
In the A Media Type, choose the type of paper used for printing, such as Glossy Paper, Coated
Paper, and so on. Make sure the paper you select is loaded in the printer.

Note
• The paper type setting in the printer driver and related software (as well as on the Control Panel)
is updated when you install the Media Conguration Tool from the User Software CD-ROM or if
you change paper information by using the Media Conguration Tool. For details, see Media
Conguration Tool.

5. After conrming that D Easy Settings is selected, click Photo (Color) in the E Print Target list.

Note
• You can check the settings values selected in the E Print Target list by clickingG View Settings.
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6. Click the Page Setup tab to display the Page Setup sheet.

7. In the A Page Size list, click the size of the original as specied in the application. In this case,
click 10"x12".

8. Click Roll Paper in the L Paper Source list.
9. Select the width of the loaded roll in theM Roll Paper Width list. In this case, click 10-in.

Roll (254.0mm), and then click OK.
10. Specify additional printing conditions.

For details on available printing conditions,see “Printer Driver Settings (Windows)”. (→P.336)
11. Conrm the print settings and print as desired.

Note
• For instructions on conrming print settings,see “Conrming Print Settings (Windows)”. (→P.340)
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Printing Photos and Images (Mac OS X)
This topic describes how to print photos based on the following example.

• Document: Photo image from a digital camera
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll paper
• Paper type: Premium Glossy Paper 200
• Roll paper width: 10 inches (254.0 mm)

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. In the F Paper Size list, click the size of the original. In this case, click 10"x12".
4. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Premium
Glossy Paper 200.
Make sure the paper you select is loaded in the printer.

Note
• The types of paper indicated in the printer driver and related software (as well as on the Control
Panel) are updated when you install the Media Conguration Tool from the User Software CD-ROM
or if you change paper information by using the Media Conguration Tool. For details, see Media
Conguration Tool.

7. After conrming that D Easy Settings is selected, click Photo (Color) in the E Print Target list.

Note
• For information on settings optimized for printing photos and images, see “Printing Photos and
Images”. (→P.152)

• You can check the settings values selected in the E Print Target list by clicking G View set..

8. Make your selection in the F Print Quality list.
9. Access the Page Setup pane.

10. Click Roll Paper in the A Paper Source list.
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11. Make sure the width of the loaded roll is displayed in the B Roll Width list-in this case, 10
in. (254.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Information
on the Main pane to update the printer information.

12. Make sure C Page Size on the Page Setup pane shows the original size as specied in C
Paper Size in the Page Attributes dialog box-in this case, 10"x12".

13. Specify additional printing conditions.
For details on available printing conditions, see “Printer Driver Settings (Mac OS X)”. (→P.454)

14. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Printing CAD Drawings

Printing CAD Drawings
Using this printer, you can print ne lines and text clearly and sharply. It’s easy to produce highly precise drawings
from CAD applications.

Note
• In Windows, you can print highly precise drawings using the provided imagePROGRAF HDI Driver for
AutoCAD/AutoCAD LT.
For details on the HDI driver, see the HDI Driver Guide.

For instructions on CAD printing, refer to the following topics, as appropriate for your computer and operating
system.

• Printing Line Drawings and Text (Windows) (→P.162)
• Printing Line Drawings and Text (Mac OS X) (→P.164)
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Printing Line Drawings and Text
Printing is easy when you simply choose the type of original to print.

Easy Settings
Simply choose the printing application in the list for optimal printing results.

Print Target
Choose presets that match the type of document to be printed.

Print targets for line drawings and text
Print Target Description

CAD (Color Line
Drawing)

Settings optimized to print intricate lines in CAD
drawings clearly.

CAD (B/W Line
Drawing)

Settings optimized to print black lines in CAD
drawings clearly.

Perspective, GIS Settings optimized for printing 3D CAD drawings,
perspective drawings, and maps, including GIS
maps.

Note
• You can check the settings values for each print target by clicking View Settings.
• You can also ne-tune these values as needed. (Advanced Settings)
For details on Advanced Settings, see “Giving Priority to Particular Graphic Elements and Colors
for Printing”. (→P.187)
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Print Quality
Choose the print quality.
The printing mode is determined by a combination of the print quality and resolution.

Print Quality Description

Highest A setting for printing at the highest resolution when quality is most
important. Printing takes longer and consumes more ink than in other
modes, but this mode offers superior printing quality.

High Choose this setting to print at high resolution when quality is most
important.
Printing takes longer and consumes more ink than in “Standard” or “Draft”
modes, but this mode offers exceptional printing quality.

Standard Choose this setting to print at standard resolution when quality and speed
are both important.
Printing takes less time than in “Highest” or “High” mode.

Draft Choose this setting to print faster.
Printing in draft mode can help you work more efciently when checking
layouts.

For instructions on printing line drawings and text, refer to the following topics, as appropriate for your
computer and operating system.

• Printing Line Drawings and Text (Windows) (→P.162)
• Printing Line Drawings and Text (Mac OS X) (→P.164)
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Printing Line Drawings and Text (Windows)
This topic describes how to print line drawings based on the following example.

• Document: CAD drawing
• Page size: A3 (297.0 × 420.0 mm [11.7 × 16.5 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. After conrming that D Easy Settings is selected, click CAD (Color Line Drawing) or CAD

(Monochrome Line Drawing) in the E Print Target list.

Note
• You can check the settings values selected in the E Print Target list by clickingG View Settings.

6. Click the Page Setup tab to display the Page Setup sheet.
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7. In A Page Size, click the size of the original as specied in the application. In this case, click
ISO A3.

8. Click Roll Paper in the L Paper Source list.
9. Select the width of the loaded roll in theM Roll Paper Width list-in this case, ISO A2/A3 Roll

(420.0mm).
10. Specify additional printing conditions.

For details on available printing conditions, see “Printer Driver Settings (Windows)”. (→P.336)
11. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Windows)”. (→P.340)
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Printing Line Drawings and Text (Mac OS X)
This topic describes how to print line drawings based on the following example.

• Document: CAD drawing
• Page size: A3 (297.0 × 420.0 mm [11.7 × 16.5 in])
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. In the F Paper Size list, click the size of the original. In this case, click ISO A3.
4. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
7. After conrming that D Easy Settings is selected, click CAD (Color Line Drawing) or CAD

(Monochrome Line Drawing) in the E Print Target list.

Note
• You can check the settings values selected in the E Print Target list by clicking G View set..

8. Make your selection in the F Print Quality list.
9. Access the Page Setup pane.

10. Click Roll Paper in the A Paper Source list.
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11. Make sure the width of the loaded roll is displayed in the B Roll Width list-in this case, ISO
A2/A3 (420.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Information
on the Main pane to update the printer information.

12. Make sure C Page Size on the Page Setup pane shows the original size as specied in C
Paper Size in the Page Attributes dialog box-in this case, ISO A3.

13. Specify additional printing conditions.
For details on available printing conditions, see “Printer Driver Settings (Mac OS X)”. (→P.454)

14. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Specifying Colors and Printing CAD Drawings
You can complete color settings when Color (CAD) is selected in Color Mode.

Colors can be adjusted before printing as follows when Color Compatibility is selected.

Note
• Color (CAD) is displayed when you select Advanced Settings on the Main sheet and set Print
Priority to Line Drawing/Text.

Color Compatibility
Color Setting Item

Color Setting Description

Color (CAD) 1 Print in standard colors.

Color (CAD) 2 Print in brighter colors.

Color (CAD) 3 Print with approximate colors emulating Canon iPF500, iPF600, iPF700,
iPF510, iPF610, iPF710, iPF605, iPF720, iPF810, iPF820.

Color (CAD) 4 Print emulating the HP Designjet 500/800, in colors resembling colors
produced by these printers.

Color (CAD) 5 Print emulating the HP Designjet 1000, in colors resembling colors
produced by this printer.

Important
• If you have selected Color (CAD) 3, Color (CAD) 4, or Color (CAD) 5, it is not possible to match the
colors and image quality produced by the specied printer exactly.

For instructions on conguring Color Compatibility, refer to the following topics.
• Specifying Colors and Printing CAD Drawings (Windows) (→P.168)
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Specifying Colors and Printing CAD Drawings (Windows)
You can complete color settings when Color (CAD) is selected in Color Mode.

Note
• Color (CAD) is displayed when you select Advanced Settings on the Main sheet and set Print
Priority to Line Drawing/Text.

1. Click start > Printers and Faxes (or Printers).
2. Select the printer, and then display the printer properties dialog box.

3. Click the Device Settings tab to display the Device Settings sheet.

4. Click A Color Compatibility to display the Color Compatibility dialog box.
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5. Select the desired color settings in the A Color Compatibility list.

Note
• For details on color settings,see “Specifying Colors and Printing CAD Drawings”. (→P.167)

For printing instructions, refer to the following topic.
• Choosing the Document Type and Printing Conditions (Windows) (→P.190)
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HP-GL/2 Printing
This printer supports the original Canon GARO printer control language as well as HP-GL/2 and HP
RTL(*1) emulation.(*2) When printing from applications that support HP-GL/2 output, specify HP-GL/2 in
the application’s plotter output settings.

Note
• For instructions on conguring these settings, refer to the software documentation.

The printer automatically switches to the corresponding processing depending on whether a GARO,
HP-GL/2, or HP RTL job is received. Congure the optional settings for HP-GL/2 emulation on the printer
control panel. (→P.49)
This printer can emulate the following printers using HP-GL/2 emulation.

Emulated Printers

Canon iPF500, iPF600, iPF700, iPF510, iPF610, iPF710, iPF605, iPF720, iPF810
and iPF820

Hewlett-Packard Designjet 500, Designjet 800 and Designjet 1000

*1: HP-GL/2: Hewlett-Packard Graphics Language 2; HP RTL: Hewlett-Packard Raster Transfer Language
*2: It may not be possible to print jobs with excessively large amounts of data correctly.
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Printing Ofce Documents

Printing Ofce Documents
Printing is easy when you simply choose the type of original to print.

Easy Settings
Simply choose the printing application in the list for optimal printing results.

Print Target
Choose presets that match the type of document to be printed.

Print targets for ofce documents
Print Target Description

Ofce Document Settings optimized for clear printing of ofce
documents such as handouts.

Note
• You can check the settings values for each print target by clicking View Settings.
• You can also ne-tune these values as needed. (Advanced Settings)
For details on Advanced Settings, see “Giving Priority to Particular Graphic Elements and Colors
for Printing”. (→P.187)

Print Quality
Choose the print quality.
The printing mode is determined by a combination of the print quality and resolution.

Print Quality Description

Highest A setting for printing at the highest resolution when quality is most important. Printing
takes longer and consumes more ink than in other modes, but this mode offers
superior printing quality.

High Choose this setting to print at high resolution when quality is most important.
Printing takes longer and consumes more ink than in “Standard” or “Draft” modes,
but this mode offers exceptional printing quality.

Standard Choose this setting to print at standard resolution when quality and speed are both
important.
Printing takes less time than in “Highest” or “High” mode.

Draft Choose this setting to print faster.
Printing in draft mode can help you work more efciently when checking layouts.

For instructions on printing ofce documents, refer to the following topics, as appropriate for your computer
and operating system.

• Printing Ofce Documents (Windows) (→P.172)
• Printing Ofce Documents (Mac OS X) (→P.174)
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Printing Ofce Documents (Windows)
This topic describes how to print ofce documents based on the following example.

• Document: Ofce document created using word-processing or spreadsheet programs
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Sheets
• Paper type: Plain Paper
• Paper size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. After conrming that D Easy Settings is selected, click Ofce Document in the E Print

Target list.

Note
• You can check the settings values selected in the E Print Target list by clickingG View Settings.

6. Click the Page Setup tab to display the Page Setup sheet.
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7. In the A Page Size list, click the size of the original as specied in the application. In this
case, click ISO A4.

8. Click Manual in the L Paper Source list.
9. Specify additional printing conditions.

For details on available printing conditions, see “Printer Driver Settings (Windows)”. (→P.336)
10. Conrm the print settings and print as desired.

Caution
• Depending on the A Media Type setting, some E Print Target options may not be available.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Windows)”. (→P.340)
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Printing Ofce Documents (Mac OS X)
This topic describes how to print ofce documents based on the following example.

• Document: Ofce document created using word-processing or spreadsheet programs
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Sheets
• Paper type: Plain Paper
• Paper size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. In the F Paper Size list, click the size of the original. In this case, click ISO A4 - for Paper

Tray (Large Margins).
4. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
7. After conrming that D Easy Settings is selected, click Ofce Document in the E Print

Target list.

Note
• You can check the settings values selected in the E Print Target list by clicking G View set..

8. Make your selection in the F Print Quality list.
9. Access the Page Setup pane.

10. Click Manual in the A Paper Source list.
11. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the

Page Attributes dialog box-in this case, ISO A4 - for Paper Tray (Large Margins).
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12. Specify additional printing conditions.
For details on available printing conditions, see “Printer Driver Settings (Mac OS X)”. (→P.454)

13. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Enhanced Printing Options

Adjusting Images

Adjusting the Color in the Printer Driver
Color settings specied in the application for your documents are essentially given priority over other settings for
each print job, but further color adjustment is possible in the printer driver.

Color Mode
Choose how the printer driver processes color, as desired.
The available options vary depending on the color mode.

Color Mode Description Color Adjustment

Color Print in color. You can adjust the color balance and
color-matching method.

Monochrome Print in grayscale. You can adjust the color balance.

Color (CAD) A color mode optimized for line
drawings (2D-CAD). Lines in red,
yellow, and other colors are printed
especially clearly.

You can adjust the color balance.

Monochrome (BK
ink)

A color mode for printing line
drawings. Only Black ink is used.

You can adjust the color balance.

Monochrome
Bitmap

Print in a color mode for CAD,
using Color Ink, with all non-white
portions printed in black.

No color adjustment is supported.
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Color Adjustment
You can adjust colors separately for images, graphics, and text documents.
Adjustment Item Description

Cyan

Magenta

Yellow

Fine-tune color tones by adjusting the levels of Cyan, Magenta, and Yellow.

Gray Tone Adjust the gray tone to suit the images of monochrome photos. Choose cool black
(tinged with blue), pure black (neutral), warm black (tinged with red), and so on.
Select the color tone in the color region or from the list.

Brightness Adjust the brightness of printed images while keeping the darkest and lightest
portions intact.

Contrast Adjust the contrast of the darkest and lightest portions relative to each other.
For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Saturation Adjust the level of color saturation, in a range from subdued to vivid.

Note
• Click Object Adjustment to open the Object Adjustment dialog box, which allows you to select the
color adjustment target from Image, Graphics, and Text.
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Matching
You can choose the color-matching mode and method.
By adjusting the color-matching mode and method, you can make printed colors match the colors of
on-screen images more closely.

Matching Mode Description Remarks

Driver Matching
Mode

Color adjustment based on the original
color prole of the printer driver.

This is the default color-matching
method. Normally, use Driver Matching
Mode.

ICC Matching
Mode

Color adjustment based on ICC color
proles (an international standard) using
the printer driver.

You can select the Input Prole in the
Input Prole Settings.
You can select the printer prole in the
Printer Prole Settings list.

Driver ICM Mode Color adjustment based on the standard
Windows ICM function. The printer
driver adjusts the colors.

Host ICM Mode Color adjustment based on the standard
Windows ICM function. Windows
adjusts the colors.

Available when using Windows 2000,
Windows XP, Windows Server 2003,
Windows Vista, or Windows Server
2008.

ColorSync Color adjustment based on the standard
Mac OS ColorSync function. Mac OS
adjusts the colors.

Available when using Mac OS X
10.3.9-10.4.

Off (No
Adjustment)

No color-matching Choose this option for color-matching by
the software application or with your own
color prole, when you want to disable
color-matching by the printer driver.

Matching Method Description Remarks

Auto Color-matching optimized for images,
graphics, or text.

Perceptual Color-matching optimized for photos.
Prints images with smooth gradations
and colors closer to those as displayed
on the screen.

Colorimetric Color-matching with adjustment to
remove color from white area. Colors in
data are reproduced accurately.

Colorimetric (No
Wht-pnt Corr)

Color-matching without white adjustment
to reect the prole of original data.
Colors in data are reproduced accurately.
Without white adjustment, colors are
added to white areas.

Saturation Color-matching optimized for graphics.
This option emphasizes color saturation.

The available options and their display
order vary depending on your selected
color-matching mode, as well as the
operating system.
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Note
• Be sure to calibrate your monitor colors correctly if you adjust the colors for printing. If monitor colors
are not calibrated correctly, you may not obtain the desired printing results. For instructions on monitor
calibration, refer to the documentation for your monitor and operating system.

For instructions on color adjustment, refer to the following topics, as appropriate for your computer and
operating system.

• Fine-Tuning Colors of Photos and Images (Windows) (→P.181)
• Fine-Tuning Colors of Photos and Images (Mac OS X) (→P.184)
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Fine-Tuning Colors of Photos and Images (Windows)
You can specify your own print settings instead of using the Print Target presets. This topic describes how
to ne-tune the color tone of photos before printing.

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded.
5. Click D Advanced Settings to switch the print mode.

6. Click Color in the G Color Mode list.
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7. Click H Color Settings to display the Color Settings dialog box.

8. On the Color Adjustment sheet, adjust the color tones, brightness, and so on as desired.
Adjustment Item Description

D Cyan

E Magenta

F Yellow

Fine-tune color tones by adjusting the levels of Cyan, Magenta, and
Yellow.

G Gray Tone Adjust the gray tone to suit the images of monochrome photos. Choose
cool black (tinged with blue), pure black (neutral), warm black (tinged
with red), and so on. Select the color tone in the color region or from
the list.

H Brightness Adjust the brightness of printed images while keeping the darkest and
lightest portions intact.

I Contrast Adjust the contrast of the darkest and lightest portions relative to each
other.
For soft gradation, decrease the contrast. For hard gradation, increase
the contrast.

J Saturation Adjust the level of color saturation, in a range from subdued to vivid.

Note
• Click Object Adjustment to open the Object Adjustment dialog box, which allows you to select the
color adjustment target from Image, Graphics, and Text.

9. Close the Color Settings dialog box.
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10. Click the Page Setup tab to display the Page Setup sheet.

11. Conrm the settings of A Page Size, L Paper Source, and so on.
12. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Windows)”. (→P.340)
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Fine-Tuning Colors of Photos and Images (Mac OS X)
You can specify your own print settings instead of using the Print Target presets. This topic describes how
to ne-tune the color tone of photos before printing.

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. Choose the original size in the F Paper Size list.
4. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
5. Access the Main pane.
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6. In the A Media Type list, select the type of paper that is loaded.
7. Click D Advanced Settings to switch the print mode.

8. Click Color in the H Color Mode list.
9. Click I Set to display the Color Settings dialog box.
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10. On the Color Adjustment pane, adjust the color tones, brightness, and so on as desired.
Adjustment Item Description

D Cyan

E Magenta

F Yellow

Fine-tune color tones by adjusting the levels of Cyan, Magenta, and
Yellow.

G Gray Tone Adjust the gray tone to suit the images of monochrome photos. Choose
cool black (tinged with blue), pure black (neutral), warm black (tinged
with red), and so on. Select the color tone in the color region or from
the list.

H Brightness Adjust the brightness of printed images while keeping the darkest and
lightest portions intact.

I Contrast Adjust the contrast of the darkest and lightest portions relative to each
other.
For soft gradation, decrease the contrast. For hard gradation, increase
the contrast.

J Saturation Adjust the level of color saturation, in a range from subdued to vivid.

Note
• Click Object Adjustment to open the Object Adjustment dialog box, which allows you to select the
color adjustment target from Image, Graphics, and Text.

11. Click OK to close the Color Settings dialog box.
12. Access the Page Setup pane.

13. Conrm the settings of A Paper Source and C Page Size.
14. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Giving Priority to Particular Graphic Elements and Colors
for Printing

You can specify detailed print settings as desired for the quality level, colors, and other criteria.

Advanced Settings
For printing results that appear just as expected for your original, you can specify which graphic elements and
colors to prioritize for printing.

Note
• Easy Settings are also available, providing convenient presets. To use the presets, simply choose
the printing application.
For details on Easy Settings, refer to the following topics.

• Printing Photos and Images (→P.152)
• Printing Line Drawings and Text (→P.160)
• Printing Ofce Documents (→P.171)

Print Priority
Choose the graphic elements that you want to emphasize for printing.
Print Priority (*1) Description

Image A setting for posters or other documents made up mainly of photos or images, or for
emphasizing photos or images in printed documents.

Line Drawing/Text Choose this setting for CAD drawings made up mainly of intricate lines, or wall
newspapers and other notices with a large amount of text. Suitable for emphasizing
detailed text in printed documents.
However, the quality may not be sufcient when printing photos or images that require
a lot of color coverage. In this case, choose “Image” instead.

Ofce Document Choose this setting for better legibility of documents combining text and graphics,
such as documents and presentation material created with typical ofce applications.

*1: Options suitable for the selected type of paper are listed under Print Priority.

Print Quality
Choose the print quality.
The printing mode is determined by a combination of the print quality and resolution.

Print Quality (*1) Description Print Priority

Highest A setting for printing at the highest resolution when quality
is most important. Printing takes longer and consumes
more ink than in other modes, but this mode offers
superior printing quality.

Image

High Choose this setting to print at high resolution when quality
is most important.
Printing takes longer and consumes more ink than
in “Standard” or “Draft” modes, but this mode offers
exceptional printing quality.

Image
Line Drawing/Text
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Print Quality (*1) Description Print Priority

Standard Choose this setting to print at standard resolution when
quality and speed are both important.
Printing takes less time than in “Highest” or “High” mode.

Image
Line Drawing/Text
Ofce Document

Draft Choose this setting to print faster.
Printing in draft mode can help you work more efciently
when checking layouts.

Image
Line Drawing/Text

*1: Options suitable for the selected Print Priority are listed under Print Quality.

Color Settings
Setting Item Options Description

Color Mode (*1) Color
Monochrome
Color (CAD)
Monochrome (BK ink)
Monochrome Bitmap

Choose whether to print in color or
monochrome.
(→P.177)

Color Adjustment Cyan
Magenta
Yellow
Gray Tone
Brightness
Contrast
Saturation

You can adjust the levels of cyan,
magenta, and yellow as well as the
brightness, contrast, saturation, and gray
tones.
If you choose Monochrome or
Monochrome (BK ink) in Color Mode
only Brightness and Contrast can be
adjusted.
Image, Graphics, and Text are available
as Object Adjustment options. (In
Windows and Mac OS X 10.5 only.)

Color-Matching Modes Driver Matching Mode
ICC Matching Mode
Driver ICM Mode
Host ICM Mode
ColorSync (Mac OS
10.3.9-10.4)
Off (Windows)
No Correction (Max OS X)

Choose the color-matching mode. Other
color-matching modes may be provided
by the computer operating system, such
as ICM and ColorSync.

Color-Matching Method (*2) Auto
Perceptual
Colorimetric
Colorimetric (No Wht-pnt
Corr) (Max OS X)
Saturation
other

Choose the color-matching method. The
available options vary depending on your
selection in “Color-Matching Mode”.

*1: Options suitable for the selected Print Priority are listed under Color Mode.
*2: The order of options displayed varies depending on the operating system.
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Enhancing printing quality
Setting Item Description

Unidirectional Printing Choosing unidirectional printing can improve printing results if lines are
printed crooked or images are uneven. However, this takes more time
than regular printing.

Thicken Fine Lines
(Windows)
Thicken Fine Lines (Mac OS
X)

Choose this option to make ne lines clearer in CAD drawings or similar
documents.

Sharpen Text Choose this option to print intricate text more distinctly.

Reduce Print Unevenness
(*1)

Choose this option to counteract uneven printing.

Economy Printing When this mode is selected, less ink is consumed than in regular printing,
but the quality is diminished.
Select this mode if you want to conserve ink when checking drawings, for
example. Depending on the Media Type and Print Quality settings, this
mode may not be available.

*1: Displayed in Mac OS X.

Note
• To print at a higher level of quality, in the printer driver, choose High or Highest in Print Quality, and
choose Unidirectional Printing as the direction of printing.

For instructions on specifying the print quality and color settings before printing, refer to the following topics,
as appropriate for your computer and operating system.

• Choosing the Document Type and Printing Conditions (Windows) (→P.190)
• Choosing the Document Type and Printing Conditions (Mac OS X) (→P.192)
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Choosing the Document Type and Printing Conditions
(Windows)

You can specify your own print settings instead of using the Print Target presets. As an example, this topic
describes how to print CAD drawings as clearly as possible, with sharp lines and text.

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded.
5. Click D Advanced Settings to switch the print mode.

6. Click Line Drawing/Text in the E Print Priority list.
7. Click High (1200dpi) in the F Print Quality list.

Note
• Options displayed in the F Print Quality list vary depending on the paper type.
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8. Click Color (CAD) in the G Color Mode list.
9. To adjust the color, click H Color Settings.

Note
• For instructions on adjusting color,see “Adjusting the Color in the Printer Driver”. (→P.177)

10. Select the K Sharpen Text check box.
11. Click the Page Setup tab to display the Page Setup sheet.

12. Conrm the settings of A Page Size, L Paper Source, and so on.
13. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings,see “Conrming Print Settings (Windows)”. (→P.340)
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Choosing the Document Type and Printing Conditions
(Mac OS X)

You can specify your own print settings instead of using the Print Target presets. As an example, this topic
describes how to print CAD drawings as clearly as possible, with sharp lines and text.

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. Choose the original size in the F Paper Size list.
4. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded.
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7. Click D Advanced Settings to switch the print mode.

8. Click Line Drawing in the E Print Priority list.
9. Click High(1200dpi) in the F Print Quality list.

Note
• Options displayed in the F Print Quality list vary depending on the type of paper.

10. Click Color (CAD) in the H Color Mode list.
11. To adjust the color, click I Set.

Note
• For instructions on adjusting color, see “Adjusting the Color in the Printer Driver”. (→P.177)

12. Access the Page Setup pane.

13. Conrm the settings of A Paper Source and C Page Size.
14. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Choosing Paper for Printing

Choosing a Paper for Printing
Choosing the right paper for your particular printing application will give you the best printing results.

Media Type
The printer and printer driver offer print settings optimized for various paper characteristics.

Note
• For information on the types of paper the printer supports, refer to the Paper Reference Guide. (→P.95)
• The types of paper indicated in the printer driver and related software (as well as on the Control
Panel) are updated when you install the Media Conguration Tool from the User Software CD-ROM
or if you change paper information by using the Media Conguration Tool. For information about the
Media Conguration Tool, see the Media Conguration Tool (Windows) or Media Conguration Tool
(Macintosh).

• An error message may be displayed on the printer Control Panel if the type of paper as specied in
the printer driver does not match the type specied on the printer. Although you can print under these
conditions, the printing results may not be suitable.

If the paper type is not listed for selection
If the type of paper loaded is not listed among the options for selection, try printing on Special 1, Special 2,
and so on. Note that higher numbers in this setting enable more vivid colors but may also cause colors to
run together.
For instructions on specifying the paper type before printing, refer to the following topics.

• Changing the Type of Paper (→P.195)
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Changing the Type of Paper
Follow these steps to change the type of paper specied on the printer after you have loaded paper.
If you will continue using this type of paper later, selecting Keep Paper Type > On will save the time and effort of
conguring the media type setting when you load the paper again. The current media type settings before you
select On will be automatically selected at that time. (→P.111)

Important
• For best printing results, the printer ne-tunes the feed amount for each type of paper. Be sure to select
the type of paper to use correctly before printing.

• Because the printer ne-tunes the feed amount for each type of paper, the margins and the size of
printed images may vary depending on the type of paper used. If margins and the size of images are not
as you expected, adjust the paper feed amount.
(→P.612)

Changing the Type of Paper

Note
• After you load a roll, the printer automatically shows a menu for selection of the type of paper on the
Display Screen. Select the type of paper and press the OK button.
If no barcode has been printed on the roll and you have set ManageRemainRoll to On, specify the roll
length after the type of paper. (→P.112)

1. On the Tab Selection screen of the Control Panel, press◄ or► to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Chg. Paper Type, and then press the OK button.
4. Press ▲ or ▼ to select the type of paper loaded (Roll Paper or Cut Sheet), and then press

the OK button.
5. Press▲ or▼ to select the type of paper loaded in the printer, and then press the OK button.

Note
• For details on types of paper, see the Paper Reference Guide. (→P.95) By default, Plain Paper
is selected.

• If you move the Release Lever, the setting automatically reverts to the previously selected paper.
• Be sure to select the correct paper type. If this setting does not match the loaded paper, it may
cause feed errors and affect printing quality.
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Using the Same Type of Paper Regularly
Congure this setting so that current media type settings will be automatically selected when you load the
same type of paper later.

1. On the Tab Selection screen of the Control Panel, press◄ or► to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Keep Paper Type, and then press the OK button.
4. Press ▲ or ▼ to select On, and then press the OK button.

Note
• The specied media type setting is updated in the following situations.

• When using sheets, if you send a print job before loading a sheet, the media type setting is
updated to match the type of paper specied by the print job.

• When you have selected ManageRemainRoll > On on the Control Panel and a barcode is printed
on the roll, the media type setting is updated to match the type of paper specied by the barcode.

• To change the media type setting, see “Changing the Type of Paper”. (→P.195)
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Specifying Paper in the Printer Driver
If you replace the paper, complete the printer driver settings for the paper type and size.

For instructions on conguring paper settings in the printer driver, refer to the following topics, as appropriate
for your computer and operating system.

• Specifying Paper in the Printer Driver (Windows) (→P.197)
• Specifying Paper in the Printer Driver (Mac OS X) (→P.199)

Specifying Paper in the Printer Driver (Windows)
If you have replaced the paper, you must complete the following settings in the printer driver.

Important
• Always specify the same type and size of paper in the printer menu and printer driver.
If the type and size do not match, an error message will be displayed and printing is not possible.

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded.

Note
• Click the B Get Information button to display the Paper Information on Printer dialog box. On the
Paper Information on Printer dialog box, you can obtain information on the paper in the printer and
congure printer driver settings for the feed source and type of paper.

Enhanced Printing Options 197



Choosing Paper for Printing

5. Click the Page Setup tab to display the Page Setup sheet.

6. In the A Page Size list, select the size of the original as specied in the application.
7. In the L Paper Source list, select how paper is supplied.
8. If you have selected Roll Paper in L Paper Source, select the width of the loaded roll inM Roll

Paper Width.

Note
• A variety of settings are available in the printer driver to suit different printing applications.
For details on available printing conditions, see “Printer Driver Settings (Windows)”. (→P.336)
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Specifying Paper in the Printer Driver (Mac OS X)
If you have replaced the paper, you must complete the following settings in the printer driver.

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. Choose the original size in the F Paper Size list.
4. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded.
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7. Access the Page Setup pane.

8. In the A Paper Source list, select how paper is supplied.
9. If you have selected Manual in A Paper Source, make sure the size as selected in Page Setup

is displayed in C Page Size. If you have selected Roll Paper in A Paper Source, make sure
the width of the loaded roll is displayed in B Roll Width.

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Information
on the Main pane to update the printer information.

Note
• A variety of settings are available in the printer driver to suit different printing applications.
For details on available printing conditions, see “Printer Driver Settings (Mac OS X)”. (→P.454)
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Printing enlargements or reductions

Resizing Originals to Match the Paper Size
You can freely adjust the size of originals by enlarging or reducing them as desired.

Enlarged/Reduced Printing
Enlarge or reduce the original in the printer driver, as desired.

Fit Paper Size
Enlarge or reduce the original to match the size of the paper you are using.

For instructions on resizing originals to match the paper size, refer to the following topics, as appropriate for
your computer and operating system.

• Resizing Originals to Match the Paper Size (Windows) (→P.202)
• Resizing Originals to Match the Paper Size (Mac OS X) (→P.204)

Note
• For better printing results when enlarging photos from a digital camera in TIFF or JPEG format, use
an image-editing application software such as Adobe Photoshop to specify an image resolution of
150 dpi or more at actual size.
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Resizing Originals to Match the Paper Size (Windows)
This topic describes how to enlarge originals before printing to match the paper size, based on the following
example.

• Document: Any Type
• Page size: A4 (210.0×297.0mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then open the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. Select the printing application in the E Print Target list.
6. Click the Page Setup tab to display the Page Setup sheet.
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7. Click Roll Paper in the L Paper Source list.
8. Select the width of the loaded roll in theM Roll Paper Width list-in this case, ISO A2/A3 Roll

(420.0mm).
9. In the A Page Size list, click the size of the original as specied in the application. In this

case, click ISO A4.
10. Select the C Enlarged/Reduced Printing check box.
11. Select the D Fit Paper Size check box.
12. Click ISO A3 in the G Paper Size list.
13. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings,see “Conrming Print Settings (Windows)”. (→P.340)
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Resizing Originals to Match the Paper Size (Mac OS X)
This topic describes how to enlarge originals before printing to match the paper size, based on the following
example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.
4. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
7. Make your selection in the E Print Target list.
8. Make your selection in the F Print Quality list.
9. Access the Page Setup pane.

10. Click Roll Paper in the A Paper Source list.
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11. Make sure the width of the loaded roll is displayed in the B Roll Width list-in this case, ISO
A2/A3 (420.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Information
on the Main pane to update the printer information.

12. Make sure C Page Size on the Page Setup pane shows the original size as specied in C
Paper Size in the Page Attributes dialog box-in this case, ISO A4.

13. Select the D Enlarged/Reduced Printing check box.
14. Make sure E Fit Paper Size is selected.
15. Click ISO A3 in the I Paper Size list.
16. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Resizing Originals to Fit the Roll Width
You can freely adjust the size of originals by enlarging or reducing them as desired.

Enlarged/Reduced Printing
Enlarge or reduce the original in the printer driver, as desired.

Fit Roll Paper Width
Enlarge or reduce the original as a whole to match the roll paper width, as desired.

For instructions on resizing originals to match the roll paper width, refer to the following topics, as appropriate
for your computer and operating system.

• Resizing Originals to Fit the Roll Width (Windows) (→P.208)
• Resizing Originals to Fit the Roll Width (Mac OS X) (→P.210)

Note
• For better printing results when enlarging photos from a digital camera in TIFF or JPEG format, use
an image-editing application software such as Adobe Photoshop to specify an image resolution of
150 dpi or more at actual size.
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Resizing Originals to Fit the Roll Width (Windows)
This topic describes how to enlarge originals before printing to match the roll width, based on the following example.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: 16 inches (406.4 mm)

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. Select the printing application in the E Print Target list.
6. Click the Page Setup tab to display the Page Setup sheet.

7. Click Roll Paper in the L Paper Source list.
8. In the A Page Size list, click the size of the original as specied in the application. In this case,

click ISO A4 or Letter (8.5"x11").
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9. Select the C Enlarged/Reduced Printing check box.

Note
• If the C Enlarged/Reduced Printing check box is not displayed on the Page Setup sheet, clear the
B Borderless Printing check box.

10. Click E Fit Roll Paper Width.

Note
• After you click E Fit Roll Paper Width, the Information dialog box is displayed. Select the width of
the loaded roll in the Roll Paper Width list and click OK.

• Make sure the roll paper width you specify matches the width of the loaded roll.

11. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings,see “Conrming Print Settings (Windows)”. (→P.340)
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Resizing Originals to Fit the Roll Width (Mac OS X)
This topic describes how to enlarge originals before printing to match the roll width, based on the following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: 16 inches (406.4 mm)

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.
4. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
7. Make your selection in the E Print Target list.
8. Make your selection in the F Print Quality list.
9. Access the Page Setup pane.

10. Click Roll Paper in the A Paper Source list.
11. Make sure the width of the loaded roll is displayed in the B Roll Width list-in this case, 16

in. (406.4mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Information
on the Main pane to update the printer information.
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12. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the
Page Attributes dialog box-in this case, ISO A4.

13. Select the D Enlarged/Reduced Printing check box.
14. Click F Fit Roll Paper Width.
15. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Resizing Originals by Entering a Scaling Value
You can freely adjust the size of originals by enlarging or reducing them as desired.

Enlarged/Reduced Printing
Enlarge or reduce the original in the printer driver, as desired.

Scaling
Enlarge or reduce originals by a particular amount, as desired.

For instructions on entering a scaling value to resize originals, refer to the following topics, as appropriate for
your computer and operating system.

• Resizing Originals by Entering a Scaling Value (Windows) (→P.214)
• Resizing Originals by Entering a Scaling Value (Mac OS X) (→P.216)

Note
• For better printing results when enlarging photos from a digital camera in TIFF or JPEG format, use
an image-editing application software such as Adobe Photoshop to specify an image resolution of
150 dpi or more at actual size.
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Resizing Originals by Entering a Scaling Value (Windows)
This topic describes how to enlarge originals before printing by entering a scaling value, based on the following
example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

Important
• In borderless printing, you cannot resize originals by entering a scaling value.

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. Select the printing application in the E Print Target list.
6. Click the Page Setup tab to display the Page Setup sheet.
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7. Click Roll Paper in the L Paper Source list.
8. Select the width of the loaded roll in theM Roll Paper Width list-in this case, ISO A2/A3 Roll

(420.0mm).
9. In the A Page Size list, click the size of the original as specied in the application. In this

case, click ISO A4.
10. Select the C Enlarged/Reduced Printing check box.
11. Click ISO A4 in the G Paper Size list.
12. Click F Scaling and enter “120”.

Note
• You can specify enlargement that exceeds the paper size, but in this case, the portions off the bottom
and right edges of the paper will not be printed.

• If the original size after enlargement or reduction is smaller than the paper size, the original is
printed in the upper-left corner. In this case, you can center originals by selecting E Print Centered
on the Layout sheet.

13. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Windows)”. (→P.340)
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Resizing Originals by Entering a Scaling Value (Mac OS
X)

This topic describes how to enlarge originals before printing by entering a scaling value, based on the following
example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.
4. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
7. Make your selection in the E Print Target list.
8. Make your selection in the F Print Quality list.
9. Access the Page Setup pane.

10. Click Roll Paper in the A Paper Source list.
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11. Make sure the width of the loaded roll is displayed in the B Roll Width list-in this case, ISO
A2/A3 (420.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Information
on the Main pane to update the printer information.

12. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the
Page Attributes dialog box-in this case, ISO A4.

13. Select the D Enlarged/Reduced Printing check box.
14. Click G Scaling and enter “120”.

Note
• You can specify enlargement that exceeds the paper size, but in this case, the portion off the edge of
the paper will not be printed.

• If the original size after enlargement or reduction is smaller than the paper size, the original is printed
in the upper-left corner. In this case, you can center originals by selecting the J Print Centered
check box.

15. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Printing at full size

Printing on Oversized Paper
Except in borderless printing, the actual printing area corresponds to your selected paper size minus the space for
a margin. (→P.75) To print documents or images you prepare without a margin at actual size, use an oversized
paper size.

For example, to print a A4-sized original without a margin at A4 size, print it on paper larger than A4 size and
cut away the excess margin.

Note
• If you prepare an original for printing without a margin and print it on paper of regular size, the image
near the edge will not be printed.

Oversize
The margin required by the printer is added around the “outside” of a regular paper size. For example, when
printing a A4-sized original (210×297 mm), you have the following options.

• (a) Regular paper size: Gray area not printed
• (b) Page Size
• (c) Oversized paper size: Print area matches the page size (b)

Important
• When printing on oversize paper, load paper larger than the page size-a size that includes the margin
required by the printer.

• Sheets: Load paper that is at least 6 mm (0.24 in) wider and 26 mm (1 in) higher than the page size
• Rolls: Load paper that is at least 6 mm (0.24 in) wider and 6 mm (0.24 in) higher than the page size

Note
• Paper larger than the maximum size supported by the printer cannot be used as paper for oversized
printing. (→P.100)

• Oversized printing (selecting Oversize in Page Size) is only available in Windows. For oversized
printing on sheets, choose Manual as Paper Source.

• To perform oversized printing on a Macintosh computer, you must specify a non-standard page size and
print on it.

• To specify a non-standard paper size in oversized printing, register the paper size as a Custom Paper
Size. Oversized printing is not available with “Custom Size”. (→P.261)
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For instructions on oversized printing, refer to the following topics, as appropriate for your computer and
operating system.

• Printing at Full Size (Windows) (→P.220)
• Printing at Full Size (Mac OS X) (→P.222)

Printing at Full Size (Windows)
This topic describes how to print at full size based on the following example. (Oversized Printing)

• Document: Any Type
• Page Size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. Click the Page Setup tab to display the Page Setup sheet.
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6. Click O Size Options to display the Paper Size Options dialog box.
7. In the Paper Size Options dialog box, select the Oversize check box in Display Series.
8. Click OK to close the Paper Size Options dialog box.
9. Click Oversize - ISO A4 in the A Page Size list.
10. Click Roll Paper in the L Paper Source list.
11. Select the width of the loaded roll in theM Roll Paper Width list-in this case, ISO A2/A3 Roll

(420.0mm).
12. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings,see “Conrming Print Settings (Windows)”. (→P.340)
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Printing at Full Size (Mac OS X)
This topic describes how to print at full size based on the following example. (Oversized Printing)

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. In F Paper Size, click the size of the original. In this case, click ISO A4 - Oversize.
4. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
7. Make your selection in the E Print Target list.
8. Make your selection in the F Print Quality list.
9. Access the Page Setup pane.

10. Click Roll Paper in the A Paper Source list.
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11. Make sure the width of the loaded roll is displayed in the B Roll Width list-in this case, ISO
A2/A3 (420.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Information
on the Main pane to update the printer information.

12. Make sure C Page Size shows the original size as specied in C Paper Size in the Page
Attributes dialog box-in this case, ISO A4 - Oversize.

13. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Borderless Printing at Actual Size
Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images)
without a surrounding margin, or border.

Borderless Printing
In regular printing, a margin required by the printer is added around the original. With borderless printing, you
can print documents without the margin, so that the printed image covers the entire surface of the paper.

Important
• Borderless printing is only available with rolls.
• Paper you can use for borderless printing is restricted to particular types of paper and rolls of particular
widths. For information on types of paper compatible with borderless printing, refer to the Paper
Reference Guide. (→P.95)

• Paper incompatible with the printer’s auto cut function can be printed without borders on the left and
right sides only.

• These features cannot be used in combination with borderless printing: special page layouts, centering
originals, and printing cut lines on rolls.

• You cannot have pages rotated 90 degrees to conserve paper if you have set up borderless printing at
actual size or in combination with resizing originals to match the paper size.

• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be
uneven at the edges. If you require higher image quality, specify No in Auto Cut in the printer driver. In
this case, the paper can be printed without borders on the left and right sides only. After ejecting and
cutting the printed document, use scissors to cut away the top and bottom edges.

• By factory default, the ink drying time is disabled for all paper. When you are using paper that takes
longer for ink to adhere for borderless printing and the Cutter Unit touches printing surfaces that are not
dry yet, it may damage the paper or the edge of the document that is cut, depending on frequency of
use. In this case, follow these steps to change the ink drying time.

• On the Main sheet of the printer driver, click Settings in Media Type.
• Select the ink drying time in the Between Pages list of Drying Time.

Borderless Printing Method
Choose the method of borderless printing that suits the original, as desired.
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Print Image with Actual Size
Prints originals at actual size, without enlarging or reducing them. Originals must be prepared in a size that
exceeds the dimensions of the paper by 3 mm (0.12 in) on each side.

Note
• Not all page sizes are available.
• Even if you prepare originals of the same size as the paper size, the originals are automatically enlarged
when you print borderlessly in combination with resizing originals to match the paper size. This may
affect image quality. When image quality is most important, make the original 3 mm longer on each side
than the paper size so that the image can be printed at actual size in borderless printing.

For instructions on borderless printing of photos and images at actual size, refer to the following topics, as
appropriate for your computer and operating system.

• Borderless Printing at Actual Size (Windows) (→P.227)
• Borderless Printing at Actual Size (Mac OS X) (→P.229)
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Borderless Printing at Actual Size (Windows)
This topic describes how to print borderlessly at actual size based on the following example.

• Document: Any type
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1. Create the original in the source application 3 mm (0.12 in) larger on each side than 254.0×304.8
mm (10 × 12 in) -that is, 260.0×310.8 mm (10.2 × 12.2 in)

Note
• If you can specify the margin, as in Microsoft Word, set the margin at 0 mm. For instructions on
specifying the margin, refer to the software documentation.

• The extra 3 mm (0.12 in) on each side will not be printed. Create the original so that it ts inside the
paper area to be printed on.

2. Choose Print in the application menu.
3. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
4. Make sure the Main sheet is displayed.

5. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight
Coated Paper.

6. Select the print target in the E Print Target list.
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7. Click the Page Setup tab to display the Page Setup sheet.

8. In the A Page Size list, click the size of the original as specied in the source application.
In this case, click 10"x12".

9. Click Roll Paper in the L Paper Source list.
10. Select the B Borderless Printing check box to display the Information dialog box.

11. Select the width of the loaded roll in the Roll Paper Width list-in this case, click 10-in. Roll
(254.0mm).

12. Click OK to close the Information dialog box.
13. In C Borderless Printing Method, click F Print Image with Actual Size.
14. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings,see “Conrming Print Settings (Windows)”. (→P.340)
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Borderless Printing at Actual Size (Mac OS X)
This topic describes how to print borderlessly at actual size based on the following example.

• Document: Any Type
• Page size: 10 × 12 inches (254.0×304.8 mm)-Borderless
• Paper: Roll paper
• Paper type: Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. In the F Paper Size list, choose a paper size supported for borderless printing. Here, click

10"x12" - Borderless.

Note
• Paper sizes supported for borderless printing are indicated by “-Borderless”.

4. If you congured the settings using the Page Attributes dialog box, click F OK to close the
dialog box, and then select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight
Coated Paper.

7. Make your selection in the E Print Target list.
8. Make your selection in the F Print Quality list.
9. Access the Page Setup pane.

10. Click Roll Paper in the A Paper Source list.
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11. Conrm that the roll paper width matches the paper size.
Make sure the width of the loaded roll is displayed in the B Roll Width list-in this case, 10
in. (254.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Information
on the Main pane to update the printer information.

12. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the
Page Attributes dialog box-in this case, 10"x12" - Borderless.

13. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Borderless Printing

Borderless Printing on Paper of Equivalent Size
Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images)
without a surrounding margin, or border.

Borderless Printing
In regular printing, a margin required by the printer is added around the original. With borderless printing, you
can print documents without the margin, so that the printed image covers the entire surface of the paper.

Important
• Borderless printing is only available with rolls.
• Paper you can use for borderless printing is restricted to particular types of paper and rolls of particular
widths. For information on types of paper compatible with borderless printing, refer to the Paper
Reference Guide. (→P.95)

• Paper incompatible with the printer’s auto cut function can be printed without borders on the left and
right sides only.

• These features cannot be used in combination with borderless printing: special page layouts, centering
originals, and printing cut lines on rolls.

• You cannot have pages rotated 90 degrees to conserve paper if you have set up borderless printing at
actual size or in combination with resizing originals to match the paper size.

• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be
uneven at the edges. If you require higher image quality, specify No in Auto Cut in the printer driver. In
this case, the paper can be printed without borders on the left and right sides only. After ejecting and
cutting the printed document, use scissors to cut away the top and bottom edges.

• By factory default, the ink drying time is disabled for all paper. When you are using paper that takes
longer for ink to adhere for borderless printing and the Cutter Unit touches printing surfaces that are not
dry yet, it may damage the paper or the edge of the document that is cut, depending on frequency of
use. In this case, follow these steps to change the ink drying time.

• On the Main sheet of the printer driver, click Settings in Media Type.
• Select the ink drying time in the Between Pages list of Drying Time.

Borderless Printing Method
Choose the method of borderless printing that suits the original, as desired.
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Fit Paper Size
Enlarge or reduce the original to match the size of the paper you are using.

Note
• The printer driver automatically enlarges originals 3 mm (0.12 in) past the dimensions of the paper on
each side. The 3 mm portion beyond the edge on each side is not printed.

For instructions on borderless printing of photos, images, and other documents to match the paper size, refer
to the following topics, as appropriate for your computer and operating system.

• Borderless Printing by Resizing Originals to Match the Paper Size (Windows) (→P.234)
• Borderless Printing by Resizing Originals to Match the Paper Size (Mac OS X) (→P.236)
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Borderless Printing by Resizing Originals to Match the
Paper Size (Windows)

This topic describes how to enlarge originals before borderless printing to match the paper size, based on the
following example.

• Document: Any type
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1. In the application, create an original that takes up the entire space of the paper size.

Note
• If you can specify the margin, as in Microsoft Word, set the margin at 0 mm. For instructions on
specifying the margin, refer to the software documentation.

2. Choose Print in the application menu.
3. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
4. Make sure the Main sheet is displayed.

5. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight
Coated Paper.

6. Select the print target in the E Print Target list.
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7. Click the Page Setup tab to display the Page Setup sheet.

8. In the A Page Size list, click the size of the original as specied in the application. In this case,
click 10"x12".

9. Click Roll Paper in the L Paper Source list.
10. Select the B Borderless Printing check box to display the Information dialog box.

11. Select the width of the loaded roll in the Roll Paper Width list-in this case, click 10-in. Roll
(254.0mm).

12. Click OK to close the Information dialog box.
13. In C Borderless Printing Method, click D Fit Paper Size.
14. Click Match Page Size in the G Paper Size list.
15. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings,see “Conrming Print Settings (Windows)”. (→P.340)
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Borderless Printing by Resizing Originals to Match the
Paper Size (Mac OS X)

This topic describes how to enlarge originals before borderless printing to match the paper size, based on the
following example.

• Document: Any Type
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll paper
• Paper type: Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. In the F Paper Size list, click the size of the original. In this case, click 10"x12".

Note
• All sizes are available in borderless printing if you resize originals to match the paper size.

4. If you congured the settings using the Page Attributes dialog box, click F OK to close the
dialog box, and then select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight
Coated Paper.

7. Make your selection in the E Print Target list.
8. Make your selection in the F Print Quality list.
9. Access the Page Setup pane.

10. Click Roll Paper in the A Paper Source list.
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11. Make sure the width of the loaded roll is displayed in the B Roll Width list-in this case, 10
in. (254.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Information
on the Main pane to update the printer information.

12. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the
Page Attributes dialog box-in this case, 10"x12".

13. On the Page Setup pane, select the D Enlarged/Reduced Printing check box.
14. Select the H Borderless Printing check box.
15. Click E Fit Paper Size under D Enlarged/Reduced Printing.
16. In I Paper Size, click the paper size. In this case, click 10"x12" - Borderless.
17. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Borderless Printing by Resizing Originals to Fit the Roll
Width

Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images)
without a surrounding margin, or border.

Borderless Printing
In regular printing, a margin required by the printer is added around the original. With borderless printing, you
can print documents without the margin, so that the printed image covers the entire surface of the paper.

Important
• Borderless printing is only available with rolls.
• Paper you can use for borderless printing is restricted to particular types of paper and rolls of particular
widths. For information on types of paper compatible with borderless printing, refer to the Paper
Reference Guide. (→P.95)

• Paper incompatible with the printer’s auto cut function can be printed without borders on the left and
right sides only.

• These features cannot be used in combination with borderless printing: special page layouts, centering
originals, and printing cut lines on rolls.

• You cannot have pages rotated 90 degrees to conserve paper if you have set up borderless printing at
actual size or in combination with resizing originals to match the paper size.

• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be
uneven at the edges. If you require higher image quality, specify No in Auto Cut in the printer driver. In
this case, the paper can be printed without borders on the left and right sides only. After ejecting and
cutting the printed document, use scissors to cut away the top and bottom edges.

• By factory default, the ink drying time is disabled for all paper. When you are using paper that takes
longer for ink to adhere for borderless printing and the Cutter Unit touches printing surfaces that are not
dry yet, it may damage the paper or the edge of the document that is cut, depending on frequency of
use. In this case, follow these steps to change the ink drying time.

• On the Main sheet of the printer driver, click Settings in Media Type.
• Select the ink drying time in the Between Pages list of Drying Time.

Borderless Printing Method
Choose the method of borderless printing that suits the original, as desired.
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Scale to t Roll Paper Width
Enlarge or reduce the original as a whole to match the roll paper width.

Note
• You can combine this function with rotating pages 90 degrees before printing so that the original width
(relative to portrait orientation) matches the roll paper width in borderless printing.

For instructions on borderless printing of photos, images, and other documents to match the roll paper width,
refer to the following topics, as appropriate for your computer and operating system.

• Borderless Printing by Resizing Originals to Fit the Roll Width (Windows) (→P.241)
• Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS X) (→P.243)
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Borderless Printing by Resizing Originals to Fit the Roll
Width (Windows)

This topic describes how to enlarge originals before borderless printing to match the roll width, based on the
following example.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1. In the application, create an original that takes up the entire space of the paper size.

Note
• If you can specify the margin, as in Microsoft Word, set the margin at 0 mm. For instructions on
specifying the margin, refer to the software documentation.

2. Choose Print in the application menu.
3. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
4. Make sure the Main sheet is displayed.

5. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight
Coated Paper.

6. Select the print target in the E Print Target list.
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7. Click the Page Setup tab to display the Page Setup sheet.

8. In the A Page Size list, click the size of the original as specied in the application. In this case,
click ISO A4 or Letter (8.5"x11").

9. Click Roll Paper in the L Paper Source list.
10. Select the B Borderless Printing check box to display the Information dialog box.

11. Select the width of the loaded roll in the Roll Paper Width list-in this case, click 10-in. Roll
(254.0mm).

12. Click OK to close the Information dialog box.
13. In C Borderless Printing Method, make sure E Scale to t Roll Paper Width is selected.
14. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings,see “Conrming Print Settings (Windows)”. (→P.340)
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Borderless Printing by Resizing Originals to Fit the Roll
Width (Mac OS X)

This topic describes how to enlarge originals before borderless printing to match the roll width, based on the
following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.

Note
• All sizes are available in borderless printing if you resize originals to t the roll width.

4. If you congured the settings using the Page Attributes dialog box, click F OK to close the
dialog box, and then select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight
Coated Paper.

7. Make your selection in the E Print Target list.
8. Make your selection in the F Print Quality list.
9. Access the Page Setup pane.

10. Click Roll Paper in the A Paper Source list.
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11. Make sure the width of the loaded roll is displayed in the B Roll Width list-in this case, 10
in. (254.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Information
on the Main pane to update the printer information.

12. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the
Page Attributes dialog box-in this case, ISO A4.

13. Select the D Enlarged/Reduced Printing check box.
14. Select the H Borderless Printing check box.

This ensures that F Fit Roll Paper Width is automatically selected in D Enlarged/Reduced
Printing.

15. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Borderless Printing at Actual Size
Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images)
without a surrounding margin, or border.

Borderless Printing
In regular printing, a margin required by the printer is added around the original. With borderless printing, you
can print documents without the margin, so that the printed image covers the entire surface of the paper.

Important
• Borderless printing is only available with rolls.
• Paper you can use for borderless printing is restricted to particular types of paper and rolls of particular
widths. For information on types of paper compatible with borderless printing, refer to the Paper
Reference Guide. (→P.95)

• Paper incompatible with the printer’s auto cut function can be printed without borders on the left and
right sides only.

• These features cannot be used in combination with borderless printing: special page layouts, centering
originals, and printing cut lines on rolls.

• You cannot have pages rotated 90 degrees to conserve paper if you have set up borderless printing at
actual size or in combination with resizing originals to match the paper size.

• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be
uneven at the edges. If you require higher image quality, specify No in Auto Cut in the printer driver. In
this case, the paper can be printed without borders on the left and right sides only. After ejecting and
cutting the printed document, use scissors to cut away the top and bottom edges.

• By factory default, the ink drying time is disabled for all paper. When you are using paper that takes
longer for ink to adhere for borderless printing and the Cutter Unit touches printing surfaces that are not
dry yet, it may damage the paper or the edge of the document that is cut, depending on frequency of
use. In this case, follow these steps to change the ink drying time.

• On the Main sheet of the printer driver, click Settings in Media Type.
• Select the ink drying time in the Between Pages list of Drying Time.

Borderless Printing Method
Choose the method of borderless printing that suits the original, as desired.
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Print Image with Actual Size
Prints originals at actual size, without enlarging or reducing them. Originals must be prepared in a size that
exceeds the dimensions of the paper by 3 mm (0.12 in) on each side.

Note
• Not all page sizes are available.
• Even if you prepare originals of the same size as the paper size, the originals are automatically enlarged
when you print borderlessly in combination with resizing originals to match the paper size. This may
affect image quality. When image quality is most important, make the original 3 mm longer on each side
than the paper size so that the image can be printed at actual size in borderless printing.

For instructions on borderless printing of photos and images at actual size, refer to the following topics, as
appropriate for your computer and operating system.

• Borderless Printing at Actual Size (Windows) (→P.248)
• Borderless Printing at Actual Size (Mac OS X) (→P.250)
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Borderless Printing at Actual Size (Windows)
This topic describes how to print borderlessly at actual size based on the following example.

• Document: Any type
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1. Create the original in the source application 3 mm (0.12 in) larger on each side than 254.0×304.8
mm (10 × 12 in) -that is, 260.0×310.8 mm (10.2 × 12.2 in)

Note
• If you can specify the margin, as in Microsoft Word, set the margin at 0 mm. For instructions on
specifying the margin, refer to the software documentation.

• The extra 3 mm (0.12 in) on each side will not be printed. Create the original so that it ts inside the
paper area to be printed on.

2. Choose Print in the application menu.
3. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
4. Make sure the Main sheet is displayed.

5. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight
Coated Paper.

6. Select the print target in the E Print Target list.
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7. Click the Page Setup tab to display the Page Setup sheet.

8. In the A Page Size list, click the size of the original as specied in the source application.
In this case, click 10"x12".

9. Click Roll Paper in the L Paper Source list.
10. Select the B Borderless Printing check box to display the Information dialog box.

11. Select the width of the loaded roll in the Roll Paper Width list-in this case, click 10-in. Roll
(254.0mm).

12. Click OK to close the Information dialog box.
13. In C Borderless Printing Method, click F Print Image with Actual Size.
14. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings,see “Conrming Print Settings (Windows)”. (→P.340)
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Borderless Printing at Actual Size (Mac OS X)
This topic describes how to print borderlessly at actual size based on the following example.

• Document: Any Type
• Page size: 10 × 12 inches (254.0×304.8 mm)-Borderless
• Paper: Roll paper
• Paper type: Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. In the F Paper Size list, choose a paper size supported for borderless printing. Here, click

10"x12" - Borderless.

Note
• Paper sizes supported for borderless printing are indicated by “-Borderless”.

4. If you congured the settings using the Page Attributes dialog box, click F OK to close the
dialog box, and then select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Heavyweight
Coated Paper.

7. Make your selection in the E Print Target list.
8. Make your selection in the F Print Quality list.
9. Access the Page Setup pane.

10. Click Roll Paper in the A Paper Source list.
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11. Conrm that the roll paper width matches the paper size.
Make sure the width of the loaded roll is displayed in the B Roll Width list-in this case, 10
in. (254.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Information
on the Main pane to update the printer information.

12. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the
Page Attributes dialog box-in this case, 10"x12" - Borderless.

13. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)

252 Enhanced Printing Options



Printing banners or at other non-standard sizes

Printing banners or at other non-standard
sizes

Printing Vertical or Horizontal Banners (Large-Format
Printing)

You can create vertical or horizontal banners by printing originals that are in banner format on rolls.

Originals created in Microsoft Word or other applications in your preferred size can be enlarged to ll the width
of roll paper by completing simple printer driver settings.

Fit Roll Paper Width
You can easily create vertical or horizontal banners by automatically enlarging or reducing originals to t the
full width of rolls.

Note
• The maximum supported roll length is 18.0 m or 19.7 yd.

For instructions on printing vertical or horizontal banners, refer to the following topics, as appropriate for
your computer and operating system.

• Printing Vertical or Horizontal Banners (Large-Format Printing; Windows) (→P.254)
• Printing Vertical or Horizontal Banners (Large-Format Printing; Mac OS X) (→P.258)

Important
• Before printing, check how much of the roll paper is left. If you have activated automatic detection of the
remaining roll paper, a warning message is displayed when there is not enough roll paper left.

• If not much ink is left, prepare replacement ink tanks.
• To print at a higher level of quality, in the printer driver, choose High or Highest in Print Quality, and
choose Unidirectional Printing as the direction of printing.
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Printing Vertical or Horizontal Banners (Large-Format
Printing; Windows)

This topic describes how to print a banner about ve times as long as the roll width based on the following example.

• Document: A horizontal banner created in Microsoft Word
• Page size: Non-standard (100×500 mm [3.9×19.7 in])
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: 16 in (406.4 mm)

Follow the steps below to print a banner in either horizontal or vertical format.
1. Register a Custom Paper Size.

Banners tend to be in non-standard sizes, so register a Custom Paper Size. In this example, 100×500
mm (3.9×19.7 in) is registered.

2. In the application, create an original in the size you registered.
3. Print the banner, using the settings that correspond to banners.

Registering a Custom Paper Size
This example describes how to register a paper size that is horizontally elongated and suitable for banners in
either horizontal or vertical format.

1. Display the printer driver dialog box. (→P.348)
2. Click the Page Setup tab to display the Page Setup sheet.

3. Click Roll Paper in the L Paper Source list.
4. Click O Size Options to display the Paper Size Options dialog box.
5. Enter a desired paper name in Custom Paper Size Name. “My Horizontal Banner” is used

in this example.
6. In Units, click mm.
7. Under Paper Size, enter “100” in Width and “500” in Height.
8. Click Add to add the paper size of “My Horizontal Banner.”
9. Click OK to close the Paper Size Options dialog box.
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10. Close the printer driver dialog box.

Note
• You can also specify a Custom Size as the paper size. Note that Custom Size settings are not
available after you exit the application.
For more information,see “Printing on Non-Standard Paper Sizes (Windows)”. (→P.262)

Creating the banner in the application
Follow the steps below to create the banner in Microsoft Word using the Custom Paper Size you registered.

1. Start Microsoft Word.
2. Choose Page Setup from the File menu to display the Page Setup dialog box.
3. Under Paper Size, click the Custom Paper Size you registered-"My Horizontal Banner" in this

example.

Important
• If "My Horizontal Banner" is not listed, make sure this printer is selected as the printer to use.
• In applications such as Microsoft PowerPoint that do not enable you to choose registered paper
sizes, use the custom paper size setting in “Custom” and specify 100×500 mm (3.9×19.7 in)

4. Set the printing orientation to horizontal.
5. Create the banner.

Printing the banner
Follow these steps to print the banner using the corresponding banner settings.

1. Choose Print in the Microsoft Word menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. After conrming that D Easy Settings is selected, click Poster in the E Print Target list.
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6. Click the Page Setup tab to display the Page Setup sheet.

7. In the A Page Size list, click the size you registered, “My Horizontal Banner”.
8. Select the C Enlarged/Reduced Printing check box.

Note
• If the C Enlarged/Reduced Printing check box is not displayed on the Page Setup sheet, clear the
B Borderless Printing check box.

9. Click Roll Paper in the L Paper Source list.
10. After you click E Fit Roll Paper Width, the Information dialog box is displayed.
11. Select the width of the loaded roll in the Roll Paper Width list. In this case, click 16-in. Roll

(406.4mm), and then click OK.
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12. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Windows)”. (→P.340)

If printing is unsuccessful, you may be able to print after completing the following setting.

1. On the Layout sheet, click J Special Settings to display the Special Settings dialog box.

2. In the FineZoom Settings list, click Yes.
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Printing Vertical or Horizontal Banners (Large-Format
Printing; Mac OS X)

This topic describes how to print a banner about ve times as long as the roll width based on the following example.

• Document: An original designed for a horizontal banner
• Page Size: Non-standard (100×500 mm [3.9×19.7 in])
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: 16 inches (406.4 mm)

Follow the steps below to print a banner in either horizontal or vertical format.
1. In the application, create an original in the format of a horizontal or vertical banner.
2. Register a Custom Page Sizes

Banners tend to be in non-standard sizes, so register a Custom Page Sizes in Page Setup. In this
example, 100×500 mm (3.9×19.7 in) is registered.

3. Print the banner, using the settings that correspond to banners.

Note
• The following procedures are based on Mac OS X 10.4. The method of setting up non-standard paper
sizes varies depending on the version of Mac OS X.

Register a Custom Page Sizes
This example describes how to register and print using a page size that is horizontally elongated and suitable
for banners in either horizontal or vertical format.

1. Create the document in the application.
2. Choose Page Setup from the application menu to display the Page Attributes dialog box.

3. Select the printer in the B Format for list.
4. Click Manage Custom Sizes in the C Paper Size list to display the Custom Page Sizes

dialog box.
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5. Double-click Untitled in the list at left, and then enter a name for the page size you want
to register. Here, enter “100*500.”
If the Untitled size is not listed at left, click + below the list.

6. Under Page Size, enter “10” in Width and “50” in Height. Here, measurements are entered
in centimeters.

7. Specify the margins by entering “0.3” in Printer Margins. Here, too, measurements are entered
in centimeters.

8. Click OK to close the Custom Page Sizes dialog box.
9. In the C Paper Size list, click the size of the original. In this case, click "100*500", the size

you registered.
10. In D Orientation, click the icon of the document in landscape orientation.
11. Click F OK to close the dialog box.

Print the banner
Follow the steps below to print the banner using the corresponding banner settings.

1. Choose Print in the application menu.
2. Access the Main pane.

3. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
4. Make your selection in the E Print Target list.
5. Make your selection in the F Print Quality list.
6. Access the Page Setup pane.
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7. Click Roll Paper in the A Paper Source list.
8. Make sure the width of the loaded roll is displayed in the B Roll Width list-in this case, 16

in. (406.4mm).

Note
• If the width of the loaded roll is not displayed in B Roll Width, click L Printer Information on the
Main pane and update the printer information.

9. In C Page Size, make sure "100*500" is displayed, as registered in Page Setup.
10. Select the D Enlarged/Reduced Printing check box.
11. Click F Fit Roll Paper Width.
12. Conrm the print settings, and clickM Print to start printing.

Note
• For tips on conrming print settings,see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Printing on Non-Standard Paper Sizes
By specifying the paper size, you can print on non-standard sizes of paper.

There are two ways to print on non-standard paper sizes, as follows.

Registering non-standard paper size in the printer driver
After you register non-standard paper sizes, they are listed with standard sizes so that you can choose
them anytime as needed.

Note
• These non-standard paper sizes you register in the printer driver are called Custom Paper Size in
Windows and “Custom Sizes” in Mac OS X.

Specifying custom paper sizes for temporary use
Because these are sizes you specify temporarily in the printer driver, the sizes will not be available after you
exit the application. If you want to set up a non-standard paper size so that it will always be available, we
recommend registering the paper size in the printer driver.

Note
• These temporary paper sizes you register on the printer are called “Custom Sizes” in Windows.
• This can only be congured in Windows.

For instructions on specifying non-standard paper sizes for printing, refer to the following topics, as
appropriate for your computer and operating system.

• Printing on Non-Standard Paper Sizes (Windows) (→P.262)
• Printing on Non-Standard Paper Sizes (Mac OS X) (→P.266)
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Printing on Non-Standard Paper Sizes (Windows)
This topic describes two ways to print on non-standard paper sizes.

• Printing by using Custom Size
• Printing by using Custom Paper Size

Printing by using Custom Size
This section describes how to print using Custom Size based on the following example.

• Document: Any Type
• Page size: Square of non-standard dimensions (430×430 mm [16.9×16.9 in])
• Paper: Sheets
• Paper type: Any type
• Paper Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])

1. Load the square paper (430 × 430 mm [16.9 × 16.9 in]) in the printer.
2. Choose Print in the application menu.
3. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
4. Make sure the Main sheet is displayed.

5. In the A Media Type list, select the type of paper that is loaded.
6. After conrming that D Easy Settings is selected, select from the E Print Target list.
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7. Click the Page Setup tab to display the Page Setup sheet.

8. Click Manual in the L Paper Source list.
9. Click Custom Size in the A Page Size list to display the Custom Size Settings dialog box.
10. Conrm that mm is selected in Units.
11. Enter “430” (16.9 in) in both Width and Height.
12. Click OK to close the Custom Size Settings dialog box.
13. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Windows)”. (→P.340)
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Printing by using Custom Paper Size
This section describes how to print using Custom Paper Size based on the following example. First, register
a non-standard paper size called “430 mm Square” as a Custom Paper Size.

• Document: Any Type
• Page Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])
• Paper: Sheets
• Media Type: Any type
• Paper Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])

1. Load the square paper (430 × 430 mm [16.9 × 16.9 in]) in the printer.
2. Choose Print in the application menu.
3. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
4. Make sure the Main sheet is displayed.

5. In the A Media Type list, select the A Media Type that is loaded in the printer.
6. After conrming that D Easy Settings is selected, select the E Print Target from the E Print

Target list.
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7. Click the Page Setup tab to display the Page Setup sheet.

8. Click O Size Options to display the Paper Size Options dialog box.
9. Enter a desired paper name in Custom Paper Size Name. “430 mm Square” is used in this

example.
10. Select mm in Units.
11. Enter “430” (16.9 in) in both Width and Height.

Note
• If you select the Fix the Ratio of the Width to Height check box, after you enter a value in either
Width or Height, the other value will be automatically applied based on the original aspect ratio.

12. Click Add to register “430 mm Square”.
13. Click OK to close the Paper Size Options dialog box.
14. Click Manual in the L Paper Source list.
15. In the A Page Size list, click the size you added, "430 mm Square".
16. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Windows)”. (→P.340)
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Printing on Non-Standard Paper Sizes (Mac OS X)
This section describes how to register and print Custom Page Sizes based on the following example. Here, you
will register a non-standard paper size named “430*430” in Custom Page Sizes.

• Document: Any Type
• Page Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])
• Paper: Sheets
• Media Type: Any type
• Paper Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])

Note
• The following procedures are based on Mac OS X 10.4. The method of setting up non-standard paper
sizes varies depending on the version of Mac OS X.

1. Create the document in the application.
2. Load the square paper (430 × 430 mm [16.9 × 16.9 in]) in the printer.
3. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

4. Select the printer in the A Printer list.
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5. Click Manage Custom Sizes in the C Paper Size list to display the Custom Page Sizes
dialog box.

6. In Page Size, enter the height and width of the original. Here, enter “43.00 cm” in Height and
Width.

7. In Printer Margins, enter “0.5” for the top and side margins and “2.3” for the bottom margin.
Here, measurements are entered in centimeters.

8. Double-click Untitled in the list at left in the Custom Page Sizes dialog box and enter the
paper name-in this case, “430*430”.

9. Click OK to close the Custom Page Sizes dialog box.
10. In the C Paper Size list, click the size of the original. In this case, click “430*430”, the size

you registered.
11. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
12. Access the Main pane.

13. In the A Media Type list, select the type of paper that is loaded.
14. After conrming that D Easy Settings is selected, select from the E Print Target list.
15. Make your selection in the F Print Quality list.
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16. Access the Page Setup pane.

17. Click Manual in the A Paper Source list.
18. In C Page Size, make sure “430*430” is displayed, as registered in Page Setup.
19. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Tiling and multiple pages per sheet

Printing Multiple Originals Next to Each Other
By arranging originals from word-processing or spreadsheet programs or web browser screen shots next to each
other on single sheets, you can create highly expressive presentation materials, easy-to-understand meeting
materials, and a variety of other printed documents.

Free Layout (Windows)
Besides combining multiple pages in a single-page layout, you can combine originals from multiple les-even
multiple source applications-in a single-page layout.

Important
• Free Layout cannot be used in 64-bit version of Windows.
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imagePROGRAF Free Layout (Macintosh)
Besides combining multiple pages in a single-page layout, you can combine originals from multiple les-even
multiple source applications-in a single-page layout.

For instructions on arranging originals from multiple applications, refer to the following topics.
• Printing Multiple Originals Next to Each Other (Windows) (→P.271)
• Printing Multiple Originals Next to Each Other (Mac OS X) (→P.273)
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Printing Multiple Originals Next to Each Other (Windows)
This topic describes how to arrange multiple originals using the Free Layout function.

Important
• Free Layout cannot be used in 64-bit version of Windows.

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. Click the Layout tab to display the Layout sheet.

5. Select the A Page Layout check box.
6. Click Free Layout in the A Page Layout list.
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7. When you attempt to print, the imagePROGRAF Free Layout window is displayed. (At this
point, the document will not be printed yet.)

8. Edit and rearrange the image in the imagePROGRAF Free Layout window as desired.

Important
• Without closing the imagePROGRAF Free Layout window, repeat steps 1-7 to arrange originals
from multiple applications on the same page.

Note
• For instructions on editing and rearranging images, refer to the imagePROGRAF Free Layout
help topic.

9. Print from the imagePROGRAF Free Layout menu.

Note
• For details on imagePROGRAF Free Layout functions, refer to Free Layout.
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Printing Multiple Originals Next to Each Other (Mac OS X)
This topic describes how to use the Free Layout function to arrange multiple originals next to each other before
printing.

1. Choose Print in the application menu.
2. Access the Page Setup pane.

3. Select the N Free Layout check box.
4. Click M Print.
5. The Canon imagePROGRAF Free Layout window is displayed.

6. Edit and rearrange the image in the Canon imagePROGRAF Free Layout window as desired.

Note
• Without closing the Canon imagePROGRAF Free Layout window, repeat steps 1 to 4 to arrange
originals from multiple applications on the same page.

• For instructions on editing and rearranging images, refer to the Canon imagePROGRAF Free
Layout help topic.
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7. Print from the Canon imagePROGRAF Free Layout menu.

Note
• For details on Canon imagePROGRAF Free Layout functions, refer to Free Layout.
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Printing Multiple Pages Continuously
You can print multiple pages as a single continuous image, without margins between pages.

Roll paper (banner)

Important
• This feature is only available with rolls. It cannot be used when printing on sheets.
• During banner printing, settings for conserving paper, number of copies, borderless printing,
enlargement or reduction, and other layout-related settings are disregarded.

For instructions on borderless printing of photos and images at actual size, refer to the following topics, as
appropriate for your computer and operating system.

• Printing Multiple Pages Continuously (Windows) (→P.276)
• Printing Multiple Pages Continuously (Mac OS X) (→P.278)
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Printing Multiple Pages Continuously (Windows)
This topic describes how to print multiple pages as a single continuous image, without margins between pages.

Important
• This feature is only available with rolls. It cannot be used when printing on sheets.
• During banner printing, settings for conserving paper, number of copies, borderless printing,
enlargement or reduction, and other layout-related settings are disregarded.

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, click the type of paper that is loaded.
5. Click the Page Setup tab to display the Page Setup sheet.

6. Click Roll Paper in the L Paper Source list.
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7. Click N Roll Paper Options to display the Roll Paper Options dialog box.

8. Select the B Banner Printing check box.
9. Click OK.
10. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings,see “Conrming Print Settings (Windows)”. (→P.340)
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Printing Multiple Pages Continuously (Mac OS X)
This topic describes how to print multiple pages as a single continuous image, without margins between pages.

Important
• This feature is only available with rolls. It cannot be used when printing on sheets.
• During banner printing, settings for conserving paper, number of copies, borderless printing,
enlargement or reduction, and other layout-related settings are disregarded.

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. Click the original size in the C Paper Size list.
4. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, click the type of paper that is loaded.
7. Make your selection in the E Print Target list.
8. Make your selection in the F Print Quality list.
9. Access the Page Setup pane.

10. Click Roll Paper (Banner) in the A Paper Source list.
11. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Printing Multiple Pages Per Sheet
To conserve paper, you can print several pages of the original on a single sheet by reducing the original and
dividing the sheet into areas for each page.

Page Layout
Specify a number of pages of the original to print on a single sheet, in a layout of multiple pages per sheet.

Note
• You can print up to 16 pages of the original on a single sheet.
• You can also change the page layout order and print page boundary lines, as desired.

Important
• This function cannot be combined with the following options.

• Borderless Printing
• Scaling Originals (Windows)
• Banner Printing (Windows)

For instructions on printing multiple pages per sheet, refer to the following topics, as appropriate for your
computer and operating system.

• Printing Multiple Pages Per Sheet (Windows) (→P.281)
• Printing Multiple Pages Per Sheet (Mac OS X) (→P.283)
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Printing Multiple Pages Per Sheet (Windows)
This topic describes how to print four pages of originals together on a single sheet based on the following example.

• Document: Any Type
• Page size: A3 (297.0×420.0 mm [11.7×16.5 in])
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then open the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. Make your selection in the E Print Target list.
6. Make your selection in the F Print Quality list.
7. Click the Page Setup tab to display the Page Setup sheet.
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8. In A Page Size, click the size of the original as specied in the application software. In this case,
click ISO A4 or Letter (8.5"x11").

9. Click Roll Paper in the L Paper Source list.
10. Select the width of the loaded roll in theM Roll Paper Width list-in this case, ISO A2/A3 Roll

(420.0mm).
11. Click the Layout tab to display the Layout sheet.

12. Select the A Page Layout check box.
13. Click 4 Pages/Sheet in the A Page Layout list.

Note
• You can select the layout order for placing four pages on a sheet and a frame border in the Page
Layout Printing dialog box by clicking B Set.

14. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings,see “Conrming Print Settings (Windows)”. (→P.340)
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Printing Multiple Pages Per Sheet (Mac OS X)
This topic describes how to print four pages of an original on a single sheet, based on the following example.

• Document: Any Type
• Page size: A3 (297.0 × 420.0 mm [11.7 × 16.5 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. In the F Paper Size list, click the size of the original. In this case, click ISO A3.
4. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
5. Access the Layout pane.
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6. Click 4 in the A Pages per Sheet list.

Note
• You can choose the layout order and specify a boundary line for the four pages in B Layout
Direction and C Border.

7. Access the Main pane.

8. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
9. Make your selection in the E Print Target list.
10. Make your selection in the F Print Quality list.
11. Access the Page Setup pane.

12. Click Roll Paper in the A Paper Source list.
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13. Make sure the width of the loaded roll is displayed in the B Roll Width list-in this case, ISO
A2/A3 (420.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Information
on the Main pane to update the printer information.

14. Make sure C Page Size shows the original size as specied in C Paper Size in the Page
Attributes dialog box-in this case, ISO A3.

15. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Printing Posters in Sections
You can enlarge an original to print it in sections on several sheets. By assembling the printed sheets, you can
create a poster larger than the maximum supported paper size of the printer.

Page Layout
Choose poster printing.
For instructions on printing large posters, refer to the following topics, as appropriate for your computer
and operating system.

• Printing Large Posters (Windows) (→P.287)

Note
• This method of poster printing is supported in Windows.
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Printing Large Posters (Windows)
You can enlarge an original to print it in sections on several sheets. By assembling the printed sheets, you can
create a poster larger than the maximum supported paper size of the printer. This topic describes how to enlarge
an A2 original for printing it in sections on four sheets, based on the following example.

• Document: Poster
• Page size: A2 (420.0×594.0 mm [16.5 × 23.4 in])
• Paper: Sheets
• Paper Size: A2 (420.0 × 594.0 mm [16.5 × 23.4 in])

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded.
5. Click Poster in the E Print Target list.
6. Click the Page Setup tab to display the Page Setup sheet.
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7. In A Page Size, click the size of the original as specied in the application. In this case, click
ISO A2.

8. Click Manual in the L Paper Source list.
9. Click the Layout tab to display the Layout sheet.

10. Select the A Page Layout check box.
11. Click Poster (2 x 2) in the A Page Layout list.

Note
• Follow the steps below to print only a portion of the poster as divided for printing.

• Click B Set under A Page Layout to display the Pages to Print dialog box.
• On the Pages to Print dialog box, clear the check boxes of the portion you do not want to print.
• Click OK to close the Pages to Print dialog box.

12. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Windows)”. (→P.340)
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Centering originals

Printing Originals Centered on Rolls
You can print originals centered on a page-for example, if the paper is larger than the original, or if you are
reducing the original.

Centering originals relative to roll paper width
If you use originals smaller than the roll paper width, you can center them relative to the width when printing.
Print Centered
Aligns the center of the original with the center of the roll, relative to the width.

For instructions on centering originals when printing on rolls, refer to the following topics, as appropriate for
your computer and operating system.

• Printing Originals Centered on Rolls (Windows) (→P.290)
• Printing Originals Centered on Rolls (Mac OS X) (→P.292)
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Printing Originals Centered on Rolls (Windows)
This topic describes how to center originals before printing on rolls based on the following example.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll width: A3/A4 roll (297.0 mm [11.7 in])

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. Select the print target in the E Print Target list.
6. Click the Page Setup tab to display the Page Setup sheet.
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7. In the A Page Size list, click the size of the original as specied in the application. In this case,
click ISO A4 or Letter (8.5"x11").

8. Click Roll Paper in the L Paper Source list.
9. Select the width of the loaded roll in theM Roll Paper Width list-in this case, ISO A3/A4 Roll

(297.0mm).
10. Click the Layout tab to display the Layout sheet.

11. Select the E Print Centered check box.
12. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings,see “Conrming Print Settings (Windows)”. (→P.340)
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Printing Originals Centered on Rolls (Mac OS X)
This topic describes how to center originals before printing on rolls based on the following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.
4. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
7. Make your selection in the E Print Target list.
8. Make your selection in the F Print Quality list.
9. Access the Page Setup pane.

10. Click Roll Paper in the A Paper Source list.
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11. Make sure the width of the loaded roll is displayed in B Roll Width -in this case, ISO A3/A4
(297.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Information
on the Main pane to update the printer information.

12. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the
Page Attributes dialog box-in this case, ISO A4.

13. Select the J Print Centered check box.
14. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)

294 Enhanced Printing Options



Centering originals

Printing Originals Centered on Sheets
You can print originals centered on a page-for example, if the paper is larger than the original, or if you are
reducing the original.

Centering originals on sheets
If you use paper larger than the original size or print originals after reduction, the printed images may be
aligned in the upper-left corner of the paper. In this case, you can center originals on sheets when printing.
Print Centered
Aligns the center of the original with the center of the sheet.

For instructions on centering originals when printing on sheets, refer to the following topics, as appropriate for
your computer and operating system.

• Printing Originals Centered on Sheets (Windows) (→P.296)
• Printing Originals Centered on Sheets (Mac OS X) (→P.298)
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Printing Originals Centered on Sheets (Windows)
This topic describes how to reduce an original 50% for printing centered on a sheet.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Sheets
• Paper type: Plain Paper
• Paper size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. Make your selection in the E Print Target list.
6. Click the Page Setup tab to display the Page Setup sheet.

7. In the A Page Size list, click the size of the original as specied in the application. In this
case, click ISO A4.
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8. Select the C Enlarged/Reduced Printing check box.
9. Click Match Page Size in the G Paper Size list.
10. Click F Scaling and enter “50”.
11. Click Manual in the L Paper Source list.
12. Click the Layout tab to display the Layout sheet.

13. Select the E Print Centered check box.
14. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Windows)”. (→P.340)

Important
• If you have selected Manual as the paper source, follow the instructions on the printer control
panel to enter the paper size.
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Printing Originals Centered on Sheets (Mac OS X)
This topic describes how to center originals for printing on sheets, based on the following example.

• Document: Any Type
• Page size: A4
• Paper: Sheets
• Paper type: Plain Paper
• Paper size: Non-standard

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. In the F Paper Size list, click the size of the original. In this case, click ISO A4 - for Paper

Tray (Large Margins).
4. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
7. Make your selection in the E Print Target list.
8. Make your selection in the F Print Quality list.
9. Access the Page Setup pane.

10. Click Manual in the A Paper Source list.
11. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the

Page Attributes dialog box-in this case, ISO A4 - for Paper Tray (Large Margins).
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12. Select the J Print Centered check box.
13. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)

Important
• If you have selected Manual as the paper source, follow the instructions on the printer control panel to
enter the paper size.
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Conserving roll paper

Conserving Roll Paper by Rotating Originals 90 Degrees
You can conserve roll paper by specifying particular settings as suitable for your original.

Rotate Page 90 degrees (Conserve Paper)
When originals are printed in portrait orientation, the original is rotated 90 degrees before printing if it ts
within the roll width. This enables you to conserve paper.

Important
• If the page would exceed the roll paper width after rotation, use this function with Scale to t Roll
Paper Width to print rotated pages.

For tips on conserving roll paper, refer to the following topics, as appropriate for your computer and operating
system.

• Conserving Roll Paper by Rotating Originals 90 Degrees (Windows) (→P.302)
• Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS X) (→P.304)
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Conserving Roll Paper by Rotating Originals 90 Degrees
(Windows)

This topic describes how to conserve paper by rotating originals 90 degrees before printing, based on the
following example.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3×11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])

This example illustrates how to rotate an A4 (210.0×297.0 mm)/Letter (8.3×11.7 in) original in portrait
orientation 90 degrees to t within the width of A3/A4 roll paper (297.0 mm [11.7 in]), which enables you to
conserve paper.

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then open the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. Click the Page Setup tab to display the Page Setup sheet.
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6. In the A Page Size list, click the size of the original as specied in the application. In this case,
click ISO A4 or Letter (8.5"x11").

7. Click Roll Paper in the L Paper Source list.
8. Select the width of the loaded roll in theM Roll Paper Width list-in this case, ISO A3/A4 Roll

(297.0mm).
9. Select the K Rotate Page 90 degrees (Conserve Paper) check box.
10. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings,see “Conrming Print Settings (Windows)”. (→P.340)
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Conserving Roll Paper by Rotating Originals 90 Degrees
(Mac OS X)

This topic describes how to conserve roll paper by rotating originals 90 degrees before printing, based on the
following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])

This example illustrates how to rotate an A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in) original in portrait
orientation 90 degrees to t within the width of A3/A4 roll (297.0 mm [11.7 in]), which enables you to conserve
paper.

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.
4. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
7. Access the Page Setup pane.

8. Click Roll Paper in the A Paper Source list.
9. Make sure the width of the loaded roll is displayed in B Roll Width -in this case, ISO A3/A4

(297.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Information
on the Main pane to update the printer information.
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10. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the
Page Attributes dialog box-in this case, ISO A4.

11. Select the L Rotate Page 90 degrees check box.
12. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Conserving Roll Paper by Printing Originals Without Top
and Bottom Margins

You can conserve roll paper by specifying particular settings as suitable for your original.

No Spaces at Top or Bottom (Conserve Paper)
You can print without feeding the paper for blank portions of originals if there are top and bottom margins in
originals. This enables you to conserve as much paper as the size of the margins.

Important
• Printing without the top and bottom margins is not supported in the following cases.

• Banner printing
• If you have chosen poster as the type of page layout

Note
• Even during borderless printing, you can print without the top and bottom margins.
• Printing without the top and bottom margins may cause inconsistency in the size of printed documents,
depending on the layout of images or text in your originals.

For tips on conserving roll paper, refer to the following topics, as appropriate for your computer and operating
system.

• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Windows) (→P.308)
• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Mac OS X) (→P.310)
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Conserving Roll Paper by Printing Originals Without Top
and Bottom Margins (Windows)

This topic describes how to conserve roll paper when printing originals that have a top and bottom margin,
based on the following example.

• Document: Any type
• Page size: A4 (210.0×297.0mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. Click the Page Setup tab to display the Page Setup sheet.

308 Enhanced Printing Options



Conserving roll paper

6. In the A Page Size list, click the size of the original as specied in the application. In this case,
click ISO A4 or Letter (8.5"x11").

7. Click Roll Paper in the L Paper Source list.
8. Select the width of the loaded roll in theM Roll Paper Width list-in this case, ISO A3/A4 Roll

(297.0mm).
9. Click the Layout tab to display the Layout sheet.

10. Select the G No Spaces at Top or Bottom (Conserve Paper) check box.
11. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings,see “Conrming Print Settings (Windows)”. (→P.340)
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Conserving Roll Paper by Printing Originals Without Top
and Bottom Margins (Mac OS X)

This topic describes how to conserve roll paper when printing originals that have a top and bottom margin,
based on the following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.
4. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
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5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
7. Access the Page Setup pane.

8. Click Roll Paper in the A Paper Source list.
9. Make sure the width of the loaded roll is displayed in B Roll Width -in this case, ISO A3/A4

(297.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Information
on the Main pane to update the printer information.
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10. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the
Page Attributes dialog box-in this case, ISO A4.

11. Select the K No Spaces at Top or Bottom check box.
12. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Checking Images Before Printing

Checking the Layout in a Preview Before Printing
You can check the print layout on the preview screen.

Open Preview When Print Job Starts (Windows)
While viewing the preview screen, you can also adjust orientation or other settings, and your changes will be
instantly applied on the preview screen.

Note
• Under some settings and in some environments, PageComposer may be started.
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Preview (Macintosh)
While viewing the preview screen, you can also adjust layout or size settings, and your changes will be
instantly applied on the preview screen.

For instructions on how to check the layout before printing, refer to the following topics:
• Checking the Layout in a Preview Before Printing (Windows) (→P.315)
• Checking the Layout in a Preview Before Printing (Mac OS X) (→P.317)
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Checking the Layout in a Preview Before Printing
(Windows)

This topic describes how to preview images of print jobs before actually printing them.

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. Select the L Open Preview When Print Job Starts check box.
5. After you click OK, when you print a job, the imagePROGRAF Preview window will be displayed.

Note
• If PageComposer is running, access the Special Settings dialog box from the Layout sheet and
clear Enable Preview Switching.
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6. On the main window, you can check the layout and change settings as needed.
7. To print, click Start Printing in the File menu.

Note
• For details on imagePROGRAF Preview functions, see Preview.
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Checking the Layout in a Preview Before Printing (Mac
OS X)

This topic describes how to check the layout before printing using the Canon imagePROGRAF Preview function.

1. Choose Print in the application menu.
2. Access the Main pane.

3. Select the O Print Preview check box.
4. Click M Print.
5. The Canon imagePROGRAF Preview window is displayed.

6. Check the layout and adjust settings in the Canon imagePROGRAF Preview window as desired.
7. Print from the Canon imagePROGRAF Preview menu.

Note
• For details on imagePROGRAF Preview functions, refer to Preview.
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Other useful settings

Printing With Watermarks
You can add watermarks (background images) to documents that require special handling.

Watermark
Watermarks are applied to all pages of your document.

Important
• Watermarks are not printed if you select poster as the type of page layout.

The following watermarks are provided:
• CONFIDENTIAL
• COPY
• DRAFT
• FILE COPY
• FINAL
• PRELIMINARY
• PROOF
• TOP SECRET

You can also create your own watermarks. Specify the following options to customize your watermark.
• Watermark string: Specify the font, size, color, and so on. Surround the watermark with a frame,
if desired.

• Watermark position: Specify the position on the page, the angle, and so on.
• Watermark printing method: Specify whether to print the watermark superimposed or under the
document image. You can also print the watermark only on the rst page, if desired.

Note
• Watermarks are supported in Windows.
• In addition to the provided watermarks, you can create up to 50 original watermarks in Windows.

For detailed instructions on printing with watermarks, refer to the following topics:
• Printing with Watermarks-COPY, FILE COPY, and so on (Windows) (→P.319)
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Printing with Watermarks-COPY, FILE COPY, and so on
(Windows)

This topic describes how to print with watermarks, based on the following example of printing with a “FILE COPY”
watermark.

• Document: CAD drawing
• Page size: A2 (420.0×594.0 mm [16.5 × 23.4 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in[)

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. After conrming that D Easy Settings is selected, click CAD (Color Line Drawing) in the

E Print Target list.

Note
• You can check the settings values selected in the E Print Target list by clickingG View Settings.
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6. Click the Page Setup tab to display the Page Setup sheet.

7. In A Page Size, click the size of the original as specied in the application software. In this
case, click ISO A2.

8. Click Roll Paper in the L Paper Source list.
9. Select the width of the loaded roll in theM Roll Paper Width list-in this case, ISO A2/A3 Roll

(420.0mm).
10. Click the Layout tab to display the Layout sheet.

11. Select the C Watermark check box.
12. Click FILE COPY in the Watermarks list.

Note
• Click D Edit Watermark to open the Edit Watermark dialog box. In the Edit Watermark dialog box,
you can create custom watermarks and change the position and angle of watermarks.

13. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Windows)”. (→P.340)
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Making the Original Orientation Match the Paper
Orientation

You can specify the original orientation to match the orientation of the paper for printing.

Orientation
Paper is usually loaded in the printer in portrait orientation. When you have an original in landscape
orientation, you can specify the printing orientation so that the original is printed in landscape orientation.

Rotate 180 degrees
The original is rotated 180 degrees to print it upside down.

Mirror
A mirror image of the original is printed.
For instructions on specifying the original orientation before printing, refer to the following topics, as
appropriate for your computer and operating system.

• Making the Original Orientation Match the Paper Orientation (Windows) (→P.322)
• Making the Original Orientation Match the Paper Orientation (Mac OS X) (→P.324)
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Making the Original Orientation Match the Paper
Orientation (Windows)

This topic describes how to print an original in landscape orientation after matching the paper orientation, based
on the following example.

• Document: An original in landscape orientation
• Page size: A4 (210.0 × 297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then open the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
5. Make your selection in the E Print Target list.
6. Make your selection in the F Print Quality list.
7. Click the Page Setup tab to display the Page Setup sheet.
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8. In the A Page Size list, click the size of the original as specied in the application. In this case,
click ISO A4 or Letter (8.5"x11").

9. In H Orientation, click J Landscape.
10. Click Roll Paper in the L Paper Source list.
11. Select the width of the loaded roll in theM Roll Paper Width list-in this case, ISO A2/A3 Roll

(420.0mm).
12. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings,see “Conrming Print Settings (Windows)”. (→P.340)
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Making the Original Orientation Match the Paper
Orientation (Mac OS X)

This topic describes how to print an original in landscape orientation after matching the paper orientation, based
on the following example.

• Document: An original in landscape orientation
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. In the F Paper Size list, click the size of the original. In this case, click ISO A4.
4. In D Orientation, click the icon of the document in landscape orientation.
5. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
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6. Access the Main pane.

7. In the A Media Type list, select the type of paper that is loaded. In this case, click Plain Paper.
8. Make your selection in the E Print Target list.
9. Make your selection in the F Print Quality list.
10. Access the Page Setup pane.

11. Click Roll Paper in the A Paper Source list.
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12. Make sure the width of the loaded roll is displayed in the B Roll Width list-in this case, ISO
A2/A3 (420.0mm).

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Information
on the Main pane to update the printer information.

13. Make sure the C Page Size setting matches the original size as selected in C Paper Size in the
Page Attributes dialog box-in this case, ISO A4.

14. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Using Favorites
You can register print settings as “favorites” to reuse settings from a particular job that met your expectations, or
settings for a particular page size that you will use repeatedly.

Favorites
Registering a favorite for later use. You can choose the settings you have registered from a list before printing,
and you can check the settings details.

Note
• You can also save the favorite settings as les. Using these les is a convenient way to print under the
same conditions on another computer. (In Windows.)

For instructions on using favorites to print, refer to the following topics, as appropriate for your computer
and operating system.

• Using Favorites (Windows) (→P.328)
• Using Favorites (Mac OS X) (→P.330)

Enhanced Printing Options 327



Other useful settings

Using Favorites (Windows)
This topic describes how to register favorites and print using favorite settings.

Registering a favorite
Follow the steps below to save the current print settings as a favorite.

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Complete the print settings.
4. Click the Favorites tab to display the Favorites sheet.

5. Click H Add to display the Add dialog box.

6. Enter a desired name in Name, such as “Photos for Presentations” or “Monthly Report.”
7. Choose a tting icon for these print settings in the Icon list.
8. In Comment, enter a description of the favorite to be added, as desired.
9. Click OK to close the Add dialog box.

The favorite you have added is now displayed in A Favorites.

Note
• To save a favorite as a le, click J Export and specify the le to save.
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Printing using the favorite
Follow the steps below to print using the favorite you have registered.

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Click the Favorites tab to display the Favorites sheet.

4. In the A Favorites, choose the favorite you registered.

Note
• To import a favorite, click I Import and specify the favorite le.

5. Click D Apply Favorite to replace the favorite settings with the current print settings.
6. Conrm the print settings and print as desired.

Note
• For instructions on conrming print settings,see “Conrming Print Settings (Windows)”. (→P.340)
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Using Favorites (Mac OS X)
You can use the Presets function in Mac OS X for favorite-based printing.

Note
• In the printing dialog box, click Save As in the Presets list to save the current print settings. This is a
standard feature of the operating system. For details, refer to the Mac OS documentation.
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Cutting Roll Paper After Printing
Roll paper can be automatically cut after printing.

Note
• It may not be possible to cut certain types of paper, such as adhesive paper. For details on types of
paper that cannot be used with the auto cut feature, see the Paper Reference Guide (→P.95)

Automatic Cutting
Roll paper is cut automatically after printing. If you prefer, you can print continuously without cutting the
roll, or you can print a cut line.
For instructions on cutting roll paper after printing, refer to the following topics, as appropriate for your
computer and operating system.

• Cutting Roll Paper After Printing (Windows) (→P.332)
• Cutting Roll Paper After Printing (Mac OS X) (→P.333)

Enhanced Printing Options 331



Other useful settings

Cutting Roll Paper After Printing (Windows)
This topic describes how to cut roll paper automatically after printing (using the auto cut function), as well as
how to print a cut line for manual cutting.

Note
• The auto cut function is activated on the printer by default and when the printer driver is installed.
Follow the steps below to reactivate the function if it is disabled, or to select the setting for printing a
cut line instead.

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Click the Page Setup tab to display the Page Setup sheet.

4. Click Roll Paper in the L Paper Source list.
5. Click N Roll Paper Options to display the Roll Paper Options dialog box.

6. To enable automatic cutting, click Yes in the A Automatic Cutting list. If you prefer to cut the
paper later yourself, click Print Cut Guideline.

7. Click OK to close the Roll Paper Options dialog box.
8. Conrm the print settings and print as desired.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Windows)”. (→P.340)

Roll paper will be automatically cut after printing.
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Cutting Roll Paper After Printing (Mac OS X)
This topic describes how to cut roll paper automatically after printing (using the auto cut function), as well as
how to print a cut line for manual cutting.

Note
• The auto cut function is activated on the printer by default and when the printer driver is installed.
Follow the steps below to reactivate the function if it is disabled, or to select the setting for printing a
cut line instead.

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. Choose the original size in the C Paper Size list.
4. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
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5. Access the Page Setup pane.

6. Click Roll Paper in the A Paper Source list.
7. Access the Main pane.

8. In the A Media Type list, select the type of paper that is loaded.
9. Click C Set to display the Paper Detailed Settings dialog box.

334 Enhanced Printing Options



Other useful settings

10. To enable automatic cutting, click Printer Default in the H Automatic Cutting list. If you prefer
to cut the paper later yourself, click Print Cut Guideline.

Important
• If the automatic cut function has been deactivated on the printer, change the auto cut setting on the
printer Control Panel.

11. Click OK to close the Paper Detailed Settings dialog box.
12. Conrm the print settings, and then clickM Print to start printing.

Note
• For tips on conrming print settings, see “Conrming Print Settings (Mac OS X)”. (→P.457)
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Printer Driver

Printer Driver Settings (Windows)
For instructions on accessing the Windows printer driver, refer to the following topics.

• Accessing the Printer Driver Dialog Box from Applications (Windows) (→P.346)
• Accessing the Printer Driver Dialog Box from the Operating System Menu (Windows) (→P.348)

For information on the Windows printer driver settings, refer to the following topics.

• Main Sheet (Windows) (→P.350)
You can specify the type of paper, color processing, print quality, print preview, and other settings.
Choose Easy Settings to specify basic print settings based on the printing application or Advanced
Settings to complete more detailed settings as desired.

• Paper Detailed Settings Dialog Box (Windows) (→P.354)
• View Settings Dialog Box for the Printing Application (Windows) (→P.355)
• Color Adjustment Sheet: Color (Windows) (→P.356)
• Matching Sheet (Windows) (→P.359)
• Color Adjustment Sheet: Monochrome (Windows) (→P.361)

• Page Setup Sheet (Windows) (→P.364)
You can specify the page size of the original, borderless printing, enlargement or reduction, the
orientation, the paper size and feed source, and automatic cutting.

• Paper Size Options Dialog Box (Windows) (→P.367)
• Layout Sheet (Windows) (→P.368)
You can specify the page layout, watermarks, the orientation, the number of copies, and print processing
options.

• Page Options Dialog Box (Windows) (→P.370)
• Special Settings Dialog Box (Windows) (→P.371)
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• Favorites Sheet (Windows) (→P.372)
Groups of print settings you select on each sheet can be saved as a favorite. Favorites you have added
can be edited or used at the time of printing as desired.

• Utility Sheet (Windows) (→P.374)
You can specify settings related to maintenance for the Printhead and feed amount, as well as settings
for Color imageRUNNER Enlargement Copy.

• Support Sheet (Windows) (→P.375)
You can view support information and the user manual.

• Device Settings Sheet (Windows) (→P.377)
You can display settings for optional equipment installed on the printer and see the version information
for the printer driver.

imagePROGRAF Free Layout is a feature for freely arranging originals from various source applications on a
single page as desired before printing. For details, see Free Layout.
Color imageRUNNER Enlargement Copy is a feature for automatic enlargement and printing of scanned
originals from a Color imageRUNNER. For details, see Color imageRUNNER Enlargement Copy.

Important
• Color imageRUNNER Enlargement Copy and imagePROGRAF Free Layout cannot be used on
64-bit version of Windows.
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Specifying Paper in the Printer Driver (Windows)
If you have replaced the paper, you must complete the following settings in the printer driver.

Important
• Always specify the same type and size of paper in the printer menu and printer driver.
If the type and size do not match, an error message will be displayed and printing is not possible.

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. In the A Media Type list, select the type of paper that is loaded.

Note
• Click the B Get Information button to display the Paper Information on Printer dialog box. On the
Paper Information on Printer dialog box, you can obtain information on the paper in the printer and
congure printer driver settings for the feed source and type of paper.

5. Click the Page Setup tab to display the Page Setup sheet.
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6. In the A Page Size list, select the size of the original as specied in the application.
7. In the L Paper Source list, select how paper is supplied.
8. If you have selected Roll Paper in L Paper Source, select the width of the loaded roll inM Roll

Paper Width.

Note
• A variety of settings are available in the printer driver to suit different printing applications.
For details on available printing conditions, see “Printer Driver Settings (Windows)”. (→P.336)
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Conrming Print Settings (Windows)
There are two ways to conrm the print settings, as follows.

• Checking a preview of the settings
• Checking a print preview

Checking a preview of the settings
A preview of the settings is displayed on the left side of the Main, Page Setup, and Layout sheets. By
checking illustrations and numerical values in the preview, you can conrm current settings for the page
size, orientation, paper source, layout, and so on.

Display Area Information Displayed

P Top illustrations Illustrations indicate the orientation, page layout, borderless printing
selection, color mode, and other settings information.

Q Middle, bordered area The page size, paper size, and method and percentage of enlargement
or reduction are indicated.

R Bottom illustrations Illustrations indicate the feed source, orientation, borderless printing
selection, and other settings information.
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Note
• To conrm the Print Target specied in Easy Settings, click G View Settings on the Main sheet to
display the View Settings dialog box.

Checking a print preview
You can check an image of the original just as it will be printed.
When you activate this feature, imagePROGRAF Preview or PageComposer is started before printing.
Conrming how documents will be printed this way helps prevent printing errors.
For details on print previews,see “Checking the Layout in a Preview Before Printing”. (→P.313)
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Checking the Layout in a Preview Before Printing
(Windows)

This topic describes how to preview images of print jobs before actually printing them.

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. Select the L Open Preview When Print Job Starts check box.
5. After you click OK, when you print a job, the imagePROGRAF Preview window will be displayed.

Note
• If PageComposer is running, access the Special Settings dialog box from the Layout sheet and
clear Enable Preview Switching.
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6. On the main window, you can check the layout and change settings as needed.
7. To print, click Start Printing in the File menu.

Note
• For details on imagePROGRAF Preview functions, see Preview.
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Using Favorites (Windows)
This topic describes how to register favorites and print using favorite settings.

Registering a favorite
Follow the steps below to save the current print settings as a favorite.

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Complete the print settings.
4. Click the Favorites tab to display the Favorites sheet.

5. Click H Add to display the Add dialog box.

6. Enter a desired name in Name, such as “Photos for Presentations” or “Monthly Report.”
7. Choose a tting icon for these print settings in the Icon list.
8. In Comment, enter a description of the favorite to be added, as desired.
9. Click OK to close the Add dialog box.

The favorite you have added is now displayed in A Favorites.

Note
• To save a favorite as a le, click J Export and specify the le to save.
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Printing using the favorite
Follow the steps below to print using the favorite you have registered.

1. Choose Print in the application menu.
2. Select the printer in the dialog box, and then display the printer driver dialog box. (→P.346)
3. Click the Favorites tab to display the Favorites sheet.

4. In the A Favorites, choose the favorite you registered.

Note
• To import a favorite, click I Import and specify the favorite le.

5. Click D Apply Favorite to replace the favorite settings with the current print settings.
6. Conrm the print settings and print as desired.

Note
• For instructions on conrming print settings,see “Conrming Print Settings (Windows)”. (→P.340)
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Accessing the Printer Driver Dialog Box from
Applications (Windows)
1. Choose Print from the File menu to display the dialog box for printing conditions.
2. Select the printer, and then display the printer driver dialog box.

Note
• The dialog box for specifying printing conditions varies depending on the source application. In some
cases, when you select the printer, a sheet for conguring the printer driver is added to the dialog box.
In the following case, click Preferences.

• Example: Print dialog box displayed by the application software

Six sheets of print settings are displayed by the printer driver: Main, Page Setup, Layout,
Favorites, Utility, and Support.

Note
• The titles of dialog boxes may vary depending on the application, and sheets other than these
six sheets may be displayed.
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Important
• If you access the printer driver dialog box from the source application, changes you make to the settings
will only apply temporarily to that application. Because these are sizes you specify temporarily in the
printer driver, the sizes will not be available after you exit the application.

• You can also access the printer driver dialog box from the Windows system menu.
To use the settings continuously in all applications, open the printer driver from the system menu
to make the settings.
see “Accessing the Printer Driver Dialog Box from the Operating System Menu (Windows)”. (→P.348)
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Accessing the Printer Driver Dialog Box from the
Operating System Menu (Windows)
1. Click start > Printers and Faxes (or Printers).
2. Select the printer, and then display the printer properties dialog box.

3. Click Printing Preferences to display the Printing Preferences dialog box, titled with the
name of this printer.

Note
• The Device Settings sheet is also an extension of the printer driver. (→P.377)
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Six sheets of print settings are displayed by the printer driver: Main, Page Setup, Layout,
Favorites, Utility, and Support.

Important
• If you access the printer driver dialog box from the operating system menu, changes you make to the
settings will apply to all applications you use for printing.

• You can also access the printer driver dialog box from applications.
see “Accessing the Printer Driver Dialog Box from Applications (Windows)”. (→P.346)
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Main Sheet (Windows)
The following settings are available on the Main sheet. For details on settings items, refer to the printer driver
help le.

Note
• On the Main sheet, choose Easy Settings to specify basic print settings based on the particular printing
application, or switch to Advanced Settings to complete more detailed settings as desired.

Common Items

A Media Type
Select the type of paper.
For information on the types of paper the printer supports, refer to the Paper Reference Guide. (→P.95)

B Get Information
Displays Paper Information on Printer. You can update the printer driver settings for the feed source, media
type, and roll width by selecting the feed source.

• Paper Information on Printer Dialog Box (Windows) (→P.353)

C Advanced Settings
Displays Paper Detailed Settings. You can congure the printing settings to match the type of media, such
as the ink drying time.

• Paper Detailed Settings Dialog Box (Windows) (→P.354)

L Open Preview When Print Job Starts
If you turn this on, imagePROGRAF Preview starts before printing.
This allows you to check on-screen previews of documents before printing.

• Checking the Layout in a Preview Before Printing (→P.313)

M Status Monitor
Starts imagePROGRAF Status Monitor.
You can check the printer status, job status, and other conditions.
You can also set up email notication if printer errors occur by completing the Email Notice settings.
For details, refer to the Status Monitor help le.
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N About
Displays version information for the printer driver.

S Defaults
Restores all settings on the sheet to the default values.

Conguration using Easy Settings

E Print Target
Choose presets that match the type of document to be printed.

• Printing Photos and Images (→P.152)
• Printing Line Drawings and Text (→P.160)
• Printing Ofce Documents (→P.171)

Depending on the A Media Type setting, some E Print Target options may not be available.

F Print Quality
Choose the level of print quality.

• Giving Priority to Particular Graphic Elements and Colors for Printing (→P.187)

G View Settings
Displays the Print Target setting values.
You can view and change the order of Print Target setting values.

• View Settings Dialog Box for the Printing Application (Windows) (→P.355)
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Conguration using Advanced Settings

E Print Priority
Choose the graphic elements that you want to emphasize for printing.

• Giving Priority to Particular Graphic Elements and Colors for Printing (→P.187)

F Print Quality
Choose the level of print quality.

• Giving Priority to Particular Graphic Elements and Colors for Printing (→P.187)

G Color Mode
Choose the color mode.

• Giving Priority to Particular Graphic Elements and Colors for Printing (→P.187)
Depending on the A Media Type setting, some G Color Mode options may not be available.

H Color Settings
Click to display the Color Settings dialog box for more advanced color settings.

• Adjusting the Color in the Printer Driver (→P.177)

I Thicken Fine Lines
Activate this option to print ne lines more distinctly.

J Unidirectional Printing
Select this checkbox to prevent problems such as misaligned lines and improve the print quality. However, the
printing speed becomes slower.

K Sharpen Text
Activate this option to print text more sharply.

T Economy Printing
Select this checkbox to reduce the amount of ink consumed during printing. However, the print quality is
worse than for normal printing.
Select this mode if you want to conserve ink when checking drawings, for example. Depending on the A
Media Type and F Print Quality settings, this mode may not be available.
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Paper Information on Printer Dialog Box (Windows)
On the Paper Information on Printer dialog box, you can obtain information on the paper in the printer and
congure printer driver settings for the paper source and media type.

Note
• To display the Paper Information on Printer dialog box, on the Main sheet, click Get Information by
Media Type. (→P.350)

A Paper Source
Shows the Paper Source supported by the printer, as well as information about the loaded paper. To
update the Paper Source and media type settings in the printer driver, select the desired Paper Source
option and click OK.
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Paper Detailed Settings Dialog Box (Windows)
The Paper Detailed Settings dialog box offers the following settings. For details on settings items, refer to the
printer driver help.

Note
• To display the Paper Detailed Settings dialog box, on the Main sheet, click Settings by Media
Type. (→P.350)

A Drying Time
Specify the time that the printer waits for ink to dry, as needed. The Drying Time setting is only valid for rolls.

• (→P.127)

B Between Pages
Specify the time the printer waits after printing a page until ejecting the paper, as needed.

C Between Scans
Specify the time the printer waits after printing a line on the page until printing the next line, as needed.

D Roll Paper Margin for Safety
You can specify the length of a margin on the leading edge of paper to ensure that paper susceptible to
curling is held rmly against the Platen.

E Near End Margin
Specify the length of the Near End Margin (the leading edge margin) of the roll, as needed.

F Cut Speed
Select the speed of automatic cutting, as needed. You can adjust this setting if paper is not cut well when
automatic cutting is used.

G Mirror
Specify whether to print a mirror image, as needed. Select this option to print a version of the document or
image with the left and right sides inverted.
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View Settings Dialog Box for the Printing Application
(Windows)

In the View Settings dialog box, you can check details of the selected printing application.

Note
• To display the View Settings dialog box, on the Main sheet, click View Settings by Print Target.
(→P.350)

A Print Target
Shows all Print Target options (settings items for the printing application).

B Name
Identies the item selected in Print Target by its name and an icon.

C Details
Here, you can conrm detailed settings values for each listed item for the selected Print Target.
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Color Adjustment Sheet: Color (Windows)
If the color tone as printed is not as you expected, you can adjust it on the Color Adjustment sheet.

Note
• To display the Color Adjustment sheet, on the Main sheet, click Color Settings by Color Mode in
Advanced Settings. (→P.350)

A Sample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

B View Color Pattern
Select this checkbox to display the color pattern.

C Apply to Sample
Select this checkbox to apply the changed settings to the sample image.

D Cyan / E Magenta / F Yellow
Fine-tune color tones by adjusting the levels of each color.

G Gray Tone
Adjust the color tone of grays as desired. Choose Cool Black (tinged with blue) or Warm Black (tinged
with red).

H Brightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is
lighter or darker than the original image (that is, the original photo that was scanned or the original graphic
as it appears on the computer screen).

I Contrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the
Contrast makes images sharper, and reducing the Contrast softens images.

356 Windows Software



Printer Driver

Saturation
Adjust the color intensity as desired. Increasing the Saturation setting makes colors more vivid, and reducing
the Saturation makes colors more subdued.

K Object Adjustment
Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to
color adjustment.

S Defaults
Click to restore all settings on the sheet to the default values.

Note
• For details on settings items,see “Adjusting the Color in the Printer Driver”. (→P.177)
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Object Adjustment dialog box: Color
In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If
an original comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note
• To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment sheet.

A Image
Select this option to apply color adjustment to image areas, such as photos.

B Graphics
Select this option to apply color adjustment to graphics, such as lines and circles.

C Text
Select this option to apply color adjustment to text.
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Matching Sheet (Windows)
On the Matching sheet, you can specify color matching to compensate for differences in the appearance of
colors on various devices.

Driver Matching Mode
The following options are available when you select Driver Matching Mode in the A Matching Mode list.

Note
• To display the Matching sheet, on the Main sheet, click Color Settings by Color Mode in Advanced
Settings, and then click the Matching sheet. (→P.350)

A Matching Mode
Select the color matching mode to use, as desired.
Normally, select Driver Matching Mode. For color matching based on ICC proles, select ICC Matching
Mode, Driver ICM Mode, or Host ICM Mode, depending on your color matching system. If you prefer not to
use the printer driver for color matching, select No.

B Matching Method
Select the color matching method that suits the document to be printed. Various Matching Method options
are available depending on your selection in Matching Mode.

Note
• For details on settings items,see “Adjusting the Color in the Printer Driver”. (→P.177)
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ICC Matching Mode, Driver ICM Mode and Host ICM Mode
On the Matching sheet, you can specify color matching to compensate for differences in the appearance of
colors on various devices. The following options are available when you select ICC Matching Mode, Driver
ICM Mode, or Host ICM Mode on the A Matching Mode sheet.

Note
• To display the Matching sheet, on the Main sheet, click Color Settings by Color Mode in Advanced
Settings, and then click the Matching sheet. (→P.350)

A Matching Mode
Select the color matching mode to use, as desired.

B Input Prole Settings
You can select Image, Graphics, or Text. You can choose Matching Method and Input Prole.
Various options are available depending on your selected Matching Mode.
To apply the same input prole automatically for Graphics and Text, select Use the Same Prole for All
Objects. To apply separate input proles to Graphics and Text, clear Use the Same Prole for All Objects
and specify the individual settings.

C Printer Prole Settings
Specify the printer prole as desired. Normally, select Auto Settings.

Note
• For details on settings items,see “Adjusting the Color in the Printer Driver”. (→P.177)
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Color Adjustment Sheet: Monochrome (Windows)
On the Color Adjustment sheet for monochrome printing, you can adjust the brightness and contrast.

Note
• To display the Color Adjustment sheet, on the Main sheet, click Color Settings by Color Mode in
Advanced Settings. (→P.350)

A Sample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

B View Color Pattern
Select this checkbox to display the color pattern.

C Apply to Sample
Select this checkbox to apply the changed settings to the sample image.

D Cyan / E Magenta / F Yellow
Not available.

G Gray Tone
Not available.

H Brightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is
lighter or darker than the original image (that is, the original photo that was scanned or the original graphic
as it appears on the computer screen).

I Contrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the
Contrast makes images sharper, and reducing the Contrast softens images.
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J Saturation
Not available.

K Object Adjustment
Select this option to display theK Object Adjustment dialog box, in which you can specify objects subject to
color adjustment.

S Defaults
Click to restore all settings on the sheet to the default values.

Note
• For details on settings items,see “Adjusting the Color in the Printer Driver”. (→P.177)
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Object Adjustment dialog box: Monochrome
In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If
an original comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note
• To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment sheet.

A Image
Select this option to apply color adjustment to image areas, such as photos.

B Graphics
Select this option to apply color adjustment to graphics, such as lines and circles.

C Text
Select this option to apply color adjustment to text.
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Page Setup Sheet (Windows)
The following settings are available on the Page Setup sheet. For details on settings items, refer to the printer
driver help le.

A Page Size
Select the page size as specied in the source application.
For details on available page sizes,see “Paper Sizes”. (→P.100)

B Borderless Printing

Borderless printing is available if Roll Paper is selected in the L Paper Source list. Choose from the following
options when this setting is activated.

• Borderless Printing on Paper of Equivalent Size (→P.232)
• Borderless Printing by Resizing Originals to Fit the Roll Width (→P.239)
• Borderless Printing at Actual Size (→P.225)

D Fit Paper Size
Scales the document image to match the paper size.

E Scale to t Roll Paper Width
Scales the document image to match the roll width.

F Print Image with Actual Size
Prints documents at their actual size. This function is available when you have selected the size same as the
width of Roll Paper for either the length or width of the document from the A Page Size list.

G Paper Size
Available when D Fit Paper Size is selected.
Choose the size of the paper you will print on.
For details on available paper sizes,see “Paper Sizes”. (→P.100)
Paper sizes compatible with borderless printing are shown in the list.
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C Enlarged/Reduced Printing

Choose from the following options when this setting is activated.
• Resizing Originals to Match the Paper Size (→P.201)
• Resizing Originals to Fit the Roll Width (→P.207)
• Resizing Originals by Entering a Scaling Value (→P.213)

D Fit Paper Size
Scales the document image to match the paper size.

E Fit Roll Paper Width
Scales the document image to match the roll width.

F Scaling
Resizes the document image based on a specied scaling value. Enter a value in a range of “5-600.”

G Paper Size
Choose the size of the paper you will print on.
For details on available paper sizes,see “Paper Sizes”. (→P.100)

H Orientation
Choose the printing orientation.

• Making the Original Orientation Match the Paper Orientation (→P.321)

K Rotate Page 90 degrees (Conserve Paper)
Activate this setting to rotate the document image by 90 degrees before printing.

• Conserving Roll Paper by Rotating Originals 90 Degrees (→P.301)

L Paper Source
Choose the feed source, as desired.
Options displayed in the list vary depending on the selection in Media Type on the Main sheet.

M Roll Paper Width
Choose the roll width.
For details on available roll widths,see “Paper Sizes”. (→P.100)

N Roll Paper Options
Complete optional roll paper settings. Click to display the Roll Paper Options dialog box.

Under A Automatic Cutting, you can specify Yes or No and Print Cut Guideline.
• Cutting Roll Paper After Printing (→P.331)

Select B Banner Printing when printing multiple pages continuously.
• Printing Multiple Pages Continuously (→P.275)
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P Output Method
Click to display the Output Method dialog box, which enables you to complete the Output Method and Name
of data to be saved settings.

O Size Options
Click to display the Paper Size Options dialog box, which enables you to register additional paper sizes or
select the size system for use.

S Defaults
Restores all settings on the sheet to the default values.
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Paper Size Options Dialog Box (Windows)
In the Paper Size Options dialog box, you can create and register your own Custom Paper Size. The sizes you
dene are listed with standard paper sizes for selection later as needed.

Note
• To display the Paper Size Options dialog box, on the Page Setup sheet, click Paper Size Options.
(→P.364)

A Paper Size List
Shows the names and sizes of paper that can be used with the printer driver.

B Delete
Custom paper sizes created by users can be deleted from the A Paper Size List, as needed.
However, they cannot be deleted in the following situations.

• If a standard paper size of the printer driver is selected.
• If an oversized paper size is selected.
• If a paper size in a red box is selected.

C Custom Paper Size Name
You can name Custom Paper Size as desired.

D Units
Specify the desired unit of measure for the Custom Paper Size height and width.

E Paper Size
Specify the desired Width and Height. You can make your selection from sizes that are compatible with
Borderless Printing by selecting Borderless Printing Size. To maintain the aspect ratio of the Width and
Height as you resize the paper, select Fix the Ratio of the Width to Height.

F Add
Enables you to register the custom paper size you have specied or overwrite an existing custom paper size.
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Layout Sheet (Windows)
The following settings are available on the Layout sheet. For details on settings items, refer to the printer
driver help.

A Page Layout
Activate this setting to select a particular page layout.

• Printing Multiple Pages Per Sheet (→P.280)
• Printing Posters in Sections (→P.286)
• Printing Multiple Originals Next to Each Other (→P.269)
• Using PosterArtist to Compose Originals (→P.450)

B Set
Click to display one of the following dialog boxes depending on the selection in A Page Layout. In these
dialog boxes, you can specify layout details and which pages to print, as well as other settings.

• Page Layout Printing
• Pages to Print
• Free Layout Settings

C Watermark
Activating this option makes two settings available, Watermarks and D Edit Watermark.

• Printing With Watermarks (→P.318)

Watermarks
Lists the provided watermarks. Choose the watermark to print.

D Edit Watermark
Click to display the Edit Watermark dialog box for creating your own, original watermark.

E Print Centered
Activate this setting to print document images in the center of the paper.

• Printing Originals Centered on Rolls (→P.289)
• Printing Originals Centered on Sheets (→P.295)

F Rotate 180 degrees
Activate this option to rotate document images by 180 degrees before printing.
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G No Spaces at Top or Bottom (Conserve Paper)
Activate this setting to print the next image skipping blank areas above and below printable data in documents,
which enables you to conserve the paper.

• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (→P.307)

H Copies
Enter the number of copies to print, in a range of “1-999.”

Reverse Order
Activate this option to print pages in reverse order.

I Page Options
Click to display the Page Options dialog box, which enables you to complete settings for printing the user
name, date, or page number in the header or footer.

J Special Settings
If the printing results are not as you expected, click this option to change how printing is processed.

S Defaults
Click to restore all settings on the sheet to the default values.
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Page Options Dialog Box (Windows)
The Page Options dialog box offers the following settings.

Note
• To display the Page Options dialog box, on the Layout sheet, click Page Options. (→P.368)

A Print Date
Select where the date is printed, as desired. To print the time as well, select B Print Time Also.

C Print User Name
Select where the user name is printed, as desired.

D Print Page Number
Select where the page number is printed, as desired.

E Format Settings
Click to display the Format Settings dialog box, which enables you to complete format-related settings.

Note
• If you specify the same position for multiple items, the items are printed from left to right in this order:
date, user name, and page number.

• When you print multiple pages per sheet using Page Layout Printing or similar functions, these items
will be printed for each page.
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Special Settings Dialog Box (Windows)
If the printing results are not as you expected, you can change how printing is processed in the Special Settings
dialog box.

Note
• To display the Special Settings dialog box, on the Layout sheet, click Special Settings. (→P.368)

A FineZoom Settings
This function is used in large-format printing. Normally, choose Auto. If documents are not printed correctly
on large-format paper, it may help to select Yes, and if ne lines are not visible or if images are distorted
when printed, it may help to select No.

B Application Color Matching Priority
You can give applications priority in color management.

C Enable Preview Switching
When this option is selected, PageComposer starts if you print with Open Preview When Print Job Starts
selected on the Main sheet.

D Fast Graphic Process
If image colors are inconsistent in printed documents or if lines are printed in varying thicknesses, clearing
this option may help produce the expected results.

Important
• This function cannot be used on 64-bit version of Windows.

E Reduce Print Unevenness
If you are concerned about print unevenness, the printing results can be improved by selecting this option.
However, printing may take longer for some images.

F Adjust faint lines
If ne lines are printed in colors that do not match the colors of other shapes, clearing this option may help
produce the expected results. However, lines in some colors may appear broken.
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Favorites Sheet (Windows)
The following settings are available on the Favorites sheet. For details on settings items, refer to the printer
driver help.

A Favorites
Printing favorites you have created are listed with Default Settings favorites.

• Using Favorites (→P.327)

B Settings Details
Displays details of the favorite selected in the A Favorites.

C Comment
Displays notes registered in the favorite.

D Apply Favorite
Click to change the current print settings to those of the favorite selected in the A Favorites.

E Application Settings Priority
Activate this setting to use settings values specied in the source application in preference to favorite settings
selected in the A Favorites, when clicking D Apply Favorite. For details on the settings items used in
preference, refer to the printer driver help.

F Delete
Click to delete the selected favorite from the A Favorites list.

G Edit
Click to display the Edit dialog box, which enables you to change the name and icon for the favorite selected
in the A Favorites list.
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H Add
Click to display the Add dialog box, which enables you to add the current print settings as a favorite.

I Import
Click to display the Open dialog box, which enables you to import favorite settings saved as a le.

J Export
Click to display the Save As dialog box, which enables you to save the favorite settings as a le.

K Up
Click to move the selected favorite up in the A Favorites list.

L Down
Click to move the selected favorite down in the A Favorites list.
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Utility Sheet (Windows)
The following items can be executed on the Utility sheet. For details on the utilities, refer to the relevant utility help.

A Maintenance
Click to start the imagePROGRAF Status Monitor, which offers the following maintenance for the printer.

• Nozzle (ink ejecting outlet) check
• Nozzle (ink ejecting outlet) cleaning
• Head alignment adjustment
• Feed amount adjustment

B Color imageRUNNER Enlargement Copy
Click to launch Color imageRUNNER Enlargement Copy (*1) (iR enlargement copy), which enables you to
create hot folders used for Color imageRUNNER Enlargement Copy and assign print settings to hot folders.

• Printing Enlargements of Scanned Originals from a Color imageRUNNER (Windows) (→P.432)
*1: For details, see Color imageRUNNER Enlargement Copy.
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Support Sheet (Windows)
On the Support sheet, you can view support information and the user’s manual.

A Support Information
Click to access the Canon support webpage, where you can nd the latest information on the printer and
consumables, check for printer driver updates, and browse other information.

B User Manual
Click to view the printer user’s manual. This function requires the user’s manual to be installed on your
computer.

C Settings Summaries
Click to display the View Settings dialog box, which enables you to conrm the settings for the Main, Page
Setup, Layout, and Favorites sheets.
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Settings Summaries Dialog Box (Windows)
The Settings Summaries dialog box enables you to conrm the settings for the Main, Page Setup, Layout,
and Favorites sheets.

A Copy
Click to copy the settings information to the clipboard. You can paste the settings information into a le
created with a text editor or similar application.
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Device Settings Sheet (Windows)
Many settings items on the printer properties sheets are controlled by Windows applications. However, the Device
Settings sheet is for conguring the printer, and it is an extension of the printer driver.

The following settings are available on the Device Settings sheet.

A Color Compatibility
Click to display the Color Compatibility dialog box, which enables you to adjust colors if you have selected
Color Mode > Color (CAD).

• For details on color settings, see Specifying Colors and Printing CAD Drawings. (→P.167)

B About
You can display version information for the printer driver.
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Preview

The Features of Preview
The main features of Preview are as follows.

• While viewing this screen, you can adjust layout settings of a document created with application software.
• You can not only adjust layout settings but also your changes will be instantly applied on the preview
screen, and you can print the preview screen as it is seen.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual
print output to differ from the Preview settings.

Operating Environment
You can use the Preview in the following environments.

• Compatible Operating System
Windows 2000/XP/Server 2003/Vista/Server 2008

• Software that requires installation
imagePROGRAF Printer Driver
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Starting Preview
Follow the procedure below to start the Preview.

1. Start the apllication software which you use.
2. From the application software’s File menu, select the printer setup menu to open the Print

dialog box.

Note
• Normally, select Print from the File menu.

3. On the Main sheet, click on the Open Preview When Print Job Starts check box.
Click the OK button to save the settings.

4. On the Print dialog box in the apllication software, click the Print button.
5. Preview main window is displayed.
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Preview Main Window
The Preview main window consists of the menu and tool bars, preview and dialog area and status bar.

Note
• You can use the View menu to show or hide the tool bar.

Menu Bar
This allows you to select menus required for operations.

Tool Bar
This allows you to select tool buttons required for major operations.
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Preview Area
You can check the settings you made in this area.

Dialog Area
This allows you to set the print conditions and perform a print job.
For more information about Dialog Area, see “Dialog Area”. (→P.382)

Status Bar
This shows the message, Pages and Output Size.
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Dialog Area
You can select the layout and print on the center.

Media Type / Paper Source /Paper Size
You can conrm the information that is set.

Layout Selection
You can print which conserves paper by selecting the layout.
For more information about Layout Selection, see “Printing with Selecting the Layout”. (→P.387)

Center Originals Across Roll
You can print on the center of the media loaded in the printer.
For more information about Center Originals Across Roll, see “Print on the Center”. (→P.384)

Note
• You cannot select this if Cut Sheet is selected in Paper Source.

“No Spaces at Top or Bottom”
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at
the top or bottom.
For more information about “No Spaces at Top or Bottom”, see “Not Print Spaces at the Top/Bottom”. (→P.385)

Note
• Available only if rolls are selected in Paper Source.

“Print” Button
Click the button to start printing.

“Cancel” Button
Click the button to stop printing.
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Printer Information
You can conrm the information acquired from the printer.

Update Printer Information Button
Click the button to update the printer information with connecting to the printer.

Status Monitor Button
Click the button to start Status Monitor.
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Print on the Center
You can print on the center of the media loaded in the printer.

1. Click the Center Originals Across Roll check box on.

2. Click the “Print” button
Printing on the center begins.

Note
• You cannot select this if Cut Sheet is selected in Paper Source.
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Not Print Spaces at the Top/Bottom
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the
top or bottom.

1. Click the “No Spaces at Top or Bottom” check box on.

2. Click the “Print” button.
Printing on the settings with no spaces at top or bottom begins.
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Priority setting for rotating 90 degrees
You can select Rotate 90 Degrees If Possible or Use Driver Settings from the Options menu.

Setting Details

Rotate 90 Degrees If Possible Rotates pages in portrait orientation 90 degrees before printing. Pages are
only rotated if they can t lengthwise across the roll.

Use Driver Settings Follows printer driver settings when determining whether to rotate pages.

Selecting Rotate 90 Degrees If Possible or Placing a checkmark for Rotate Page 90 degrees (Conserve
Paper) on the printer driver

Selecting Use Driver Settings
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Printing with Selecting the Layout
You can print which conserves paper by selecting the layout.

1. In Layout Selection, click the layout button to use.

Button Details

Upper Button

Turn at the position of .

Right Button

Turn at the position of .

Left Button

Turn at the position of .

Lower Button

Turn at the position of .
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Note
• Right Button or Left Button can be selected only when the rotated pages can t lengthwise
across the roll.

• By clicking Right Button or Left Button, you can save paper by printing in landscape orientation on
roll paper.

• You can select only Upper Button or Lower Button if Cut Sheet is selected.

Button Details

The button is selected currently.

The button can be selected.

The button can not be selected.

2. Click the Start Printing button.
Printing on the selected layout begins.
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Enlarge/Reduce the screen display
You can enlarge or reduce the screen display when you select Zoom from the View menu.

Setting Details

Fit Screen Display all.

Fit to Width Display to the width of the paper.

Reduce Display at half of the standard size.

Standard Display at the standard size.

Enlarge Display with the double of the standard size.

Enlarge More Display with the triple of the standard size.

Note
• You can also select the setting by clicking the ▼ button on the tool bar.

Moving a Page
You can move a page to display when you select Go to Page from the View menu.

Setting Details

First Page Go to the rst page.

Previous Page Go to the previous page.

Next Page Go to the next page.

Last Page Go to the last page.

Go to Page Go to the specied page.

Note

• You can also move a page by clicking on the tool bar.

Using the ruler
You can conrm the layout with using the ruler.

• Switching the ruler Show/Hide
In the View menu, select Ruler to switch the ruler Show/Hide.

• Changing the ruler unit
You can set the ruler unit when you select Units from the View menu.

Setting Details

mm Use mm as the ruler unit.

inch Use inches as the ruler unit.
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Free Layout

The Features of Free Layout
The main features of Free Layout are as follows.

• Allows you to lay out at will and print a document created with application software.
• You can not only lay out multiple pages on one page but also lay out and print a multiple-le document
on one page, or lay out and print a document created with multiple application programs on one page.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print
output to differ from the Free Layout settings.

Operating Environment
You can use the Free Layout in the following environments.

• Compatible Operating System
Windows 2000/XP/Server 2003/Vista/Server 2008

• Software that requires installation
imagePROGRAF Printer Driver

Note
• This function is not available on 64-bit version of Windows.
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Starting Free Layout
Follow the procedure below to start the Free Layout.

1. Start the apllication software which you use.
2. From the application software’s “File” menu, select the printer setup menu to open the “Print”

dialog box.

Note
• Normally, select “Print” from the “File” menu.

3. From the list, select the printer and select the “Layout” sheet.

Note
• Your printer is depicted in the lower-left area of this screen.

4. In the “Layout” sheet, click on the “Page Layout” check box and select “Free Layout” from the list.
Click the “OK” button to save the settings.

Note
• When you select “Free Layout”, all other setting items will be disabled.
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5. On the Print dialog box in the apllication software, click the Print button.
Free Layout main window is displayed.
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Free Layout Main Window
The Free Layout main window consists of the menu and tool bars, layout area and status bar.

Note
• You can use the “View” menu to show or hide the tool and status bar.

Menu Bar
This allows you to select menus required for operations.

Tool Bar
This allows you to select tool buttons required for major operations.

Layout Area
This allows you to lay out objects and edit the object size and orientation.
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Status Bar
This shows the paper size, unit of length, and number of objects.

Detailed Settings
The printer driver opens when you select “Detailed Settings” from the “File” menu. The printer driver is used to
congure basic settings to match the type of media loaded in the printer.

Refer to Printer Driver for details on the printer driver.

Note
• When you select the “Detailed Settings”, the only three sheets displayed are the “Main” sheet, the “Page
Setup” sheet, and the “Layout” sheet. Some of the printer driver settings may be disabled.
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Preferences Dialog Box
This dialog box appears when you select “Preferences” from the “File” menu. This allows you to congure
the preferences of Free Layout.

“Units”
Set the unit for paper length, margins, and so on.

“Gridlines”
You can input a grid line width value in numerical characters so that they serve as a guide to laying out objects.

Note
• You can input between 10.0 and 200.0(mm) (between 0.39 and 7.88(inch)).
• You can change the numbers by clicking either “▲” button or “▼” button.

“Divisions”
You can change the number of divisions of grid lines so that they serve as a guide to laying out objects.

Note
• You can input between 1 and 10.
• You can change the numbers by clicking either “▲” button or “▼” button.

“Grid Color”
Select the grid line color.

Auto Arrange Spacing
Change the object-to-object spacing to be applied in the operation of laying out objects automatically.

Note
• You can input between 0.0 and 100.0(mm) (between 0.00 and 3.94(inch)).
• You can change the numbers by clicking either “▲” button or “▼” button.
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“Object Frame Style”
You can select the object frame style for printing.
The following settings are available for the object frame style.

Setting Details

“None” You can print with no frame style.

“Solid Line” You can print the solid line as the frame style.

“Dotted Line” You can print the dotted line as the frame style.

“Dashed Line” You can print the dashed line as the frame style.

“Crop Marks” You can print with the crop marks.
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Page Options Dialog Box
This dialog box appears when you select “Page Options” from the “File” menu. This allows you to congure the roll
paper length, object layout order, and margins of Free Layout.

“Roll Paper Length”
Set the length of one page to print on roll paper.
The following settings are available for roll paper length.

Setting Details

“Auto Settings” The one-page length to be printed on roll paper is automatically set so that
the laid-out objects are printed on one page.

“Manual Settings” You can input the length of one page to print on roll paper in numerical
characters.

Note
• Available only if rolls are selected in Paper Source.
• You can input between 203.2 and 18000.0(mm) (between 8.00 and 708.66(inch)).
• You can change the numbers by clicking either “▲” button or “▼” button.

“Order”
Set the object layout order.
The following settings are available for order.

Setting Details

“Upper Left to Right” The objects are laid out from upper left to right.

“Upper Left to Bottom” The objects are laid out from upper left to bottom.

“Upper Right to Left” The objects are laid out from upper right to left.

“Lower Left to Top” The objects are laid out from lower left to top.

Note
• When you have selected “Roll Paper Length” > “Auto Settings” and “Paper Orientation” > “Vertical”, you
can choose “Upper Left to Right” or “Upper Right to Left”.

• When you have selected “Roll Paper Length” > “Auto Settings” and “Paper Orientation” > “Horizontal”,
you can choose “Upper Left to Bottom” or “Lower Left to Top”.
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“Margins”
You can input the paper margins in numerical characters.

Note
• You can input between 0.0 and 50.0(mm) (between 0.00 and 1.97(inch)).
• You can change the numbers by clicking either “▲” button or “▼” button.

Zoom Dialog Box
This dialog box appears when you select “Zoom” from the “View” menu. You can enlarge or reduce the screen
display.

Scaling
Set the magnication for enlargement or reduction of the screen display.

Note
• You can input between 25 and 400.
• You can change the numbers by clicking “▼” button.
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Format Dialog Box
This dialog box appears when you select “Format” from the “Object” menu after you select an object.

“Size” Sheet
You can rotate, enlarge, or reduce an object.

Note
• When the objects are not selected, you can not select “Format”.

“Rotate”
When you place a checkmark here, you can select “Rotate Right” or “Rotate Left”.

Setting Details

“Rotate Right” Rotates the object 90 degrees clockwise.

“Rotate Left” Rotates the object 90 degrees counterclockwise.

Note
• When several objects are selected, you cannot select “Rotate”.

“Enl./Red.”
When you place a checkmark here, you can select “Scaling”, “Fit Paper Size”, or “Fit Photo Size”.

Setting Details

“Scaling” Allows you to input the value of the enlargement or reduction ratio of an
object.

“Fit Paper Size” Prints by enlarging or reducing each object to match the paper size. If you
are using roll paper, objects are enlarged or reduced so that the width of
each object matches the width of the roll paper.

“Fit Photo Size” Prints all of the objects at the specied photo size.

Note
• You can input between 25 and 600.
• You can change the numbers by clicking either “▲” button or “▼” button.
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“Position” Sheet
You can rotate, enlarge, or reduce an object.

Note
• When the objects are not selected, you can not select “Format”.

“Object Position”
You can move the object position by changing the values.

Setting Details

“Vertical Pos” You can input the number of the vertical position in numerical characters.

“Horizontal Pos” You can input the number of the horizontal position in numerical characters.

“Page Pos” You can input the number of the page position in numerical characters.

“Object Size”
You can conrm the object size.

Note
• When several objects are selected, you cannot display “Object Size”.
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Laying out a Multiple-File Document on One Page
You can lay out and print a multiple-le document on one page.

1. From the application software’s “File” menu, select the printer setup menu to open the “Print”
dialog box.

Note
• Normally, select “Print” from the “File” menu.

2. Click “Properties” to open the “Properties” dialog box.

3. In the “Page Setup” sheet, select Paper Source.
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4. In the “Layout” sheet, click on the “Page Layout” check box and select “Free Layout” from the list.

Note
• When you select “Free Layout”, all other setting items will be disabled.

5. Click the “OK” button to save the settings.
6. In the “Print” dialog box, select the pages to print and the number of copies, and click the “OK”

button.
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Free Layout starts, laying out the document created with application software in the layout
area as an object.

7. Leaving Free Layout running, open other les with the application software and repeat the
above steps.
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Laying out a Document Created with Multiple Application
Programs on One Page

You can lay out and print a document created with multiple application programs on one page.

1. From the application software’s “File” menu, select the printer setup menu to open the “Print”
dialog box.

Note
• Normally, select “Print” from the “File” menu.

2. Click “Properties” to open the “Properties” dialog box.

3. In the “Page Setup” sheet, select Paper Source.
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4. In the “Layout” sheet, click on the “Page Layout” check box and select “Free Layout” from the list.

Note
• When you select “Free Layout”, all other setting items will be disabled.

5. Click the “OK” button to save the settings.
6. In the “Print” dialog box, select the pages to print and the number of copies, and click the “OK”

button.
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Free Layout starts, laying out the document created with application software in the layout
area as an object.

7. Leaving Free Layout running, open other les with other application software and repeat the
above steps.
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Selecting an Object
When an object is selected, a select box (blue border) appears around the object.

Note
• To select an object, click that object.
• To select multiple successive objects, click them while holding down the Shift key.
• To select multiple arbitrary objects, click them while holding down the Ctrl key.
• To select all objects, select “Select All” from the “Edit” menu.

When you specify the area with dragging the mouse, the object in the area is selected.
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Changing the Object Size
You can change the object size by means of mouse operation or by specifying a scaling value.

Note
• The vertical-to-horizontal ratio remains unchanged when the object is enlarged or reduced.

Resizing by means of mouse operation
1. Select an object.
2. Place the pointer at a corner of the selection box around the object to show the arrow handle,

and drag this handle to change the object size.

Resizing by specifying a scaling value
1. Select an object.

Click on the “Enl./Red.” checkbox in the Format Dialog Box (→P.399) and select “Scaling”.
2. You either enter numbers directly.

Note
• You can input between 25 and 600.
• You can change the numbers by clicking either “▲” button or “▼” button.

3. Click the “OK” button.
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Moving an Object
You can move the object position.

1. Select an object.
2. Place the pointer inside the selection box of the object to show the crosshair handle, and drag it

to move the object.
Alternatively, you can move the “Object Position” by changing the values in “Vertical Pos”,
“Horizontal Pos” and “Page Pos” in the Format Dialog Box. (→P.399)

Rotating an Object
You can rotate the object.

1. Select an object.
2. Select “Rotate Left 90 Degrees” or “Rotate Right 90 Degrees” from the toolbar.

Alternatively, you may click on the “Rotate” check box in the Format Dialog Box (→P.399) then
select “Rotate Right” or “Rotate Left”, and click the “OK” button.
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Laying out Objects Automatically
Click “Auto Arrange Object” in the tool bar. This automatically lays out objects. Alternatively, you may select “Auto
Arrange Object” from the “Object” menu.

Note
• The object layout order varies depending on the “Order” setting in the Page Options Dialog Box
(→P.397) dialog box.
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Aligning Objects
You can align objects systematically.

1. Select multiple objects.
2. Click the align button from the toolbar.

Alternatively, you may select the align menu from the “Object” menu.

“Align Top”
Lays out the objects, justifying them to the top.

“Center Vertically”
Lays out the objects, justifying them to the vertical center.

“Align Bottom”
Lays out the objects, justifying them to the bottom.
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“Align Left”
Lays out the objects, justifying them to the left.

“Center Horizontally”
Lays out the objects, justifying them to the horizontal center.

“Align Right”
Lays out the objects, justifying them to the right.
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Changing the Object Overlapping Order
You can change the object overlapping order.

1. Select an object.
2. Select the Overlapping Order menu from the “Object” menu.

Note
• The order of overlapping affects the order of objects automatically laid out.
• You can also select by clicking the right button of the mouse on an object.

“Bring to Front”
Moves the object to the frontmost position.

“Send to Back”
Moves the object to the backmost position.

“Bring Forward”
Moves the object one position to the front.
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“Send Backward”
Moves the object one position to the back.
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Pasting a Copied or Cut Object
1. Click “Copy” or “Cut” from the toolbar.

Alternatively, you may select “Copy” or “Cut” from the “Edit” menu.
2. Click “Paste” from the toolbar.

Alternatively, you may select “Paste” from the “Edit” menu.

Note
• The copied or cut object is laid out at the end of the page.
• You can also select by clicking the right button of the mouse on an object.
• In order to paste an object on any position that you like, you can paste the object with “Pointed Paste” by
clicking the right button of the mouse on any position that you want.
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Folded Duplex Window
This window is displayed if you select “Folded Duplex” from the “Edit” menu after selecting an object. Using the
“Folded Duplex” function allows you to print with fold lines added.

The Folded Duplex window consists of the menu and tool bars, layout area and status bar.

Note
• The toolbar and status bar can be toggled between hidden and displayed from the “View” menu.

Menu Bar
This allows you to select menus required for operations.

Tool Bar
This allows you to select tool buttons required for major operations.

416 Windows Software



Free Layout

Layout Area
This allows you to check the arrangement and orientation of objects.

Status Bar
This shows the paper source, roll paper width, and output size.
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Prints using Folded Duplex
Allows you to produce duplex printing by combining two pages and folding them.

“Folded Duplex”
Any two pages can be arranged and printed in a layout that becomes duplex on folding.
This can be used such as for advertising posters that are suspended from the ceiling.

1. Select two objects from the layout area of Free Layout.
2. Select Folded Duplex from the “Edit” menu of Free Layout.

Open the Folded Duplex window and arrange the selected objects in the layout area.
3. Open the “Finished Size Settings” dialog box from the “Edit” menu.
4. Select “Fit Roll Paper Width” or “Specify Folded Size” in “Finished Size”.

Note
• “Rotate Page 90 degrees (Conserve Paper)” is also available when “Specify Folded Size” is selected.

5. Click “OK” to save the settings.
6. Open the “Binding Settings” dialog box from the “Edit” menu.
7. Select “Bottom” or “Top” in “Binding Edge”.
8. Specify the “Binding” width in “Binding”.
9. Congure the Fold Line Color and Fold Line Type from Print Fold Lines.

Note
• When the Only Print Center and Edges checkbox is selected, fold lines are only printed at the
three locations of the center and both edges.

10. Click “OK” to save the settings.
11. Conrm the print setting and begin printing.
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Finished Size Settings Dialog Box
This dialog box is displayed when you select “Finished Size Settings” from the “Edit” menu. This allows you to
congure nished size settings.

“Finished Size”
Selects the method for setting the nished size.
The following settings are available for the nished size.

Setting Details

“Fit Roll Paper Width” Prints by automatically enlarging or reducing the entire document so that
the width of the document matches the roll paper width.

“Specify Folded Size” Prints by automatically enlarging or reducing the entire document to match
the size of the paper. Select the actual size of the paper you want to print
on in “Fit Paper Size”.

“Rotate Page 90 degrees
(Conserve Paper)”

Prints by rotating pages by 90 degrees. Pages are automatically rotated if
they will t within the roll paper width when rotated, and are not rotated if
they will not t within the roll paper width.
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Binding Settings Dialog Box
This is displayed when you select “Binding Settings” from the “Edit” menu. This allows you to congure the
binding edge settings.

“Binding Edge”
Congures the binding edge when folding paper.
The following settings are available for the binding edge.

Setting Details

“Bottom” Prints by placing the binding margin (gutter) at the bottom of the document.

“Top” Prints by placing the binding margin (gutter) at the top of the document.

“Binding”
Congures the binding margin (gutter).
Prints by creating a binding margin (gutter) of the specied size. Enter the margin size as a number.

Note
• The values that can be entered are 0 to 50 (mm).

“Print Fold Lines”
Congures the color and type of fold lines.

Note
• To not print fold lines, clear the “Print Fold Lines” checkbox.

“Fold Line Color”
You can select the fold lines.

“Fold Line Type”
You can select the fold lines.
The following settings are available for the fold line type.

Setting Details

“Solid Line” You can print the solid line as the frame style.

“Dotted Line” You can print the dotted line as the frame style.

“Dashed Line” You can print the dashed line as the frame style.

“Only Print Center and Edges”
To print fold lines at the center and both edges, select the Only Print Center and Edges checkbox.
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Color imageRUNNER Enlargement Copy

The Features of Color imageRUNNER Enlargement Copy
The main features of Color imageRUNNER Enlargement Copy are as follows.

• Allows the document scanned with the Color imageRUNNER to be automatically enlarged and printed.
• You can perform basic printer settings such as printer selection, media type and output prole selection,
and matching methods, in addition to borderless printing and enlargement/reduction process without
growing through the printer driver.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print
output to differ from the Color imageRUNNER Enlargement Copy settings.

Operating Environment
You can use the Color imageRUNNER Enlargement Copy in the following environments.

• Compatible Operating System
Windows 2000/XP/Server 2003/Vista/Server 2008

• Software that requires installation
imagePROGRAF Printer Driver

Note
• This function is not available on 64-bit version of Windows.
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Starting Color imageRUNNER Enlargement Copy
Follow the procedure below to start the Color imageRUNNER Enlargement Copy.

To start by selecting “Printers and Faxes” from the “start” button
1. From the Windows “start” button, select “Printers and Faxes” to open the “Printers and Faxes”

dialog box.
2. Right-click the Printers icon and select “Print Settings” to open the “Printing Preferences”

dialog box.
In the “Utility” sheet, click the “Color imageRUNNER Enlargement Copy” button.

3. The “Color imageRUNNER Enlargement Copy” dialog box displays.

Note
• If you click on the “Add to Startup folder” check box in the “Color imageRUNNER Enlargement Copy”
dialog box, the icon of Color imageRUNNER Enlargement Copy utility will appear on the task bar when
starting Windows thereafter.
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To start by selecting “imageRUNNER Enlargement Copy” from the
“start” button
1. From the Windows “start” button, select “Color imageRUNNER Enlargement Copy”.

2. The “Color imageRUNNER Enlargement Copy” dialog box displays.
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Color imageRUNNER Enlargement Copy Dialog Box
The explanation below is on the “Color imageRUNNER Enlargement Copy” dialog box.

Note
• For the step to open the “Color imageRUNNER Enlargement Copy” dialog box, see “Starting Color
imageRUNNER Enlargement Copy”. (→P.422)

“Hot Folder”
The hot folder list appears.

“Add” Button
Click the button to open the “Easy Setup Wizard” dialog box so that you can add a hot folder.

“Edit” Button
From the “Hot Folder” list, select a hot folder and click the button to open the “Add/Edit Hot Folder” dialog
box that allows you to edit the hot folder.

“Delete” Button
From the “Hot Folder” list, select a hot folder and click the button to delete the hot folder.

“Start” Button
Clicking the button changes the status of the selected “inactive” Hot Folder to “active”.

“Stop” Button
Clicking the button changes the status of the selected “active” Hot Folder to “inactive”.

“Add to Startup folder”
Register the application in the Windows startup menu.

“Save Printed Data”
Automatically saves printed data.

“About” Button
Click the button to display the name and the version number of the utility.

“Operation Guide” Button
Click the button to display the “Color imageRUNNER Enlargement Copy Setup Manual”.
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Hot Folder
Hot folder refers to a folder used for Color imageRUNNER Enlargement Copy.

• When transferred to the PC’s hot folder, the document data scanned with the Color imageRUNNER is
printed in enlarged size from the printer according to the print conditions set in the hot folder.

• You can create a new hot folder, edit or delete an existing one, and set print conditions at will.

Note
• You can create up to 20 hot folders.
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Creating a New Hot Folder
1. Open the “Color imageRUNNER Enlargement Copy” dialog box, and then click the “Add” button.

Note
• For the step to open the “Color imageRUNNER Enlargement Copy” dialog box, see “Starting Color
imageRUNNER Enlargement Copy”. (→P.422)

2. The “Easy Setup Wizard” dialog box displays.
Click the “Next” button.

3. Select the type of printer to use.
Click the “Next” button.
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4. Select the media type to print.

Note
• If the “Borderless Printing” checkbox is checked, only media types that can be used for borderless
printing are displayed in the list.

Click the “Next” button.

5. Select roll paper or cut sheet to print. Also, select the media size to print.
Click the “Next” button.

6. Select the color matching method.
Click the “Next” button.
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7. To receive a document scanned with the Color imageRUNNER, you need to share a folder.
Enter the folder shared name in Shared Name.
Click the “Next” button.

Note
• This shared name is used as the name of the hot folder.
• You cannot use the “Back” button, after clicking the “Next” button here.

8. Click “Finish” button to close the “Easy Setup Wizard” dialog box.

The hot folder you have created appears in the “Hot Folder” list in the “Color imageRUNNER
Enlargement Copy” dialog box.

428 Windows Software



Color imageRUNNER Enlargement Copy

Specifying an Existing Shared Folder as a Hot Folder
1. Share the folder you want to specify as a hot folder.
2. Open the “Color imageRUNNER Enlargement Copy” dialog box, and then click the “Add” button.

Note
• For the step to open the “Color imageRUNNER Enlargement Copy” dialog box, see “Starting Color
imageRUNNER Enlargement Copy”. (→P.422)

3. The “Easy Setup Wizard” dialog box displays.
Click the “Manual Settings” button.

4. The “Add/Edit Hot Folder” dialog box displays.
Enter the hot folder name in “Name”.
Click the “Browse” botton, with selecting “Specify a folder”, to set the existing shared folder.
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5. The location of the folders will appear.
Select the folder to specify a hot folder, and click the “OK” button.

6. As necessary, set the print conditions in the hot folder. (→P.431)
Click the “OK” button to close the “Add/Edit Hot Folder” dialog box.

The hot folder you have created appears in the “Hot Folder” list in the “Color imageRUNNER
Enlargement Copy” dialog box.
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Setting the Print Parameters
The printer driver opens when you click the “Properties” button in the “Add/Edit Hot Folder” dialog box. The printer
driver is used to congure basic settings to match the type of media loaded in the printer.

Refer to Printer Driver for details on the printer driver.

Note
• The only three sheets displayed are the “Main” sheet, the “Page Setup” sheet, and the “Layout” sheet.
Some of the printer driver settings may be disabled.

“Apply Sharpness”
Place a checkmark here to set the sharpness.
Drag the slider bar to the left or right to adjust. You can also adjust by directly entering a number in the
numeric input eld.

Note
• You can input between 0 and 500.
• You can change the numbers by clicking either “▲” button or “▼” button.
• You cannot be applied to PDF les.
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Printing Enlargements of Scanned Originals from a Color
imageRUNNER (Windows)

Scanned originals from a Color imageRUNNER can be enlarged and printed automatically.

Originals you create by scanning with a Color imageRUNNER are transferred to a "hot folder" and printed
automatically after enlargement according to printing conditions you specify for that folder.
This processing sequence is called the Color imageRUNNER Enlargement Copy function.
To use Color imageRUNNER Enlargement Copy, rst complete these settings in the following order.
1. Register a hot folder on your computer.

Register a hot folder on your computer for storing scanned originals from the Color imageRUNNER
and complete the settings for enlargement copy.

2. Complete the scanning settings on the Color imageRUNNER.
Congure the Color imageRUNNER to send scanned originals to the hot folder.

After these settings are complete, you can print enlarged copies of scanned originals from the Color
imageRUNNER.

Registering a hot folder on your computer
Folders used for Color imageRUNNER Enlargement Copy (iR enlargement copy) are called hot folders.
Register a hot folder on your computer for storing scanned originals from the Color imageRUNNER. You can
specify printing conditions (such as the image quality and paper size), based on which originals transferred to
the hot folder will be printed. Follow these steps to register and modify hot folders.

1. Display the printer driver dialog box. (→P.348)
2. Click the Utility tab to display the Utility sheet.

3. Click Color imageRUNNER Enlargement Copy to start the Color imageRUNNER Enlargement
Copy utility.

4. Use the Color imageRUNNER Enlargement Copy utility to register or modify hot folders.
For instructions on registering and modifying hot folders, refer to the help le for the Color
imageRUNNER Enlargement Copy utility.
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Completing the scanning settings on the Color imageRUNNER.
Congure the Color imageRUNNER to send scanned originals to the hot folder. It is easy to send scanned
originals to the hot folder if you assign the scanning settings and destination to a Favorites button on the
Color imageRUNNER.
For instructions on assigning scanning settings and destinations to a Favorites button, refer to the setting
manual, displayed by clicking Color imageRUNNER Enlargement Copy Setup Manual button of Color
imageRUNNER Enlargement Copy utility, or refer to the Color imageRUNNER manual.

Scanning the original and print an enlargement
Follow the steps below to scan an original on the Color imageRUNNER for enlarged printing on the printer.
For detailed instructions, refer to the Color imageRUNNER manual.

1. Load the original on the platen glass or document feeder of the Color imageRUNNER.
2. Press Send to display the screen for transmission.
3. Press Favorites, and then press the Favorites button assigned to the hot folder.
4. Press Start on the control panel. If you scan originals on the platen glass, after scanning all

originals, press Done on the touch-panel display.
Scanned originals are sent to the hot folder and automatically enlarged and printed following the
conditions you specied for the folder.

Note
• For details on Color imageRUNNER Enlargement Copy, refer to Color imageRUNNER Enlargement
Copy.
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Status Monitor

The Features of imagePROGRAF Status Monitor
imagePROGRAF Status Monitor is a utility for checking the printer status and managing print jobs.

Two screens are available in imagePROGRAF Status Monitor : “Printer List” shows a list of printers, and
“Status Monitor” shows details for each printer.

• You can view a list of the printers for which printer drivers have been installed on your computer, printers
connected to your computer, and printers found on the network.

• If a printer error occurs, you can investigate the corrective action immediately.
• Images of Ink Tanks are shown, with different images for various types of ink. An icon and warning
message will notify you when ink levels are low.

• The type of paper loaded in each media source is identied. You can also check to see if paper has
run out.

• This way, the utility enables you to check printer information and take care of printer maintenance
for optimal printing results.

• You can also set up automatic email notication of any printer problems or errors to email addresses you
designate in advance.

• You can use the Accounting Manager to collect the print job logs for the printers and check information
such as the printing costs.
For details of the Accounting Manager, see Accounting Manager. (→P.437)
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Note
• For details, refer to the imagePROGRAF Status Monitor help.
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Job Management Using imagePROGRAF Status Monitor
You can use the “Job” sheet in imagePROGRAF Status Monitor for operations such as pausing and canceling
print jobs.

Preempting Other Jobs
If you select a print job and click the “Preempt” button, the selected job is printed ahead of the job that
currently precedes it in the print queue.

Pausing/Resuming Print Jobs
Selecting a print job and clicking the “Pause” button pauses printing of the selected job.
To resume printing of a paused print job, select the print job and click the “Resume” button.

Note
• Once all the print data for a print job has been sent to the printer, the job can no longer be
paused/resumed.

Canceling Print Jobs
Selecting a print job and clicking the “Cancel Job” button cancels printing of the selected job.

Note
• You cannot cancel other users’ print jobs.

Printing Held Jobs
Printing of the job with a “Status” of “Holding” is paused because the paper specied by the driver does
not match the paper currently loaded in the printer.
Use the procedure below to print the held job.

1. Select the held job and click the “Replace Paper” button.
2. Replace the paper in the printer with the correct paper.

Note
• To continue printing without changing the paper in the printer, select the held job and click “Continue
to print” button.
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Accounting

Accounting Manager
The Accounting Manager stores the printer’s print job logs so that you can use the information for checking
printing costs, etc.

The benets of using the Accounting Manager are outlined below.
• Print Job Log Collection
This allows you to check which documents were printed from each printer, who printed them and when.

• Calculation of the Total Pages Used and the Total Cost
This allows you to use the collected print job logs to calculate totals for items such as the number of
pages printed, the amount of paper used and the printing costs incurred.

• Regular Data Acquisition for Print Jobs
This automatically logs print jobs at regular intervals.

• Exporting Print Job Data
This allows you to export collected print job data as a CSV le.

Important
• The Accounting Manager in Status Monitor displays approximate estimates of the amount of paper
consumed and the ink consumed per printed page. Canon cannot guarantee the accuracy of these
estimates. These estimates will also vary depending on the conditions of printer use.

Launching the Accounting Manager
The procedure for launching the Accounting Manager is shown below.

1. Open the imagePROGRAF Status Monitor window.
2. Select “Accounting” in the “Accounting” menu.

Or, open the “Accounting” sheet and click the “Accounting” button.
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Accounting Manager Main Window
The Accounting Manager main window consists of a title bar, menu bar, toolbars, listed job selection area, job list
area, totals area and status bar.

Title Bar
This displays the printer model, its serial number and the port number it is using.

Menu Bar
Allows you to select the menu options required for operation.

Toolbars
Provide tool buttons and pull-down menus for the main operations.

Note
• You can opt to either show or hide the toolbars in the “View” menu.
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Listed Job Selection Area
You can use this area to select which job log is displayed.
If you are using regular data acquisition, this area allows you to view the collective job logs for each specied
period.

For more information on how to select the job logs displayed, see Switching Between Displaying Jobs on
Printer and Regularly Acquired Jobs. (→P.447)

Job List Area
This area lists the details of acquired jobs.
It displays a list of either the print jobs on the printers or the regularly acquired print jobs. The displayed
information includes the amounts of paper and ink consumed, the costs, the media type and the time taken
for printing.
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Totals Area
Displays the total costs for the selected job and the amounts of paper and ink consumed.

Note
• If you are viewing regularly acquired print jobs, selecting a period on the left side of the window displays
the total costs for that period and the amounts of paper and ink consumed.

Status Bar
Displays messages and other information.
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Accounting Manager Basic Procedures
The rst time you use the Accounting Manager, use the following procedures to congure the settings.

1. Congure unit costs, including the costs of ink and paper.
For details of the unit cost settings, see Conguring Unit Costs in Accounting Manager. (→P.441)

2. Set options such as the units displayed.
For details of the unit settings, see Conguring Units and Display Settings in Accounting
Manager. (→P.445)

3. If you are using Regular Data Acquisition, congure the Regular Data Acquisition settings.
For details of the Regular Data Acquisition settings, see Automatically Acquiring Print Job Logs
at Regular Intervals. (→P.446)

4. Specify the jobs to be listed.
For details of how to select the job logs displayed, see Switching Between Displaying Jobs on
Printer and Regularly Acquired Jobs. (→P.447)

This displays the required print job logs and lists the details.

Conguring Unit Costs in Accounting Manager
Select “Unit Costs” in the “Settings” menu to open the “Unit Costs” dialog box. Congure the unit cost settings
in this dialog box.

Note
• When you select a job and then open the “Unit Costs” dialog box, items with unit costs that have not yet
been congured for that job are shown highlighted.

• Setting the Unit Cost for Ink (→P.442)
• Setting the Unit Cost for Paper (→P.443)
• Setting the Unit Cost for Items Other Than Ink and Paper (→P.444)
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Setting the Unit Cost for Ink
Open the “Ink” sheet. Set the unit cost for ink in this sheet.

To set the same unit cost for all the inks
1. Select the “Use same price for all ink” checkbox.
2. Enter the “Tank Capacity” and “Price”.
3. Click the “OK” button.

Important
• Your settings are not applied until you click the “OK” button.

To set different unit costs for each ink color
1. Select the ink color to be costed.
2. Enter the “Tank Capacity” and “Price”.
3. Click the “Overwrite” button.
4. Repeat steps 1 to 3 for all the inks.
5. Click the “OK” button.

Important
• Your settings are not applied until you click the “OK” button.
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Setting the Unit Cost for Paper
Open the “Paper” sheet. Set the unit cost for paper in this sheet.

1. Select a media type from the “Media Type” list.
2. Enter the “Width”, “Length” and “Price”.
3. Click the “Add” button. To change the unit cost for a media type you have already set, click

the “Overwrite” button.
4. Click the “OK” button.

Important
• Your settings are not applied until you click the “OK” button.
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Setting the Unit Cost for Items Other Than Ink and Paper
Open the “Other” sheet. Use this sheet to set any price for items other than inks and paper.

1. Enter any name in the “Name” eld.
2. Enter a value in “Unit Cost”.
3. Use “Allocated” to specify whether the costs are allocated as being incurred by the print job.
4. Click the “Add” button. To change the unit cost for a media type you have already set, click

the “Overwrite” button.
5. Click the “OK” button.

Note
• You can set unit costs for up to 5 items.

Important
• Your settings are not applied until you click the “OK” button.
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Conguring Units and Display Settings in Accounting
Manager

Select “Units and Display” in the “Settings” menu to open the “Units and Display” dialog box. Use this dialog box to
congure the display settings.

“Date Display Format”
Use this option to select the display format for dates. "YYYY" indicates the year, "MM" the month and "DD"
the day.

“Currency Unit”
Enter the currency unit. Enter a text string up to 3 characters long.

“1000 Separator”
Use this option to select the symbol used as a separator in numbers. The symbol is inserted every 3 digits.

“Decimal Symbol”
Use this option to select the symbol used as a decimal point.

“Ink Consumed”
Use this option to select the unit used for ink consumption.

“Paper Width”
Use this to select the unit used for paper width.

“Paper Length”
Use this to select the unit used for paper length.

“Area Display Format”
Use this to select the unit used for paper area.
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Automatically Acquiring Print Job Logs at Regular
Intervals

This feature collects print job logs from the printer at regular intervals and saves the logs on your computer.

1. Select “Regular Data Acquisition” in the “Settings” menu.
2. Select “Acquire print job logs regularly”.
3. Click the “OK” button to close the dialog box.

Note
• Immediately after you congure Regular Data Acquisition, no print jobs are displayed. Wait a few
moments and then select “Refresh” in the “View” menu to display the print jobs.

• A maximum of 10,000 records are saved in a print job log. If this number is exceeded, jobs are deleted
from the log starting from the oldest record. To save old data, it is recommended that you export
the data as a CSV le.
For details of how to export print job logs as CSV les, see Exporting Print Job Data as a CSV File.
(→P.447)

Canceling Regular Print Job Log Acquisition
You can use this procedure to cancel the regular acquisition of print job logs from printers.

1. Select “Regular Data Acquisition” in the “Settings” menu.
2. Uncheck the “Acquire print job logs regularly” option.
3. Click the “OK” button to close the dialog box.
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Switching Between Displaying Jobs on Printer and
Regularly Acquired Jobs

The print job logs displayed by the Status Monitor Accounting Manager contain two types of job: Jobs on Printer
and Regularly Acquired Jobs.

You can select whether to display Jobs on Printer or Regularly Acquired Jobs in the Listed Job Selection Area
on the left side of the window.

“Jobs on Printer”
This shows a list of the print jobs currently held on printers.
You can change the number of jobs displayed per page using the “Print Jobs Shown Per Page” setting in
the “View” menu or the toolbar.
You can skip to a particular page using the “Go to” option in the “View” menu or the toolbar.

Note
• For printers with built-in hard disks, you can view up to 500 print jobs per printer.
• For printers without built-in hard disks, you can view up to 32 print jobs per printer. However, only 10
jobs can be displayed if the printer is switched off.

“Regularly Acquired Jobs”
This shows a list of regularly acquired print jobs.
To view all the jobs in a set period, specify the period using “Period” and then “Starting Date” (or “Starting
Day of Week” or “Starting Month”) in the “View” menu or the toolbar.
For example, to view monthly job logs starting on the 1st of each month, set “Period” to “Monthly” and set
“Starting Date” to “1”.

Note
• Up to 10,000 regularly acquired jobs are displayed for each printer.

Exporting Print Job Data as a CSV File
You can export the collected print job data in the form of a CSV le by selecting “Export Job Cost Data” in the
“File” menu.

Note
• You can also select “Export Job Cost Data” using the icon in the toolbar.

“Selected Jobs”
Exports the data for the selected print jobs in the job list as a CSV le.

Note
• You can select multiple jobs by holding down the Shift key or Ctrl key as you click the job names.

“Listed Jobs”
Exports the data for the print jobs currently displayed in the list as a CSV le.
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Showing Job Properties
If you select a job in the job list and then select “Show Job Properties” in the “File” menu, the “Job Properties”
dialog box appears, allowing you to check information such as detailed cost data.

You can copy text-based information in this dialog box to the clipboard by clicking the “Copy” button.

Note
• You can also open this dialog box by right-clicking the selected job and selecting “Show Job Properties”.
Or you can also use the toolbar icon to open the dialog box.

• If you select multiple jobs and open the “Job Properties” dialog box, the total costs for the selected
jobs are displayed.

Showing, Saving and Loading Selected Unit Cost Data
“Show Unit Cost Data”
Select “Show Unit Cost Data” in the “File” menu to open the “Unit Cost Data” dialog box. This lists the unit
costs for items such as the selected ink and paper.
You can copy text-based information in this dialog box to the clipboard by clicking the “Copy” button.

“Save Unit Cost Data”
Select a destination folder using “Save Unit Cost Data” in the “File” menu. The unit cost data for items such
as the selected ink and paper is saved as a le.

“Load Unit Cost Data”
Selecting “Load Unit Cost Data” in the “File” menu loads saved unit cost data.

Showing the Total Amount of Ink and Paper Consumed
Select “Show Ink and Paper Consumed” in the “File” menu to open the “Show Ink and Paper Consumed”
dialog box.

This lists the total amounts of ink and paper consumed by the printer so far.
You can copy text-based information in this dialog box to the clipboard by clicking the “Copy” button.

Note
• Up to 7 types of media are listed in order of the amount consumed. The total consumption for other
media types is shown as “Other”.
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Digital Photo Front-Access

Digital Photo Front-Access
Digital Photo Front-Access is an application that links photos from Canon digital cameras and other image
les on your computer with various other applications.

• Simply select an image and click the icon of the application you want to start to launch the application.
• You can also print from Digital Photo Front-Access. In short, Digital Photo Front-Access can help you
manage images in many ways from editing to printing as an effective way to work with other applications.

• Digital Photo Front-Access also enables image retouching. For automatic retouching, select an image
for retouching and click Image Adjustment.

• Because this application automates the workow from retouching to display for all of your images, it
can save time and work in retouching.

Note
• For details, refer to the Digital Photo Front-Access help.
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Using PosterArtist to Compose Originals

Using PosterArtist to Compose Originals
You can print a variety of source documents from word-processing or spreadsheet programs or screen shots from
web browsers after composing an original with them using PosterArtist.

This topic describes how to use PosterArtist to compose originals from multiple applications, creating a
poster layout for printing.

Important
• This function is only supported in Windows.
• PosterArtist (sold separately) must be installed to use this function.

1. Choose “Print” in the application menu.
2. Select the printer in the dialog box, and then open the printer driver dialog box. (→P.346)
3. Make sure the Main sheet is displayed.

4. Click the Layout tab to display the Layout sheet.
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5. Select the A Page Layout check box.
6. Click in the Edit Using PosterArtist in the A Page Layout list.
7. When you attempt to print, PosterArtist starts up and the PageCapture window is displayed. (At

this point, the document will not be printed yet.)

8. Choose the page to load in PosterArtist.
9. Edit and rearrange the image in the PosterArtist window as desired.

Important
• Without closing the PosterArtist window, repeat steps 1-8 to arrange originals from multiple
applications on the same page.

Note
• For instructions on editing and rearranging images, refer to the PosterArtist Manual.

10. Print from the PosterArtist menu.
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Device Setup Utility

imagePROGRAF Device Setup Utility
imagePROGRAF Device Setup Utility is a utility to establish communication between the printer and
your computer by completing relevant settings. After the printer is installed, for example, you can use
imagePROGRAF Device Setup Utility to complete the network settings initially.

• Starting imagePROGRAF Device Setup Utility will show a list of printers found on the network. In this
list, select the printer (specically, the printer’s MAC address) that you want to set up, and then congure
the basic settings from your computer, such as the printer’s IP address and the network frame type.

• You can see which printers are online in the network by checking the printer list. Communication
between your computer and these printers is possible.

Note
• We recommend that your network or printer administrator complete the setup work using
imagePROGRAF Device Setup Utility.

• For details, refer to the imagePROGRAF Device Setup Utility help.

Installing imagePROGRAF Device Setup Utility
Install imagePROGRAF Device Setup Utility from the User Software CD-ROM provided with the printer
as follows:

Important
• In Windows 2000/Windows XP/Windows Server 2003/Windows Vista/Windows Server 2008, you must
log on with administrative rights equivalent to the “Administrator” account.

1. Insert the User Software CD-ROM in the CD-ROM drive.
2. On the Setup Menu window, click Install Individual Software.
3. Click Install in imagePROGRAF Device Setup Utility.
4. Follow the instructions on the screen to proceed with the installation.
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Conguring the IP Address Using imagePROGRAF
Device Setup Utility
On a computer running Windows, you can use imagePROGRAF Device Setup Utility provided with the
printer to congure the printer’s IP address. This topic describes how to congure the IP address using
imagePROGRAF Device Setup Utility.

Important
• To congure network settings, you must be logged in with administrative rights such as “Administrator”
account. We recommend that your network administrator congure the network settings.

• For instructions on installing imagePROGRAF Device Setup Utility, see “Installing imagePROGRAF
Device Setup Utility”. (→P.452)

When specifying an IPv4 IP address
1. Start imagePROGRAF Device Setup Utility from the start menu.
2. In the Device Name list displayed, select the printer to congure.
3. Choose Protocol Settings from the Printer menu.
4. Select the IPv4 tab.
5. In the Setting IP Address list, choose Manual.
6. Enter the IP address assigned to the printer and click the Set button.
7. Click OK after the Conrmation message is displayed.
8. Exit imagePROGRAF Device Setup Utility.

Note
• To congure the IP address automatically, choose Auto in the Setting IP Address list and select
DHCP, BOOTP, or RARP.

• You can also specify the subnet mask and default gateway.

When specifying an IPv6 IP address
1. Start imagePROGRAF Device Setup Utility from the start menu.
2. In the Device Name list displayed, select the printer to congure.
3. Choose Protocol Settings from the Printer menu.
4. Select the IPv6 tab.
5. In IPv6, select On.
6. When there is an IPv6-compatible router in the network environment, select On in Stateless

Address.
Additionally, when there is an DHCPv6-compatible server in the network environment, select
On in DHCPv6.

Note
• When there is no IPv6-compatible router or DHCPv6-compatible server, select On in Manual and
enter the IPv6 Address and Prex Length.

7. Click Set.
8. Click OK after the Conrmation message is displayed.
9. Exit imagePROGRAF Device Setup Utility.
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Mac OS X Software

Printer Driver

Printer Driver Settings (Mac OS X)
For instructions on accessing the Mac OS X printer driver, refer to the following topics.

• Accessing the Printer Driver Dialog Box from Applications (Mac OS X) (→P.460)

For information on the Mac OS X printer driver settings, refer to the following topics.
• Main Pane (Mac OS X) (→P.461)
You can specify the media type, color processing, print quality, print preview, and other settings. Choose
Easy Settings to specify basic print settings based on the printing application or Advanced Settings
to complete more detailed settings as desired.

• Paper Detailed Settings Dialog Box (Mac OS X) (→P.465)
• View settings Dialog Box for the Printing Application (Mac OS X) (→P.466)
• Color Settings Pane: Color (Mac OS X) (→P.467)
• Color Settings Pane: Monochrome (Mac OS X) (→P.469)

• Page Setup Pane (Mac OS X) (→P.471)
You can specify the page size of the original, borderless printing, enlargement or reduction, the
orientation, the paper size and source, and automatic cutting.

• Utility Pane (Mac OS X) (→P.473)
You can specify settings related to maintenance for the Printhead and feed amount, as well as settings
for Color imageRUNNER Enlargement Copy.

• Additional Settings Pane (Mac OS X) (→P.474)
You can specify settings for how print jobs are sent to the printer.

• Support Pane (Mac OS X) (→P.475)
You can view support information and the user’s manual.

With the imagePROGRAF Free Layout feature, you can arrange originals from various source applications
on a single page before printing. For details, see Free Layout.
With the imagePROGRAF Preview feature, you can check the layout before printing and adjust layout or
size settings while viewing a preview screen. For details, see Preview.
With the Color imageRUNNER Enlargement Copy feature, you can automatically enlarge and print scanned
originals from a Color imageRUNNER. For details, see Color imageRUNNER Enlargement Copy.
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Specifying Paper in the Printer Driver (Mac OS X)
If you have replaced the paper, you must complete the following settings in the printer driver.

1. This sets the B Format for and C Paper Size.

Note
• The conguration method varies depending on the OS and application software you are using.
If Page Setup is displayed in the application menu, the settings are congured by opening the
Page Attributes dialog box from Page Setup.

If it is not displayed, the settings are congured in the upper part of the printer driver displayed when
you select Print from the application software menu.

2. Select the printer in the A Printer list.
3. Choose the original size in the F Paper Size list.
4. If you congured the settings using the Page Attributes dialog box, click F OK to close the

dialog box, and then select Print from the application software menu.
5. Access the Main pane.

6. In the A Media Type list, select the type of paper that is loaded.
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7. Access the Page Setup pane.

8. In the A Paper Source list, select how paper is supplied.
9. If you have selected Manual in A Paper Source, make sure the size as selected in Page Setup

is displayed in C Page Size. If you have selected Roll Paper in A Paper Source, make sure
the width of the loaded roll is displayed in B Roll Width.

Note
• If the width of the roll loaded in the printer is not shown in B Roll Width, click L Printer Information
on the Main pane to update the printer information.

Note
• A variety of settings are available in the printer driver to suit different printing applications.
For details on available printing conditions, see “Printer Driver Settings (Mac OS X)”. (→P.454)
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Conrming Print Settings (Mac OS X)
There are two ways to conrm what printing conditions have been specied, as follows.

• Checking a preview of the settings
• Checking a print preview

Checking a preview of the settings
A preview of the settings is displayed on the left side of the Main, Page Setup, Utility, and Additional
Settings panes.By checking images and numerical values in the preview, you can conrm current settings for
the page size, orientation, paper source, and so on.

Display Area Information Displayed

Pane displayed when the H
Images tab is clicked

On top, illustrations indicate the page size of the original, the paper size,
orientation, layout, borderless printing selection, color mode, and other
settings information.
Under this, the page size, paper size, and method and percentage of
enlargement or reduction is displayed.

Pane displayed when the I
Size tab is clicked

Paper size details are indicated numerically.

Pane with printer and paper
illustrations

Illustrations indicate the paper source, orientation, borderless printing
selection, and other settings information.

Note
• To conrm the Print Target specied in Easy Settings, click G View set. on the Main pane to display
the View settings dialog box.
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Checking a print preview
You can check an image of the original just as it will be printed.
Conrming the image of print jobs beforehand helps prevent printing errors.
For details on print previews,see “Checking the Layout in a Preview Before Printing”. (→P.313)
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Checking the Layout in a Preview Before Printing (Mac
OS X)

This topic describes how to check the layout before printing using the Canon imagePROGRAF Preview function.

1. Choose Print in the application menu.
2. Access the Main pane.

3. Select the O Print Preview check box.
4. Click M Print.
5. The Canon imagePROGRAF Preview window is displayed.

6. Check the layout and adjust settings in the Canon imagePROGRAF Preview window as desired.
7. Print from the Canon imagePROGRAF Preview menu.

Note
• For details on imagePROGRAF Preview functions, refer to Preview.
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Using Favorites (Mac OS X)
You can use the Presets function in Mac OS X for favorite-based printing.

Note
• In the printing dialog box, click Save As in the Presets list to save the current print settings. This is a
standard feature of the operating system. For details, refer to the Mac OS documentation.

Accessing the Printer Driver Dialog Box from
Applications (Mac OS X)
1. In the application software, select Print from the File menu to display the dialog box for printing

conditions.

Note
• This dialog box includes basic printing options and enables you to choose the printer, specify the
range of pages, number of copies, and so on.

2. Select the printer in the Printer list.

3. Click Print to start printing.
As shown in the following illustration, you can switch to other panes in this dialog box to complete
settings for various methods of printing, including enlarged and reduced printing, borderless
printing, and so on.
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Main Pane (Mac OS X)
The following settings are available on the Main pane. For details on settings items, refer to the printer driver help.

Note
• On the Main pane, choose Easy Settings to specify basic print settings based on the print target, or
switch to Advanced Settings to complete more detailed settings as desired.

Common Items

A Media Type
Select the paper type.
For information on the types of paper the printer supports, refer to the Paper Reference Guide. (→P.95)

B Get Information
Displays Paper Information on Printer. You can update the printer driver settings for the feed source, media
type, and roll width by selecting the feed source.

• Paper Information on Printer Dialog Box (Mac OS X) (→P.464)

C Set
Displays Paper Detailed Settings. You can congure the printing settings to match the type of media, such
as the ink drying time.

• Paper Detailed Settings Dialog Box (Mac OS X) (→P.465)

O Print Preview
If you turn this on, imagePROGRAF Preview starts before printing.
This allows you to check on-screen previews of documents before printing.

Important
• This cannot be selected if Free Layout is enabled in the Page Setup panel.

• Checking the Layout in a Preview Before Printing (→P.313)

L Printer
Displays Printer. You can display printer information such as the remaining ink levels.
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Conguration using Easy Settings

E Print Target
Choose presets that match the type of document to be printed.

• Printing Photos and Images (→P.152)
• Printing Line Drawings and Text (→P.160)
• Printing Ofce Documents (→P.171)

F Print Quality
Choose the level of print quality.

G View set.
Click to display the View settings dialog box, which enables you to conrm the settings for the selected item
from the E Print Target list or change the order of items listed in E Print Target.
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Conguration using Advanced Settings

E Print Priority
Choose the graphic elements that you want to emphasize for printing.

• Giving Priority to Particular Graphic Elements and Colors for Printing (→P.187)

F Print Quality
Choose the level of print quality.

• Giving Priority to Particular Graphic Elements and Colors for Printing (→P.187)

H Color Mode
Choose the color mode.

• Giving Priority to Particular Graphic Elements and Colors for Printing (→P.187)

I Set
Click to display the Color Settings dialog box for more advanced color settings.

• Adjusting the Color in the Printer Driver (→P.177)

J Unidirectional Printing
Select this checkbox to prevent problems such as misaligned lines and improve the print quality. However, the
printing speed becomes slower.

Q Thicken Fine Lines
Activate this option to print ne lines more distinctly.

P Sharpen Text
Activate this option to print text more sharply.

K Reduce Print Unevenness
Select this checkbox for two-pass printing to reduce color shading.
This option is displayed if you have selected Plain Paper in Media Type and Ofce Document in Print
Priority.

N Economy Printing
Select this checkbox to reduce the amount of ink consumed during printing. However, the print quality is
worse than for normal printing.
Select this mode if you want to conserve ink when checking drawings, for example. Depending on the Media
Type and Print Quality settings, this mode may not be available.
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Paper Information on Printer Dialog Box (Mac OS X)
On the Paper Information on Printer dialog box, you can obtain information on the paper in the printer and
congure printer driver media type setting.

Note
• To display the Paper Information on Printer dialog box, on the Main pane, click Get Information by
Media Type. (→P.461)

A Paper Source
Shows the Paper Source supported by the printer, as well as the type of paper loaded. To update the media
type setting in the printer driver, select the desired Paper Source option and click OK.

464 Mac OS X Software



Printer Driver

Paper Detailed Settings Dialog Box (Mac OS X)
The Paper Detailed Settings dialog box offers the following settings. For details on settings items, refer to the
printer driver help.

Note
• To display the Paper Detailed Settings dialog box, on the Main pane, click Set by Media Type.
(→P.461)

A Media Type
Select the paper type.
For information on the types of paper the printer supports, refer to the Paper Reference Guide. (→P.95)

B Drying Time
Specify the time that the printer waits for ink to dry, as needed. The Drying Time setting is only valid for rolls.

• (→P.127)

C Between Pages
Specify the time the printer waits after printing a page until ejecting the paper, as needed.

D Between Scans
Specify the time the printer waits after printing a line on the page until printing the next line, as needed.

E Roll Paper Margin for Safety
You can specify the length of a margin on the leading edge of paper to ensure that paper susceptible to
curling is held rmly against the Platen.

F Near End Margin
Specify the length of the Near End Margin (the leading edge margin) of the roll, as needed.

G Cut Speed
Select the speed of automatic cutting, as needed. You can adjust this setting if paper is not cut well when
automatic cutting is used.

H Automatic Cutting
You can activate or deactivate automatic cutting and printing of cut lines, as desired. In this list, specify
Printer Default, None, or Print Cut Guideline.
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J Mirror
Specify whether to print a mirror image, as needed. Select this option to print a version of the document or
image with the left and right sides inverted.

View settings Dialog Box for the Printing Application
(Mac OS X)

In the View settings dialog box, you can check details of the selected printing application.

Note
• To display the View settings dialog box, on the Main pane, click View settings by Print Target.
(→P.461)

A Print Target
Shows all Print Target options (settings items for the printing application).

B Name
Identies the item selected in Print Target by its name and an icon.

C Details
Here, you can conrm detailed settings values for each item selected in the Print Target list.
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Color Settings Pane: Color (Mac OS X)
In general, make any needed adjustments to the color of documents in the application used to create them.
However, if the color tone as printed is not as you expected, you can also adjust the color in the printer driver.

Color Adjustment pane: color
If the color tone as printed is not as you expected, you can adjust it on the Color Adjustment pane.

Note
• To display the Color Adjustment pane, on the Main pane click Color Settings by Color Mode in
Advanced Settings. (→P.461)

A Sample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

B View Color Pattern
Select this checkbox to display the color pattern.

C Apply to Sample
Select this checkbox to apply the changed settings to the sample image.

D Cyan / E Magenta / F Yellow
Correct color tones by adjusting the levels of each color.

G Gray Tone
Adjust the color tone of grays as desired. Choose Cool (tinged with blue) orWarm (tinged with red).

H Brightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is
lighter or darker than the original image (that is, the original photo that was scanned or the original graphic
as it appears on the computer screen).

I Contrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the
Contrast makes images sharper, and reducing the Contrast softens images.
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J Saturation
Adjust the color intensity as desired. Increasing the Saturation setting makes colors more vivid, and reducing
the Saturation makes colors more subdued.

Note
• For details on settings items,see “Adjusting the Color in the Printer Driver”. (→P.177)

K Object Adjustment
Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to
color adjustment.

Matching pane
On the Matching pane, you can specify color matching to compensate for differences in the appearance
of colors on various devices.

Note
• To display the Matching pane, on the Main pane click Color Settings by Color Mode in Advanced
Settings, and then click Matching. (→P.461)

A Matching Mode
Select the color matching mode to use, as desired.

B Matching Method
Select the matching method that suits the document to be printed. Various Matching Method options are
available depending on your selection in Matching Mode.

Note
• For details on settings items,see “Adjusting the Color in the Printer Driver”. (→P.177)
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Color Settings Pane: Monochrome (Mac OS X)
The following settings are available on the Color Settings pane for monochrome printing.

Color Adjustment pane: Monochrome
On the Color Adjustment pane for monochrome printing, you can adjust the brightness and contrast.

Note
• To display the Color Adjustment pane, on the Main pane, click Color Settings in Advanced Settings.
(→P.461)

A Sample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

B View Color Pattern
Select this checkbox to display the color pattern.

C Apply to Sample
Select this checkbox to apply the changed settings to the sample image.

D Cyan / E Magenta / F Yellow
Not available.

G Gray Tone
Not available.

H Brightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is
lighter or darker than the original image (that is, the original photo that was scanned or the original graphic
as it appears on the computer screen).

I Contrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the I
Contrast makes images sharper, and reducing the I Contrast softens images.
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J Saturation
Not available.

Note
• For details on settings items,see “Adjusting the Color in the Printer Driver”. (→P.177)

K Object Adjustment
Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to
color adjustment.

470 Mac OS X Software



Printer Driver

Page Setup Pane (Mac OS X)
The following settings are available on the Page Setup pane. For details on settings items, refer to the printer
driver help.

A Paper Source
Choose how paper is supplied.
Options displayed in the list vary depending on the selection in A Media Type in the Main pane.

B Roll Width
Displays the paper width of the roll loaded in the printer. Unknown is displayed if the printer cannot detect the
roll paper width.

C Page Size
Displays the size of the original, as specied in the page settings of the application.
For details on page sizes available in the application.see “Paper Sizes”. (→P.100)

D Enlarged/Reduced Printing
Select this checkbox to choose the following options.

• Resizing Originals to Match the Paper Size (→P.201)
• Resizing Originals to Fit the Roll Width (→P.207)
• Resizing Originals by Entering a Scaling Value (→P.213)

E Fit Paper Size
Resizes the document image to match the paper size.

F Fit Roll Paper Width
Resizes the document image to match the roll width.

G Scaling
Resizes the document image based on a specied scaling value. Enter a value in a range of “5-600.”

H Borderless Printing
Borderless printing is available if Roll Paper is selected in the A Paper Source list.
Activate this setting for borderless printing to match the size and width of the paper.

• Borderless Printing on Paper of Equivalent Size (→P.232)
• Borderless Printing by Resizing Originals to Fit the Roll Width (→P.239)
• Borderless Printing at Actual Size (→P.225)
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I Paper Size
Choose the size of the paper you will print on.
Click Display all selections for Paper Size to list available sizes.
For details on available paper sizes,see “Paper Sizes”. (→P.100)

J Print Centered
Select this checkbox to print document images in the center of the paper.

• Printing Originals Centered on Rolls (→P.289)
• Printing Originals Centered on Sheets (→P.295)

K No Spaces at Top or Bottom
Select this checkbox to print the next image skipping blank areas above and below printable data in
documents, which enables you to conserve the paper.

• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (→P.307)

L Rotate Page 90 degrees
Select this checkbox to rotate the document image by 90 degrees before printing.

• Conserving Roll Paper by Rotating Originals 90 Degrees (→P.301)

N Free Layout
Select this checkbox to start imagePROGRAF Free Layout before printing.
This allows you to print multiple documents next to each other.

Important
• This cannot be selected if Print Preview is enabled in the Main panel.

• Printing Multiple Originals Next to Each Other (→P.269)

472 Mac OS X Software



Printer Driver

Utility Pane (Mac OS X)
The following settings are available on the Utility pane.

A Set
Click to display the Printer dialog box, which offers the following maintenance for the printer.

• Nozzle (ink ejecting outlet) cleaning
• Head alignment adjustment
• Feed amount adjustment

B View
Click to start imagePROGRAF Printmonitor, which enables you to view the status of print jobs.

C Set
Click to complete the settings for Color imageRUNNER Enlargement Copy (iR enlargement copy).
*1: For details, see Color imageRUNNER Enlargement Copy.
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Additional Settings Pane (Mac OS X)
The following settings are available on the Additional Settings pane.

A Data Send Method
Choose how print data is sent to the printer.

• B Send Print Data Immediately to Printer
• C Send All Print Data as Batch to Printer

474 Mac OS X Software



Printer Driver

Support Pane (Mac OS X)
On the Support pane, you can view support information and the user’s manual.

A Support Information
Click to access the Canon support webpage, where you can nd the latest information on the printer and
consumables, check for printer driver updates, and browse other information.

B User Manual
Click to view the printer user’s manual. This function requires the user’s manual to be installed on your
computer.

C Settings
The settings can be saved as a le. Click to display the Export dialog box, which enables you to specify
where to save the le.

D About
You can display version information for the printer driver.
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Preview

The Features of Preview
The main features of Preview are as follows.

• While viewing this screen, you can adjust layout settings of a document created with application software.
• You can not only adjust layout settings but also your changes will be instantly applied on the preview
screen, and you can print the preview screen as it is seen.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual
print output to differ from the Preview settings.

Operating Environment
You can use the Preview in the following environments.

• Compatible Operating System
Mac OS X (10.3.9 to 10.5)

• Software that requires installation
imagePROGRAF Printer Driver
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Starting Preview
Follow the procedure below to start the Preview.

1. Start the apllication software which you use.
2. From the application software’s “File” menu, select the printer setup menu to open the “Print”

dialog box.

Note
• Normally, select “Print” from the “File” menu.

3. Click “Print Preview” in the “Main” panel to attach a checkmark.
4. Click the “Print” button in the “Print” dialog box.

5. Preview main window is displayed.
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Preview Main Window
The Preview main window consists of the menu and tool bars, and preview, dialog , drawer and status area.

Note
• You can use the “View” menu to show or hide the tool bar.

Menu Bar
This allows you to select menus required for operations.

Tool Bar
This allows you to select tool buttons required for major operations.

Preview Area
You can check the settings you made in this area.
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Dialog Area
This allows you to set the print conditions and perform a print job.

Drawer Area
This allows you to display the thumbnails of a document.

This area appears when you click “Drawer” from the tool bar.
Alternatively, you may select “Drawer” from the “View” menu.

Status Area
This shows “Input Size” and “Output Size”.
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Paper Settings Panel
This panel appears when you select Paper Settings in the dialog area.

“Media Type”
This allows you to select the media type.

Note
• Always select media type that is actually set in the printer. When the media you chose is different from
the media set in the printer, you may not receive the desired print results.

“Easy Settings” / “Advanced Settings”
Two modes are available to provide the optimum print settings for jobs.
The settings available on each mode are as follows.

• Easy Settings (→P.482)
• Advanced Settings (→P.484)

Paper Source
You can select the paper source.
The following settings are available for paper source.

Setting Details

“Manual” Select for manual paper feed printing.

“Roll Paper” Select to print on roll paper.

“Roll Paper Width”
This selects the width of the roll media set to the printer.

Note
• Available only if rolls are selected in Paper Source.
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“Copies”
You can input the number of print copies in numerical characters.

Note
• The maximum value is 999.
• You can change the numbers by clicking either “▲” button or “▼” button.

“Restore Defaults” Button
Click the button to reset to the setting when starting Preview.

“Print” Button
Click the button to begin printing.

“Update Printer Info.” Button
Click the button to acquire printer information.
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Easy Settings
You can easily select the best settings for the print job by just selecting an item from the print target list that
matches the content of the document.

“Print Target”
You can easily select the best settings for the print job simply.
If you select each “Print Target” item the corresponding comment for that item is displayed below the list.

Setting Details

“Default Settings” Suitable for printing normal documents that contain a mixture of text,
photographs, and graphics.

“Ofce Document” Suitable for printing handouts as well as general ofce documents for
which print clarity is key.

“Poster” The best setting for posters.Prints using vivid and high impact colors.

“CAD (Color Line Drawing)” Prints the ne lines of CAD drawings and other such documents sharp
and clear.

CAD (B/W Line Drawing) Suitable for printing CAD drawings with sharp, dark lines.

“Perspective, GIS” Suitable for attractive printing of 3D-CAD drawings, perspective drawings,
and GIS drawings including maps.

“Photo (Color)” Suitable for printing photographic images captured with a digital camera.

“Faithful Color Reproduction” Prints by faithfully reproducing the colors of the original image.

“Custom Settings” Suitable for printing documents for which Advanced Settings have been
specied.

Note
• The number of settings available for selection depends on the media type.
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“Print Quality”
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
The level of the print quality and resolution settings are displayed in the following combinations.

Setting Details

Print Quality “Highest” / “High” / “Standard” / “Draft”

Resolution “1200dpi” / “600dpi” / “300dpi”

Note
• The availability of settings is determined by the media type and print priority selections.
• Printing time is longer and more ink is consumed with High than with Draft, however, print quality is
higher.

• Printing time is shorter and less ink is consumed with Draft than with High, however, print quality is lower.
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Advanced Settings
Presents detailed settings for the print quality, the color mode, and other items so you can select the values for
these settings yourself.

“Print Priority”
Select a print quality mode that is appropriate for the print job.

Setting Details

“Image” This mode achieves the best results for printing photographic images and
illustrations.

“Line Drawing” This mode is best for printing CAD drawings with ne lines or wall
newssheet or other documents that contain large amounts of text.
However, you may not achieve the quality you expect with printing
photographs or other images with many lled areas. For these types of
jobs, select “Image”.

“Ofce Document” Prints common ofce documents, such as proposals, memos for
distribution, etc., so they are easy to read.

Note
• The number of settings available for selection depends on the media type.

“Print Quality”
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
The level of the print quality and resolution settings are displayed in the following combinations.

Setting Details

Print Quality “Highest” / “High” / “Standard” / “Draft”

Resolution “1200dpi” / “600dpi” / “300dpi”

Note
• The availability of settings is determined by the media type and print priority selections.
• Printing time is longer and more ink is consumed with High than with Draft, however, print quality is
higher.

• Printing time is shorter and less ink is consumed with Draft than with High, however, print quality is lower.
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Output Settings Panel
This panel appears when you select Output Settings in the dialog area.

“Enlarged/Reduced Printing”
Select the method for enlarged/reduced printing.
The following settings are available for enlarged/reduced printing.

Setting Details

Fit Paper Size Enlarges/reduces the whole page automatically to t the media size
selected for output. Select the media size to print from Paper Size.

“Fit Roll Paper Width” Enlarges/reduces the whole page automatically to t the width of the roll
paper with the page width.
*Make sure that the width of the roll paper in the printer is set correctly for
“Roll Paper Width” in the Paper Settings panel.
*Displayed only if rolls are selected in Paper Source.

Scaling Enlarges/reduces the whole page by the scaling rate as specied. Input the
scaling value in numerical characters. You can specify a range between 5
and 600%.
*You can change the numbers by clicking either “▲” button or “▼” button.
*Although Scaling can be set to make the image larger than the media
size, the part that does not t in the media cannot be printed.
*This is not displayed when a checkmark is placed in “Borderless Printing”.

“Borderless Printing”
You can print the media without margins on all sides when the roll paper with the specic width and the
specic media type is used.
For more information about “Borderless Printing”, see “Print with No Borders”. (→P.496)

Note
• Available only if rolls are selected in Paper Source.
• This is not displayed when a checkmark is placed in “Print Centered”.
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Paper Size
You can select the size of the print media.

Note
• This is not displayed when “Fit Roll Paper Width” is set in “Enlarged/Reduced Printing”.

“Print Centered”
You can print on the center of the media loaded in the printer.
For more information about “Print Centered”, see “Print on the Center”. (→P.497)

Note
• This is not displayed when a checkmark is placed in “Borderless Printing”.

“No Spaces at Top or Bottom”
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at
the top or bottom.
For more information about “No Spaces at Top or Bottom”, see “Not Print Spaces at the Top/Bottom”. (→P.498)

Note
• Available only if rolls are selected in Paper Source.

“Rotate Page”
Select the method for rotating page.
The following settings are available for rotating page.

Setting Details

“Rotate Right 90 Degrees” Rotates the portrait page right 90 degrees and print in landscape
orientation. When the rotated page can t in the width of roll paper, the
page is rotated automatically, and when it can not t in the width of roll
paper, the page is not rotated.

“Rotate Left 90 Degrees” Rotates the portrait page left 90 degrees and print in landscape orientation.
When the rotated page can t in the width of roll paper, the page is rotated
automatically, and when it can not t in the width of roll paper, the page is
not rotated.

“Rotate 180 degrees” Allows you to rotate the image 180 degrees from the vertical to the right.

“Restore Defaults” Button
Click the button to reset to the setting when starting Preview.

“Print” Button
Click the button to begin printing.

“Update Printer Info.” Button
Click the button to acquire printer information.
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Color Settings Panel
This panel appears when you select Color Settings in the dialog area.

“Color Mode”
You can select a color mode to suit the print job.

Setting Details

“Color” Enables color printing.

“Monochrome” Disables color printing and converts image from continuous color to
grayscaled monochrome.

“Color (CAD)” Prints lines in the best color possible so they are easy to see.

“Monochrome Bitmap” Prints all colors other than white in black.

“Monochrome (BK ink)” Select to print all lines with black ink.

Note
• The availability of settings depends on the print priority and media type selections.

“Color Adjustment” / “Matching”
You can set the color adjustment and matching.

• Color Adjustment (→P.488)
• Matching (→P.490)

“Restore Defaults” Button
Click the button to reset to the setting when starting Preview.

“Print” Button
Click the button to begin printing.

“Update Printer Info.” Button
Click the button to acquire printer information.
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Color Adjustment
You can set the color adjustment.

Adjusting Color
Normally colors should be adjusted in the software application, but if you see colors in the printout that do
not match colors on the screen, you can perform color adjustments.

1. Select “Color” on “Color Mode” in the Color Settings panel.
2. Select “Color Adjustment”.

3. Drag each slider to the left or right to adjust.
Setting Details

“Cyan” Adjusts the strength of colors to compensate the hues.

“Magenta” Adjusts the strength of colors to compensate the hues.

“Yellow” Adjusts the strength of colors to compensate the hues.

“Brightness” Adjusts the brightness of the entire image. When the results of the
printout are brighter than the original images such as the original photo
before scanning and graphics created on the display, or when you want
to print in different degrees of brightness, use this feature.

“Contrast” Adjusts the relative brightness between the brightest and darkest
portions of the image.
*For soft gradation, decrease the contrast. For hard gradation, increase
the contrast.

“Saturation” Adjusts the hues for vivid color or dark color.

“Gray Tone” Adjusts gray from cool black (bluish tones) to warm black (reddish tones).

Note
• You can also click the up or down arrow, or enter the number directly to increase or decrease the
value.
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Adjusting Monochrome
Use the monochrome setting to print monochrome images of color photographs captured with a scanner
or digital camera or other color images.

1. Select “Monochrome” on “Color Mode” in the Color Settings panel.
2. Select “Color Adjustment”.

3. Drag each slider to the left or right to adjust.
Setting Details

“Brightness” Adjusts the brightness of the entire image. When the results of the
printout are brighter than the original images such as the original photo
before scanning and graphics created on the display, or when you want
to print in different degrees of brightness, use this feature.

“Contrast” Adjusts the relative brightness between the brightest and darkest
portions of the image.
*For soft gradation, decrease the contrast. For hard gradation, increase
the contrast.

Note
• You can also click the up or down arrow, or enter the number directly to increase or decrease the
value.
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Matching
You can set the matching.

“Matching Mode”
You can select a matching mode to suit the print job.

Setting Details

Driver Matching Mode
(→P.492)

Independent driver color matching is performed.

ICC Matching Mode (→P.493) Color matching using ColorGear is performed.

ColorSync (→P.494) Color matching using CMM from Mac OS is performed.

“No Correction” No color matching is performed. Select this option when you want to
perform color matching in the software application.

Note
• You need to set each correction on the printer driver.

“Matching Method”
You can select a matching method to suit the print job.

“Input Prole”
Select the input prole.

Note
• You can select only after ICC Matching Mode has been selected in “Matching Mode”.

“Printer Prole”
Select the printer prole.

Note
• You can select only after ICC Matching Mode or “ColorSync” has been selected in “Mode”.
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“Soft Proof”
When you place a checkmark here, “ColorSync” applies to the preview area.

Note
• You can select only after “ColorSync” has been selected in “Matching Mode”.
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Driver Matching Mode
1. Under “Mode”, select Driver Matching Mode.

2. Click “Matching Method” list, and then select a setting.
Setting Details

“Auto” Automatically selects the best color matching method for each Image,
Graphics, Text.

“Perceptual” Gives priority to color hue in color matching suitable for output of
photographic images.

Saturation Gives priority to vividness in color matching.

Colorimetric Gives priority to reducing the differences in color between the original as
it appears on the screen and the printed output.
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ICC Matching Mode
1. Under “Matching Mode” on the “Matching”, select ICC Matching Mode.

2. Click the “Matching Method” list, and then select a setting.
Setting Details

“Perceptual” Gives priority to color hue in color matching suitable for output of
photographic images.

Colorimetric Gives priority to reducing the differences in color between the original as
it appears on the screen and the printed output.

Colorimetric (No
White-Point Correction)

Performs Colorimetric color matching but without white point correction.

“Saturation” Gives priority to vividness in color matching.

3. Click the “Input Prole” list and select an input prole.
4. Click the “Printer Prole” list and select a printer prole.
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ColorSync

1. Place a checkmark on “Soft Proof” to simulate the output product in Layout Area.
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Preferences Dialog Box
This dialog box appears when you select “Preferences” from the “imagePROGRAF Advanced Preview” menu.
You can set the preferences for Preview.

“Units”
Set the unit for paper length, margins, and so on.

Zoom Dialog Box
This dialog box appears when you select “Zoom” from the “View” menu. You can enlarge or reduce the screen
display.

Scaling
Set the magnication for enlargement or reduction of the screen display.

Note
• You can input between 10 and 400.
• You can change the numbers by clicking “▼” button.

Go to Page Dialog Box
This dialog box appears when you select “Go to Page” from the “View” menu.

Note
• You can not select “Go to Page” if the document is only one page.

“Page”
Input the page number in numerical characters to display in the preview area.

Note
• You can change the numbers in the range of the page of the documents.
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Print with No Borders
You can use the borderless printing function to print without margins surrounding the image.

Note
• With some media borderless printing can be performed only between two edges.
• To use the borderless printing function, the specied media must be set to the printer.

1. On the Paper Settings Panel (→P.480) , select “Roll Paper” in Paper Source.
2. On the Output Settings panel, click the “Enlarged/Reduced Printing” check box on.
3. Select “Fit Roll Paper Width”.
4. Click the “Borderless Printing” check box on.

5. Click the “Print” button.
Borderless printing begins.
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Print on the Center
You can print on the center of the media loaded in the printer.

Note
• This is not displayed when a checkmark is placed in “Borderless Printing”.

1. On the Output Settings panel, click the “Print Centered” check box on.

2. Click the “Print” button.
Printing on the center begins.
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Not Print Spaces at the Top/Bottom
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the
top or bottom.

Note
• This is not displayed when a checkmark is placed in “Borderless Printing”.

1. On the Paper Settings Panel (→P.480) , select “Roll Paper” in Paper Source.
2. On the Output Settings panel, click the “No Spaces at Top or Bottom” check box on.

3. Click the “Print” button.
Printing on the settings with no spaces at top or bottom begins.
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Print Page Rotated 90 Degrees
You can save paper by printing in landscape orientation on roll paper.

1. On the Paper Settings Panel (→P.480) , select “Roll Paper” in Paper Source.
2. On the Output Settings panel, click the “Rotate Page” check box on.
3. Select “Rotate Right 90 Degrees” or “Rotate Left 90 Degrees”.

4. Click the “Print” button.
Printing on rotating 90 degrees begins.
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Display with Fitting to the Width of the Paper
In the preview area, you can display to the width of the paper.

1. Select “Fit to Width” from the tool bar.
2. Fitting to the width of the paper, it is displayed.
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Display with All
In the preview area, you can display all.

1. Select “Fit Screen” from the tool bar.
2. All is displayed.
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Display with Actual Size
In the preview area, you can display the actual size.

1. Select “Actual Size” from the tool bar.
2. Actual size is displayed.
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Moving a Page
You can move a page to display in the preview area.

1. Select each button in “Go to Page” on the tool bar.
Setting Details

Go to the rst page.

Go to the previous page.

Go to the next page.

Go to the last page.

2. The target page appears.

Note
• You can also move a page by clicking the page on the thumbnails.
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Free Layout

The Features of Free Layout
The main features of Free Layout are as follows.

• Allows you to lay out at will and print a document created with application software.
• You can not only lay out multiple pages on one page but also lay out and print a multiple-le document
on one page, or lay out and print a document created with multiple application programs on one page.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print
output to differ from the Free Layout settings.

Operating Environment
You can use the Free Layout in the following environments.

• Compatible Operating System
Mac OS X (10.3.9 to 10.5)

• Software that requires installation
imagePROGRAF Printer Driver
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Starting Free Layout
Follow the procedure below to start the Free Layout.

1. Start the apllication software which you use.
2. From the application software’s “File” menu, select the printer setup menu to open the “Print”

dialog box.

Note
• Normally, select “Print” from the “File” menu.

3. Click on “Free Layout” in the “Page Setup” panel to attach a checkmark.
4. Click the “Print” button in the “Print” dialog box.

5. Free Layout main window is displayed.
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Free Layout Main Window
The Free Layout main window consists of the menu and tool bars, layout area and dialog areas.

Note
• You can use the “View” menu to show or hide the tool.

Menu Bar
This allows you to select menus required for operations.

Tool Bar
This allows you to select tool buttons required for major operations.

Layout Area
This allows you to lay out objects and edit the object size and orientation.

506 Mac OS X Software



Free Layout

Dialog Area
This allows you to set the print conditions and perform a print job.
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Paper Settings Panel
This panel appears when you select Paper Settings in the dialog area.

“Media Type”
This allows you to select the media type.

Note
• Always select media type that is actually set in the printer. When the media you chose is different from
the media set in the printer, you may not receive the desired print results.

“Easy Settings” / “Advanced Settings”
Two modes are available to provide the optimum print settings for jobs.
The settings available on each mode are as follows.

• Easy Settings (→P.510)
• Advanced Settings (→P.512)

Paper Source
You can select the paper source.
The following settings are available for paper source.

Setting Details

“Manual” Select for manual paper feed printing.

“Roll Paper” Select to print on roll paper.

“Roll Paper Width”
This selects the width of the roll media set to the printer.

Note
• Available only if rolls are selected in Paper Source.
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“Copies”
You can input the number of print copies in numerical characters.

Note
• The maximum value is 999.
• You can change the numbers by clicking either “▲” button or “▼” button.

“Restore Defaults” Button
Click the button to reset to the setting when starting Free Layout.

“Print” Button
Click the button to begin printing.

“Update Printer Info.” Button
Click the button to acquire printer information.
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Easy Settings
You can easily select the best settings for the print job by just selecting an item from the print target list that
matches the content of the document.

“Print Target”
You can easily select the best settings for the print job simply.
If you select each “Print Target” item the corresponding comment for that item is displayed below the list.

Setting Details

“Default Settings” Suitable for printing normal documents that contain a mixture of text,
photographs, and graphics.

“Ofce Document” Suitable for printing handouts as well as general ofce documents for
which print clarity is key.

“Poster” The best setting for posters.Prints using vivid and high impact colors.

“CAD (Color Line Drawing)” Prints the ne lines of CAD drawings and other such documents sharp
and clear.

CAD (B/W Line Drawing) Suitable for printing CAD drawings with sharp, dark lines.

“Perspective, GIS” Suitable for attractive printing of 3D-CAD drawings, perspective drawings,
and GIS drawings including maps.

“Photo (Color)” Suitable for printing photographic images captured with a digital camera.

“Faithful Color Reproduction” Prints by faithfully reproducing the colors of the original image.

“Custom Settings” Suitable for printing documents for which Advanced Settings have been
specied.

Note
• The number of settings available for selection depends on the media type.
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“Print Quality”
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
The level of the print quality and resolution settings are displayed in the following combinations.

Setting Details

Print Quality “Highest” / “High” / “Standard” / “Draft”

Resolution “1200dpi” / “600dpi” / “300dpi”

Note
• The availability of settings is determined by the media type and print priority selections.
• Printing time is longer and more ink is consumed with High than with Draft, however, print quality is
higher.

• Printing time is shorter and less ink is consumed with Draft than with High, however, print quality is lower.
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Advanced Settings
Presents detailed settings for the print priority, the print quality, and other items so you can select the values for
these settings yourself.

“Print Priority”
Select a print quality mode that is appropriate for the print job.

Setting Details

“Image” This mode achieves the best results for printing photographic images and
illustrations.

“Line Drawing” This mode is best for printing CAD drawings with ne lines or wall
newssheet or other documents that contain large amounts of text.
However, you may not achieve the quality you expect with printing
photographs or other images with many lled areas. For these types of
jobs, select “Image”.

“Ofce Document” Prints common ofce documents, such as proposals, memos for
distribution, etc., so they are easy to read.

Note
• The number of settings available for selection depends on the media type.

“Print Quality”
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
The level of the print quality and resolution settings are displayed in the following combinations.

Setting Details

Print Quality “Highest” / “High” / “Standard” / “Draft”

Resolution “1200dpi” / “600dpi” / “300dpi”

Note
• The availability of settings is determined by the media type and print priority selections.
• Printing time is longer and more ink is consumed with High than with Draft, however, print quality is
higher.

• Printing time is shorter and less ink is consumed with Draft than with High, however, print quality is lower.
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Color Settings Panel
This panel appears when you select Color Settings in the dialog area.

“Color Mode”
You can select a color mode to suit the print job.

Setting Details

“Color” Enables color printing.

“Monochrome” Disables color printing and converts image from continuous color to
grayscaled monochrome.

“Color (CAD)” Prints lines in the best color possible so they are easy to see.

“Monochrome Bitmap” Prints all colors other than white in black.

“Monochrome (BK ink)” Select to print all lines with black ink.

Note
• The availability of settings depends on the print priority and media type selections.

“Color Adjustment” / “Matching”
You can set the color adjustment and matching.

• Color Adjustment (→P.514)
• Matching (→P.516)

“Restore Defaults” Button
Click the button to reset to the setting when starting Free Layout.

“Print” Button
Click the button to begin printing.

“Update Printer Info.” Button
Click the button to acquire printer information.
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Color Adjustment
You can set the color adjustment.

Adjusting Color
Normally colors should be adjusted in the software application, but if you see colors in the printout that do
not match colors on the screen, you can perform color adjustments.

1. Select “Color” on “Color Mode” in the Color Settings panel.
2. Select “Color Adjustment”.

3. Drag each slider to the left or right to adjust.
Setting Details

“Cyan” Adjusts the strength of colors to compensate the hues.

“Magenta” Adjusts the strength of colors to compensate the hues.

“Yellow” Adjusts the strength of colors to compensate the hues.

“Brightness” Adjusts the brightness of the entire image. When the results of the
printout are brighter than the original images such as the original photo
before scanning and graphics created on the display, or when you want
to print in different degrees of brightness, use this feature.

“Contrast” Adjusts the relative brightness between the brightest and darkest
portions of the image.
*For soft gradation, decrease the contrast. For hard gradation, increase
the contrast.

“Saturation” Adjusts the hues for vivid color or dark color.

“Gray Tone” Adjusts gray from cool black (bluish tones) to warm black (reddish tones).

Note
• You can also click the up or down arrow, or enter the number directly to increase or decrease the
value.
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Adjusting Monochrome
Use the monochrome setting to print monochrome images of color photographs captured with a scanner
or digital camera or other color images.

1. Select “Monochrome” on “Color Mode” in the Color Settings panel.
2. Select “Color Adjustment”.

3. Drag each slider to the left or right to adjust.
Setting Details

“Brightness” Adjusts the brightness of the entire image. When the results of the
printout are brighter than the original images such as the original photo
before scanning and graphics created on the display, or when you want
to print in different degrees of brightness, use this feature.

“Contrast” Adjusts the relative brightness between the brightest and darkest
portions of the image.
*For soft gradation, decrease the contrast. For hard gradation, increase
the contrast.

Note
• You can also click the up or down arrow, or enter the number directly to increase or decrease the
value.
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Matching
You can set the matching.

“Matching Mode”
You can select a matching mode to suit the print job.

Setting Details

Driver Matching Mode
(→P.518)

Independent driver color matching is performed.

ICC Matching Mode (→P.519) Color matching using ColorGear is performed.

ColorSync (→P.520) Color matching using CMM from Mac OS is performed.

“No Correction” No color matching is performed. Select this option when you want to
perform color matching in the software application.

Note
• You need to set each correction on the printer driver.

“Matching Method”
You can select a matching method to suit the print job.

“Input Prole”
Select the input prole.

Note
• You can select only after ICC Matching Mode has been selected in “Matching Mode”.

“Printer Prole”
Select the printer prole.

Note
• You can select only after ICC Matching Mode or “ColorSync” has been selected in “Mode”.
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“Soft Proof”
When you place a checkmark here, “ColorSync” applies to the layout area.

Note
• You can select only after “ColorSync” has been selected in “Matching Mode”.
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Driver Matching Mode
1. Under “Matching Mode”, select Driver Matching Mode.

2. Click the “Matching Method” list, and then select a setting.
Setting Details

“Auto” Automatically selects the best color matching method for each Image,
Graphics, Text.

“Perceptual” Gives priority to color hue in color matching suitable for output of
photographic images.

Saturation Gives priority to vividness in color matching.

Colorimetric Gives priority to reducing the differences in color between the original as
it appears on the screen and the printed output.
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ICC Matching Mode
1. Under “Matching Mode”, select ICC Matching Mode.

2. Click the “Matching Method” list, and then select a setting.
Setting Details

“Perceptual” Gives priority to color hue in color matching suitable for output of
photographic images.

Saturation Gives priority to vividness in color matching.

Colorimetric Gives priority to reducing the differences in color between the original as
it appears on the screen and the printed output.

Colorimetric (No
White-Point Correction)

Performs Colorimetric color matching but without white point correction.

3. Click the “Input Prole” list and select an input prole.
4. Click the “Printer Prole” list and select a printer prole.

Mac OS X Software 519



Free Layout

ColorSync
1. Check that “ColorSync” is selected in “Matching Mode”.

2. Place a checkmark on “Soft Proof” to simulate the output product in Layout Area.
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Preferences Dialog Box
This dialog box appears when you select “Preferences” from the “imagePROGRAF Advanced Preview” menu.
You can set the preferences for Free Layout.

“Units”
Set the unit for paper length, margins, and so on.

“Gridlines”
You can input a grid line width value in numerical characters so that they serve as a guide to laying out objects.

Note
• You can input between 10.0 and 200.0(mm) (between 0.39 and 7.87(inch)).
• You can change the numbers by clicking either “▲” button or “▼” button.

“Divisions”
You can change the number of divisions of grid lines so that they serve as a guide to laying out objects.

Note
• You can input between 1 and 10.
• You can change the numbers by clicking either “▲” button or “▼” button.

“Grid Color”
Select the grid line color.

“Print Object Frames”
You can print the object border.

Note
• If you do not want to print the object border, deselect the “Print Object Frames” check box.

“Object Frame Style”
You can select the object frame style for printing.
The following settings are available for the object frame style.

Setting Details

“Solid Line” You can print the solid line as the frame style.

“Dotted Line” You can print the dotted line as the frame style.

“Dashed Line” You can print the dashed line as the frame style.
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Auto Arrange Spacing
Change the object-to-object spacing to be applied in the operation of laying out objects automatically.

Note
• You can input between 0.0 and 100.0(mm) (between 0.00 and 3.94(inch)).
• You can change the numbers by clicking either “▲” button or “▼” button.
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Page Setup Dialog Box
This dialog box appears when you select “Page Setup” from the “File” menu.This dialog box provides selections
for setting the media size, orientation and other important features.

“Paper Orientation”
This selects the paper orientation.
The following settings are available for orientation.

Setting Details

“Vertical” Prints the image and text created with the application software in the
orientation as it is.

“Horizontal” Prints the image and text by rotating sideways 90 degrees from the
orientation as specied in the application.

“Roll Paper Length”
Set the length of one page to print on roll paper.
When you place a checkmark on “Auto Settings”, the one-page length to be printed on roll paper is
automatically set so that the laid-out objects are printed on one page.

Note
• Available only if rolls are selected in Paper Source.
• You can input between 203.2 and 18000.0(mm) (between 8.00 and 708.66(inch)).
• You can change the numbers by clicking either “▲” button or “▼” button.

“Order”
Set the object layout order.
The following settings are available for order.

Setting Details

“Upper Left to Right” The objects are laid out from upper left to right.

“Upper Left to Bottom” The objects are laid out from upper left to bottom.

Note
• When you have selected “Roll Paper Length” > “Auto Settings” and “Paper Orientation” > “Vertical”, you
can choose only “Upper Left to Right”.

• When you have selected “Roll Paper Length” > “Auto Settings” and “Paper Orientation” > “Horizontal”,
you can choose only “Upper Left to Bottom”.
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Paper Size
You can select the size of the print media.

Note
• You cannot display this if “Roll Paper” is selected in Paper Source.

Zoom Dialog Box
This dialog box appears when you select “Zoom” from the “View” menu. You can enlarge or reduce the screen
display.

Scaling
Set the magnication for enlargement or reduction of the screen display.

Note
• You can input between 10 and 400.
• You can change the numbers by clicking “▼” button.
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Format Dialog Box
This dialog box appears when you select “Format” from the “Object” menu after you select an object. You can
rotate, enlarge, or reduce an object.

Note
• When the objects are not selected, you can not select “Format”.

“Rotate”
When you place a checkmark here, you can select “Rotate Right” or “Rotate Left”.

Setting Details

“Rotate Right” Rotates the object 90 degrees clockwise.

“Rotate Left” Rotates the object 90 degrees counterclockwise.

Note
• When several objects are selected, you cannot select “Rotate”.

Scaling
You can input the value for enlargement or reduction of the obeject in numerical characters.

Note
• You can input between 25 and 400.
• You can change the numbers by clicking either “▲” button or “▼” button.

“Object Size”
You can conrm the object size.

Note
• When several objects are selected, you cannot display “Object Size”.
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Laying out a Multiple-File Document on One Page
You can lay out and print a multiple-le document on one page.

1. From the application software’s “File” menu, select the printer setup menu to open the “Print”
dialog box.

Note
• Normally, select “Print” from the “File” menu.

2. Click on “Free Layout” in the “Page Setup” panel to attach a checkmark.
3. In the “Print” dialog box, select the pages to print and the number of copies, and click the “Print”

button.
Free Layout starts, laying out the document created with application software in the layout
area as an object.

4. Leaving Free Layout running, open other les with the application software and repeat the
above steps.

Laying out a Document Created with Multiple Application
Programs on One Page

You can lay out and print a document created with multiple application programs on one page.

1. From the application software’s “File” menu, select the printer setup menu to open the “Print”
dialog box.

Note
• Normally, select “Print” from the “File” menu.

2. Click on “Free Layout” in the “Page Setup” panel to attach a checkmark.
3. In the “Print” dialog box, select the pages to print and the number of copies, and click the “Print”

button.
Free Layout starts, laying out the document created with application software in the layout
area as an object.

4. Leaving Free Layout running, open the les with other application software and repeat the
above steps.

526 Mac OS X Software



Free Layout

Selecting an Object
When an object is selected, a select box (blue border) appears around the object.

Note
• To select an object, click that object.
• To select multiple successive objects, click them while holding down the shift key.
• To select multiple arbitrary objects, click them while holding down the command key.
• To select all objects, select “Select All” from the “Edit” menu.
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Changing the Object Size
You can change the object size by means of mouse operation or by specifying a scaling value.

Note
• The vertical-to-horizontal ratio remains unchanged when the object is enlarged or reduced.

Resizing by means of mouse operation
1. Select an object.
2. Place the pointer at a corner of the selection box around the object to show the arrow handle,

and drag this handle to change the object size.

Resizing by specifying a scaling value
1. Select an object.
2. Open the Format Dialog Box. (→P.525)
3. Use Scaling to set the magnication for enlargement or reduction. You either enter numbers

directly.

Note
• You can input between 25 and 400.
• You can change the numbers by clicking either “▲” button or “▼” button.

4. Click the “OK” button.
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Moving an Object
You can move the object position.

1. Select an object.
2. Place the pointer inside the selection box of the object to show the crosshair handle, and drag it

to move the object.

Rotating an Object
You can rotate the object.

1. Select an object.
2. Select “Rotate Left” or “Rotate Right” from the toolbar.

Alternatively, you may click on the “Rotate” check box in the Format Dialog Box (→P.525) then
select “Rotate Right” or “Rotate Left”, and click the “OK” button.

Note
• When several objects are selected, you cannot select “Rotate”.
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Laying out Objects Automatically
Click “Auto Arrange” in the tool bar. This automatically lays out objects. Alternatively, you may select “Auto
Arrange Object” from the “Object” menu.

Note
• The object layout order varies depending on the “Order” setting on the Page Setup Dialog Box. (→P.523)
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Aligning Objects
You can align objects systematically.

1. Select multiple objects.
2. Select the align menu from the “Object” menu.

“Align Top”
Lays out the objects, justifying them to the top.

“Center Vertically”
Lays out the objects, justifying them to the vertical center.

“Align Bottom”
Lays out the objects, justifying them to the bottom.
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“Align Left”
Lays out the objects, justifying them to the left.

“Center Horizontally”
Lays out the objects, justifying them to the horizontal center.

“Align Right”
Lays out the objects, justifying them to the right.
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Changing the Object Overlapping Order
You can change the object overlapping order.

1. Select an object.
2. Select the overlapping order menu from the “Object” menu.

“Bring to Front”
Moves the object to the frontmost position.

“Send to Back”
Moves the object to the backmost position.
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“Bring Forward”
Moves the object one position to the front.

“Send Backward”
Moves the object one position to the back.
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Pasting a Copied or Cut Object
1. Click “Copy” or “Cut” from the toolbar.

Alternatively, you may select “Copy” or “Cut” from the “Edit” menu.
2. Click “Paste” from the toolbar.

Alternatively, you may select “Paste” from the “Edit” menu.

Note
• The copied or cut object is laid out at the end of the page.
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Color imageRUNNER Enlargement Copy

The Features of Color imageRUNNER Enlargement Copy
The main features of Color imageRUNNER Enlargement Copy are as follows.

• Allows the document scanned with the Color imageRUNNER to be automatically enlarged and printed.
• You can perform basic printer settings such as printer selection, media type and output prole selection,
and matching methods, in addition to borderless printing and enlargement/reduction process without
growing through the printer driver.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print
output to differ from the Color imageRUNNER Enlargement Copy settings.

Operating Environment
You can use the Color imageRUNNER Enlargement Copy in the following environments.

• Compatible Operating System
Mac OS X (10.3.9 to 10.5)

• Software that requires installation
imagePROGRAF Printer Driver
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Starting Color imageRUNNER Enlargement Copy
Follow the procedure below to start the Color imageRUNNER Enlargement Copy.

1. Open the “Utility” panel of the “Print” dialog box.

Note
• Your printer is depicted in the lower-left area of this screen.

2. Click the “Set” button in “Congure Color imageRUNNER Enlargement Copy” to open the “Color
imageRUNNER Enlargement Copy” dialog box.

Note
• If you click on the “Monitor Hot Folder Constantly” check box in the “Color imageRUNNER Enlargement
Copy” dialog box, the icon of Color imageRUNNER Enlargement Copy utility will appear on the Dock
when starting OS X thereafter.

• You can also start the utility directly by clicking on the “Color imageRUNNER Enlargement Copy.app”
icon in “Applications” > “Canon Utilities” > “iR Enlargement Copy”.
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Color imageRUNNER Enlargement Copy Dialog Box
The explanation below is on the “Color imageRUNNER Enlargement Copy” dialog box.

Note
• For the step to open the “Color imageRUNNER Enlargement Copy” dialog box, see “Starting Color
imageRUNNER Enlargement Copy”. (→P.537)

“Delete les in the folder”
From the Hot Folder list, select a hot folder and click the “Delete” button to delete only les in the hot folder.

“Delete the entire folders, as well as items in the list above”
From the Hot Folder list, select a hot folder and click the “Delete” button to delete the hot folder.

“Delete” Button
Select “Delete les in the folder” or “Delete the entire folders, as well as items in the list above” and click this
button to delete the hot folder or only les in the hot folder.

“Add” Button
Click the button to open the “Destination Selection” dialog box so that you can add a hot folder.

“Edit” Button
From the Hot Folder list, select a hot folder and click this button to open the “Add/Edit Hot Folder” dialog
box that allows you to edit the hot folder.

“Monitor Hot Folder Constantly”
If you click on the check box, the icon of Color imageRUNNER Enlargement Copy utility will appear on
the Dock when starting OS X thereafter.
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Hot Folder
Hot folder refers to a folder used for Color imageRUNNER Enlargement Copy.

• When transferred to the PC’s hot folder, the document data scanned with the Color imageRUNNER is
printed in enlarged size from the printer according to the print conditions set in the hot folder.

• You can create a new hot folder, edit or delete an existing one, and set print conditions at will.

Note
• You can create up to 10 hot folders.

Creating a New Hot Folder
1. Open the “Color imageRUNNER Enlargement Copy” dialog box.

Note
• For the step to open the “Color imageRUNNER Enlargement Copy” dialog box, see “Starting Color
imageRUNNER Enlargement Copy”. (→P.537)

2. Click the “Add” button in “Enlarged Copy Settings” to open the “Destination Selection” dialog box.

3. From the printer list in “Destination”, select the printer of destination.
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4. Click the “OK” button to open the “Add/Edit Hot Folder” dialog box.

5. In “Name”, enter the name to display in the Hot Folder list.
6. In “Hot Folder”, enter the Hot Folder name.
7. Click the “OK” button. The created Hot Folder is listed in the “Color imageRUNNER Enlargement

Copy” dialog box.

8. Click the “Close” button to close the “Color imageRUNNER Enlargement Copy” dialog box.
9. From the “Apple” Menu, open the “Sharing” dialog box for “System Preferences”.
10. Select the check box labeled “File Sharing”, and click the “Options” button.
11. Select the check box labeled “Share les and folders using FTP” and “Share les and folders

using SMB” to make shared settings.

Note
• You can create up to 10 hot folders.
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Editing a Hot Folder (Setting Print Conditions)
1. Open the “Color imageRUNNER Enlargement Copy” dialog box.

2. Select the Hot Folder from the Hot Folder list.
3. From “Enlarged Copy Settings”, click “Edit” button to open the “Add/Edit Hot Folder” dialog box.
4. Make the necessary settings in the Paper Settings Panel. (→P.544)
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5. Make the necessary settings in the Output Settings Panel. (→P.549)

6. Make the necessary settings in the Color Settings Panel. (→P.551)

7. Click the “OK” button to close the “Add/Edit Hot Folder” dialog box.
8. From the “Apple” Menu, open the “Sharing” dialog box for “System Preferences”.
9. Select the check box labeled “File Sharing”, and click the “Options” button.
10. Select the check box labeled “Share les and folders using FTP” and “Share les and folders

using SMB” to make shared settings.

Note
• If you’ve made shared settings when you created a new Hot Folder, you do not need to execute
steps 8 to 10.
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Deleting a Hot Folder
1. Open the “Color imageRUNNER Enlargement Copy” dialog box.

2. Select the Hot Folder you want to delete from the Hot Folder list.
3. Select “Delete the entire folders, as well as items in the list above”, and then click the “Delete”

button.

4. Read the messag,e and then click the “OK” button.

Note
• Select “Delete les in the folder” to delete only les in the hot folder.
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Setting the Print Parameters
You can set the print conditions in the setting panels within the “Add/Edit Hot Folder” dialog box.

The settings available on each panel are as follows.
• Paper Settings Panel (→P.544)
• Output Settings Panel (→P.549)
• Color Settings Panel (→P.551)

Paper Settings Panel

“Easy Settings” / “Advanced Settings”
Two modes are available to provide the optimum print settings for jobs.
The settings available on each mode are as follows.

• Easy Settings (→P.546)
• Advanced Settings (→P.548)

“Media Type”
This allows you to select the media type.

Note
• Always select media type that is actually set in the printer. When the media you chose is different from
the media set in the printer, you may not receive the desired print results.

Paper Source
You can select the paper source.
The following settings are available for paper source.

Setting Details

“Manual” Select for manual paper feed printing.

“Roll Paper” Select to print on roll paper.
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“Roll Paper Width”
This selects the width of the roll media set to the printer.

Note
• Available only if rolls are selected in Paper Source.

Automatic Cutting
You can set the printer to cut roll paper automatically or print a guideline for cutting.
The following settings are available for automatic cutting.

Setting Details

“Printer Default” The value set on the printer operation panel takes priority.

“None” Each page is not cut after it is printed and printing continues without
interruption.

Print Cut Guideline A print cut guideline is printed after each page and printing continues
without interruption.

Note
• Available only if rolls are selected in Paper Source.

“Copies”
You can input the number of print copies in numerical characters.

Note
• The maximum value is 999.
• You can change the numbers by clicking either “▲” button or “▼” button.
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Easy Settings
You can easily select the best settings for the print job by just selecting an item from the print target list that
matches the content of the document.

“Print Target”
You can easily select the best settings for the print job simply.
If you select each “Print Target” item the corresponding comment for that item is displayed below the list.

Setting Details

“Default Settings” Suitable for printing normal documents that contain a mixture of text,
photographs, and graphics.

“Ofce Document” Suitable for printing handouts as well as general ofce documents for
which print clarity is key.

“Poster” The best setting for posters.Prints using vivid and high impact colors.

“CAD (Color Line Drawing)” Prints the ne lines of CAD drawings and other such documents sharp
and clear.

CAD (B/W Line Drawing) Suitable for printing CAD drawings with sharp, dark lines.

“Perspective, GIS” Suitable for attractive printing of 3D-CAD drawings, perspective drawings,
and GIS drawings including maps.

“Photo (Color)” Suitable for printing photographic images captured with a digital camera.

“Faithful Color Reproduction” Prints by faithfully reproducing the colors of the original image.

“Custom Settings” Suitable for printing documents for which Advanced Settings have been
specied.

Note
• The number of settings available for selection depends on the media type.
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“Print Quality”
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
The level of the print quality and resolution settings are displayed in the following combinations.

Setting Details

Print Quality “Highest” / “High” / “Standard” / “Draft”

Resolution “1200dpi” / “600dpi” / “300dpi”

Note
• The availability of settings is determined by the media type and print priority selections.
• Printing time is longer and more ink is consumed with High than with Draft, however, print quality is
higher.

• Printing time is shorter and less ink is consumed with Draft than with High, however, print quality is lower.
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Advanced Settings
Presents detailed settings for the print priority, the print quality, and other items so you can select the values for
these settings yourself.

“Print Priority”
Select a print quality mode that is appropriate for the print job.

Setting Details

“Image” This mode achieves the best results for printing photographic images and
illustrations.

“Line Drawing” This mode is best for printing CAD drawings with ne lines or wall
newssheet or other documents that contain large amounts of text.
However, you may not achieve the quality you expect with printing
photographs or other images with many lled areas. For these types of
jobs, select “Image”.

“Ofce Document” Prints common ofce documents, such as proposals, memos for
distribution, etc., so they are easy to read.

Note
• The number of settings available for selection depends on the media type.

“Print Quality”
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
The level of the print quality and resolution settings are displayed in the following combinations.

Setting Details

Print Quality “Highest” / “High” / “Standard” / “Draft”

Resolution “1200dpi” / “600dpi” / “300dpi”

Note
• The availability of settings is determined by the media type and print priority selections.
• Printing time is longer and more ink is consumed with High than with Draft, however, print quality is
higher.

• Printing time is shorter and less ink is consumed with Draft than with High, however, print quality is lower.
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Output Settings Panel

“Enlarged/Reduced Printing”
Select the method for enlarged/reduced printing.
The following settings are available for enlarged/reduced printing.

Setting Details

Fit Paper Size Enlarges/reduces the whole page automatically to t the media size
selected for output. Select the media size to print from Paper Size.

“Fit Roll Paper Width” Enlarges/reduces the whole page automatically to t the width of the roll
paper with the page width.
*Make sure that the width of the roll paper in the printer is set correctly for
“Roll Paper Width” in the Paper Settings panel.
*Displayed only if rolls are selected in Paper Source.

Scaling Enlarges/reduces the whole page by the scaling rate as specied. Input the
scaling value in numerical characters. You can specify a range between 5
and 600%.
*You can change the numbers by clicking either “▲” button or “▼” button.
*Although Scaling can be set to make the image larger than the media
size, the part that does not t in the media cannot be printed.
*This is not displayed when a checkmark is placed in “Borderless Printing”.

“Borderless Printing”
You can print the media without margins on all sides when the roll paper with the specic width and the
specic media type is used.

Note
• Available only if rolls are selected in Paper Source.

Paper Size
You can select the size of the print media.

Note
• This is not displayed when “Fit Roll Paper Width” is set in “Enlarged/Reduced Printing”.
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“Print Centered”
Select this feature to print the image in the center of a cut sheet or to print left and right margins evenly
from the edges of roll paper.

Note
• This feature is useful when you print the document enlarged or reduced with Scaling as well. When an
image is scaled, it is always enlarged or reduced in reference to a starting point in the upper left corner
of the page. If the image is reduced, the bottom and right margins are enlarged and the top and left
margins remain unchanged. At that point, you can set all margins evenly with this feature.

“No Spaces at Top or Bottom”
You can set the printer to print without any empty area when the print data contains empty area at the top or
bottom. Since the printer does not feed paper over the empty area, you can save paper.

Note
• Available only if rolls are selected in Paper Source.

“Rotate Page”
Select the method for rotating page.
The following settings are available for rotating page.

Setting Details

“Rotate Right 90 Degrees” Rotates the portrait page right 90 degrees and print in landscape
orientation. When the rotated page can t in the width of roll paper, the
page is rotated automatically, and when it can not t in the width of roll
paper, the page is not rotated.
*When “Fit Roll Paper Width” is selected under “Enlarged/Reduced
Printing”, then the image is enlarged or reduced after rotating to t the
width of the roll paper.

“Rotate Left 90 Degrees” Rotates the portrait page left 90 degrees and print in landscape orientation.
When the rotated page can t in the width of roll paper, the page is rotated
automatically, and when it can not t in the width of roll paper, the page is
not rotated.
*When “Fit Roll Paper Width” is selected under “Enlarged/Reduced
Printing”, then the image is enlarged or reduced after rotating to t the
width of the roll paper.

“Rotate 180 degrees” Allows you to rotate the image 180 degrees from the vertical to the right.

Note
• Available only if rolls are selected in Paper Source.

“Output Method” Button
Click the button to open the “Output Method” dialog box.
In this dialog box, you can specify the object output method.

Note
• To print after saving jobs in the temporary storage space, select “Save data before printing”.

550 Mac OS X Software



Color imageRUNNER Enlargement Copy

Color Settings Panel

“Color Mode”
You can select a color mode to suit the print job.

Setting Details

“Color” Enables color printing.

“Monochrome” Disables color printing and converts image from continuous color to
grayscaled monochrome.

“Color (CAD)” Prints lines in the best color possible so they are easy to see.

“Monochrome Bitmap” Prints all colors other than white in black.

“Monochrome (BK ink)” Select to print all lines with black ink.

Note
• The availability of settings depends on the print priority and media type selections.

“Mode”
Under “Mode”, select the matching mode.

Setting Details

Driver Matching Mode
(→P.552)

Independent driver color matching is performed.

ICC Matching Mode (→P.553) Color matching using ColorGear is performed.

ColorSync (→P.554) Color matching using CMM from Mac OS is performed.

“No Correction” No color matching is performed. Select this option when you want to
perform color matching in the software application.
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Driver Matching Mode
1. Under “Mode”, select Driver Matching Mode.

2. Click “Matching Method” list, and then select a setting.
Setting Details

“Auto” Automatically selects the best color matching method for each Image,
Graphics, Text.

“Perceptual” Gives priority to color hue in color matching suitable for output of
photographic images.

Saturation Gives priority to vividness in color matching.

Colorimetric Gives priority to reducing the differences in color between the original as
it appears on the screen and the printed output.
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ICC Matching Mode
1. Under “Mode”, select ICC Matching Mode.

2. Click “Method” list, and then select a setting.
Setting Details

“Perceptual” Gives priority to color hue in color matching suitable for output of
photographic images.

“Saturation” Gives priority to vividness in color matching.

Colorimetric Gives priority to reducing the differences in color between the original as
it appears on the screen and the printed output.

Colorimetric (No
White-Point Correction)

Performs Colorimetric color matching but without white point correction.

3. Click the “Input Prole” list, and then select an input prole.

Note
• To match the color on the printing, select the input prole for Color imageRUNNER Enlargement
Copy of the Color imageRUNNER type in use.

4. Click the “Printer Prole” list, and then select a printer prole.
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ColorSync
1. Under “Mode”, select “ColorSync”.

2. Click the “Printer Prole” list, and then select a printer prole.

Note
• Available when using Mac OS X 10.3.9-10.4.
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Printing Enlargements of Scanned Originals from a Color
imageRUNNER (Mac OS X)

Scanned originals from a Color imageRUNNER can be enlarged and printed automatically.

Originals you create by scanning with a Color imageRUNNER are transferred to a "hot folder" and printed
automatically after enlargement according to printing conditions you specify for that folder.
This processing sequence is called the Color imageRUNNER Enlargement Copy function.
To use Color imageRUNNER Enlargement Copy, rst complete these settings in the following order.
1. Register a hot folder on your computer.

Register a hot folder on your computer for storing scanned originals from the Color imageRUNNER
and complete the settings for enlargement copy.

2. Complete the scanning settings on the Color imageRUNNER.
Congure the Color imageRUNNER to send scanned originals to the hot folder.

After these settings are complete, you can print enlarged copies of scanned originals from the Color
imageRUNNER.

Registering a hot folder on your computer
Folders used for Color imageRUNNER Enlargement Copy (iR enlargement copy) are called hot folders.
Register a hot folder on your computer for storing scanned originals from the Color imageRUNNER. You can
specify printing conditions (such as the image quality and paper size), based on which originals transferred to
the hot folder will be printed. Follow these steps to register and modify hot folders.

1. To display the Color imageRUNNER Enlargement Copy dialog box, either double-click the
Color imageRUNNER Enlargement Copy.app icon after navigating to Canon Utilities - “iR
Enlargement Copy” in the Applications folder or click C Set in the Utility pane

2. In Enlarged Copy Settings, click Add or Edit and either create or modify the hot folder.
For instructions on registering and modifying hot folders, refer to the help le for Color
imageRUNNER Enlargement Copy.
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Completing the scanning settings on the Color imageRUNNER.
Congure the Color imageRUNNER to send scanned originals to the hot folder. It is easy to send scanned
originals to the hot folder if you assign the scanning settings and destination to a Favorites button on the
Color imageRUNNER.
For instructions on assigning scanning and sending settings to the Favorites button, refer to the Color
imageRUNNER manual.

Scanning the original and print an enlargement
Follow the steps below to scan an original on the Color imageRUNNER for enlarged printing on the printer.
For detailed instructions, refer to the Color imageRUNNER manual.

1. Load the original on the platen glass or document feeder of the Color imageRUNNER.
2. Press Send to display the screen for transmission.
3. Press Favorites, and then press the Favorites button assigned to the hot folder.
4. Press Start on the control panel. If you scan originals on the platen glass, after scanning all

originals, press Done on the touch-panel display.
Scanned originals are sent to the hot folder and automatically enlarged and printed following the
conditions you specied for the folder.

Note
• For details on Color imageRUNNER Enlargement Copy, see Color imageRUNNER Enlargement Copy.
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Printmonitor

The Features of imagePROGRAF Printmonitor
“imagePROGRAF Printmonitor” is a utility for checking the printer status and managing print jobs.

• Printer status can be checked in real time on a computer monitor.
• You can check the status of print jobs, cancel jobs, and manage them as needed.
• If a printer error occurs, you can investigate the corrective action immediately.
• You can also set up automatic email notication of any printer problems or errors to email addresses you
designate in advance.

Note
• If the status of the desired printer is not shown in imagePROGRAF Printmonitor, select the printer
again as follows.
1. Make sure the printer is on and connected to the network or to a local port.
2. In the Printer menu, select the name of the desired printer. After the printer is detected, the

printer status is shown.
3. If information about the printer is not shown in step 2, choose Search Printer in the Printer menu.

Printer names listed in the Printer menu are updated with the printers that are now detected.
4. In the Printer menu, select the name of the desired printer. After the printer is detected, the

printer status is shown.
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Job Management Using imagePROGRAF Printmonitor
You can use the Driver Panel in imagePROGRAF Status Monitor for operations such as pausing and canceling
print jobs.

Preempting Other Jobs

If you select a print job and click the button, the selected job is printed ahead of the job that currently
precedes it in the print queue.

Pausing/Resuming Print Jobs

Selecting a print job and clicking the button pauses printing of the selected job.

To resume printing of a paused print job, select the print job and click the button.

Note
• Once all the print data for a print job has been sent to the printer, the job can no longer be
paused/resumed.

Canceling Print Jobs

Selecting a print job and clicking the button cancels printing of the selected job.

Note
• You cannot cancel other users’ print jobs.
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Printing Held Jobs
Printing of the job with a “Status” of “Holding” is paused because the paper specied by the driver does
not match the paper currently loaded in the printer.
Use the procedure below to print the held job.

1. Select the held job and click the “Replace Paper” button.
2. Replace the paper in the printer with the correct paper.

Note
• To continue printing without changing the paper in the printer, select the held job and click “Continue
to print” button.
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Network Environment
System requirements
The system requirements, which vary depending on your network, are as follows.

• Printing over a TCP/IP network (when using IPv4)
• Compatible operating systems

• Windows 2000 (Professional or Server)
• Windows XP (Home Edition or Professional)
• Windows Server 2003 (Standard Edition)
• Windows Vista (Home Basic/Business/Ultimate)
• Windows Server 2008 (Standard Edition or Enterprise Edition)
• Windows XP Professional x64 Edition
• Windows Server 2003 x64 Edition
• Windows Vista x64
• Windows Server 2008 x64
• Mac OS X 10.2.8 or later
• Unix (Solaris 9)
• Unix (Red Hat 9)

• Compatible computer
• A computer that runs one of the above operating systems

• Printing over a TCP/IP network (when using IPv6)
• Compatible operating systems

• Windows Vista (Home Basic/Business/Ultimate)
• Windows Server 2008 (Standard Edition or Enterprise Edition)
• Windows Vista x64
• Windows Server 2008 x64
• Mac OS X 10.3.9 or later

Note
• When using IPv6, you must specify IPv6 on the Control Panel or in RemoteUI. For instructions, see
“Conguring TCP/IPv6 Network Settings”. (→P.568) or see “Conguring the Printer’s TCP/IP Network
Settings”. (→P.570)

• The imagePROGRAF printer driver is supported in Mac OS X 10.3.9 or later.
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• Printing over an AppleTalk network
• Compatible operating systems

• Mac OS X 10.2.8-10.4
• Compatible computer

• A computer that runs one of the above operating systems

Note
• The printer cannot be used over a LocalTalk network.
• Compatible with EtherTalk Phase 2.
• The imagePROGRAF printer driver is not compatible with AppleTalk.

• Printing over a NetWare network
• Compatible servers

• Novell NetWare 4.2/5.1/6.0
• Compatible clients

• Windows 2000 (Professional or Server)
• Windows XP (Professional)

• Compatible computer
• A computer that runs one of the above operating systems

Note
• In NetWare 6.0, iPrint is not supported.
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Network Environment
After conrming what type of network environment you will connect the printer to, set up the printer and
computers as needed.

• Example of a Windows network
In Windows networks, print over TCP/IP.

Note
• NetBIOS is not supported.

• Example of a Macintosh network
In Macintosh networks, print over AppleTalk (EtherTalk) or TCP/IP, using Bonjour (Zeroconf) functions.

Note
• The imagePROGRAF printer driver is not compatible with AppleTalk.

• Example of a NetWare network

Note
• Even if there is a NetWare server in your network environment, you can use it in conjunction with TCP/IP
or AppleTalk. In this case, complete the settings for each protocol you will use.
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Conguring the IP Address on the Printer
You must congure the printer’s IP address before using the printer in a TCP/IP network.
The printer’s IP address is congured automatically when you install the printer driver following the
instructions in the Setup Guide.
Congure the IP address by using imagePROGRAF Device Setup Utility, the printer Control Panel, or ARP or
PING commands, if the IP address is changed, or if you change the printer connection mode to a network
connection. For details on conguring the IP address, refer to the following topics.

• Conguring the IP Address Using imagePROGRAF Device Setup Utility (→P.564)
• Conguring the IP Address Using the Printer Control Panel (→P.565)
• Conguring the IP Address Using ARP and PING Commands (→P.567)

Important
• If you use a DHCP server for automatic assignment of the printer’s IP address, printing may no longer
be possible after the printer is turned off and on. This is because an IP address different from before
has been assigned. Thus, when using DHCP server functions, consult your network administrator and
congure the settings in one of the following ways.

• Congure the setting for dynamic DNS updating
In RemoteUI, activate the setting Enable DNS Dynamic Update. (→P.570)

• Congure the setting for assignment of the same IP address each time the printer starts up

Note
• We recommend conguring the printer’s IP address even if you will use the printer in networks other
than TCP/IP networks. Conguring the printer’s IP address enables you to use RemoteUI to congure
the network settings and manage the printer with a web browser.
For details on RemoteUI, see “Using RemoteUI”. (→P.569)
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Conguring the IP Address Using imagePROGRAF
Device Setup Utility
On a computer running Windows, you can use imagePROGRAF Device Setup Utility provided with the
printer to congure the printer’s IP address. This topic describes how to congure the IP address using
imagePROGRAF Device Setup Utility.

Important
• To congure network settings, you must be logged in with administrative rights such as “Administrator”
account. We recommend that your network administrator congure the network settings.

• For instructions on installing imagePROGRAF Device Setup Utility, see “Installing imagePROGRAF
Device Setup Utility”. (→P.452)

When specifying an IPv4 IP address
1. Start imagePROGRAF Device Setup Utility from the start menu.
2. In the Device Name list displayed, select the printer to congure.
3. Choose Protocol Settings from the Printer menu.
4. Select the IPv4 tab.
5. In the Setting IP Address list, choose Manual.
6. Enter the IP address assigned to the printer and click the Set button.
7. Click OK after the Conrmation message is displayed.
8. Exit imagePROGRAF Device Setup Utility.

Note
• To congure the IP address automatically, choose Auto in the Setting IP Address list and select
DHCP, BOOTP, or RARP.

• You can also specify the subnet mask and default gateway.

When specifying an IPv6 IP address
1. Start imagePROGRAF Device Setup Utility from the start menu.
2. In the Device Name list displayed, select the printer to congure.
3. Choose Protocol Settings from the Printer menu.
4. Select the IPv6 tab.
5. In IPv6, select On.
6. When there is an IPv6-compatible router in the network environment, select On in Stateless

Address.
Additionally, when there is an DHCPv6-compatible server in the network environment, select
On in DHCPv6.

Note
• When there is no IPv6-compatible router or DHCPv6-compatible server, select On in Manual and
enter the IPv6 Address and Prex Length.

7. Click Set.
8. Click OK after the Conrmation message is displayed.
9. Exit imagePROGRAF Device Setup Utility.
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Conguring the IP Address Using the Printer Control
Panel
This topic describes how to congure the printer’s IP address on the Control Panel.

1. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.
tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Interface Setup, and then press the OK button.
4. Press ▲ or ▼ to select TCP/IP, and then press the OK button.
5. Press ▲ or ▼ to select IPv4, and then press the OK button.
6. Press ▲ or ▼ to select IPv4 Settings, and then press the OK button.
7. Press ▲ or ▼ to select IP Address, and then press the OK button.
8. After you press◄ or► to select the input eld, numerical input is possible.
9. Press the ▲ or ▼ button to enter the value.

Note
• Pressing the ▲ button increases the number by 1. The maximum value is “9,” after which “0” is
displayed.

• Pressing the ▼ button decreases the number by 1. The minimum value is “0,” after which “9” is
displayed.

• Hold down ▲ or ▼ to increase or decrease the value continuously.
• Make sure the IP address you enter for the printer is not the same as any computer IP address
in your network.

10. Repeat steps 8 and 9 to complete the settings, and then press the OK button.
11. Press the Menu button.

If you have changed the settings, a conrmation message is displayed. Press▲ or▼ to select
Yes, and then press the OK button.
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Important
• Be sure to complete step 11. This will activate the values you have entered.
• You can also specify the subnet mask and default gateway on the Control Panel.

Note
• If an error message is displayed, check the settings and correct any invalid values.
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Conguring the IP Address Using ARP and PING
Commands
This topic describes how to congure the IP address using ARP and PING commands.
To use the ARP and PING commands, you will need to know the printer’s MAC address. You can conrm
the MAC address on the Control Panel.

1. Check the printer’s MAC address.
You can conrm the MAC address on the Control Panel as follows:
1. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj. tab

( ).

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Interface Setup, and then press the OK button.
4. Press ▲ or ▼ to select Ethernet Driver, and then press the OK button.
5. Press ▲ or ▼ to select MAC Address, and then press the OK button.

Note
• If the Tab Selection screen is not displayed, press the Menu button.
• You can investigate the MAC address by printing an interface setting report.
(→P.65)

2. In Windows, open a command prompt, or in Mac OS X, start Terminal.
3. Execute the following command to add entries to the ARP table for managing IP addresses

and corresponding MAC addresses.
arp -s [IP address] [the printer’s MAC address you have veried]
Example: arp -s xxx.xxx.xxx.xxx 00-1E-8F-xx-xx-xx

Note
• In Mac OS X when using Terminal, enter the arp command in the format “arp -s xxx.xxx.xxx.xxx
00:1E:8F:xx:xx:xx.” For details, refer to the help le for the command line.

4. Execute the following command to send the IP address to the printer and congure it.
ping [IP address as specied in the ARP command] -l 479
Example: ping xxx.xxx.xxx.xxx -l 479

Note
• In “-l,” the “l” is the letter “l”.
• In Mac OS X when using Terminal, enter the ping command in the format “ping -s 479
xxx.xxx.xxx.xxx.” For details, refer to the help le for the command line.
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Note
• The subnet mask and default gateway are set to “0.0.0.0.” Use RemoteUI to change the subnet mask
and default gateway to match your network settings.
For details on RemoteUI, see “Using RemoteUI”. (→P.569)

Conguring TCP/IPv6 Network Settings
When printing in a TCP/IPv6 network, you must congure the TCP/IPv6 settings on the Control Panel.
Follow the steps below to congure the TCP/IPv6 network settings.

1. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.
tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Interface Setup, and then press the OK button.
4. Press ▲ or ▼ to select TCP/IP, and then press the OK button.
5. Press ▲ or ▼ to select IPv6, and then press the OK button.
6. Press ▲ or ▼ to select IPv6 Support, and then press the OK button.
7. Press ▲ or ▼ to select On, and then press the OK button.

Important
• Once you set IPv6 Support to On, the IPv6 StlessAddrs setting takes effect.
• You can also congure IPv6 StlessAddrs and DHCPv6 from the printer Control Panel.
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Using RemoteUI
Enter the printer’s IP address in a web browser to display the RemoteUI page. After you log on to RemoteUI from
the page, you can check and change the status of the printer and print jobs, and congure network settings.

To access RemoteUI, start the web browser and enter the following URL in the Location (or Address) box to
display the RemoteUI page.
http://“printer IP address or name”/
Example: http://xxx.xxx.xxx.xxx/
For details on conguring printer settings for networks, refer to the following topics.

• Conguring the Printer’s TCP/IP Network Settings (→P.570)
• Conguring the Printer’s AppleTalk Network Settings (→P.574)
• Conguring the Printer’s NetWare Network Settings (→P.575)
• Specifying Printer-Related Information (→P.577)

Note
• RemoteUI also offers many other features. You can display the ink levels, check error messages and
other status information, and cancel print jobs.

• By factory default, the English screen is displayed. To change the display language, select the desired
language under Language before logging on in administrator mode.

Important
• Use Netscape Navigator 6.0 or later, Internet Explorer 5.01 or later, or Firefox 1.5 or later as a web
browser. In Mac OS X, you can also use Safari 1.32 or later or Safari 2.03 or later.

• Access is not possible via a proxy server. In environments where a proxy server is used, add the
printer’s IP address to Exceptions (addresses accessed without a proxy server) in the web browser
proxy server settings. (Settings may vary depending on the network environment.)

• Enable JavaScript and cookies in the web browser.
• If you access RemoteUI with the printer name instead of its IP address, make sure the DNS settings are
correctly congured.
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Conguring the Printer’s TCP/IP Network Settings
Follow the steps below to congure the TCP/IP network settings.

When using an IPv4 IP address
1. Start the web browser and enter the following URL in the Location (or Address) box to display

the RemoteUI page.
http://“printer IP address or name”/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.
3. If a password has been set on the printer, enter the password.
4. Click Network in the Device Manager menu at left to display the Network page.
5. Click Edit in the upper-right corner of the TCP/IPv4 group to display the Edit TCP/IP Protocol

Settings page.
6. Refer to the TCP/IP Settings Items table to complete the settings.

TCP/IP Settings Items
Item Details Default Setting

Use DHCP Activate this setting to use DHCP for
conguring the IP address.

Off

Use BOOTP Activate this setting to use BOOTP for
conguring the IP address.

Off

Use RARP Activate this setting to use RARP for
conguring the IP address.

Off

Enable DNS Dynamic Update Activate this setting to perform DNS
server registration automatically.

Off

Use Zeroconf Function Activate this setting to use Bonjour. On

IP Address Specify the printer’s IP address. 0.0.0.0

Subnet Mask Specify the printer’s subnet mask. 0.0.0.0

Gateway Address Specify the printer’s default gateway. 0.0.0.0

LPD Printing Activate this setting to use LDP Printing. On

IPP Printing Activate this setting to use IPP Printing. On

IPP Printer URI Specify the URI of the printer used for
IPP printing using up to 252 characters.
When using a standard Windows port for
IPP printing, enter an URL which should
not exceed 255 bytes for all characters
for “http://"IP address"/IPP-URI.”

printer

RAW Printing Activate this setting to use Raw Printing. On

RAW Mode Bi-direction Activate this setting to use Raw mode
bidirectional communication.

Off

FTP Printing Activate this setting to use FTP Printing. On

Use Discovery Activate this setting to use Discovery. On

Scope Enter the search range. default
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Item Details Default Setting

SMTP Server Address Specify the SMTP server’s IP address.
You can also specify the SMTP server
domain name, if desired.

0.0.0.0

Primary DNS Server Address Specify the IP address of the primary
DNS server.

0.0.0.0

Secondary DNS Server
Address

Specify the IP address of the secondary
DNS server.

0.0.0.0

DNS Host Name Specify the printer host name, up to
63 characters (1-63 characters). Use
single-byte letters, numbers, and “-”
(hyphens). Do not use numbers or “-”
for the rst character or “-” for the last
character.

NB-18GBxxxxxxxxxxxx

DNS Domain Name Specify the printer domain name, up
to 63 characters. Use single-byte
letters, numbers, “-” (hyphens), and “.”
(periods). Do not use numbers, “-”, or
“.” for the rst character, or “-” or “.” for
the last character.

blank

Multicast DNS Service Name Specify the printer’s Multicast DNS
service name. (1-63 characters)
This name will be displayed when
Bonjour functions are used.

Canon iPFxxxx (xxxxxx)

7. Click OK to display the Network page.

Note
• If you specify to congure the IP address using DHCP, BOOTP, or RARP, there must be a server that
supports such protocol running in the network.

• If you specify to congure the IP address using DHCP, BOOTP, or RARP, the IP address obtained by this
method is used rst. If you cannot obtain the IP address, the address specied in IP Address is used.

• It takes up to two minutes to determine whether DHCP, BOOTP, or RARP are available. We recommend
clearing check boxes of options you will not use.

• If you are using a DNS server, select Enable DNS Dynamic Update and enter the IP Address for DNS
servers, DNS host name, and DNS domain name in Primary DNS Server Address, Secondary DNS
Server Address, DNS Host Name, and DNS Domain Name, respectively.
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When using an IPv6 IP address
1. Start the web browser and enter the following URL in the Location (or Address) box to display

the RemoteUI page.
http://“printer IP address or name”/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.
3. If a password has been set on the printer, enter the password.
4. Click Network in the Device Manager menu at left to display the Network page.
5. Click Edit in the upper-right corner of the TCP/IPv6 group to display the Edit TCP/IP Protocol

Settings page.
6. Refer to the TCP/IP Settings Items table to complete the settings.

TCP/IP Settings Items
Item Details Default Setting

Use IPv6 Activate to enable IPv6. Off

Use a stateful address Activate when using a DHCP server to
acquire the IP address.

Off

Use a stateless address Activate when using an IPv6-compatible
router to acquire the IP address.

On

Use a manual address Activate when conguring the IP
address manually.

Off

IP Address Enter the printer’s IP address. blank

Prex Length Enter the IP address prex length. blank

Default Router
Address

Enter the default router address. blank

Prex Length Enter the prex length of the default
router address.

blank

Primary DNS Server Address Specify the IP address of the primary
DNS server.

blank

Secondary DNS Server Address Specify the IP address of the secondary
DNS server.

blank

Use the same host name and
domain name as IPv4

Activate when using the same DNS host
and domain names as for IPv4.

Off

DNS Host Name Specify the printer host name, up to
63 characters (1-4 characters). Use
single-byte letters, numbers, and “-”
(hyphens). Do not use numbers or “-”
for the rst character or “-” for the last
character.

NB-18GBip6xxxxxx

DNS Domain
Name

Specify the printer domain name, up
to 63 characters. Use single-byte
letters, numbers, “-” (hyphens), and “.”
(periods). Do not use numbers, “-”, or
“.” for the rst character, or “-” or “.” for
the last character.

blank
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Item Details Default Setting

Perform dynamic updating of
stateful addresses

Activate when assigning a stateful
address dynamically.

Off

Dynamically update the stateless
address

Activate when assigning a stateless
address dynamically.

Off

Dynamically update the manual
address

Activate when assigning a manual
address dynamically.

Off

7. Click OK to display the Network page.

Network Setting 573



Network Setting

Conguring the Printer’s AppleTalk Network Settings
Follow the steps below to congure the AppleTalk network settings.

1. Start the web browser and enter the following URL in the Location (or Address) box to display
the RemoteUI page.
http://“printer IP address or name”/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.
3. If a password has been set on the printer, enter the password.
4. Click Network in the Device Manager menu at left to display the Network page.
5. Click Edit in the upper-right corner of the AppleTalk group to display the Edit AppleTalk

Protocol Settings page.
6. Refer to the AppleTalk Settings Items table to complete the settings.

AppleTalk Settings Items
Item Details Default Setting

Phase Type Specify whether to use AppleTalk.
If you will use AppleTalk, choose
Phase 2.
If you will not use AppleTalk,
choose Disabled.

Disabled

Name (*1) Specify the object name used by
AppleTalk (in up to 31 single-byte
or 15 double-byte characters).
However, do not use the following
single-byte characters: @, *, :,
and =.

Canon NB-18GB (xxxxxx)

Zone (*2) Specify the printer zone name, up
to 31 single-byte characters.
However, do not use the following
single-byte characters: Also avoid
using “*” (which represents the
default zone) in the middle of a
string.

*

*1: The object name you have specied in Name is displayed in Printer Setup Utility (or Print Center)
in Mac OS X 10.2.8-10.4. If you use multiple printers in the same zone, assign a unique name to
each printer. By default, the network interface name is “Canon NB-18GB (xxxxxx).” (Here, xxxxxx is
the last six digits of the printer’s MAC address.)

*2: If zones have been created on the network, enter the name of the printer’s zone. If there are
no zones, leave the asterisk “*” entry (for the default zone) as it is. If you enter a network zone
name that does not match created zones, the printer will not be detected by Macintosh computers.
Consult your network administrator for information on zone names.

7. Click OK to display the Network page.
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Conguring the Printer’s NetWare Network Settings
Follow the steps below to congure the NetWare network settings.

1. Start the web browser and enter the following URL in the Location (or Address) box to display
the RemoteUI page.
http://“printer IP address or name”/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.
3. If a password has been set on the printer, enter the password.
4. Click Network in the Device Manager menu at left to display the Network page.
5. Click Edit in the upper-right corner of the NetWare group to display the Edit NetWare Protocol

Settings page.
6. Refer to the NetWare Settings Items table to complete the settings.

NetWare Settings Items
Item Details Default Setting

Frame Type Specify the type of frame to
use in NetWare.

Disabled

NCP Burst Mode Activate this setting to use
NCP Burst Mode.
This mode supports fast data
transfer when printing in queue
server mode. Normally, leave
the setting On.

On

Print Application Choose the print service.
• Bindery PServer
• RPrinter
• NDS PServer
• NPrinter

NDS PServer

Packet Signature Select If Requested by Server
to use packet signature.

If Requested by Server

Bindery
PServer

File Server Name Specify the name of a le
server that has a NetWare print
server.
(0-47 characters)

-

Print Server Name Specify the name of a NetWare
print server.
(0-47 characters)

-

Print Server Password Set a password for the print
server.
(0-20 characters)

-

Polling Interval Specify the interval to conrm
jobs.
(1-15 seconds)

5

RPrinter Print Server Name Specify the name of a NetWare
print server.
(0-47 characters)

-
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Item Details Default Setting

Printer Number Specify the number of the
printer connected to the
NetWare print server.
(0-15)

0

NDS
PServer

Tree Name Specify the name of an NDS
tree that has a NetWare print
server.
(0-32 characters)

-

Context Name Specify the name of a context
that has a NetWare print server.
(0-255 characters)

-

Print Server Name Specify the name of a NetWare
print server.
(0-64 characters)

-

Print Server Password Set a password for the print
server.
(0-20 characters)

-

Polling Interval Specify the interval to conrm
jobs.
(1-255 seconds)

5

NPrinter Print Server Name Specify the name of a NetWare
print server.
(0-47 characters)

-

Printer Number Specify the number of the
printer connected to the
NetWare print server.
(0-254)

0

7. Click OK to display the Network page.
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Specifying Printer-Related Information
Specify device information, security, and email notication settings as follows.

1. Start the web browser and enter the following URL in the Location (or Address) box to display
the RemoteUI page.
http://“printer IP address or name”/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.
3. If a password has been set on the printer, enter the password.
4. Click Information in the Device Manager menu at left to display the Information page.
5. To display the relevant settings page, click Edit in the upper-right corner of Device Information

or Security, depending on what information you want to specify.
To change the administrator password, click the Change Password button in the Security group.

6. Refer to the table of settings for device information, security, and email notication as you
complete these settings.
Security setting items are displayed when you click the Change Password button in the
Security group.

Device Information Settings
Item Details Default Setting

Device Name Enter a device name.
(0-32 characters)

blank

Location Enter the location where the
device is installed.
(0-32 characters)

blank

Administrator Enter the administrator’s name.
(0-32 characters)

blank

Phone Enter the administrator’s contact
information.
(0-32 characters)

blank

Comments(E-mail) Enter any comments regarding
the administrator.
(0-32 characters)

blank

Security Settings
Item Details Default Setting

New Password Enter the new password.
(0-9999999)

blank

Conrm Enter the new password again to
conrm it.
(0-9999999)

blank

On the Security settings screen, besides entering a password, you can specify other security-related
information, such as IP address-based SNMP or TCP usage restrictions, MAC address-based
access restrictions, or IPP and FTP authentication settings.

7. Click OK to activate the settings.
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Conguring the Communication Mode Manually
This topic gives instructions for conguring the communication mode manually.

1. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.
tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Interface Setup, and then press the OK button.
4. Press ▲ or ▼ to select Ethernet Driver, and then press the OK button.
5. Press ▲ or ▼ to select Auto Detect, and then press the OK button.
6. Press ▲ or ▼ to select Off, and then press the OK button.

The display reverts to the Ethernet Driver menu.
7. Press ▲ or ▼ to select Comm.Mode, and then press the OK button.
8. Press▲ or▼ to select the communication mode, and then press the OK button.

The display reverts to the Ethernet Driver menu.
9. Press ▲ or ▼ to select Ethernet Type, and then press the OK button.
10. Press ▲ or ▼ to select the Ethernet type, and then press the OK button.

The display reverts to the Ethernet Driver menu.
11. Press ▲ or ▼ to select Spanning Tree, and then press the OK button.
12. Press▲ or▼ to enable or disable spanning tree support, and then press the OK button.

The display reverts to the Ethernet Driver menu.
13. Press the Menu button.

After the conrmation message is displayed, press the OK button.
The new settings will take effect after the printer restarts.
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Email Notication When Printing is Finished or Errors
Occur

The printer can notify you of the printer status by email. Even when you are away from the printer, you can know
when printing is nished or if errors occur. Receive notication via email on your mobile phone or at your computer.

Use the imagePROGRAF Status Monitor (Windows) function to set up email recipients and message timing.
Besides being informed of nished print jobs or errors, you can also complete settings for email notication
when service is needed or it’s time to replace consumables. For detailed instructions,see “Specifying
Printer-Related Information”. (→P.577)

Note
• For details on email notication using imagePROGRAF Status Monitor (in Windows), refer to the
imagePROGRAF Status Monitor help.

• Mail server authentication is only supported with imagePROGRAF Status Monitor.
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Initializing the Network Settings
Use RemoteUI to restore the network settings to the default values as follows.

Important
• Initializing the network settings will also restore the default value of the printer’s IP address. As a result,
the RemoteUI page cannot be displayed in the web browser after this procedure.

• For instructions on reconguring the IP address, see “Conguring the IP Address on the Printer”.
(→P.563)

• For details on RemoteUI, see “Using RemoteUI”. (→P.569)

1. Start the web browser and enter the following URL in the Location (or Address) box to display
the RemoteUI page.
http://“printer IP address or name”/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.
3. If a password has been set on the printer, enter the password.
4. Click Network in the Device Manager menu at left to display the Network page.
5. Click Reset to Default settings in the lower-right corner of the Network Interface group.
6. After conrming the message, click OK to restore the network settings to the default values.

Note
• You can also use imagePROGRAF Device Setup Utility or the Control Panel to restore the default
network settings.
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Conguring the Printer Driver Destination (Windows)
This topic describes how to specify the printer driver destination if the printer’s IP address is changed, or if you
will use the printer over a network connection instead of via USB connection.
The procedure described below is the conguration based on the LPR or Raw protocol using the standard
TCP/IP port in Windows (Standard TCP/IP Port).

Important
• If you will use the printer in a TCP/IP network, make sure the printer’s IP address is congured correctly.

• Conguring the IP Address on the Printer (→P.563)

1. Open the Printers and Faxes (or Printers) window.
2. Right-click the icon of this printer and choose Properties to open the printer properties window.
3. Click the Port tab to display the Port sheet.
4. Click Add Port to display the Printer Ports dialog box.
5. In the Available Port list, select Standard TCP/IP Port.
6. Click New Port.

After the wizard starts, a window is displayed for the Welcome to the Add Standard TCP/IP
Printer Port Wizard.

7. Click Next.
8. In Printer Name or IP Address, enter the printer’s IP address.
9. Follow the instructions on the screen to add a printer port.
10. Click Close to close the Printer Ports dialog box.
11. Make sure the printer port you added is displayed under Ports, and that the port is selected.
12. Click Close to close the printer properties window.
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Sharing the Printer in Windows
If you set up a computer as a print server in Windows 2000, Windows XP, Windows Server 2003, Windows
Vista, or Windows Server 2008, the computer can receive print jobs sent from other computers (clients)
connected to it for printing. This topic describes how to share the printer in Windows.

Important
• We recommend that your network administrator congure your network for printer sharing.

1. Open the Printers and Faxes (or Printers) window.

2. Right-click the icon of this printer and choose Sharing to open the printer properties window.
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3. On the Sharing sheet, click Share this printer and enter the shared name.

4. To print jobs from clients running other versions of Windows, click Additional Drivers and follow
the instructions to install the printer driver of the corresponding version.
If you are prompted to choose the location of the printer driver le, insert the provided User
Software CD-ROM in the CD-ROM drive and specify the folder where the printer driver is located.

5. Click OK.

Important
• When installing the printer driver on client computers, select "Network Printer" on the connection type
screen in the printer wizard, and then select the printer shared from the computer set up as the print
server.
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Conguring the Printer’s NetWare Network Settings
Follow the steps below to congure the NetWare network settings.

1. Start the web browser and enter the following URL in the Location (or Address) box to display
the RemoteUI page.
http://“printer IP address or name”/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.
3. If a password has been set on the printer, enter the password.
4. Click Network in the Device Manager menu at left to display the Network page.
5. Click Edit in the upper-right corner of the NetWare group to display the Edit NetWare Protocol

Settings page.
6. Refer to the NetWare Settings Items table to complete the settings.

NetWare Settings Items
Item Details Default Setting

Frame Type Specify the type of frame to
use in NetWare.

Disabled

NCP Burst Mode Activate this setting to use
NCP Burst Mode.
This mode supports fast data
transfer when printing in queue
server mode. Normally, leave
the setting On.

On

Print Application Choose the print service.
• Bindery PServer
• RPrinter
• NDS PServer
• NPrinter

NDS PServer

Packet Signature Select If Requested by Server
to use packet signature.

If Requested by Server

Bindery
PServer

File Server Name Specify the name of a le
server that has a NetWare print
server.
(0-47 characters)

-

Print Server Name Specify the name of a NetWare
print server.
(0-47 characters)

-

Print Server Password Set a password for the print
server.
(0-20 characters)

-

Polling Interval Specify the interval to conrm
jobs.
(1-15 seconds)

5

RPrinter Print Server Name Specify the name of a NetWare
print server.
(0-47 characters)

-
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Item Details Default Setting

Printer Number Specify the number of the
printer connected to the
NetWare print server.
(0-15)

0

NDS
PServer

Tree Name Specify the name of an NDS
tree that has a NetWare print
server.
(0-32 characters)

-

Context Name Specify the name of a context
that has a NetWare print server.
(0-255 characters)

-

Print Server Name Specify the name of a NetWare
print server.
(0-64 characters)

-

Print Server Password Set a password for the print
server.
(0-20 characters)

-

Polling Interval Specify the interval to conrm
jobs.
(1-255 seconds)

5

NPrinter Print Server Name Specify the name of a NetWare
print server.
(0-47 characters)

-

Printer Number Specify the number of the
printer connected to the
NetWare print server.
(0-254)

0

7. Click OK to display the Network page.
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Specifying the Printer’s Frame Type
To enable communication between the printer and computers on your network, specify the Ethernet frame
type in your NetWare environment.
Follow these steps to specify the frame type by using imagePROGRAF Device Setup Utility or the printer
Control Panel.

Note
• You can specify the frame type by using RemoteUI if the printer’s IP address is congured.

Important
• Before specifying the frame type, make sure the printer is on and connected to the network.
• For instructions on installing imagePROGRAF Device Setup Utility, see “Installing imagePROGRAF
Device Setup Utility”. (→P.452)

Specifying the frame type using imagePROGRAF Device Setup Utility
1. Start imagePROGRAF Device Setup Utility.
2. In the list of printers, select the printer to congure.
3. Choose Protocol Settings from the Printer menu.
4. Click the NetWare tab and select the frame type in the NetWare Frame Type list.
5. Click the IPv4 tab and select ETHERNET II in the Frame Type list.
6. In IP Address, enter the IP address assigned to the printer, and then enter the subnet mask in

Subnet Mask and the default gateway in Gateway Address.

Important
• You must specify the IP address here to be able to congure NetWare protocol settings using
RemoteUI.

7. Click Set.
8. Click OK after the Conrmation message is displayed.
9. Exit imagePROGRAF Device Setup Utility.
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Specifying the frame type using the printer Control Panel
1. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.

tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Interface Setup, and then press the OK button.
4. Press ▲ or ▼ to select NetWare, and then press the OK button.
5. Press ▲ or ▼ to select NetWare, and then press the OK button.
6. Press ▲ or ▼ to select On, and then press the OK button.

The display reverts to the NetWare menu.
7. Press ▲ or ▼ to select Frame Type, and then press the OK button.
8. Press▲ or▼ to select the frame type to use, and then press the OK button.

The display reverts to the NetWare menu.
9. Press ▲ or ▼ to select Print Service, and then press the OK button.
10. Press▲ or▼ to select the desired print service, and then press the OK button.

The display reverts to the NetWare menu.
11. Press the Menu button.

If any of the settings is changed, a conrmation message is displayed. In this case, press
the OK button.

Important
• Be sure to complete step 11. This will activate the values you have entered.

Note
• If an error message is displayed, check the settings and correct any invalid values.
• To cancel this process, press the Stop button.
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Specifying NetWare Print Services
Before printing in a NetWare network, you must congure print services such as print servers, print queues, and
so on. You can congure the print service settings from a computer using any of the following Novell software
provided with NetWare.

• NWADMIN
• PCONSOLE

Important
• If you use NWADMIN to congure the print service settings, Novell Client (the Novell NetWare client
software) must be installed as the client software application.

• NetWare networking is unsupported in Windows Vista and Windows Server 2008.

This topic gives instructions for conguring NetWare print services. The order of this procedure may vary
depending on the environment.

Choosing the type of print services
Before completing print service settings, choose the type of print service. Refer to the following descriptions
as needed.

Note
• In NetWare 5.1 or 6.0, NDPS may also be used as the print service. If you use NDPS, use the Novell
printer gateway included with NetWare. For details on conguring NDPS, refer to the NetWare
documentation.

• NDS (Novell Directory Service) and bindery
NDS and bindery are both supported. Use the mode that is compatible with your network environment.

• Queue server mode and remote printer mode
Queue server mode and remote printer mode are both supported.

• Queue server mode
When using queue server mode, all print server functions are supported, so there is no need for
other print server software or hardware. In NDS queue server mode (NDS PServer), the NDS
print server is used for printing. In bindery queue server mode (Bindery PServer), the bindery print
server is used for printing. Note that if you use queue server mode, a NetWare user license is
required for each network interface.

• Remote printer mode
In remote printer mode, the printer is controlled by the NetWare print server. Thus, a NetWare
print server is required. In NDS remote printer mode (NPrinter), the NDS print server is used for
printing, and in bindery remote printer mode (RPrinter), the bindery print server is used for printing.
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Using NWADMIN or PCONSOLE to set up the print server
Use NWADMIN to set up the print server if NDS queue server mode or remote printer mode is used.

1. Log into NetWare as Administrator or with equivalent rights, and then start NWADMIN.
2. Run Quick Setup.

1. Choose Print Services Quick Setup in the Tools menu.
2. Enter a desired name in Print Server Name. To use an existing print server, click the button at right

and choose the name from the list.
3. Enter a desired printer name in Name.
4. To use the printer in queue server mode, choose Other/Unknown in Type. To use the printer in

remote printer mode, choose Parallel in Type, click Communications, and set Ports to LPT1 and
Connection Type to Manual Load.

5. Enter a desired queue name in Name.
6. In Volume, enter the volume object (that is, the object representing the physical volume on the

network) where the print queue will be created. Click the button at right to choose from a list.
7. Complete other settings as needed and click OK.

Note
• The print server name will be required when conguring the printer’s protocol settings. Write down
the print server name for future reference.

• When running Quick Setup, the printer is assigned printer number “0.” When using the printer in
queue server mode, do not change the printer number from “0.”

3. Set a password.
1. Right-click the print server created in step 2 and choose Details.
2. Click Change Password to open the password input dialog box. Enter the password.
3. Click OK to close the password input dialog box.
4. Click OK or Cancel to close the details dialog box.

4. To use the printer in remote printer mode, start the print server.
To use the NetWare le server as the print server, enter “LOAD PSERVER.NLM” at the le
server and press the Enter key.

Note
• This procedure is not required when using queue server mode.
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Use PCONSOLE to set up the print server if bindery queue server mode or remote printer mode is used.

1. Log into NetWare as Admin and start PCONSOLE.
2. Switch to bindery mode.
3. If the print server has not been created, create it.

1. In Available Options, select Quick Setup, and press the Enter key.
2. Enter the name of the new print server, the new printer, and the queue.

Note
• The print server name will be required when conguring the printer’s protocol settings. Write down
the print server name for future reference.

4. Specify the printer type.
1. To use the printer in queue server mode, choose Other/Unknown in Type. To use remote printer

mode, set Printer Type to Parallel and Position to Manual Load.
2. Press the Esc key.
3. After the conrmation message is displayed, choose Yes and press the Enter key.

5. Set a password.
1. In Available Options, select Print Servers and press the Enter key.
2. Select the print server created in step 2 and press the Enter key.
3. Select Password, and press the Enter key to display the password input dialog box.
4. Enter the password and press the Enter key.

6. Press the Esc key several times to display the dialog box for conrming that PCONSOLE
is nished.

7. Click Yes to exit PCONSOLE.
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Specifying NetWare Protocols
Follow the steps below to congure NetWare protocol settings other than the frame type by using RemoteUI.

Note
• For details on RemoteUI, see “Using RemoteUI”. (→P.569)

1. Start the web browser and enter the following URL in the Location (or Address) box to display
the RemoteUI page.
http://“printer IP address or name”/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.
3. If a password has been set on the printer, enter the password.
4. Click Network in the Device Manager menu at left to display the Network page.
5. Click Edit in the upper-right corner of the NetWare group to display the Edit NetWare Protocol

Settings page.
6. Make sure the Frame Type indicates the frame type used on the NetWare network.
7. To use burst mode, choose On for NCP Burst Mode.

Note
• Burst mode supports fast data transfer when printing in queue server mode. Normally, choose On.

8. In Print Application, click the print service to be used.

Note
• Only one print service selected here will be enabled. Multiple print services are not available at
the same time.

9. For packet signature, click If Requested by Server in Packet Signature.
10. Complete the following settings based on the selected service.

• If you have selected Bindery PServer: Queue Server Mode (Using a Bindery Print Server)
1. In File Server Name, enter the le server name.
2. In Print Server Name, enter the name of the print server created in "Specifying NetWare

Print Services. (→P.588)"
3. In Print Server Password, enter the password of the print server created in "Specifying

NetWare Print Services. (→P.588)"
4. In Polling Interval, specify the interval at which the printer checks the NetWare print queue.

• If you have selected RPrinter: Remote Printer Mode (Using a Bindery Print Server)
1. In Print Server Name, enter the advertising name of the print server created in "Specifying

NetWare Print Services. (→P.588)"
2. In Printer Number, enter the same printer number specied in "Specifying NetWare Print

Services. (→P.588)"
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• If you have selected NDS PServer: Queue Server Mode (Using an NDS Print Server)
1. In Tree Name and Context Name, enter the tree and context name of the print server.
2. In Print Server Name, enter the name of the print server created in "Specifying NetWare

Print Services. (→P.588)"
3. In Print Server Password, enter the password of the print server created in "Specifying

NetWare Print Services. (→P.588)"
4. In Polling Interval, specify the interval at which the printer checks the NetWare print queue.

• If you have selected NPrinter: Remote Printer Mode (Using a NDS Print Server)
1. In Print Server Name, enter the advertising name of the print server created in "Specifying

NetWare Print Services. (→P.588)" Usually, the advertising name is the same as the name of
the print server.

2. In Printer Number, enter the same printer number specied in "Specifying NetWare Print
Services. (→P.588)"

11. Click OK to display the Network page.
For a list of NetWare protocol settings items, see “Conguring the Printer’s NetWare Network Settings”.
(→P.575)
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Conguring NetWare Network Settings
To print over a NetWare network, congure the network environment as follows.

Important
• To congure network settings, you must be logged in with administrative rights such as “Administrator”
account. We recommend that your network administrator congure the network settings.

1. Specify the Ethernet frame type for communication between the printer and computers.
For instructions, see “Specifying the Printer’s Frame Type”. (→P.586)

2. Specify the NetWare print services, including the print server and queue.
For instructions, see “Specifying NetWare Print Services”. (→P.588)

3. Specify NetWare protocol details besides the frame type.
For instructions, see “Specifying NetWare Protocols”. (→P.591)
After you have completed the steps above, congure each computer for printing over the
NetWare network.

4. Connect to the NetWare network.
Install NetWare client software on each computer to be used for printing over the network, and
log in to the NetWare server or tree. For instructions on connection, refer to the NetWare and
operating system documentation.

5. Install the printer driver.
Follow the instructions of your network administrator to install the printer driver on each computer
to be used for printing. When installing the printer driver, choose Network Printer as the printer
destination, and then choose the print queue created from the NetWare print service settings.

6. Follow these steps to congure the printer port. This step is not necessary if you specied the
printer destination during installation of the printer driver.
1. Open the Printers and Faxes (or Printers) window.
2. Right-click the printer icon and choose Properties.
3. Click the Port (or Advanced) tab to display the Port (or Advanced) sheet.
4. As the destination port, specify the print queue created by conguring the NetWare print service

settings.
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Installing imagePROGRAF Device Setup Utility
Install imagePROGRAF Device Setup Utility from the User Software CD-ROM provided with the printer
as follows:

Important
• In Windows 2000/Windows XP/Windows Server 2003/Windows Vista/Windows Server 2008, you must
log on with administrative rights equivalent to the “Administrator” account.

1. Insert the User Software CD-ROM in the CD-ROM drive.
2. On the Setup Menu window, click Install Individual Software.
3. Click Install in imagePROGRAF Device Setup Utility.
4. Follow the instructions on the screen to proceed with the installation.
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Conguring the IP Address Using imagePROGRAF
Device Setup Utility
On a computer running Windows, you can use imagePROGRAF Device Setup Utility provided with the
printer to congure the printer’s IP address. This topic describes how to congure the IP address using
imagePROGRAF Device Setup Utility.

Important
• To congure network settings, you must be logged in with administrative rights such as “Administrator”
account. We recommend that your network administrator congure the network settings.

• For instructions on installing imagePROGRAF Device Setup Utility, see “Installing imagePROGRAF
Device Setup Utility”. (→P.452)

When specifying an IPv4 IP address
1. Start imagePROGRAF Device Setup Utility from the start menu.
2. In the Device Name list displayed, select the printer to congure.
3. Choose Protocol Settings from the Printer menu.
4. Select the IPv4 tab.
5. In the Setting IP Address list, choose Manual.
6. Enter the IP address assigned to the printer and click the Set button.
7. Click OK after the Conrmation message is displayed.
8. Exit imagePROGRAF Device Setup Utility.

Note
• To congure the IP address automatically, choose Auto in the Setting IP Address list and select
DHCP, BOOTP, or RARP.

• You can also specify the subnet mask and default gateway.

When specifying an IPv6 IP address
1. Start imagePROGRAF Device Setup Utility from the start menu.
2. In the Device Name list displayed, select the printer to congure.
3. Choose Protocol Settings from the Printer menu.
4. Select the IPv6 tab.
5. In IPv6, select On.
6. When there is an IPv6-compatible router in the network environment, select On in Stateless

Address.
Additionally, when there is an DHCPv6-compatible server in the network environment, select
On in DHCPv6.

Note
• When there is no IPv6-compatible router or DHCPv6-compatible server, select On in Manual and
enter the IPv6 Address and Prex Length.

7. Click Set.
8. Click OK after the Conrmation message is displayed.
9. Exit imagePROGRAF Device Setup Utility.
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Conguring the Printer Driver Destination (Macintosh)
Specify the printer driver destination as follows if the printer’s IP address is changed, or if you will use the
printer over a network connection instead of via USB connection.

• If you switch to printing in an AppleTalk network, see “Conguring the Destination for AppleTalk
Networks (Macintosh)”. (→P.598)

• If you switch to printing in a TCP/IP network, or if the printer’s IP address is changed, see “Conguring
the Destination in TCP/IP Networks (Macintosh)”. (→P.600)

• If you switch to printing in a Bonjour network, see “Conguring the Destination for Bonjour Network
(Macintosh)”. (→P.602)

596 Network Setting



Network Setting (Mac OS X)

Conguring the Printer’s AppleTalk Network Settings
Follow the steps below to congure the AppleTalk network settings.

1. Start the web browser and enter the following URL in the Location (or Address) box to display
the RemoteUI page.
http://“printer IP address or name”/
Example: http://xxx.xxx.xxx.xxx/

2. Select Administrator Mode and click Logon.
3. If a password has been set on the printer, enter the password.
4. Click Network in the Device Manager menu at left to display the Network page.
5. Click Edit in the upper-right corner of the AppleTalk group to display the Edit AppleTalk

Protocol Settings page.
6. Refer to the AppleTalk Settings Items table to complete the settings.

AppleTalk Settings Items
Item Details Default Setting

Phase Type Specify whether to use AppleTalk.
If you will use AppleTalk, choose
Phase 2.
If you will not use AppleTalk,
choose Disabled.

Disabled

Name (*1) Specify the object name used by
AppleTalk (in up to 31 single-byte
or 15 double-byte characters).
However, do not use the following
single-byte characters: @, *, :,
and =.

Canon NB-18GB (xxxxxx)

Zone (*2) Specify the printer zone name, up
to 31 single-byte characters.
However, do not use the following
single-byte characters: Also avoid
using “*” (which represents the
default zone) in the middle of a
string.

*

*1: The object name you have specied in Name is displayed in Printer Setup Utility (or Print Center)
in Mac OS X 10.2.8-10.4. If you use multiple printers in the same zone, assign a unique name to
each printer. By default, the network interface name is “Canon NB-18GB (xxxxxx).” (Here, xxxxxx is
the last six digits of the printer’s MAC address.)

*2: If zones have been created on the network, enter the name of the printer’s zone. If there are
no zones, leave the asterisk “*” entry (for the default zone) as it is. If you enter a network zone
name that does not match created zones, the printer will not be detected by Macintosh computers.
Consult your network administrator for information on zone names.

7. Click OK to display the Network page.
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Conguring the Destination for AppleTalk Networks
(Macintosh)

To print over an AppleTalk network, activate the AppleTalk protocol and congure the destination as follows.

Activating AppleTalk on the printer

Important
• By factory default, the AppleTalk protocol is disabled on the printer.

1. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.
tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Interface Setup, and then press the OK button.
4. Press ▲ or ▼ to select AppleTalk, and then press the OK button.
5. Press ▲ or ▼ to select On, and then press the OK button.
6. Press the Menu button.

If any of the settings is changed, a conrmation message is displayed. In this case, press
the OK button.

Important
• Be sure to complete step 6. This will activate the values you have entered.

Note
• By using RemoteUI, you can also specify the object name used for AppleTalk, as well as the printer
zone name.
For details on RemoteUI, see “Using RemoteUI”. (→P.569)
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Conguring the destination (Mac OS X)

Important
• AppleTalk is supported in Mac OS X 10.2.8-10.4.

Note
• The following procedures are based on Mac OS X 10.4. The method of conguring the destination
varies depending on the version of Mac OS X.

1. In System Preferences, click Network to display the Network window.
2. In Show, choose Built-in Ethernet. Next, click AppleTalk, select Make AppleTalk Active,

and click Apply now.

3. Close the Network window and save the settings.
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Conguring the Destination in TCP/IP Networks
(Macintosh)

Follow these steps to congure the destination when using the printer in a TCP/IP network.

Important
• If you use the printer in a TCP/IP network, make sure the printer’s IP address is congured correctly.
(→P.565)

Conguring the Destination (Mac OS X)
1. Navigate to Applications > Canon Utilities > imagePROGRAF PrinterSetup and double-click

imagePROGRAF PrinterSetup.app.
2. Click Next.

3. Select the printer to register and click Next.

Note
• When specifying an IP address, click Registering IP Address.
Enter the IP address of the printer to set up in IP Address and click Next.
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4. Complete Printer Name and Location as desired and click Register.

5. Click Finish.

Network Setting 601



Network Setting (Mac OS X)

Conguring the Destination for Bonjour Network
(Macintosh)
In Mac OS X 10.2.8 and later, use Bonjour functions to easily connect the printer to the network. Follow the
steps below to congure the destination if you use the printer on TCP/IP network.

Important
• Bonjour and IP Print (Auto) do not support printing to a printer on other network groups that require a
router for connection. Make sure the computer and printer are on the same network. For information
about network settings, ask your network administrator.

• By default, Bonjour is activated on the printer. The printer name as displayed in Printer Setup Utility
(or Print Center) in Mac OS X is predened as the Multicast DNS Service Name. You can activate
or deactivate the Bonjour function or change the printer name by using RemoteUI. For instructions on
changing it, see “Using RemoteUI”. (→P.569)

1. Choose Utilities (or Applications) in the Go menu of Finder.
2. Click Printer Setup Utility (or Print Center) in the Utilities folder.
3. If the printer name is not displayed in Printer List, click Add.

4. Select the printer from the list in the Printer Browser window and click Add.
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Adjusting the Printhead

Adjusting the Printhead
If printed documents are affected by the following problems, try adjusting the printhead.

• Printing is faint or affected by banding in different colors
Execute Nozzle Check to check for printhead nozzle clogging.
For instructions, see “Checking for Nozzle Clogging”. (→P.630)

• Printed vertical lines are warped or colors are out of alignment
Execute Head Posi. Adj. to adjust the printhead position.
Normally, execute Auto(Standard) or Auto(Advanced). However, when using special paper or if
printing is not improved after executing Auto(Advanced), try Manual.
(→P.604)
(→P.606)

• Printed lines are misaligned
Execute Head Inc. Adj. to adjust the angle of inclination of the printhead.
Even slight misalignment can be corrected.
(→P.608)

• Paper rubs against the printhead, or image edges are blurred
Executing Head Height to adjust the printhead height may improve printing results.
(→P.611)
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Automatic Adjustment to Straighten Lines and Colors
(Head Posi. Adj.)

If printed vertical lines are warped or colors are out of alignment, execute Head Posi. Adj. to adjust the Printhead
alignment.

There are two modes for automatic Printhead adjustment: Auto(Standard) and Auto(Advanced).
Auto(Standard) will x most slight image distortion or color misalignment, but if not, try Auto(Advanced).
Use Auto(Standard) or Auto(Advanced) to have the printer print and read a test pattern for automatic
adjustment of the Printhead.

Important
• Always make sure the loaded paper matches the type of paper specied on the printer. Adjustment
cannot be completed correctly unless the loaded paper matches the settings.

• This function is not available with CAD Tracing Paper, CAD Translucent Matte Film, or CAD Clear Film.
If adjustment is not possible as expected using highly transparent lm or similar media, try another type
of paper, or try Manual adjustment.
(→P.606)

Note
• When printing on special paper, or if printing is not improved after Auto(Advanced), try Manual.
(→P.606)

• Use Auto(Standard) if you have switched to another type of paper or if you want the boundaries
between colors to appear as clear as possible.

• Use Auto(Advanced) to ne-tune the space between nozzles or colors if you have switched the
printhead or if clearer printing is required. We recommend Auto(Advanced) for printing at the highest
level of quality.

• We recommend using the type of paper you use most often for adjustment.

Paper to Prepare

Rolls An unused roll at least 10 inches wide

Sheets Auto(Standard) : One sheet of unused paper of at least A4/Letter size
Auto(Advanced) : Five sheets of unused paper of at least A4/Letter size (or one
sheet when using A2 or larger)

Perform adjustment as follows.

1. Load the paper.
• Attaching the Roll Holder to Rolls (→P.103)
• Loading Rolls in the Printer (→P.106)
• Loading Sheets in the Printer (→P.136)
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2. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.
tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Adjust Printer, and then press the OK button.
5. Press ▲ or ▼ to select Head Posi. Adj., and then press the OK button.
6. Press▲ or▼ to select Auto(Standard) or Auto(Advanced), and then press the OK button.

A test pattern is printed for adjustment.
Adjustment is now nished if you have printed on a roll or a sheet of A2 size or larger.

7. If you are printing on sheets smaller than A2 size for Auto(Advanced), a conrmation message
is displayed requesting you to continue printing. Press the OK button and follow the instructions
displayed.
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Manual Adjustment to Straighten Lines and Colors (Head
Posi. Adj.)

If printed vertical lines are warped or colors are out of alignment, execute Head Posi. Adj. to adjust the Printhead
alignment.

Normally, execute Auto(Standard) or Auto(Advanced).
(→P.604)
However, when printing on special paper, or if printing is not improved after Auto(Advanced), try Manual.
Manual adjustment requires you to examine the printed test pattern and enter an adjustment value.

Note
• Manual may be unavailable in some cases, even if it is displayed in the menu.
If so, execute Auto(Advanced) once.

• Always make sure the loaded paper matches the type of paper specied on the printer. Adjustment
cannot be completed correctly unless the loaded paper matches the settings.

• We recommend using the type of paper you use most often for adjustment.

Paper to Prepare

Rolls An unused roll at least 10 inches wide

Sheets One sheet of unused paper of at least A4/Letter size

Perform adjustment as follows.

1. Load the paper.
• Attaching the Roll Holder to Rolls (→P.103)
• Loading Rolls in the Printer (→P.106)
• Loading Sheets in the Printer (→P.136)

2. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.
tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Adjust Printer, and then press the OK button.
5. Press ▲ or ▼ to select Head Posi. Adj., and then press the OK button.
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6. Press ▲ or ▼ to select Manual, and then press the OK button.
A test pattern is printed for adjustment.

7. Press ▲ or ▼ to select D, and then press the OK button.
8. Press ▲ or ▼ to select D-1, and then press the OK button.
9. Examine adjustment test pattern D-1 and determine the number with straight lines.

Note
• If two patterns seem equally good and you cannot decide which one is better, choose an intermediate
value.
For example, choose 11 if you cannot decide whether pattern 10 or 12 is better.

10. Press▲ or▼ to select the pattern number you have decided, and then press the OK button.
11. Repeat steps 8-10 to specify the adjustment value for D-2 to D-5 and D-7 to D-11.
12. Press the Back button.
13. Press ▲ or ▼ to select Register Setting, and then press the OK button.
14. Press ▲ or ▼ to select Yes, and then press the OK button.

The adjustment value is now registered, and adjustment is complete.
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Adjusting Line Misalignment (Head Inc. Adj.)
If printed lines are misaligned, execute Head Inc. Adj. to adjust the angle of inclination of the Printhead. Executing
Head Inc. Adj. requires you to examine a printed test pattern and enter an adjustment value.

Paper to Prepare

Rolls An unused roll at least 10 inches wide

Sheets One sheet of unused paper of at least A4/Letter size

Perform adjustment as follows.

1. Load the paper.
• Attaching the Roll Holder to Rolls (→P.103)
• Loading Rolls in the Printer (→P.106)
• Loading Sheets in the Printer (→P.136)

Note
• When loading paper, specify the type of paper correctly. Using paper that you have not specied on
the printer may cause feeding problems and affect the printing quality.

• We recommend loading a type of paper that you use often.

2. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.
tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Adjust Printer, and then press the OK button.
5. Press ▲ or ▼ to select Head Inc. Adj., and then press the OK button.

After the Carriage is moved, a message is displayed requesting you to open the Top Cover.
6. Open the Top Cover.
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7. Align the Angle Adjustment Lever with the red square and close the Top Cover.

A test pattern is printed for adjustment.

Important
• Do not touch the Linear Scale (a) or Carriage Shaft (b). Touching these parts may damage them.

• If you accidentally move the Carriage, you will hear a warning tone. In this case, close the Top Cover.

8. Examine the test pattern for adjustment. Determine the straightest set of lines.

9. Open the Top Cover and move the Angle Adjustment Lever to match the number (or the square)
of the straightest set of lines.
If no single set of lines is perfectly straight, move the Angle Adjustment Lever to a position
between the numbers (or between the number and the square) of the two sets of lines that
are least misaligned.

Adjustments for Better Print Quality 609



Adjusting the Printhead

10. Close the Top Cover.
The Printhead is now straight, and adjustment is complete.
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Troubleshooting Paper Abrasion and Blurry Images
(Head Height)

If the Printhead rubs against paper during printing, adjusting the Printhead height may improve results.
If image edges are blurred, it may help to lower the Printhead.

Note
• Raise or lower the printhead, depending on the nature of the problem.
(→P.670)
(→P.671)
(→P.676)

1. On the Tab Selection screen of the Control Panel, press◄ or► to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Paper Details, and then press the OK button.
4. Press ▲ or ▼ to select the type of paper, and then press the OK button.
5. Press ▲ or ▼ to select Head Height, and then press the OK button.
6. Press▲ or▼ to select the desired setting value, and then press the OK button.

Note
• Depending on the type of paper, some setting values may not be available.
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Adjusting the Feed Amount
If printed documents are affected by the following problems, try adjusting the feed amount.

• Banding in different colors
• Line length is not accurate in the direction paper is fed

To adjust the feed amount, do the following, in this order.

1. Depending on the issue, adjust Adj. Priority to suit the particular type of paper.
(→P.613)

2. Execute Adj. Quality or Adjust Length, depending on the selection in Adj. Priority.
(→P.614)
(→P.616)
(→P.619)

3. After executing Adj. Quality, execute Adj. Fine Feed for further adjustment as needed.
(→P.618)
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Selecting a Feed Amount Adjustment Method (Feed
Priority)

Methods of adjusting the amount paper is fed are set in Adj. Priority.
Adjust Adj. Priority to suit your particular printing application.

• Print Quality : Adjusts the feed amount to reduce banding across the sheet in printed documents.
Adj. Quality settings are applied. When Adj. Fine Feed is executed, the Adj. Fine Feed settings are
applied in addition to the Adj. Quality settings.

• Print Length : Adjusts the feed amount for better accuracy of lines in printed documents.
The settings of A:High or B:Standard/Draft in Adjust Length are applied.

• Automatic : Print Quality or Print Length is selected, depending on Print Priority as selected in the
printer driver at the time of printing.
Image or Ofce Document : Print Quality is selected.
Line Drawing/Text : Print Length is selected.

Note
• Either B:Standard/Draft or A:High in the Adjust Length menu is applied, depending on printer driver
settings at the time of printing.

• If you have selected Easy Settings in the printer driver, follow these steps to conrm the Print Priority
setting.

• Windows: Click View Settings on the Main tab to display the View Settings dialog box.
• Mac OS X: Click View set. on the Main pane to display the View settings dialog box.

Follow these steps to congure the settings.

1. Load the paper.
• Attaching the Roll Holder to Rolls (→P.103)
• Loading Rolls in the Printer (→P.106)
• Loading Sheets in the Printer (→P.136)

2. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.
tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Adjust Printer, and then press the OK button.
5. Press ▲ or ▼ to select Feed Priority, and then press the OK button.
6. Press ▲ or ▼ to select Adj. Priority, and then press the OK button.
7. Press ▲ or ▼ to select Automatic, Print Quality, or Print Length, and then press the OK

button.
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Automatic Banding Adjustment (Adj. Quality)
If printed images are affected by banding in different colors across the sheet, execute Adj. Quality for automatic
adjustment of the paper feed amount.

There are two modes of automatic adjustment to correct banding: Auto(GenuinePpr) and Auto(OtherPaper).
In either mode, the printer prints and reads a test pattern for automatic adjustment of the feed amount.

• Auto(GenuinePpr)
Use this mode with paper identied in the Paper Reference Guide.
(→P.95)

• Auto(OtherPaper)
Use this mode with paper not in the Paper Reference Guide, or if Auto(GenuinePpr) does not eliminate
banding.
(→P.95)

Note
• Always check the Adj. Priority values before using Auto(GenuinePpr) or Auto(OtherPaper).
(→P.613)

• Adjustment is not possible with Auto(GenuinePpr) and Auto(OtherPaper) when using highly
transparent media.
In this case, use Manual adjustment.
(→P.616)

• If additional ne-tuning is necessary after Auto(GenuinePpr) and Auto(OtherPaper), execute Adj.
Fine Feed.
(→P.618)

• Use Adjust Length to ensure that lines in CAD drawings are printed at exactly the right length.
(→P.619)

• This may take some time, depending on the type of paper.
• Use paper of the same type and size for adjustment as you will use for printing.

Paper to Prepare

Rolls An unused roll at least 10 inches wide

Sheets Auto(GenuinePpr) : One sheet of unused paper of at least A4/Letter size
Auto(OtherPaper) : Two sheets of unused paper of at least A4/Letter size (or one
sheet when using A2 or larger)

Perform adjustment as follows.

1. Load the paper.
• Attaching the Roll Holder to Rolls (→P.103)
• Loading Rolls in the Printer (→P.106)
• Loading Sheets in the Printer (→P.136)

Note
• Always make sure the loaded paper matches the type of paper specied. Adjustment cannot be
completed correctly unless the loaded paper matches the settings.
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2. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.
tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Adjust Printer, and then press the OK button.
5. Press ▲ or ▼ to select Feed Priority, and then press the OK button.
6. Press ▲ or ▼ to select Adj. Quality, and then press the OK button.
7. Press▲ or▼ to select Auto(GenuinePpr) or Auto(OtherPaper), and then press the OK button.

A test pattern is printed for adjustment.
Adjustment is now nished if you have printed on a roll or a sheet of A2 size or larger.

8. If you are printing on sheets smaller than A2 size for Auto(GenuinePpr), a conrmation
message is shown on the Display Screen requesting you to continue printing.
Press the OK button and follow the instructions on the Display Screen.

Adjustments for Better Print Quality 615



Adjusting the feed amount

Manual Banding Adjustment (Adj. Quality)
If printed images are affected by banding in different colors, execute Adj. Quality for adjustment of the paper
feed amount.

Use Manual adjustment with highly transparent media or other paper for which Auto(GenuinePpr) or
Auto(OtherPaper) cannot be used.
(→P.614)
Manual adjustment requires you to enter an adjustment value after a test pattern is printed.

Note
• Always check the Adj. Priority values before using Manual adjustment.
(→P.613)

• If additional ne-tuning is necessary after Manual adjustment, use Adj. Fine Feed
(→P.618)

• Use Adjust Length to ensure that lines in CAD drawings are printed at exactly the right length.
(→P.619)

• Use paper of the same type and size for adjustment as you will use for printing.

Paper to Prepare

Rolls An unused roll at least 10 inches wide

Sheets Two sheets of unused paper of at least A4/Letter size

Perform adjustment as follows.

1. Load the paper.
• Attaching the Roll Holder to Rolls (→P.103)
• Loading Rolls in the Printer (→P.106)
• Loading Sheets in the Printer (→P.136)

Note
• Always make sure the loaded paper matches the type of paper specied. Adjustment cannot be
completed correctly unless the loaded paper matches the settings.

2. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.
tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Adjust Printer, and then press the OK button.
5. Press ▲ or ▼ to select Feed Priority, and then press the OK button.
6. Press ▲ or ▼ to select Adj. Quality, and then press the OK button.
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7. Press ▲ or ▼ to select Manual, and then press the OK button.
Test pattern A is printed for manual adjustment.

Note
• When printing on sheets, follow the instructions on the Display Screen and remove the sheet.

8. Examine test pattern A for adjustment. Determine the pattern in which banding is least noticeable.

Note
• If banding seems least noticeable in two patterns but you cannot decide which one is better, choose
an intermediate value.
For example, choose 11 if you cannot decide whether pattern 10 or 12 is better.

9. Press▲ or▼ to select the pattern number you have decided, and then press the OK button.
Test pattern B is printed for adjustment.

Note
• If you printed test pattern A on a sheet, follow the instructions on the Display Screen and use another
sheet of the same type of paper.
Additionally, after test pattern B is printed, follow the instructions on the Display Screen and remove
the sheet.

10. Examine test pattern B for adjustment. Determine the pattern in which banding is least noticeable.
11. Press▲ or▼ to select the pattern number you have decided, and then press the OK button.

The adjustment value is now registered, and adjustment is complete.
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Fine-Tuning the Paper Feed Amount (Adj. Fine Feed)
If the contrast is uneven or banding in different colors appears at 50 mm (2.0 in) intervals in printed documents, try
executing Adj. Fine Feed during printing to ne-tune the feed amount.

Note
• Always execute Adj. Quality before Adj. Fine Feed.
Once you execute Adj. Quality, the Adj. Fine Feed value will revert to 0.
(→P.614)
(→P.616)

Perform adjustment as follows.

1. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.
tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Adj. Fine Feed, and then press the OK button.
4. Press▲ or▼ to select a setting value in the range -5 to +5, and then press the OK button.

The setting is now applied.
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Adjusting Line Length (Adjust Length)
To ensure that lines in CAD drawings are printed at exactly the right length, use Adjust Length to adjust the
amount that paper is advanced.

There are two options in Adjust Length : AdjustmentPrint and Change Settings.
• AdjustmentPrint
After a test pattern is printed, you will measure the discrepancy based on the results of printing.

• Change Settings
No test pattern is printed. Instead, you will measure a document already printed to determine the
discrepancy.

Additionally, two modes are available in both AdjustmentPrint and Change Settings : A:High or
B:Standard/Draft. Choose the mode that suits your particular printing application.

• A:High
This setting is applied when Highest or High is selected in Print Quality in the printer driver.

• B:Standard/Draft
This setting is applied when Standard or Draft is selected in Print Quality in the printer driver.

Note
• Always check the Adj. Priority values before using Adjust Length. (→P.613)
• Use paper of the same type and size for adjustment as you will use for printing.

Paper to Prepare

Rolls • An unused roll at least 10 inches wide
• High-precision ruler

Sheets • One sheet of unused paper of at least A4/Letter size
• High-precision ruler

Perform adjustment as follows.

1. Load the paper.
• Attaching the Roll Holder to Rolls (→P.103)
• Loading Rolls in the Printer (→P.106)
• Loading Sheets in the Printer (→P.136)

Note
• Always make sure the loaded paper matches the type of paper specied. Adjustment cannot be
completed correctly unless the loaded paper matches the settings.

2. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.
tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.
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3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Adjust Printer, and then press the OK button.
5. Press ▲ or ▼ to select Feed Priority, and then press the OK button.
6. Press ▲ or ▼ to select Adjust Length, and then press the OK button.
7. Press▲ or▼ to select AdjustmentPrint or Change Settings, and then press the OK button.

When you select AdjustmentPrint, a test pattern is printed for you to measure the scale and
calculate the discrepancy. The scale bar shows “Millimeter” in 50 mm units and “Inch” in 1
inch units.

Note
• A test pattern is printed in black when you choose A:High or in magenta if you choose
B:Standard/Draft.

• To cancel printing the test pattern for adjustment, hold down the Stop button. When Stop printing?
is displayed, press ▲ or ▼ to select Yes, and then press the OK button.

8. Press▲ or▼ to enter the amount of discrepancy, and then press the OK button.
If the scale is shorter than the actual size, use a positive setting value. If it is longer, use a
negative value.
The feed amount can be adjusted in 0.02% increments.
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Adjusting the Vacuum Strength (VacuumStrngth)
When printing on heavyweight paper or paper that curls or wrinkles easily, if the Printhead rubs against paper,
adjusting the level of suction against paper on the Platen may improve results.

1. On the Tab Selection screen of the Control Panel, press◄ or► to select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Paper Menu is displayed.

3. Press ▲ or ▼ to select Paper Details, and then press the OK button.
4. Press ▲ or ▼ to select the type of paper, and then press the OK button.
5. Press ▲ or ▼ to select VacuumStrngth, and then press the OK button.
6. Press▲ or▼ to select the desired setting value, and then press the OK button.
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Maintenance

Ink Tanks

Ink Tanks
Ink tanks that can be used in the printer are labeled with a white letter “J” in a black circle on the side. When
purchasing ink tanks, make sure a “J” is printed on the label, along with the following Ink Tank serial numbers.

• 130 ml (4.4  oz) per color
• BK Ink Tank PFI-102BK
• MBK Ink Tank PFI-102MBK
• C Ink Tank PFI-102C
• M Ink Tank PFI-104M
• Y Ink Tank PFI-102Y

Note
• For instructions on ink tank replacement, see “Replacing Ink Tanks”. (→P.623)
• You can also use ink tanks other than M Ink Tank PFI-104M that are simply labeled “A.”
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Replacing Ink Tanks
Compatible ink tanks
Ink tanks that can be used in the printer are labeled with a white letter “J” in a black circle on the side. Request
ink tanks with the same label when you purchase new ones. For details, see “Ink Tanks”. (→P.622)

Precautions when handling ink tanks
Take the following precautions when handling ink tanks.

Caution
• For safety, keep ink tanks out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.
• There may be ink around the ink supply section of ink tanks you removed. Handle ink tanks carefully
during replacement. The ink may stain clothing.

Important
• Do not install used ink tanks in another model of printer.
This will prevent correct ink level detection, which may damage the printer or cause other problems.

• We recommend using up an Ink Tank in the course of printing within six months after breaking the seal.
Printing quality may be affected if you use older ink tanks.

• Do not leave the printer without ink tanks installed for extended periods (a month or more). Residual ink
may become clogged inside the printer and affect printing quality.

Make sure the printer is ready for Ink Tank replacement
You can replace ink tanks if the Display Screen advises you to check the amount of ink left or replace ink tanks.

If a message requests you to replace an Ink Tank, press the OK button. In this case, you can skip the step
“Access the menu for ink tank replacement.” Follow the instructions in “Remove the ink tanks.”

Important
• Do not remove an Ink Tank during initialization immediately after turning on the printer, or during
printhead cleaning.

Note
• Ink Tank replacement is possible even during printing, when print jobs are being canceled, or when
paper is being advanced.
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Access the menu for Ink Tank replacement
1. On the Tab Selection screen of the Control Panel, press◄ or► to select the Ink tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Ink Menu is displayed.

3. Press ▲ or ▼ to select Rep. Ink Tank, and then press the OK button.
A message on the Display Screen requests you to open the Ink Tank Cover. Remove the Ink
Tank at this point.

Remove the Ink Tank
1. Open the Ink Tank Cover and check the ink lamps.

Ink lamps ash when there is little ink left.

2. Press the tip of the Ink Tank Lock Lever of the color for replacement horizontally and pull the
Ink Tank Lock Lever up to open it.
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3. Hold the Ink Tank by the grips and remove it. Press the OK button.

Caution
• If there is still ink in the Ink Tank you removed, store it with the ink holes (a) facing up. Otherwise, ink
may leak and cause stains. Put the Ink Tank in a plastic bag and seal it.

Note
• Dispose of used ink tanks according to local regulations.

Install the ink tanks
1. Before opening the pouch, gently agitate the Ink Tank once or twice. Agitate the ink in the Ink

Tank by slowly rotating the Ink Tank upside-down and right side up repeatedly.

Caution
• Do not remove and agitate ink tanks that have already been installed in the printer. Ink may leak out.

Important
• If you do not agitate the Ink Tank, the ink may settle, which may affect printing quality.

Maintenance 625



Ink Tanks

2. Open the pouch and remove the Ink Tank.

Caution
• Never touch the ink holes or electrical contacts. This may cause stains, damage the Ink Tank,
and affect printing quality.

3. Press the OK button and insert the Ink Tank into the holder facing as shown, with the ink holes
down.

Important
• Ink tanks cannot be loaded in the holder if the color or orientation is incorrect.
If the Ink Tank does not t in the holder, do not force it into the holder. Make sure the color of the
Ink Tank Lock Lever matches the color of the Ink Tank and check the orientation of the Ink Tank
before reloading it.

4. Push the Ink Tank Lock Lever closed until it clicks into place.
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5. Make sure the Ink Lamp is lit in red.

Note
• If the Ink Lamp is not lit, reload the tank.

6. Close the Ink Tank Cover.
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Checking Ink Tank Levels
On the Display Screen, you can check how much ink is left in the ink tanks.

To check remaining Ink Tank levels, access the Tab Selection screen on the Control Panel and press◄ or

► to select the Ink tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.
• If an error has occurred and the Tab Selection screen cannot be displayed, display Ink Info as follows.

1. Press the OK button to display Printer Info.
2. Press the ▲ or ▼ button to select Ink Info.
3. Press the OK button.

The remaining ink levels shown on the Display Screen correspond to the inks identied by the Color Label on
the bottom of the Display Screen.
These symbols may be displayed above the ink level: “!” if ink is low, “×” if no ink is left, and “?” if you have
deactivated ink level detection.
The remaining ink level is indicated as shown below.

If the Display Screen indicates to replace the Ink Tank, replace the Ink Tank. If a message is displayed
indicating to check the remaining ink levels, or after tasks that consume a lot of ink such as large-format
printing or head cleaning, check the remaining levels and replace Ink Tank as needed. (→P.623)
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When to Replace Ink Tanks
Replace or prepare to replace ink tanks in the following situations.

If a message for checking the ink is shown on the Display Screen
When there is little ink left, the Message Lamp is lit and Not much ink is left. is shown on the Display
Screen. You can continue to print, but prepare to replace the Ink Tank. (→P.628)

Before print jobs and maintenance that consume a lot of ink
If little ink is left, there may not be enough for large-format printing, head cleaning, and maintenance, which
require a lot of ink. In this case, replace or prepare to replace the Ink Tank before maintenance.

If a message for ink replacement is shown on the Display Screen
When ink runs out, the Message Lamp ashes, a message regarding Ink Tank replacement is shown on the
Display Screen, and printing is disabled. Replace the Ink Tank at this point.
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Printhead
A replacement Printhead.

• Printhead PF-04

Note
• For instructions on replacing the Printhead, see “Replacing the Printhead”. (→P.633)

Checking for Nozzle Clogging
If printing is faint or affected by banding in different colors, make sure the Printhead nozzles are clear by printing a
test pattern to check the nozzles.

Note
• Nozzles are periodically checked to ensure they are clear. Congure the settings on the Control Panel
menu in Nozzle Check. (→P.49)

1. Load unused paper.
• Attaching the Roll Holder to Rolls (→P.103)
• Loading Rolls in the Printer (→P.106)
• Loading Sheets in the Printer (→P.136)

2. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.
tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3. Press the OK button.
The Set./Adj. Menu is displayed.

4. Press ▲ or ▼ to select Test Print, and then press the OK button.
5. Press ▲ or ▼ to select Nozzle Check, and then press the OK button.

The printer now prints a test pattern for checking the nozzles.
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6. Check the printing results.
If the horizontal lines are not faint or incomplete, the nozzles are clear.

If some sections of the horizontal lines are faint or incomplete, the nozzles for those colors
are clogged.

If horizontal lines are faint or incomplete, follow the steps below and check again for nozzle
clogging.
1. Clean the Printhead. (→P.632)
2. Print a test pattern to check the nozzles.

Note
• If you repeat these steps several times but the horizontal lines are still faint or incomplete, contact
your Canon dealer.
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Cleaning the Printhead
If printing is faint, cleaning the Printhead may improve results.

Choose one of two Printhead cleaning modes (Head Cleaning A or Head Cleaning B), depending on
the problem to resolve.

• Head Cleaning A
Use this mode if printing is faint or contains foreign substances. This method of cleaning consumes
the least amount of ink.
It takes about three minutes to complete.

• Head Cleaning B
Use this mode if no ink is ejected at all, or if Head Cleaning A does not solve the problem.
It takes about three and a half minutes to complete.

Caution
• Do not remove the Maintenance Cartridge or ink tanks during either Head Cleaning A or Head
Cleaning B.

Note
• If printing does not improve after Head Cleaning B, try repeating Head Cleaning B once or twice. If this
still does not improve printing, the Printhead may have reached the end of its useful life. Contact your
Canon dealer for assistance.

• Nozzles are periodically checked to ensure they are clear. Congure the settings on the Control Panel
menu in Nozzle Check. (→P.49)

Perform cleaning as follows.

1. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.
tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Maintenance, and then press the OK button.
4. Press ▲ or ▼ to select Head Cleaning, and then press the OK button.
5. Press▲ or▼ to select Head Cleaning A or Head Cleaning B, and then press the OK button.

Head cleaning is now executed.
6. Print a test pattern to check the nozzles, and determine whether cleaning has cleared the

nozzles. (→P.630)
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Replacing the Printhead
When to replace the Printhead
Replace the Printhead in the following situations.

• If the printing quality does not improve even after one or two cycles of Head Cleaning B from the
printer menu

• If the Display Screen indicates Open top cover and replace the printhead.
• If your Canon dealer has advised you to replace the Printhead

Compatible printheads
For information on compatible printheads, see “Printhead”. (→P.630)

Precautions when handling the Printhead
Take the following precautions when handling the Printhead.

Caution
• For safety, keep the Printhead out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.
• Do not touch the Printhead immediately after printing. The Printhead becomes extremely hot, and
there is a risk of burns.

Important
• There may be ink around the nozzles of the Printhead you remove. Handle the Printhead carefully
during replacement. The ink may stain clothing.

• Do not open the Printhead pouch until immediately before installation. After removing the Printhead
from the pouch, install it right away. If the Printhead is left after the pouch is opened, the nozzles
may dry out, which may affect printing quality.
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Access the menu for Printhead replacement

Caution
• When replacing the Printhead immediately after printing, wait a few minutes before replacing it. The
metal parts of the Printhead become hot during printing, and there is a risk of burns from touching
these parts.

Note
• Prepare a new Ink Tank when ink levels are low.
• Your hands may become dirty during Printhead replacement. Use the gloves provided with the new
Printhead for replacement.

1. If the roll is not ejected because of the cutting method selected, cut it manually and remove it.
(→P.331)

2. Clean inside the Top Cover. (→P.647)
3. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.

tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

4. Press the OK button.
The Set./Adj. Menu is displayed.

5. Press ▲ or ▼ to select Maintenance, and then press the OK button.
6. Press ▲ or ▼ to select Replace P.head, and then press the OK button.

Ink is now lled.
After about two minutes, a message is shown on the Display Screen instructing you to open
the Top Cover.
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Replace the Printhead
1. Open the Top Cover.

Instructions are now shown on the Display Screen regarding Printhead replacement.

Important
• During Printhead replacement, do not move the Carriage from the position indicated. If you
accidentally move the Carriage, you will hear a warning tone, and Printhead replacement is no
longer possible.
If you move the Carriage by mistake, close the Top Cover. The Carriage will be moved to the
position as indicated.

2. If the Printhead Fixer Cover or Printhead Fixer Lever is dirty, use a damp cloth that you have
wrung out completely to wipe it clean.
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Important
• Do not touch the Linear Scale (a) or Carriage Shaft (b). Touching these parts may damage them.

• Never touch the metal contacts of the Carriage. This may damage the printer.

3. Pull the Printhead Fixer Lever forward all the way to open it completely.

4. Pull up the Printhead Fixer Cover to open it completely.

5. Remove the Printhead and press the OK button.

Note
• Dispose of the used Printhead in accordance with local regulations.
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6. Holding the new Printhead by the grips (a), remove it from the pouch.

Important
• When handling the Printhead, always hold it by the grips (a). Never touch the nozzles (b) or metal
contacts (c). This may damage the Printhead and affect printing quality.

• Never touch the ink supply section (d). This may cause printing problems.

• If you need to put a Printhead somewhere temporarily before installation, do not keep the nozzles
and metal contacts facing down. If the nozzles or metal contacts are damaged, it may affect the
printing quality.

7. While rmly holding the Printhead you have removed, use your other hand to remove the orange
Protective Part (a). Squeeze the grips (c) of Protective Part (b) and pull it down to remove it.

Important
• The inside surface of the Protective Part (a) and Protective Part (b) is coated with ink to protect the
nozzles. Be careful not to touch these surfaces when removing the caps.

• The Printhead contains ink to protect the nozzles. We recommend removing Protective Part (b) as
you hold it over the Printhead package or safely out of the way to avoid spilling ink and staining your
clothes or the surrounding area. If ink accidentally spills, wipe off the ink with a dry cloth.

• Do not reattach the Protective Part or protective material. Dispose of these materials in accordance
with local regulations.

Maintenance 637



Printheads

8. With the nozzles facing down and the metal contacts toward the back, insert the Printhead into
the Carriage. Carefully push the printhead rmly into the Carriage, ensuring that the nozzles
and metal contacts do not touch the carriage.

9. Pull the Printhead Fixer Cover down toward the front to lock the Printhead in place.

10. Push the Printhead Fixer Lever toward the back of the printer until it clicks.

11. Close the Top Cover.

Ink now lls the system. It takes about six minutes for ink to ll the system.

Important
• Never remove an Ink Tank while the system is lling with ink.
• After Printhead has been replaced and lled with ink, Head Posi. Adj. (Auto(Advanced)) is
performed if you have selected Rep.P.head Print > On in the Control Panel menu. (→P.49)
In this case, follow the instructions on the Display Screen for Printhead adjustment.
If Rep.P.head Print is Off, perform Head Posi. Adj. (Auto(Advanced)) yourself. (→P.604)
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Maintenance Cartridge

Maintenance Cartridge
A replacement Maintenance Cartridge.

• Maintenance Cartridge MC-10

Note
• For instructions on replacing the Maintenance Cartridge, see “Replacing the Maintenance Cartridge”.
(→P.639)

Replacing the Maintenance Cartridge
Compatible maintenance cartridges
For information on compatible maintenance cartridges, see “Maintenance Cartridge”. (→P.639)

Precautions when handling the Maintenance Cartridge
Take the following precautions when handling the Maintenance Cartridge.

Caution
• For safety, keep the Maintenance Cartridge out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.
• To prevent ink from leaking from a used Maintenance Cartridge, avoid dropping the cartridge or storing it
at an angle. Otherwise, ink may leak and cause stains.

• Ink adheres to the top of the Maintenance Cartridge after it has been used. Handle the Maintenance
Cartridge carefully during replacement. The ink may stain clothing.

Important
• Do not remove the Maintenance Cartridge except to replace it.
• Do not install a used Maintenance Cartridge in another printer.
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Make sure the printer is ready for Maintenance Cartridge replacement
You can replace Maintenance Cartridge if the Display Screen advises you to check the remaining capacity
or replace the Maintenance Cartridge.

If a message is displayed requesting Maintenance Cartridge replacement, you can skip the step “Access the
menu for Maintenance Cartridge replacement.” Follow the instructions in “Replace the Maintenance Cartridge.”

Caution
• Do not replace the Maintenance Cartridge during initialization immediately after turning on the printer,
during Printhead cleaning, or when ink is being absorbed. Ink may leak out.

Access the menu for Maintenance Cartridge replacement
1. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.

tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Maintenance, and then press the OK button.
4. Press ▲ or ▼ to select Repl. maint cart, and then press the OK button.

A message on the Display Screen advises you to open the Maintenance Cartridge Cover.
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Replace the Maintenance Cartridge
1. Open the box, remove the plastic bag and packaging material, and take out the Maintenance

Cartridge.

Important
• Never touch the metal contacts (a). This may damage the Maintenance Cartridge.

2. At this point, open the Maintenance Cartridge Cover.

3. Hold the used Maintenance Cartridge by the grip (a) with one hand and put your other hand
under the Maintenance Cartridge to hold it rmly on the bottom, keeping it level as you pull it out.

Caution
• Used maintenance cartridges are heavy. Always grasp the cartridge rmly and keep the cartridge
level during removal and storage. If you drop a used Maintenance Cartridge or store it at an angle,
ink may leak and cause stains.
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Important
• The remaining Maintenance Cartridge capacity is recorded on each printer. Do not install a used
Maintenance Cartridge in another printer.

4. Keep the used Maintenance Cartridge level as you put it in the plastic bag. Expel excess air from
the plastic bag and seal the zipper.

5. Conrm the Maintenance Cartridge is right-side up, put it in the box with the packaging material
attached, and store it so that it stays level.

Caution
• Always put the used Maintenance Cartridge back in the box and store the box on a at surface.
Otherwise, ink may leak and cause stains.

Note
• In accordance with active and ongoing environmental programs, Canon supports recycling of used
maintenance cartridges. Follow the instructions provided with the new Maintenance Cartridge that
describe how to process the used Maintenance Cartridge.

6. Keeping the new Maintenance Cartridge level, insert it all the way in.
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7. Close the Maintenance Cartridge Cover.

8. Press the OK button.

The printer now initializes the Maintenance Cartridge.
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Checking the Remaining Maintenance Cartridge Capacity
The Maintenance Cartridge absorbs excess ink from borderless printing, printhead cleaning, and other processes.
You can conrm the remaining capacity of the Maintenance Cartridge by checking the Maintenance Cartridge
capacity shown on the Display Screen.

To check remaining Maintenance Cartridge capacity, access the Tab Selection screen on the Control Panel

and press ◄ or ► to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

If the Display Screen indicates to replace the Maintenance Cartridge, replace the Maintenance Cartridge. If a
message is displayed indicating to check the remaining capacity of the Maintenance Cartridge, or before
tasks that deplete much of the capacity such as head cleaning or preparations to move the printer, check the
remaining Maintenance Cartridge capacity and replace the Maintenance Cartridge as needed. (→P.639)

644 Maintenance



Maintenance Cartridge

When to Replace the Maintenance Cartridge
Replace or prepare to replace the Maintenance Cartridge in the following situations.

If a message for checking the Maintenance Cartridge is shown on
the Display Screen
When the Maintenance Cartridge is almost full, the Message Lamp is lit and The level is low is shown on
the Display Screen. You can continue to print, but check the remaining Maintenance Cartridge capacity and
prepare to replace the Maintenance Cartridge with a new one. (→P.644)

When much of the Maintenance Cartridge capacity is depleted
Printhead cleaning, Printhead replacement, and preparations to transfer the printer deplete much of the
Maintenance Cartridge capacity. (In particular, preparing to move the printer depletes a lot of the capacity.)
Check the remaining Maintenance Cartridge capacity before this maintenance and replace the Maintenance
Cartridge if necessary.

If a message for the Maintenance Cartridge replacement is shown on
the Display Screen
When the Maintenance Cartridge is full, the Message Lamp ashes and a message to replace the
Maintenance Cartridge is shown on the Display Screen. Printing is disabled, and you cannot replace the
Printhead or transfer the printer. Replace the Maintenance Cartridge with a new one.
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Cleaning the Printer

Cleaning the Printer Exterior
Clean the printer regularly to maintain better printing quality and help prevent problems.
To ensure a comfortable working environment, clean the printer exterior about once a month.

1. Turn the printer off. (→P.24)
2. Unplug the power cord from the outlet.

Caution
• Always turn off the printer and unplug the power cord before cleaning or maintenance. Accidentally
leaving the printer on poses a risk of injury if you touch moving parts inside the printer.

3. Using a damp cloth that you have wrung out completely, wipe the exterior surfaces of the printer.
Dry the surfaces with a dry cloth.

Caution
• Never use ammable solvents such as alcohol, benzene, or thinner. If these substances come into
contact with electrical components inside the printer, there is a risk of re or electrical shock.

Important
• If the Ejection Guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend
cleaning the Ejection Guide even if it does not appear dirty, because it may actually be covered
with paper dust.

4. Plug the power cord into the outlet.
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Cleaning Inside the Top Cover
Clean inside the Top Cover about once a month to maintain better printing quality and help prevent problems.
Also clean inside the Top Cover in the following situations to ensure optimal operation.

• If the printed surface or the underside of paper is dirty after printing
• After you have used up a roll
• After borderless printing
• After printing on small paper
• After printing on paper that generates a lot of cutting debris
• If you have replaced the roll
• After printing on paper that generates a lot of paper dust
• After printing on adhesive paper

Important
• If the Platen inside the Top Cover becomes dirty, it may soil the underside of paper. We recommend
cleaning the Platen after borderless printing or printing on small paper.

• If the Ejection Guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend
cleaning the Ejection Guide even if it does not appear dirty, because it may actually be covered with
paper dust.

• Printing on adhesive paper may leave adhesive on the Platen, Paper Retainer, or other parts. To
prevent paper jams, we recommend cleaning inside the Top Cover after printing.

1. Open the Top Cover.

2. If paper dust has accumulated in the Vacuum holes (a) on the Platen or in the Borderless Printing
Ink Grooves (b), use the Cleaning Brush (c), provided with the printer, to wipe it away.

Note
• If the Cleaning Brush is dirty, rinse it in water.
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3. Using a damp cloth that you have wrung out completely, wipe inside the Top Cover to clean it.
Wipe away any ink residue on the Platen as a whole (a), the Paper Retainer (b), Borderless
Printing Ink Grooves (c), and Ejection Guide (d).

Important
• Do not use a dry cloth to wipe inside the Top Cover. This may create a static charge, which may
attract dust and affect the printing quality.

• Never use ammable solvents such as alcohol, benzene, or thinner. If these substances come into
contact with electrical components inside the printer, there is a risk of re or electrical shock.

• Do not touch the Linear Scale (a) or Carriage Shaft (b).
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Note
• When cleaning between the Platen and Ejection Guide, use a damp cloth that you have wrung out
completely to wipe over the Output Tray and along grooves.

4. Close the Top Cover.
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Cleaning the Printhead
If printing is faint, cleaning the Printhead may improve results.

Choose one of two Printhead cleaning modes (Head Cleaning A or Head Cleaning B), depending on
the problem to resolve.

• Head Cleaning A
Use this mode if printing is faint or contains foreign substances. This method of cleaning consumes
the least amount of ink.
It takes about three minutes to complete.

• Head Cleaning B
Use this mode if no ink is ejected at all, or if Head Cleaning A does not solve the problem.
It takes about three and a half minutes to complete.

Caution
• Do not remove the Maintenance Cartridge or ink tanks during either Head Cleaning A or Head
Cleaning B.

Note
• If printing does not improve after Head Cleaning B, try repeating Head Cleaning B once or twice. If this
still does not improve printing, the Printhead may have reached the end of its useful life. Contact your
Canon dealer for assistance.

• Nozzles are periodically checked to ensure they are clear. Congure the settings on the Control Panel
menu in Nozzle Check. (→P.49)

Perform cleaning as follows.

1. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.
tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Maintenance, and then press the OK button.
4. Press ▲ or ▼ to select Head Cleaning, and then press the OK button.
5. Press▲ or▼ to select Head Cleaning A or Head Cleaning B, and then press the OK button.

Head cleaning is now executed.
6. Print a test pattern to check the nozzles, and determine whether cleaning has cleared the

nozzles. (→P.630)
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Preparing to Transfer the Printer
To protect the internal parts in transit, always follow these steps before transferring the printer to a new location.
Refer to the Setup Guide for details on packing the printer and installing it after transfer.

Important
• Be sure to contact your Canon dealer before transferring the printer to a new location. Ink may leak and
damage the printer if you do not prepare the printer correctly and it is tipped or stood on end in transit.

Note
• It is not possible to prepare the printer for transfer if the Display Screen requests you to replace the
Maintenance Cartridge or check the remaining capacity. Replace the Maintenance Cartridge before
transfer preparations. In this case, you will need one new Maintenance Cartridge. (→P.639)

• Depending on the state of the printer, part replacement may be necessary when preparing to transfer
the printer (that is, when you execute the printer menu item to prepare for transfer).

Remove paper
1. Remove the paper.

• Rolls (→P.116)
• Sheets (→P.144)

Access the Move Printer menu
1. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.

tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Prep.MovePrinter, and then press the OK button.
Once preparations are nished, a message on the Display Screen requests you to open the
Ink Tank Cover.

Important
• If consumables must be replaced, the message Consumables must be replaced. Call for service.
is shown on the Display Screen and preparation is not possible. If this message is displayed, press
the OK button and contact your Canon dealer for assistance.
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Remove the Ink Tank
1. Open the Ink Tank Cover.

2. Pressing the tip of the Ink Tank Lock Lever horizontally, lift the Ink Tank Lock Lever to release the
lock.

3. Holding the ink tanks by the grips, remove them.

Note
• Store the ink tanks you removed with the ink holes (a) facing up. Otherwise, ink may leak and
cause stains.

4. Repeat steps 2 and 3 to remove all ink tanks.

5. Push all ink tank lock levers closed until they click into place.
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6. Close the Ink Tank Cover.

At this point, ink is drawn out from inside the tubes.

Important
• Do not remove the Maintenance Cartridge during this process.

When the process is nished, Completed! Turn Power Off!! is displayed.

Pack the printer
1. Press the Power button and turn off the printer.

Important
• Turn off the printer before you unplug it. It may damage the printer if you unplug it before it is off
and transfer it in that state. If you accidentally unplug the printer, plug it in again, reinstall the ink
tanks, and follow this procedure again.

2. Disconnect the power cord and interface cable.
3. Tape down printer covers to secure them, in the reverse order of tape removal during installation.
4. Remove the Stand by reversing the installation procedure, when it was attached to the printer.
5. Disassemble and repackage the Stand by following the installation procedure in reverse.
6. Repack the Roll Holder, Holder Stopper, and printer in shipping materials, and then package

them in a shipping box.
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Updating the Firmware
Update the printer rmware to take advantage of new and improved printer functions.

Conrming the rmware version
1. On the Tab Selection screen of the Control Panel, press ◄ or ► to select the Settings/Adj.

tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2. Press the OK button.
The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Printer Info, and then press the OK button.
4. Press ▲ or ▼ to select System Info, and then press the OK button.

The rmware version is displayed.

Updating the Firmware
To obtain the latest rmware, visit the Canon website. If the rmware available online is newer than the
installed rmware, update the printer rmware. For details on downloading and updating the rmware,
visit the Canon website.
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Frequently Asked Questions

Frequently Asked Questions
This section presents frequently asked questions and answers. To view more detailed explanations, click the
hyperlinks in the answer column.

Question Answer
How do I print on a roll? When printing on rolls, after loading the roll, specify the paper type and

length, both on the Control Panel and in the printer driver.
⇒"Loading and Printing on Rolls (→P.78) "

How do I print on a sheet? When printing on sheets, specify the paper type and size in the printer
driver before loading the paper.
⇒"Loading and Printing on Sheets (→P.81) "

How do I switch between
printing on rolls and sheets?

When you complete operations on the Control Panel to load or replace
paper, the paper source is automatically switched to the selected paper.
⇒"Loading Rolls in the Printer (→P.106) "
⇒"Loading Sheets in the Printer (→P.136) "

How do I change the paper
type or size?

Specify the type and size of paper, both on the Control Panel and in the
printer driver.
• Specifying it in the printer driver
⇒"Specifying Paper in the Printer Driver (→P.197) "

• Specifying it on the Control Panel
Selecting the paper type
⇒"Changing the Type of Paper (→P.110) "
Selecting the paper size
⇒"Specifying the Paper Length (→P.112) "

How do I cut the roll paper after
printing?

You can wait until ink dries before cutting the roll, and you can cut rolls
at a desired position.
⇒"Specifying the Cutting Method for Rolls (→P.129) "

How do I print without borders? Borderless printing is possible on rolls. You can also specify borderless
printing in the printer driver by adjusting the original size to match the
paper size.
Borderless printing is not supported on sheets.
⇒"Borderless Printing on Paper of Equivalent Size (→P.232) "
⇒"Borderless Printing by Resizing Originals to Fit the Roll Width (→P.239) "
⇒"Borderless Printing at Actual Size (→P.225) "

How do I print an A4 original
enlarged on A2 paper?

In the printer driver, you can adjust the original image to match the paper
size or width, or you can specify enlargement or reduction before printing
as desired.
⇒"Resizing Originals to Match the Paper Size (→P.201) "
⇒"Resizing Originals to Fit the Roll Width (→P.207) "
⇒"Resizing Originals by Entering a Scaling Value (→P.213) "

Troubleshooting 655



Frequently Asked Questions

Question Answer
How do I print without wasting
paper?

To conserve paper, you can specify in the printer driver to rotate originals
90 degrees or to print without top and bottom margins.
⇒"Conserving Roll Paper by Rotating Originals 90 Degrees (→P.301) "
⇒"Conserving Roll Paper by Printing Originals Without Top and Bottom
Margins (→P.307) "

How do I print without wasting
all the blank space on the right
side when printing an A4-sized
original at A3 size?

By specifying to rotate originals 90 degrees in the printer driver, you can
print at A4 size to ll the width of A3 paper.
⇒"Conserving Roll Paper by Rotating Originals 90 Degrees (→P.301) "

How do I print in landscape (or
portrait) orientation?

You can print originals that are in landscape (or portrait) orientation
automatically enlarged to t the roll width. This is an easy way to create
vertical or horizontal banners.
⇒"Printing Vertical or Horizontal Banners (Large-Format Printing) (→P.253)
"

How do I print on a custom
paper size?

You can specify custom sizes temporarily in the printer driver.
⇒"Printing on Non-Standard Paper Sizes (→P.261) "

How do I register custom paper
sizes?

You can add desired sizes (Custom Media Sizes) in the Size Options
dialog box of the printer driver.
⇒"Printing on Non-Standard Paper Sizes (→P.261) "

How do I print lines thicker? By specifying Thicken Fine Lines in the printer driver, you can print ne
lines thicker to make them easier to see.
⇒"Giving Priority to Particular Graphic Elements and Colors for Printing
(→P.187) "

How do I modify how colors are
printed?

You can adjust colors as desired in the printer driver before printing.
⇒"Adjusting the Color in the Printer Driver (→P.177) "

How do I use printer driver
settings again in subsequent
jobs?

By saving settings information in a favorite, you can apply the settings
again before printing anytime as needed.
⇒"Using Favorites (→P.327) "

Can I use the printer in
combination with a Color
imageRUNNER ?

The printer can be used for automatic enlargement and printing of scanned
originals from a Color imageRUNNER.
⇒"Printing Enlargements of Scanned Originals from a Color
imageRUNNER (Windows) (→P.432) "
⇒"Printing Enlargements of Scanned Originals from a Color
imageRUNNER (Mac OS X) (→P.555) "

How do I print enlargements of
scanned originals from a Color
imageRUNNER ?

By using Color imageRUNNER Enlargement Copy (iR enlargement copy),
you can automatically print enlargements of scanned originals from a
Color imageRUNNER.
⇒"Printing Enlargements of Scanned Originals from a Color
imageRUNNER (Windows) (→P.432) "
⇒"Printing Enlargements of Scanned Originals from a Color
imageRUNNER (Mac OS X) (→P.555) "
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Problems Regarding Paper

Clearing Jammed Paper (Paper Feed Slot)
Follow these steps to remove any scraps left in the Paper Feed Slot after you clear jammed sheets or roll paper.

1. Turn the printer off. (→P.24)
2. Push the Release Lever back.

3. Positioning your hands as shown, open the Roll Cover.

4. Fold an A4 sheet lengthwise four times and insert it through the gap of the Paper Feed Slot.
Push the scrap out toward the Platen.

5. Remove the scrap when it is pushed out onto the Platen.
6. If any scraps remain inside the paper feed slot, repeat steps 4 and 5.
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7. Holding it at the positions indicated, close the Roll Cover.

8. Pull the Release Lever forward.
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Clearing Jammed Roll Paper
If paper from a roll becomes jammed, Paper jam. is shown on the Display Screen of the Control Panel.
Remove the jammed paper as follows.

1. Open the Roll Cover. Use a commercially available cutter or the like to cut the paper of the
loaded roll.

Caution
• When cutting paper, be careful to avoid injury or damage to the printer.

2. Push the Release Lever back.

3. Remove the jammed paper.
• If paper is jammed inside the Top Cover

1. Open the Top Cover and move the Carriage to the left or right side manually, away from the jam.

2. Clear any jammed paper from inside the Top Cover.
After removing the paper, make sure there are no other scraps of paper in the printer.
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3. Close the Top Cover.

Important
• Do not move the Carriage over jammed paper. This may damage the Printhead.
• Do not touch the Linear Scale (a) or Carriage Shaft (b). This may stain your hands and damage
the printer.

• If paper from a roll is jammed by the Paper Feed Slot
1. Open the Roll Cover.
2. Remove the jammed paper from the Paper Feed Slot.

After removing the paper, make sure there are no other scraps of paper in the printer.
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• If the paper is jammed by the Ejection Guide
Remove the jammed paper from the Output Tray.
After removing the paper, make sure there are no other scraps of paper in the printer.

4. Pull the Release Lever forward.
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Clearing a Jammed Sheet
If a sheet becomes jammed, Paper jam. is shown on the Display Screen of the Control Panel. Remove
the jammed paper as follows.

1. Push the Release Lever back.

2. Remove the jammed paper.
• If paper is jammed inside the Top Cover

1. Open the Top Cover and move the Carriage to the left or right side manually, away from the jam.

2. Clear any jammed paper from inside the Top Cover.
After removing the paper, make sure there are no other scraps of paper in the printer.

3. Close the Top Cover.
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Important
• Do not move the Carriage over jammed paper. This may damage the Printhead.
• Do not touch the Linear Scale (a) or Carriage Shaft (b). This may stain your hands and damage
the printer.

• If the paper is jammed by the Paper Feed Slot
Remove the jammed paper from the Paper Feed Slot.
After removing the paper, make sure there are no other scraps of paper in the printer.

• If the paper is jammed by the Ejection Guide
Remove the jammed paper from the Output Tray.
After removing the paper, make sure there are no other scraps of paper in the printer.
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3. Pull the Release Lever forward.
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Roll Paper Cannot be Inserted into the Paper Feed Slot
Cause Corrective Action

The roll paper is warped. Straighten out curls and reload the roll.

Paper is jammed by the paper feed slot. Remove the jammed paper.
(→P.120)
(→P.145)

Cannot load sheets
Cause Corrective Action

The paper source selection is incorrect. Press the Load button and select the paper source.

Paper is not cut straight
Cause Corrective Action

The paper is bent or curled at the cut position. Straighten out any curling by the edges of the paper.

Paper rises by the ends of the cut position before
it is cut.

Reload the paper correctly.

You are using paper that cannot be cut with the
Cutter Unit.

Specify Manual in Cutting Mode in the Control
Panel menu and use scissors or a cutting tool to cut
the roll after printing.
(→P.129)

Paper is not cut
Cause Corrective Action

In the printer driver, No or Print Cut Guideline is
specied in Auto Cut.

Specify Yes in Auto Cut in the printer driver.

In the Control Panel menu, Cutting Mode is set to
Eject or Manual.

If the Cutting Mode is Eject, press the Cut button to
cut the paper.
If the Cutting Mode is Manual, cut rolls with scissors
or the like.

Depression on the leading edge is left
Cause Corrective Action

Keeping a roll in the printer for a long time without
printing on it may leave a depression on the leading
edge.

When printing quality is most important, we
recommend setting TrimEdge Reload to On or
Automatic so that the paper edge is automatically
cut before printing.
(→P.35)

The size of clear lm cannot be detected
Cause Corrective Action

The Platen is soiled with ink or other substances. Open the Top Cover and clean the entire Platen.
(→P.647)
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Roll Paper is Continuously Ejected
Cause Corrective Action

Although sheets are selected as the paper source, a
roll was advanced.

After roll ejection stops, follow these steps to reload
the roll.
1.Push the Release Lever back.
2.Open the Roll Cover.
3.Using both hands, rotate the Roll Holder toward
the back to rewind the roll. At this time, ensure
that both ends of the roll are rewound evenly.

4.Pull the Release Lever forward.
5.Load the roll. At this time, be sure to press the
Load button and select Load Roll Paper.
(→P.106)
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Printing does not start

The Data Reception Lamp on the Control Panel does
not light up

Cause Corrective Action
The printer is not on. Make sure the power cord is securely plugged in, all the way. Press the

Power button to turn on the printer.

In Windows, select the printer by clicking Select Printer or Printer in
the printing dialog box and try printing again.

The printer is not selected in the
printer driver. (The printer is in
Sleep mode.)

In Mac OS X, select the printer by clicking Printer Setup Utility (or
Print Center) and try printing again.

In Windows, restart the print job as follows.
1.Select the printer icon in the Printers and Faxes (or Printers)
window.

2.Clear Pause Printing in the File menu to restart the print job.

The print job is paused. (The
printer is in Sleep mode.)

In Mac OS X, restart the print job as follows.
1.Click Print & Fax. (This is identied as Printer Setup Utility in some
versions of Mac OS X.)

2.Select the printer, and then Start Jobs in the Printers menu to
restart the print job.

The printer does not respond even if print jobs are sent
Cause Corrective Action

In the Control Panel menu, Pause Print is On. Set Pause Print to Off.
(→P.94)

Ink Filling.. is displayed
Cause Corrective Action

The printer was forced off during operation. Wait until the system has been lled with ink. This
process may take about seven and a half minutes.

The display screen indicates Agitating
Cause Corrective Action

Ink agitation is in progress. Please wait until ink agitation is nished.
The time for agitation varies depending on how long
the printer has been off. (Between about 30 seconds
and two minutes.)
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The printer stops during a print job

An error message is shown on the Display Screen
Status Corrective Action

An error message is displayed during printing. Check the error message and take action as
necessary.
(See "Error Messages.")

The last portion of roll paper was used during a print
job, and paper could not be advanced because the
trailing edge is taped to the roll.

Remove the used roll and insert a new roll.
(→P.116)
(→P.118)
(→P.78)

The printer ejects blank, unprinted paper
Status Corrective Action

The leading edge of the roll paper was cut to
straighten it.

The leading edge of rolls may be cut to straighten
it if you have selected Trim Edge First > On or
Automatic in the Control Panel menu.
(→P.133)

The Printhead nozzles are clogged. Print a test pattern to check the nozzles and make
sure the Printhead is in good condition for printing.
(→P.630)

A print job was received from an incompatible printer
driver.

Use the correct imagePROGRAF printer driver for
the printer and try printing again.

The printer has received print data that includes HP
RTL commands when Auto Rotate is On in the
Control Panel menu.

In the Control Panel, set Auto Rotate to Off and
print again.
(→P.49)

The printer is damaged. Contact your Canon dealer for assistance.

The printer stops when printing a HP-GL/2 job (the
carriage stops moving)

Cause Corrective Action
The printer is analyzing the print job. Please wait a while until printing is nished.

A job was printed when Input Resolution in the
Control Panel menu was set to 600dpi.

In the Control Panel menu, set Input Resolution to
300dpi and print again.
(→P.49)
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Problems with the printing quality

Printing is faint
Cause Corrective Action

You may be printing on the wrong side of the paper. Print on the printing surface.

The Printhead nozzles are clogged. Print a test pattern to check the nozzles and see if
they are clogged.
(→P.630)

Because the printer was left without ink tanks
installed for some time, ink has become clogged in
the ink supply system.

After the ink tanks have been installed for 24 hours,
run Head Cleaning B from the Control Panel.
(→P.632)

Paper is jammed inside the Top Cover. Follow the steps below to remove the jammed piece
of paper inside the Top Cover.
1.Open the Top Cover and make sure the Carriage
is not over the Platen.

2.Remove any scraps of paper inside the Top Cover.
(→P.120)
(→P.145)

3.Close the Top Cover.

The ink was not dry when paper was cut. Specify a longer drying period in the Control Panel
menu, in Paper Details > Roll DryingTime.
(→P.49)

Printing may be faint if Print Quality in Advanced
Settings in the printer driver is set to Standard or
Draft.

In Advanced Settings of the printer driver, choose
Highest or High in Print Quality.
Printing in Draft or Standard mode is faster and
consumes less ink than in Highest or High modes,
but the printing quality is lower.
(→P.187)
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Paper rubs against the Printhead
Cause Corrective Action

Load paper of the same type as you have specied
in the printer driver.
(→P.106)
(→P.136)

The type of paper specied in the printer driver does
not match the type loaded in the printer.

Make sure the same type of paper is specied in the
printer driver as you have loaded in the printer.
1.Press the Stop button and stop printing.
2.Change the type of paper in the printer driver and
try printing again.

Paper has been loaded incorrectly, causing it to
wrinkle.

Reload the paper.
(→P.106)
(→P.136)

The Printhead is set too low in the Control Panel
menu.

In the Control Panel menu, set Head Height to
Automatic.
(→P.611)

When printing on Heavyweight Coated Paper or
other paper-based media, choose a VacuumStrngth
setting of Strong or Strongest in the Control Panel
menu. If the paper still rubs, set Head Height to
Highest in the Control Panel menu.
(→P.621)
(→P.611)

When printing on CAD Tracing Paper or other
lm-based media, choose a VacuumStrngth setting
of Standard, Strong, or Strongest in the Control
Panel menu. If the paper still rubs, set Head Height
to Highest in the Control Panel menu.
(→P.621)
(→P.611)

You are printing on heavyweight paper or paper that
curls or wrinkles easily after absorbing ink.

When printing on paper 0.1 mm (0.004 in) thick or
less, choose a VacuumStrngth setting of Weakest
in the Control Panel menu. If the paper still rubs, set
Head Height to Highest in the Control Panel menu.
(→P.621)
(→P.611)

When you have loaded paper, the paper you have
loaded does not match the type selected on the
Control Panel.

Be sure to select the correct type of paper in the
Control Panel menu when loading paper.
(→P.106)
(→P.136)

670 Troubleshooting



Problems with the printing quality

The edges of the paper are dirty
Cause Corrective Action

The Platen has become dirty after borderless printing
or printing on small paper.

Open the Top Cover and clean the Platen.
(→P.647)

Make sure the same type of paper is specied on the
printer as in the printer driver.
(→P.110)

The type of paper as specied on the printer does not
match the type specied in the printer driver.

Make sure the same paper type is specied in the
printer driver as on the printer.
1.Press the Stop button and stop printing.
2.Change the type of paper in the printer driver and
try printing again.

The paper is wrinkled or warped. Straighten out the wrinkles or curls and reload the
paper. Do not use paper that has been printed on
previously.
(→P.106)
(→P.136)

A cut line is printed because CutDustReduct. is On
in the Control Panel menu to reduce cutting dust.

If this function is not needed, set CutDustReduct. to
Off in the Control Panel menu.
(→P.49)

The Printhead is set too low in the Control Panel
menu.

In the Control Panel menu, set Head Height to
Automatic.
(→P.611)

When printing on Heavyweight Coated Paper or
other paper-based media, choose a VacuumStrngth
setting of Strong or Strongest in the Control Panel
menu. If the paper still rubs, set Head Height to
Highest in the Control Panel menu.
(→P.621)
(→P.611)

You are printing on heavyweight paper or paper that
curls or wrinkles easily after absorbing ink.

When printing on CAD Tracing Paper or other
lm-based media, choose a VacuumStrngth setting
of Standard, Strong, or Strongest in the Control
Panel menu. If the paper still rubs, set Head Height
to Highest in the Control Panel menu.
(→P.621)
(→P.611)

The Ejection Guide is soiled. Clean the Ejection Guide.
(→P.646)
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The surface of the paper is dirty
Cause Corrective Action

The Paper Retainer is soiled. Clean the Paper Retainer.
(→P.647)

In the Control Panel menu, set Roll DryingTime to
at least 1 min.
(→P.49)

You are using a paper that does not dry easily.

When paper that does not dry easily is used for
printing, it may curl during printing and touch the
Output Tray.
In this case, in the Control Panel menu, set Scan
Wait Time to an option other than Off.
However, note that printing will now take longer.
(→P.49)

The back side of the paper is dirty
Cause Corrective Action

The Platen has become dirty after borderless printing
or printing on small paper.

Open the Top Cover and clean the Platen.
(→P.647)

Set Width Detection to On in the Control Panel
menu, and then open the Top Cover and clean the
Platen.
(→P.647)

The Platen has become soiled because you have set
Width Detection to Off in the Control Panel menu.

Open the Top Cover and clean the Platen. After this,
manually advance the roll onto the Platen before
printing.
(→P.647)
(→P.125)

The Paper Retainer is soiled. Clean the Paper Retainer.
(→P.647)
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Printed colors are inaccurate
Cause Corrective Action

Color adjustment has not been activated in the
Advanced Settings of the printer driver.

In the Advanced Settings of the printer driver,
access Color Settings in Color Mode to adjust
colors.

Refer to the computer and monitor documentation
to adjust the colors.

Colors have not been adjusted on the computer or
monitor.

Adjust the settings of the color management software,
referring to the software documentation as needed.

The Printhead nozzles are clogged. Print a test pattern to check the nozzles and see if
they are clogged.
(→P.630)

In the Windows printer driver, Application Color
Matching Priority is not selected.

Click Special Settings on the Layout sheet of the
printer driver and select Application Color Matching
Priority in the dialog box.

Printhead characteristics gradually change through
repeated use, and colors may change.

Adjust the Printhead alignment.
(→P.604)
(→P.606)

Color may change slightly even on the same model
of printer if you use a different version of the rmware
or printer driver, or when you print under different
settings or in a different printing environment.

Follow these steps to prepare the printing
environment.
1.Use the same version of rmware or printer driver.
2.Specify the same value for all settings items.
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Banding in different colors occurs
Cause Corrective Action

The paper feed amount is out of adjustment. Adjust the feed amount.
(→P.612)

Printing does not proceed smoothly because print
jobs are interrupted during transmission.

Exit other applications and cancel other print jobs.

In the Control Panel menu, Adj. Priority is set to
Print Length.

Setting Adj. Priority to Print Quality in the Control
Panel menu and adjusting the feed amount may
improve results.
(→P.612)

The Printhead is out of alignment. Adjust the Printhead alignment.
(→P.604)

The Printhead nozzles are clogged. Print a test pattern to check the nozzles and see if
they are clogged.
(→P.630)

Streaks may occur if you set the Print Quality too
low.

Choose a higher level of Print Quality in the
Advanced Settings of the printer driver and try
printing again.
Printing in Draft or Standard mode is faster and
consumes less ink than in Highest or High modes,
but the printing quality is lower.
(→P.187)

Load paper of the same type as you have specied
in the printer driver.
(→P.106)
(→P.136)

The type of paper specied in the printer driver does
not match the type loaded in the printer.

Make sure the same type of paper is specied in the
printer driver as you have loaded in the printer.
1.Press the Stop button and stop printing.
2.Change the type of paper in the printer driver and
try printing again.
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Colors in printed images are uneven
Cause Corrective Action

Line Drawing/Text is selected when printing images
in many solid colors.

In Print Priority in the Advanced Settings of the
printer driver, choose Image.

You are printing on paper that curls easily. Printed colors may appear uneven on the leading
edge of paper that is susceptible to curling. Select a
stronger level in VacuumStrngth in the Control Panel
menu to increase suction against the paper, and
specify a trailing margin of 20 mm (0.79 in) or more.
(→P.621)

Printed colors may be uneven if you set the Print
Quality too low.

Choose a higher level of Print Quality in the
Advanced Settings of the printer driver.
Printing in Draft or Standard mode is faster and
consumes less ink than in Highest or High modes,
but the printing quality is lower.
(→P.187)

Color may be uneven between dark and light image
areas.

Select Unidirectional Printing in the Advanced
Settings of the printer driver.

Specify No in Auto Cut in the printer driver before
printing. In this case, the paper can be printed without
borders on the left and right sides only. Cut the
printed document ejected from the printer, then use
scissors to cut away the edges on the top and bottom.

When borderless printing is used, the edge of the
paper is cut during printing. Thus, ink density may be
slightly uneven at the edges.

Choose a higher level of Print Quality in the
Advanced Settings of the printer driver.
(→P.187)

The Printhead is out of alignment. Adjust the Printhead alignment.
(→P.604)

Allowing printed documents to dry on top of each
other may cause uneven colors.

To avoid uneven colors, we recommend drying each
sheet separately.

Density may be uneven if you use Glossy Paper or
Coated Paper.

In Advanced Settings of the printer driver, choose
Highest or High in Print Quality.

Load paper of the same type as you have specied
in the printer driver.
(→P.106)
(→P.136)

The type of paper specied in the printer driver does
not match the type loaded in the printer.

Make sure the same type of paper is specied in the
printer driver as you have loaded in the printer.
1.Press the Stop button and stop printing.
2.Change the type of paper in the printer driver and
try printing again.
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Image edges are blurred or white banding occurs
Cause Corrective Action

The Platen suction is too strong. In the Control Panel menu, set VacuumStrngth to
Weakest.
(→P.621)

The Printhead is set too high in the Control Panel
menu.

In the Control Panel menu, set Head Height to
Lowest.
(→P.611)

Load paper of the same type as you have specied
in the printer driver.
(→P.106)
(→P.136)

The type of paper specied in the printer driver does
not match the type loaded in the printer.

Make sure the same type of paper is specied in the
printer driver as you have loaded in the printer.
1.Press the Stop button and stop printing.
2.Change the type of paper in the printer driver and
try printing again.

The contrast becomes uneven during printing
Cause Corrective Action

The paper feed amount is out of adjustment. Adjust the feed amount.
(→P.612)

Load paper of the same type as you have specied
in the printer driver.
(→P.106)
(→P.136)

The type of paper specied in the printer driver does
not match the type loaded in the printer.

Make sure the same type of paper is specied in the
printer driver as you have loaded in the printer.
1.Press the Stop button and stop printing.
2.Change the type of paper in the printer driver and
try printing again.
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The length of printed images is inaccurate in the feeding
direction

Cause Corrective Action
In the Control Panel menu, Adj. Priority is set to
Print Quality.

Set Adj. Priority to Print Length in the Control
Panel menu, and then execute Adjust Length.
(→P.612)

Load paper of the same type as you have specied
in the printer driver.
(→P.106)
(→P.136)

The type of paper specied in the printer driver does
not match the type loaded in the printer.

Make sure the same type of paper is specied in the
printer driver as you have loaded in the printer.
1.Press the Stop button and stop printing.
2.Change the type of paper in the printer driver and
try printing again.

Images are printed crooked
Cause Corrective Action

In the Control Panel menu, Skew Check Lv. is set to
Loose or Off.

In the Control Panel menu, set Skew Check Lv. to
Standard.

In the Control Panel menu, Width Detection is set
to Off.

Set Width Detection to On in the Control Panel
menu.

Documents are printed in monochrome
Cause Corrective Action

In the Advanced Settings of the printer driver,
Monochrome, Monochrome (BK ink), or
Monochrome Bitmap is specied in Color Mode.

In the Advanced Settings of the printer driver,
specify Color in Color Mode and try printing again.

The Printhead nozzles are clogged. Print a test pattern to check the color ink nozzles and
see if they are clogged.
(→P.630)
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Line thickness is not uniform
Cause Corrective Action

In the Special Settings dialog box of the Windows
printer driver, Fast Graphic Process is selected.

Access the printer driver Properties dialog box from
Print in the File menu of the source application, and
follow these steps to print.
1.Clear the option Open Preview When Print Job
Starts on the Main sheet.

2.Clear the option Page Layout on the Layout
sheet.

3.Click the Special Settings button in the Layout
sheet to open the Special Settings dialog
box, and remove the check from Fast Graphic
Process.

Load paper of the same type as you have specied
in the printer driver.
(→P.106)
(→P.136)

The type of paper specied in the printer driver does
not match the type loaded in the printer.

Make sure the same type of paper is specied in the
printer driver as you have loaded in the printer.
1.Press the Stop button and stop printing.
2.Change the type of paper in the printer driver and
try printing again.

Lines are misaligned
Cause Corrective Action

The Printhead alignment is not adjusted. Adjust the Printhead alignment.
(→P.604)
(→P.606)
(→P.608)

Load paper of the same type as you have specied
in the printer driver.
(→P.106)
(→P.136)

The type of paper specied in the printer driver does
not match the type loaded in the printer.

Make sure the same type of paper is specied in the
printer driver as you have loaded in the printer.
1.Press the Stop button and stop printing.
2.Change the type of paper in the printer driver and
try printing again.

Problems with the printing quality caused by the type
of paper
For paper-specic troubleshooting tips to improve the printing quality, refer to the Paper Reference Guide.
(→P.95)
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Cannot print over a network

Cannot connect the printer to the network
Cause Corrective Action

The Ethernet cable is not connected
correctly to the printer’s Ethernet port.

1.Make sure the printer is connected to the network with the correct
Ethernet cable, and then turn the printer on. For instructions on
connecting the cable, refer to the Setup Guide.

2.Make sure the Link indicator is lit.
The bottom indicator is green if the printer is connected via
1000Base-T, while the top indicator is orange if connected via
100Base-TX and the top indicator is green if connected via
10Base-T.
If the Link indicator is not lit, check the following points.

• Make sure the hub is on.
• Make sure the end of the Ethernet cable is connected
correctly.
Insert the Ethernet cable until it clicks and locks in place.

• Make sure there is no problem with the Ethernet cable.
If there is any problem, replace the Ethernet cable.

• Check the communication mode with the hub.
Although the printer normally detects the hub
communication mode and transmission rate automatically
(in auto negotiation mode), sometimes the hub settings
cannot be detected. In this case, congure the connection
method manually, specifying the communication mode in
use.
(→P.578)

Cannot print over a TCP/IP network
Cause Corrective Action

The printer’s IP address is not congured correctly. Make sure the printer’s IP address is congured
correctly.
(→P.564)
(→P.565)

The printer’s TCP/IP network settings are not
congured correctly.

Make sure the printer’s TCP/IP network settings are
congured correctly.
(→P.570)

The computer you are trying to print from is not
congured correctly.

Make sure the computer’s TCP/IP network settings
are congured correctly.
(→P.581)
(→P.600)
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Cannot print over a NetWare network
Cause Corrective Action

The printer’s NetWare settings are not congured
correctly.

Make sure the printer’s NetWare settings are
congured correctly. In particular, make sure a valid
frame type is selected.
(→P.575)

The computer you are trying to print from is not
congured correctly.

Make sure the computer’s NetWare settings are
congured correctly.
(→P.593)

The NetWare server and services are not congured
correctly.

Check the following points.
1.Make sure the NetWare le server is running.
2.Make sure there is enough free disk space on the
NetWare le server. Insufcient disk space may
prevent you from processing large print jobs.

3.Start NWADMIN or PCONSOLE and conrm that
the print service is congured correctly and the
print queue is available.

4.If data transmission to a printer on another subnet
fails, deactivate NCP burst mode in that printer’s
network protocol settings.

5.If the printer is used in queue server mode, specify
“Other/Unknown” as the printer type.

Cannot print over AppleTalk or Bonjour networks
Cause Corrective Action

The AppleTalk protocol is not enabled on the printer. Activate AppleTalk on the printer.
(→P.574)

The computer you are trying to print from is not
congured correctly.

Make sure the computer’s AppleTalk settings are
congured correctly.
(→P.598)
(→P.602)

The computer and printer are not on the same
network.

Due to the nature of Bonjour, you cannot print if
the printer is on another network behind a router.
Make sure the computer and printer are on the same
network. For information about network settings, ask
your network administrator.
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Installation problems

Removing Installed Printer Drivers
Follow these steps to remove installed printer drivers and utilities.

Removing printer drivers (Windows)
Remove the printer driver as follows.

Note
• In Windows 2000/Windows XP/Windows Server 2003/Windows Vista/Windows Server 2008, you must
log on with administrative rights, such as those of the “Administrator” account.

1. From the Windows start menu, select Programs >Canon Printer Uninstaller
>imagePROGRAF Printer Driver Uninstaller to display the Delete Printer window.

2. Select the printer in the list and click Delete.
3. Click Yes after the Warning message is displayed.
4. Make sure that the printer has been removed from the list, and then click Exit.

Removing printer drivers and imagePROGRAF Printmonitor
(Macintosh)
Remove the printer driver or imagePROGRAF Printmonitor as follows.

1. Insert the User Software CD-ROM provided with the printer in the CD-ROM drive.
2. Start the printer driver installer included in the User Software CD-ROM.

Open the OS X folder and double-click iPF Driver Installer X.
3. In the upper left menu, choose Uninstall, and then click Uninstall.
4. Follow the instructions on the screen to remove the printer driver or imagePROGRAF

Printmonitor.

Removing imagePROGRAF Status Monitor (Windows)
Remove imagePROGRAF Status Monitor as follows.

1. From the Windows start menu, select Programs >imagePROGRAF Status Monitor
>Uninstaller (imagePROGRAF Status Monitor) to start the wizard.

2. In the wizard window, click Delete, and then click Next.
3. Follow the instructions on the screen to remove imagePROGRAF Status Monitor.

Removing imagePROGRAF Device Setup Utility (Windows)
Remove imagePROGRAF Device Setup Utility as follows.

1. From the Windows start menu, select Programs >imagePROGRAF Device Setup Utility
>Uninstaller (imagePROGRAF Device Setup Utility) to start the wizard.

2. In the wizard window, click Delete, and then click Next.
3. Follow the instructions on the screen to remove imagePROGRAF Device Setup Utility.
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HP-GL/2 problems

With HP-GL/2, printing is misaligned
Cause Corrective Action

The plotter origin is incorrect. Check the printing commands.

The Margin setting in the Control Panel menu is
incorrect.

Adjust the Margin setting values in the Control Panel
menu.

Lines or images are missing in printed HP-GL/2 jobs.
Cause Corrective Action

The memory is full. Check the size of the data in the print job.

An HP-GL/2 command not supported by this printer
was received.

Check the print job and settings.

The printer has received print data that includes HP
RTL commands when Auto Rotate is On in the
Control Panel menu.

In the Control Panel, set Auto Rotate to Off and
print again.
(→P.49)

Lines are printed too thick or thin in HP-GL/2 print jobs
Cause Corrective Action

The Width setting in the Control Panel menu is
incorrect.

Check the Width setting value specied for Pen
no. in Palette A or Palette B in the Control
Panel menu. If ne lines are printed faintly, setting
ThickenFineLines to On will print the lines more
distinctly.
(→P.49)

HP-GL/2 jobs are printed in monochrome (or color)
Cause Corrective Action

The Color Mode setting in the Control Panel menu
is incorrect.

Check the Color Mode setting in the Control Panel
menu.
(→P.49)
However, for optimal Printhead performance, the
printer consumes trace amounts of color ink even
when Monochrome is selected as Color Mode.

Printed colors of lines are inaccurate during HP-GL/2
printing

Cause Corrective Action
AdjustFaintLines is On in the Control Panel menu. Setting AdjustFaintLines to Off in the Control

Panel menu may help produce the expected results.
However, lines in some colors may appear broken.
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HP-GL/2 jobs are printed 6 mm larger than specied
Cause Corrective Action

The page size of the HP-GL/2 print job, as created in
the source application, is incorrect.

In the Control Panel menu, set PageSizeProcess1
to On.
(→P.49)

HP-GL/2 jobs are printed at maximum size, even if a
standard size is specied

Cause Corrective Action
The page size of the HP-GL/2 print job, as created in
the source application, is incorrect.

In the Control Panel menu, set PageSizeProcess2
or Conserve Paper to On.
The layout will be changed to the optimal layout.
(→P.49)

HP-GL/2 printing takes a long time
Cause Corrective Action

Large print jobs with a lot of data take longer to print. Please wait a while until printing is nished.

A job was printed when Input Resolution in the
Control Panel menu was set to 600dpi.

In the Control Panel menu, set Input Resolution to
300dpi and print again.
(→P.49)

Replotting with HP-GL/2 jobs is not possible.
Cause Corrective Action

The data was lost because of replotting. Data for replotting is lost after the following
operations. In this case, send the print job again.
• The memory buffer was cleared from the Control
Panel.

• The printer was turned off.
• The printer has received a new HP-GL/2 print job.
• Printing has been canceled

The printer stops when printing a HP-GL/2 job (the
carriage stops moving)

Cause Corrective Action
The printer is analyzing the print job. Please wait a while until printing is nished.

A job was printed when Input Resolution in the
Control Panel menu was set to 600dpi.

In the Control Panel menu, set Input Resolution to
300dpi and print again.
(→P.49)
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The printer does not go on
Cause Corrective Action

The printer is unplugged. Plug the power cord into the outlet, and then turn on
the printer.

The specied voltage is not supplied. Check the voltage of the outlet and breaker.
Use a power source that conforms to the printer
specications.
(→P.71)
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If the Printer Makes a Strange Sound
Cause Corrective Action

The printer makes a sound during
operation.

The following sounds do not indicate a problem with the printer.
• There is a sound of suction from the Platen
To prevent paper from rising, paper is held against the Platen by
suction from Vacuum holes under it.

• There is a sound when a different size of paper is used and when
the Carriage goes from side to side
When paper of a different size is used, a valve is automatically
activated to switch the area for paper suction, which may make a
sound. This mechanism prevents suction from Vacuum holes where
there is no paper.
In addition, ink is ejected in sync with the movement of the Carriage
back and forth to ensure optimal ink ow. At this time, the valve
automatically switches the area for paper suction, which may make
a sound.

• Roll paper makes a uttering sound during printing
There may be a uttering sound when large paper is advanced.

• If you suddenly hear the tone for cleaning operations
At regular intervals, for printer maintenance, cleaning operations will
begin automatically, even if the printer is in Sleep mode.

• If you suddenly hear the tone for ink agitation
At regular intervals, to ensure optimal printing quality, the ink is
agitated automatically, even if the printer is in Sleep mode. Ink
agitation takes about 30 seconds.
The ink is also agitated automatically under the following conditions.
Note that other operations are not possible while Agitating is
displayed on the control panel.

• After the printer is turned on. (The time for agitation varies
depending on how long the printer was off-between about 30
seconds and two minutes.)

• After data transmission. (After about a minute and a half,
printing operations begin. However, printing may start later
after data reception, depending on the size of print data.)

• After ink tank replacement. (Ink agitation takes about three
and a half minutes.)

In other cases, contact your Canon dealer.
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Messages advising to check the maintenance cartridge
are not cleared

Cause Corrective Action
Remove the new Maintenance Cartridge you have
just installed and insert it again rmly.

The printer has not detected the new Maintenance
Cartridge that was used to replace the old one.

Restart the printer.

The printer consumes a lot of ink
Cause Corrective Action

Many full-page color images are printed. In print jobs such as photos, images are lled with
color. This consumes a lot of ink. This does not
indicate a problem with the printer.

Head Cleaning B in the Control Panel menu is
executed frequently.

Head Cleaning B in the Control Panel menu
consumes a lot of ink. This does not indicate a
problem with the printer. Unless the printer has
been moved or stored for a long period or you are
troubleshooting Printhead problems, we recommend
not performing Head Cleaning B, to the extent
possible.

You have just nished initial installation, when more
ink is consumed to ll the system.

After initial installation or at the rst-time use after
transfer, ink ows into the system between the Ink
Tank and Printhead, which may cause the ink level
indicators to drop to 80%. This does not indicate a
problem with the printer.

The Printhead nozzles are clogged. Check for nozzle clogging.
(→P.630)
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Ink Level Detection
Ink level detection will be deactivated if you load ink tanks once emptied.

Ink level detection
Ink tanks specied for this printer feature an ink level detection function to prevent the ink from running out
during printing, which prevents printer damage. (→P.622)
This function will not work correctly if you use rell ink tanks. As a result, printing stops. Thus, before using
rell ink tanks, you must cancel the ink level detection.
Printing with the ink level detection canceled may lead to printer damage and printing problems. Canon Inc.
is not liable for any damage that may occur as a result of relling ink.

Caution
• After ink level detection has been released, this function cannot be reactivated for currently loaded Ink
Tank. To use ink level detection again, replace the Ink Tank with new ones specied for use with
the printer.

• Repeatedly removing and inserting an Ink Tank may damage the connection between the Ink Tank and
the printer, which may cause ink leakage from the Ink Tank and damage the printer.

Releasing ink level detection
1. On the Display Screen, a message indicates that the ink level cannot be detected. After checking

the message, press the ► button.

2. Press ▲ or ▼ to select Information, and then press the OK button.

3. A conrmation message is shown on the Display Screen about releasing ink level detection.
After checking the message, press the ► button.

4. After checking the message, press the ► button.
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5. Press ▲ or ▼ to select Yes, and then press the OK button.

6. Check the message and press the ► button.

7. Check the message and press the ► button.

8. Press ▲ or ▼ to select Yes, and then press the OK button.

9. A conrmation message about updating ink information is shown on the Display Screen. After
checking the message, press the ► button.

10. Press ▲ or ▼ to select Yes, and then press the OK button.

Ink level detection is now released.
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Error Message

Messages regarding paper

MediaType Mismatch
Cause Corrective Action

When Detect Mismatch in the Control Panel menu
is set to Pause, the type of paper loaded does not
match the type specied in the printer driver.

Follow these steps to ensure the paper type matches
on the printer and in the printer driver.
1.Press ▲ or ▼ to select Stop Printing, and then
press the OK button.

2.Either change the type of paper specied in the
printer driver settings or replace the loaded paper
and change the paper type setting on the printer.
(→P.78)
(→P.81)

When printing a test pattern for adjustment, use
sheets of the same type of paper, in the required
quantity. Replace the paper as follows and perform
adjustment again.
1.Press ▲ or ▼ to select Stop Printing, and then
press the OK button.

2.Replace the paper.
(→P.81)

3.Execute adjustment again from the control panel
menu.

You tried to print a test pattern for printer adjustment
on several sheets, but sheets of different types of
paper were used.

Press▲ or▼ to select Print, and then press the OK
button to resume printing.
However, note that this error may cause paper jams
and affect the printing quality.

When Detect Mismatch in the Control Panel menu
is set to Warning, the type of paper loaded does not
match the type specied in the printer driver.

You can continue to print, but note that this error may
cause problems in the printing results.
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The paper is too small.
Cause Corrective Action

Press▲ or▼ to select Print, and then press the OK
button to resume printing.
However, note that this error may cause paper jams
and affect the printing quality.

Adjust the paper size setting in the printer driver to
match the size loaded in the printer as follows.
1.Press ▲ or ▼ to select Stop Printing, and then
press the OK button.

2.Change the paper size setting in the printer driver
to the size loaded in the printer and try printing
again.

When Detect Mismatch in the Control Panel menu
is set to Pause, paper smaller than the size specied
in the printer driver is loaded.

Replace the loaded paper with paper of a size that
matches the size setting in the printer driver as
follows.
1.Press▲ or▼ to select Change Paper, and then
press the OK button to stop printing.

2.Replace the loaded paper to match the paper
width setting in the printer driver and try printing
again.

When Detect Mismatch in the Control Panel menu is
set toWarning, paper smaller than the size specied
in the printer driver is loaded.

You can continue to print, but note that this error may
cause problems in the printing results.
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The paper is too small.
Replace paper with A4/LTR (vertical) or larger

Cause Corrective Action
Replace the paper with paper of A4/Letter (vertical)
size or larger as follows.
1.Press▲ or▼ to select Change Paper, press the
OK button, and remove the paper.
(→P.144)

2.Switch to paper A4/Letter (vertical) or larger.
(→P.81)
The printer will resume printing.

The loaded paper is too small.

Press ▲ or ▼ to select Stop Printing, and then
press the OK button.

Replace roll with 10 in. wide or larger roll.
Cause Corrective Action

Replace the roll with a roll 10 inches in width or larger
as follows.
1.Press▲ or▼ to select Change Paper, and then
press the OK button.
(→P.116)
(→P.118)

2.Replace the roll with a roll 10 inches wide or larger.
(→P.103)
(→P.106)
The printer will resume printing.

The loaded paper is too small.

Press ▲ or ▼ to select Stop Printing, and then
press the OK button.

Remove paper and check pap. size
Cause Corrective Action

A sheet has come out of the printer during printing. 1.Press the Release Lever back and remove the
paper.

2.Reload the sheet, aligning it with the guide on the
right.

3.Pull the Release Lever forward.
4.If Not nished printing. Finish printing
remaining jobs? is shown on the Display Screen,
press the OK button.
Printing will resume, starting from the page on
which the error occurred.

(→P.136)
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PaprWidth Mismatch
Cause Corrective Action

Press▲ or▼ to select Print, and then press the OK
button to resume printing.
However, note that this error may cause paper jams
and affect the printing quality.

Press ▲ or ▼ to select Stop Printing, and then
press the OK button.

Follow these steps to replace the roll to match the
width specied in the printer driver.
1.Press▲ or▼ to select Change Paper, and then
press the OK button.
(→P.116)
(→P.118)

2.Replace the paper with paper compatible for
borderless printing.
(→P.103)
(→P.106)
The printer now starts printing the print job.

When Detect Mismatch in the Control Panel menu is
set to Pause orWarning, the width of the loaded roll
does not match the width specied in Fit Roll Paper
Width in the printer driver.

Make sure the roll width selected in the dialog box
displayed when you select Fit Roll Paper Width in
the printer driver matches the width of the roll loaded
in the printer, and then try printing again.
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Paper size not detected.
Cause Corrective Action

Follow these steps to reload the roll.
1.Push the Release Lever back.
2.Adjust the right edge of the roll to make it parallel
to the orange Paper Alignment Line.

3.Pull the Release Lever forward.
4.If Not nished printing. Finish printing
remaining jobs? is shown on the Display Screen,
press the OK button.
Printing will resume, starting from the page on
which the error occurred.

(→P.106)

If this error recurs after you reload the roll, remove
the Roll Holder from the printer, push the roll rmly in
until it touches the Roll Holder ange, and reload the
Roll Holder in the printer.
(→P.103)

Paper has been loaded askew, or warped paper has
been loaded.

Follow these step to reload a sheet.
1.Push the Release Lever back.
2.Load the sheet, aligning it with the guide on the
right.

3.Pull the Release Lever forward.
4.If Not nished printing. Finish printing
remaining jobs? is shown on the Display Screen,
press the OK button.
Printing will resume, starting from the page on
which the error occurred.

(→P.136)

Because the Platen is soiled with ink or other
substances, the size of the clear lm cannot be
detected.

Open the Top Cover and clean the entire Platen.
(→P.647)
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Insufcient paper for job
Cause Corrective Action

Press▲ or▼ to select Print, and then press the OK
button to resume printing.
However, the roll paper may run out during the
print job and you may not be able to print all of the
document.

The printer has received a print job longer than the
amount of roll paper left when ManageRemainRoll
in the Control Panel menu is On.

Press ▲ or ▼ to select Change Paper, and then
press the OK button to stop printing.
Either change the printer driver Paper Source setting
or the GL2 Settings > Paper Source setting in the
printer menu or replace the roll with a roll that has
enough paper for the print job, and then try printing
again.
(→P.116)
(→P.106)

This paper cannot be used.
Cause Corrective Action

Paper smaller than the printer’s minimum supported
size has been loaded.

Push the Release Lever back and load paper of the
correct size.
(→P.100)

Paper has been loaded that is too small to print
the test pattern for printhead adjustment or nozzle
checking.

Push the Release Lever back and load unused paper
of A4 size or larger. More than one sheet may be
required depending on the adjustment.

Roll printing is selected.
Cause Corrective Action

Press ▲ or ▼ to select Load Roll Paper, and then
press the OK button. Load the roll, and then print.
(→P.103)
(→P.106)

You have attempted to print a test print sheet or
other printer status information on a roll, but no roll
is loaded.

To print on sheets, follow these steps.
1.Press ▲ or ▼ to select Stop Printing, and then
press the OK button to stop printing.

2.Load a sheet and try printing again.
(→P.81)
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Roll printing is selected, but sheets are loaded.
Cause Corrective Action

Follow these steps to load and print on a roll.
1.Press ▲ or ▼ to select Eject Cut Sheet, press
the OK button, and remove the sheet.
(→P.144)

2.Load a new roll.
(→P.106)
The printer now starts printing the print job.

A print job for rolls was received when a sheet is
loaded.

Press ▲ or ▼ to select Stop Printing, and then
press the OK button.

The roll is empty.
Cause Corrective Action

The roll is empty. Follow these steps to replace the used roll with a new
roll of the same type and size.
1.Press the Release Lever back and remove the roll.
(→P.116)
(→P.118)

2.Load the new roll.
(→P.103)
(→P.106)

3.If no barcode was printed on the roll, specify the
type of paper.
(→P.110)

4.When you have selected ManageRemainRoll >
On in the control panel menu and a barcode is not
printed on the roll, also specify the paper length.
(→P.112)

5.If Not nished printing. Finish printing
remaining jobs? is shown on the Display Screen,
press the OK button.
Printing will resume, starting from the page on
which the error occurred.

There is remaining roll paper, but because it could
not be advanced, it could not be detected.

Choose a higher level of Print Quality in the
Advanced Settings of the printer driver.
(→P.187)
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Sheet printing is selected.
Cause Corrective Action

Press ▲ or ▼ to select Load Cut Sheet, and then
press the OK button. Load the sheet, and then print.
(→P.81)

You have attempted to print a test print sheet or other
printer status information on a sheet, but no sheet
is loaded.

To print on rolls, follow these steps.
1.Press ▲ or ▼ to select Stop Printing, and then
press the OK button to stop printing.

2.Load a roll and try printing again.
(→P.78)

Regular printing is selected, but a roll is loaded.
Cause Corrective Action

A print job for printing on sheets was sent when a
roll is loaded.

1.Press▲ or▼ to select Remove Roll Paper, and
then press the OK button to stop printing.

2.After removing the roll, load and print on a sheet
of the type and size of paper you have specied in
the printer driver.
(→P.116)
(→P.81)
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Paper jam
Push the release lever back.

Cause Corrective Action
A paper jam occurred in the printer during printing. 1.Push the Release Lever back and remove the

jammed paper.
(→P.120)
(→P.145)

2.Load the paper.
3.Pull the Release Lever forward.
4.If Not nished printing. Finish printing
remaining jobs? is shown on the Display Screen,
press the OK button.
Printing will resume, starting from the page on
which the error occurred.

(→P.106)
(→P.136)

Manually rewind the roll all the way and press OK.
Cause Corrective Action

A paper jam occurred when advancing the paper. 1.Rewind paper on the Roll Holder manually, all the
way, and then press the OK button.

2.Load the paper.
3.If Not nished printing. Finish printing
remaining jobs? is shown on the Display Screen,
press the OK button.
Printing will resume, starting from the page on
which the error occurred.

(→P.106)
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Paper is crooked.
Cause Corrective Action

Follow these steps to reload the roll.
1.Push the Release Lever back.
2.Adjust the right edge of the roll to make it parallel
to the orange Paper Alignment Line.

3.Pull the Release Lever forward.
(→P.106)

If this error recurs after you reload the roll, remove
the Roll Holder from the printer, push the roll rmly in
until it touches the Roll Holder ange, and reload the
Roll Holder in the printer.
(→P.103)

Paper loaded crooked was detected when the paper
was advanced.

Follow these step to reload a sheet.
1.Push the Release Lever back.
2.Pull out the sheet.
3.Pull the Release Lever forward.
4.Reload the sheet, aligning it with the guide on the
right.

(→P.136)

Note
• To disable this message (if it is displayed repeatedly despite reloading paper, for example), choose Off
or Loose in the Skew Check Lv. setting of the printer menu. However, this may cause jams and
printing problems because paper may be askew when printed. Also, the Platen may become soiled,
which may soil the back of the next document when it is printed.
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Paper not aligned with right guide.
Cause Corrective Action

When paper was loaded, it was not aligned with the
guide on the right side.

Follow these step to reload a sheet.
1.Push the Release Lever back.
2.Pull out the sheet.
3.Pull the Release Lever forward.
4.Reload the sheet, aligning it with the guide on the
right.

Cannot detect papr
Cause Corrective Action

Follow these step to reload a sheet.
1.Remove the paper and press the OK button.
2.Reload the sheet, aligning it with the guide on the
right.
(→P.136)

The paper has come out of the printer.

Follow these step to reload a sheet.
1.Push the Release Lever back and remove the
paper.

2.Pull the Release Lever forward.
3.Reload the sheet, aligning it with the guide on the
right.
(→P.136)
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Paper cutting failed.
Cause Corrective Action

There are sheets left on the Ejection Guide. 1.Push the Release Lever back and remove the
paper.

2.Load the paper.
3.Pull the Release Lever forward.
4.If Not nished printing. Finish printing
remaining jobs? is shown on the Display Screen,
press the OK button.
Printing will resume, starting from the page on
which the error occurred.

(→P.106)

There is a foreign object by the Output Tray,
obstructing the Cutter Unit.

1.Lift the Top Cover and remove the foreign object.
2.If Not nished printing. Finish printing
remaining jobs? is shown on the Display Screen,
press the OK button.
Printing will resume, starting from the page on
which the error occurred.

You are not using the printer under the recommended
environmental conditions for the paper.

Use the printer only where the recommended
environmental conditions for the paper are met.
Note that various environmental conditions are
recommended for various types of paper. For details
on the recommended environmental conditions for
paper, see Paper Reference Guide."
(→P.95)

You are using paper that is not compatible with
automatic cutting.

1.Specify Manual as the cutting method and use
scissors or a cutting tool to cut the roll.
(→P.129)
For information about paper that is compatible
with automatic cutting, see the Paper Reference
Guide.
(→P.95)

2.Push the Release Lever back and remove the
paper.

In other cases, the Cutter Unit may be damaged. Contact your Canon dealer for assistance.

End of paper feed.
Cause Corrective Action

You are pressing the▲ button on the Control Panel
and trying to rewind the roll to the edge.

Release the ▲ button.
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Rel lever is in wrong position.
Cause Corrective Action

The Release Lever is pushed back. Pull the Release Lever forward.
Turn off the printer and wait a while before restoring
power.

Borderless printng not possible.
Cause Corrective Action

Follow these steps to change the settings of the print
job to enable borderless printing.
1.Press ▲ or ▼ to select Stop Printing, and then
press the OK button.

2.Make sure the correct printer driver for the printer
is selected and try printing again.
For information on types of paper compatible with
borderless printing, refer to the Paper Reference
Guide.
(→P.95)

Select None when you have set Detect Mismatch
on the control panel to Warning.

The print job received species a type or width of
paper that is not compatible with borderless printing.

Press ▲ or ▼ to select Print With Border, and
then press the OK button to continue printing. The
document will be printed with a border.

Press ▲ or ▼ to select Stop Printing, and then
press the OK button.

Replace the paper with paper compatible for
borderless printing as follows.
1.Press▲ or▼ to select Change Paper, and then
press the OK button.
(→P.116)
(→P.118)

2.Replace the paper with paper compatible for
borderless printing.
(→P.103)
(→P.106)
The printer now starts printing the print job.
For information on types of paper compatible with
borderless printing, refer to the Paper Reference
Guide.
(→P.95)

The loaded paper is a size not compatible with
borderless printing.

Press ▲ or ▼ to select Print With Border, and
then press the OK button to continue printing. The
document will be printed with a border.
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Paper position not suitable for borderless printing.
Cause Corrective Action

Press ▲ or ▼ to select Stop Printing, and then
press the OK button.
Use each type of paper only where the recommended
environmental conditions are met. For details on
environmental conditions for various paper, see the
Paper Reference Guide.
(→P.95)

Because paper expands or contracts depending on
the environment of use, it may become narrower or
wider than the supported width for borderless printing.

Select None when you have set Detect Mismatch in
the Control Panel menu to Warning.
However, note that this error may affect the printing
quality.

Press ▲ or ▼ to select Fix Paper Position and
straighten the paper so that the edges are between
the ink grooves for borderless printing.
Insert the roll rmly until it touches the ange of the
Roll Holder.
(→P.103)

Select None when you have set Detect Mismatch in
the Control Panel menu to Warning.
However, note that this error may affect the printing
quality.

The paper is loaded askew.

Press ▲ or ▼ to select Print With Border, and
then press the OK button to continue printing. The
document will be printed with a border.

Roll paper is not securely in contact with roll holder.
Cause Corrective Action

When the roll was loaded, the roll was not inserted
rmly all the way on the Roll Holder.

Follow these steps to reload the roll.
1.Press the OK button and remove the roll holder
from the printer.

2.Insert the roll rmly on the Roll Holder until it
touches the ange.
(→P.103)

3.Load the Roll Holder in the printer.
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Messages regarding ink

Ink insufcient.
Cause Corrective Action

Press ▲ or ▼ to select Rep. Ink Tank, and then
press the OK button. Replace the Ink Tank that is
low with a new Ink Tank.
(→P.623)

The ink level is low, so you cannot print, clean the
Printhead, or do other operations that require ink.

Press▲ or▼ to select Continue to print, and then
press the OK button to resume printing. However,
note that this error may affect the printing quality.

No ink left.
Cause Corrective Action

There is no ink left. Open the Ink Tank Cover and replace the Ink Tank
for which the Ink Lamp is ashing.
(→P.623)

Remaining level of the ink cannot be correctly detected.
Cause Corrective Action

Ink level detection cannot work correctly if you use
rell ink tanks.

The rell ink tank can no longer be used. See the
section “Ink level detection” and take the appropriate
action. (→P.687)

Unable to detect ink level correctly.
Cause Corrective Action

The remaining ink level could not be correctly
detected.

Close the Ink Tank Cover.
The buzzer will stop once the error is cleared.

Close Ink Tank Cover
Cause Corrective Action

The Ink Tank Cover is open. Close the Ink Tank Cover.
The buzzer will stop once the error is cleared.
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Ink tank is empty.
Cause Corrective Action

There is no ink left in an ink tank. Open the Ink Tank Cover and replace the Ink Tank
for which the Ink Lamp is ashing.
(→P.623)

Not much ink is left.
Cause Corrective Action

Not much ink is left. Prepare a new Ink Tank.
We recommend replacing the Ink Tank with a new Ink
Tank at this point if you plan to print large-format or
high-quantity jobs.

No ink tank loaded.
Cause Corrective Action

There is no Ink Tank of the indicated color in the
printer.

Load or reload the Ink Tank.
(→P.623)

There is a problem with the Ink Tank. Replace it with a new Ink Tank.
(→P.623)

Wrong ink tank.
Cause Corrective Action

The Ink Tank in the printer is incompatible. Load an Ink Tank specied for use with the printer.
(→P.623)

Do not pull out ink tank.
Cause Corrective Action

The remaining ink level could not be correctly
detected.

Install the Ink Tank that was removed.
The buzzer will stop once the error is cleared.
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Messages regarding printing or adjustment

Cannot adjust printhead.
Cause Corrective Action

The Printhead nozzles are clogged. Execute Head Posi. Adj. again, as follows.
1.Press the OK button to clear the error.
2.Print a test pattern to check the nozzles.
(→P.630)

3.Clean the Printhead if the nozzles are clogged.
(→P.632)

4.Execute Head Posi. Adj. again.
(→P.604)

The Printhead cannot be aligned; highly transparent
lm is loaded.

Press the OK button to clear the error.
We recommend using a type of paper that you often
use, other than lm, for Printhead adjustment.
(→P.604)

The Printhead is installed crooked. Straighten the Printhead as follows, and then execute
Head Posi. Adj. again.
1.Press the OK button to clear the error.
2.Use Head Inc. Adj. to adjust the angle of
inclination of the Printhead.
(→P.608)

3.Execute Head Posi. Adj. again.
(→P.604)

Cannot adjust paper feed.
Cause Corrective Action

The Printhead nozzles are clogged. Execute Adj. Quality again, as follows.
1.Press the OK button to clear the error.
2.Print a test pattern to check the nozzles.
(→P.630)

3.Clean the Printhead if the nozzles are clogged.
(→P.632)

4.Execute Adj. Quality again.
(→P.614)

Highly transparent lm is loaded that cannot be used
for automatic feed amount adjustment.

Press the OK button to clear the error, and then
adjust the feed amount manually.
(→P.616)
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Check printed document.
Cause Corrective Action

The Printhead nozzles are becoming clogged. If printing is faint, clean the Printhead.
(→P.632)
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Messages regarding printheads

Cannot adjust printhead.
Cause Corrective Action

The Printhead nozzles are clogged. Execute Head Posi. Adj. again, as follows.
1.Press the OK button to clear the error.
2.Print a test pattern to check the nozzles.
(→P.630)

3.Clean the Printhead if the nozzles are clogged.
(→P.632)

4.Execute Head Posi. Adj. again.
(→P.604)

The Printhead cannot be aligned; highly transparent
lm is loaded.

Press the OK button to clear the error.
We recommend using a type of paper that you often
use, other than lm, for Printhead adjustment.
(→P.604)

The Printhead is installed crooked. Straighten the Printhead as follows, and then execute
Head Posi. Adj. again.
1.Press the OK button to clear the error.
2.Use Head Inc. Adj. to adjust the angle of
inclination of the Printhead.
(→P.608)

3.Execute Head Posi. Adj. again.
(→P.604)

Wrong printhead.
Cause Corrective Action

An incompatible Printhead has been installed. Open the Top Cover and replace the Printhead with
a new one.
(→P.633)

Printhead error
Cause Corrective Action

There is a problem with the Printhead. Open the Top Cover and replace the Printhead with
a new one.
(→P.633)
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No printhead
Cause Corrective Action

No Printhead is installed. Install the Printhead.
(→P.633)

Execute printhead cleaning.
Cause Corrective Action

Follow these steps to clean the Printhead.
1.Stop printing by pressing ▲ or ▼ to select Stop
Printing.

2.Clean the Printhead.
(→P.632)

If this message is still displayed, replace the
Printhead.
(→P.633)

Press▲ or▼ to select Print, and then press the OK
button to resume printing. However, note that this
error may affect the printing quality.

The Printhead nozzles are clogged.

If OK is shown on the Display Screen, clean the
Printhead.
1.Press the OK button on the Control Panel to stop
printing.

2.Clean the Printhead.
(→P.632)

If this message is still displayed, replace the
Printhead.
(→P.633)
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Messages regarding the maintenance cartridge

Insert the maintenance cartridge.
Cause Corrective Action

The Maintenance Cartridge is not installed. Install the Maintenance Cartridge.
(→P.639)

Wrong maintenance cartridge.
Cause Corrective Action

A Maintenance Cartridge for a different model of
printer is installed.

Replace it with the Maintenance Cartridge for your
particular model.

Maint. cart. The level is low
Cause Corrective Action

The Maintenance Cartridge is almost full. You can continue to print, but prepare a new
Maintenance Cartridge to use when the message for
replacement is displayed.

No Maintenance Cartridge capacity.
Cause Corrective Action

The Maintenance Cartridge cannot absorb enough
ink for Printhead cleaning or other operation.

After conrming that the printer has stopped
operating, replace the Maintenance Cartridge.
(→P.639)

Maintenance cartridge full.
Cause Corrective Action

The Maintenance Cartridge is full. After conrming that the printer has stopped
operating, replace the Maintenance Cartridge.
(→P.639)

Maintenance cartridge problem.
Cause Corrective Action

An incompatible or used Maintenance Cartridge has
been installed.

Install an unused Maintenance Cartridge specied for
use with the printer.
(→P.639)
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Messages regarding HP-GL/2

This type of paper is not compatible with HP-GL/2.
Cause Corrective Action

Follow these steps to replace the type of paper in
the printer.
1.Press ▲ or ▼ to select Stop Printing, and then
press the OK button.

2.Replace the paper with a type compatible with
HP-GL/2. For details on paper compatible with
HP-GL/2, refer to the Paper Reference Guide.
(→P.95)

The printer has received a HP-GL/2 print job that
cannot be printed on the paper that has been
advanced.

Press▲ or▼ to select Print, and then press the OK
button to resume printing. However, note that this
error may cause paper jams and affect the printing
quality.

GL2: Wxxxx The memory is full. (xxxx is 0501, 0903, or
0904)

Cause Corrective Action
The printer memory is full. Because the entire print job could not be received,

the printer may not be able to print the entire original.
Check the printing results.

GL2: W0502 The parameter is out of range.
Cause Corrective Action

Check the print job.A parameter specied in a HP-GL/2 command is out
of the supported range.

If you have specied ProcessingOption > Warning
> On in the Control Panel menu, set it to Off instead.

GL2: W0504 This command is not supported.
Cause Corrective Action

Check the print job.The printer has received an unsupported HP-GL/2
command.

If you have specied ProcessingOption > Warning
> On in the Control Panel menu, set it to Off instead.
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Other Messages

GARO Wxxxx (x represents a number)
Cause Corrective Action

Try printing again, using the correct printer driver.There is a problem with the print job.

It is also possible to continue printing in this state.
However, you may not be able to obtain the desired
printing results.

ERROR Exxx-xxxx (x represents a letter or number)
Cause Corrective Action

An error requiring service may have occurred. Write down the error code and message, turn off the
printer, and contact your Canon dealer for assistance.

Hardware error. xxxxxxxx-xxxx (x represents a letter or
number)

Cause Corrective Action
The last portion of roll paper was used during a
print job. The paper was not advanced because the
trailing edge is taped to the roll.

Turn off the printer and remove the roll from the
printer before restoring power.

Fastening tape or the Belt Stopper has not been
removed inside the Top Cover.

Turn off the printer, open the Top Cover and remove
the tape or the Belt Stopper before restoring power.

An error requiring service may have occurred. Turn off the printer and wait at least three seconds
before restoring the power.
If the message is displayed again, write down the
error code and message, turn off the printer, and
contact your Canon dealer for assistance.

Top cover is open.
Cause Corrective Action

Open the Top Cover fully, remove any foreign objects,
and close the Top Cover again.

The printer has detected that the Top Cover is open.

If the error occurs again, close the Top Cover, turn off
the printer, and wait a while before restoring power.
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Prepare for parts replacement.
Cause Corrective Action

It is almost time to replace consumables for which
service is required.

You can continue to use the printer for some time
until Parts replacement time has passed. will be
displayed.
Contact your Canon dealer for assistance.

Parts replacement time has passed.
Cause Corrective Action

It is past the recommended time to replace
consumables for which service is required.

Contact your Canon dealer for assistance.

Unknown le.
Cause Corrective Action

Data sent to keep the printer up to date (such as
paper information) is in the wrong format.

Check the data. Turn off the printer and wait a while
before restoring power, and then resend the data.

Check the rmware version. Turn off the printer and
wait a while before restoring power, and then resend
the rmware.

You have uploaded rmware for a different model.

If the message is displayed again, contact your
Canon dealer for assistance.

Multi-sensor error
Cause Corrective Action

Direct sunlight or strong lighting may be shining on
the printer and causing the sensor to malfunction.

Take steps to ensure the printer is not used when
exposed to direct sunlight or strong lighting.

The performance of a sensor inside the printer may
be impaired.

Turn off the printer and wait at least three seconds
before restoring the power.
If the message is displayed again, contact your
Canon dealer for assistance.

Error in cutter position.
Cause Corrective Action

The Cutter Unit stops in the middle of cutting. 1.Push the Release Lever back and remove the
paper.

2.Pull the Release Lever forward.
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